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Chapter 1

Introduction

Getting Started

After successfully implementing your design, the next step is to run it in hardware by
programming the FPGA device and debugging the design in-system. All of the necessary
commands to perform programming of FPGA devices and in-system debugging of the
design are in the Program and Debug section of the Flow Navigator in the Vivado®
Integrated Design Environment (IDE) (see Figure 1-1).

HH
Al

Flow Navigator

~ PROJECT MANAGER
£+ settings
Add Sources
Language Templates

1F P Catalog

~ |PINTEGRATOR

Create Block Design

Open Block

Generate Block Design

~  SIMULATION

Run Simulation

~ RTL AMALYSIS

» Open Elaborated Design

v SYNTHESIS
P Run Synthesis

¥ Open Synthesized Design

~ IMPLEMENTATION
P Run Implementation

» OpenImplemented Design

~ PROGRAM AND DEBUG

{i Generate Bitstream

» OpenHardware Manager

Figure 1-1: Program and Debug section of the Flow Navigator panel
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(: X”_INX® Chapter 1: Introduction

Debug Terminology

ILA: The Integrated Logic Analyzer (ILA) feature allows you to perform in-system
debugging of post-implemented designs on an FPGA device. This feature should be used
when there is a need to monitor signals in the design. You can also use this feature to
trigger on hardware events and capture data at system speeds.

The ILA core can be instantiated in your RTL code or inserted post synthesis in the Vivado
design flow. Chapter 10 and Chapter 11 of this guide have more details on the ILA core and
its usage methodology in the Vivado Design Suite. Detailed documentation on the ILA core
IP can be found in the Integrated Logic Analyzer LogiCORE IP Product Guide (PG172)

[Ref 29].

VIO: The Virtual Input/Output (VIO) debug feature can both monitor and drive internal
FPGA signals in real time. In the absence of physical access to the target hardware, you can
use this debug feature to drive and monitor signals that are present on the real hardware.

This debug core needs to be instantiated in the RTL code, hence you need to know up-front,
what nets to drive. The IP Catalog lists this core under the Debug category. Chapter 11 of
this guide has more details on the VIO core and its usage methodology in the Vivado
Design Suite. Detailed documentation on the VIO core IP can be found in the Virtual
Input/Output LogiCORE IP Product Guide (PG 159) [Ref 25].

IBERT: The IBERT (Integrated Bit Error Ratio Tester) Serial Analyzer design enables
in-system serial I/O validation and debug. This allows you to measure and optimize your
high-speed serial I/O links in your FPGA-based system. Xilinx recommends using the IBERT
Serial Analyzer design when you are interested in addressing a range of in-system debug
and validation problems from simple clocking and connectivity issues to complex margin
analysis and channel optimization issues.

Xilinx recommends using the IBERT Serial Analyzer design when you are interested in
measuring the quality of a signal after a receiver equalization has been applied to the
received signal. This ensures that you are measuring at the optimal point in the TX-to-RX
channel thereby ensuring real and accurate data. Users can access this design by selecting,
configuring, and generating the IBERT core from the IP Catalog and selecting the Open
Example Design feature of this core. Chapter 14 and Chapter 15 of this guide have more
details on the IBERT core and its usage methodology in the Vivado Design Suite. Detailed
documentation on the IBERT design can be found in the Integrated Bit Error Ratio Tester for
7 Series GTX Transceivers LogiCORE IP Product Guide (PG132) [Ref 26], Integrated Bit Error
Ratio Tester for 7 Series GTP Transceivers LogiCORE IP Product Guide (PG133) [Ref 27], and
Integrated Bit Error Ratio Tester for 7 Series GTH Transceivers LogiCORE IP Product Guide
(PG152) [Ref 28].

JTAG-to-AXI Master: JTAG-to-AXI Master debug feature is used to generate AXI
transactions that interact with various AXI full and AXI lite slave cores in a system that is
running in hardware. Xilinx recommends that you use this core to generate AXI transactions
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and debug/drive AXI signals internal to an FPGA at run time. This core can be used in
designs without processors as well.

The IP Catalog lists this core under the Debug category. Chapter 11 of this guide has more
details on the JTAG-to-AXI Master core and its usage methodology in the Vivado Design
Suite. Detailed documentation on the JTAG-to-AXI IP core can be found in the JTAG to AX/
Master LogiCORE IP Product Guide (PG174) [Ref 30].

Debug Hub: The Vivado Debug Hub core provides an interface between the JTAG Boundary
Scan (BSCAN) interface of the FPGA device and the Vivado Debug cores, including the
following types of cores:

« Integrated Logic Analyzer (ILA)

« Virtual Input/Output (VIO)

« Integrated Bit Error Ratio Test (IBERT)
«  JTAG-to-AXI

+ Memory IP

ﬁ IMPORTANT: The Vivado Debug Hub core cannot be instantiated into the design. It is inserted by
Vivado during the opt_design stage.

System ILA: The System Integrated Logic Analyzer (System ILA) IP core is a logic analyzer
that allows you to perform in-system debugging of post-implemented designs on an FPGA
device. Use this IP when you need to monitor interfaces and signals in the IP Integrator
Block Design. You can also use this feature to trigger on interface and signal related
hardware events and capture data at system speeds. This ensures the intuitive presentation
of interface events in the Hardware Manager when debugging the design on an FPGA
device. This IP offers AXI interface debug and monitoring capability along with AXI4-MM
and AXI4-Stream protocol checking.

Since the System ILA core is synchronous to the design being monitored, all design clock
constraints that are applied to your design are also applied to the components of the
System ILA core. Detailed documentation on the System ILA core IP can be found in the
LogiCORE IP System Integrated Logic Analyzer Product Guide, (PG261) [Ref 31].

Debug Bridge: The Debug Bridge IP core is a controller that provides multiple options to
communicate with the debug cores in the design.

The primary use case for a Debug Bridge is to use a Xilinx Virtual Cable (XVC) to remotely
debug designs through Ethernet or other interfaces without the need for a JTAG cable.

The other common use case is for debugging Partial Reconfiguration and Tandem with Field
Updates designs. For more information on the Tandem with Field Updates flow and Debug
Bridge refer to UltraScale+ Devices Integrated Block for PCl Express LogiCORE IP Product
Guide (PG213) [Ref 32].
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The Debug Bridge can also be used with the PCle® core in systems where JTAG is not the
preferred communication and debug mechanism. For more information on the using the
XVC flow with the PCle core and Debug Bridge refer to UltraScale+ Devices Integrated Block
for PCI Express LogiCORE IP Product Guide (PG213) [Ref 32].

Detailed documentation on the Debug Bridge core IP can be found in the LogiCORE IP
Debug Bridge Product Guide (PG245) [Ref 33].

In-System IBERT: The In-System IBERT IP enables you to perform 2-D eye-scans of
UltraScale® and UltraScale+ transceivers in your design, using the Vivado Serial IO
Analyzer. The IP uses data from the design to plot the eye-scan of the transceivers in real
time while they interact with the rest of the system. This IP can be integrated with user logic
in the design or Xilinx transceiver based IPs (for example GT Wizard, or Aurora, etc.).

Detailed documentation on the In-System IBERT IP can be found in the LogiCORE IP
In-System IBERT Product Guide (PG246) [Ref 34].

IBERT GTR: IBERT UltraScale+ GTR can be used to evaluate and monitor GTR transceivers in
Zynq UltraScale+ MPSoC devices. With this feature, you can accomplish the following tasks:

« Perform eye scans with user data
« Change GTR settings
» View link status

» Check the "lock” status of all PLLs used by all GTR lanes
However, IBERT GTR does not provide the following capabilities:

« Perform eye scans with raw PRBS data patterns

« Measure Bit Error Ratio (no bit or error counters)

Note that this solution is software based, meaning that no IP or logic is required in the
programmable logic of the device. For a tutorial demonstrating the creation of a first stage
boot loader (FSBL), loading the FSBL into the Zynqg UltraScale+ board, and using IBERT GTR
in the Vivado Hardware Manager, see this link in Vivado Design Suite Tutorial: Programming
and Debugging (UG936) [Ref 10].
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Chapter 2

Vivado Lab Edition

)

Vivado® Lab Edition is a standalone installation of the full Vivado Design Suite with all the
features and capabilities required to program and debug Xilinx® FPGAs after generating
the bitstream. Typical usage is for programming and debug in the lab environment where
machines have a smaller amount of resources in terms of disk space, memory, and
connectivity. Vivado Lab Edition has a reduced product footprint of around 2.4GB after
installation and the install package size is 1GB.

Installation

You will need to use the Lab Edition Installer to install Vivado Lab Edition.

Detailed installation, licensing and release information is available in Vivado Design Suite
User Guide: Release Notes, Installation, and Licensing (UG973) [Ref 7].

Launching Vivado Lab Edition on Windows
To launch Vivado Lab Edition, select the following:

Start>All Programs>Xilinx Design Tools>Vivado Lab 2019.x>Vivado Lab 2019.x

Launching the Vivado Lab Edition from the Command Line on
Windows or Linux

Enter the following command at the command prompt:

vivado_lab

TIP: To run vivado_lab at the command prompt setup your environment using either of the two scripts
(depending on OS platform type):
C:\Xilinx\Vivado_Lab\2019.x\settings32. (bat|sh)
C:\Xilinx\Vivado_Lab\2019.x\settingsé64. (bat[sh)

RECOMMENDED: You can open the Vivado Lab Edition from any directory. However, Xilinx recommends
running it from a writable project directory, because the Vivado Lab Edition log and journal files are
written to the launch directory. When running from a command prompt, launch the Vivado IDE from
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the project directory, or use the vivado_lab -log and journal options to specify a location. When using
a Windows shortcut, you must modify the Start in folder, which is a Property of the shortcut. Failure to
launch from a writable project directory results in warnings and unpredictable behavior from the tool.

Using the Vivado Lab Edition

When you launch the Vivado Lab Edition, the Getting Started page (Figure 2-1) displays and
provides you with different options to help you begin working with the Vivado Lab Edition.

4 Vivado Lab Edition =N R <"
File  Tools Window  Help Q- Quick Access
VIVADO! € XILINX
Lab Edition. ALL PROGRAMMABLE.

Quick Start

Create Project >

Open Hardware Manager >

Learning Center

Documentation and Tutorials »

Quick Take Videos >

Release Motes Guide >

Tcl Console ? 008 X

Qa = s I B B o

© start_gui

Figure 2-1: Vivado Lab Edition Welcome Screen
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Starting with a Project

To program or debug your design, you can create or open a project, and connect to a target
server and device. The Quick Start section of the Getting Started Page provides links for
easy access to the following tasks:

+ Create a project.
« Open existing projects

Note: You can also open recently accessed projects from the Recent Projects list.

Opening the Hardware Manager

You can open the Vivado Design Suite Hardware Manager to download your design
bitstream to a device. Use the Vivado logic analyzer and Vivado serial I/O analyzer features
of the Hardware Manager to debug your design. For example, you can add ILA, VIO, and
JTAG-to-AXI cores to your design for debugging in the Vivado logic analyzer, or use the
IBERT example design from the Xilinx IP catalog to test and configure the GTs in your design
with the Vivado serial I/O analyzer.

Reviewing Documentation and Videos

From the Getting Started page, you can use the Xilinx Documentation Navigator to access
documentation, including user guides, tutorials, videos, and the release notes.

Vivado Lab Edition Project

Vivado Lab Edition allows users in the lab to create projects. All the relevant programming
and runtime debug preferences and settings are stored in the project. When the project is
reopened, the settings and preferences are restored back into the tool. A Vivado Lab Edition
project can be created in both the Vivado Lab Edition tool as well as in Vivado Design Suite.

Create a New Project

To create a new project in Vivado Lab Edition, click the Create New Project icon as shown
below. Enter the project name and location in the New Vivado Lab Edition Project dialog
box. When you create a new project, Vivado Lab Edition creates a project file. The project
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file has the same name as the project name entered in the New Vivado Lab Edition Project
dialog box with the . 1pr extension. See Figure 2-2 below.

¢ Vivado Lab Edition |E||F”Y|
File  Tools Window  Help Q.- Quick Access
[ 4
VIVADO £ XILINX
Lahb Editiono ALL PROGRAMMABLE..

Quick Start

Create Project >
Open Project >

Open Hardwar § _
¢ New Vivado Lab Edition Project

Specify the name and location for a new Vivado Lab Edition project.

Learni

Project name: project_4

Documentatior Project location: | C:/Users/smitha/AppData/Roamina/Xilinkvivado_lab IZ‘
Quick Take Vid)

Tcl Console A o [ K

Q= £ I B B o

atart gui =
< >

Specify the name and location for a new Vivado Lab Edition project.

Figure 2-2: Vivado Lab Edition Creating a New Project

Creating Projects Using Tcl Commands

You can also create a project using Tcl commands. Enter the following command in the Tcl
Console of Vivado Lab Edition or source them from a Tcl file.

create_project project_1 C:/Lab_edition/project_1
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Opening the Project

To open existing projects, click the open project icon as shown in Figure 2-3 or double-click
a project in the Recent Projects list. This opens a browser that enables you to open any
Vivado Lab Edition project file (. 1pr extension). By default, the last ten previously opened
projects are listed in the Recent Projects list. To change this number, click Tools > Settings
and update the Project options. Vivado Lab Edition checks to ensure that the project data
is available before displaying the projects.

¢ Vivado Lab Edition o @ &)

File  Tools Window  Help Q- Quick Access

VIVADO! & XILINX

Lab Edition

Quick Siart Recent Projects

project_4
Create Project > C:/Users/smitha/AppData/Roaming/Xilinx/vivado_lab/project 4

Open Project >
Open Hardware Manager >

s Open Vivado Lab Edition Project
v 2oERke xS [EEE

Lookin: | .4 vivado_lab

& 20151 & project 3 Recent Directories
4 20152 W project_4 C:/Users/smitha/AppData/Roaming/ilinvivado_lab -
4 20153 Ay project_dirs

A+ 20154 File Preview

& 20161 Select afile to preview
A4 20162

& 2016.3

+F 20171

& Xil

A proj_lab_save_as

& project_1

Q A project 2

s
Fie File name: || |

Files oftype: | Vivado Lab Edition Project Files (.lpr)

v

Open one of the most recently used projects or any previously created project.

Figure 2-3: Vivado Lab Edition Open Project Dialog
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Opening Projects Using Tcl Commands

You can also open a project using Tcl commands. Enter the following command in the Tcl
Console of the Vivado Lab Edition or source them from a . tc1 file.

open_project C:/Lab_edition/project_1/project_1.1lpr

Using existing bitstream (.bit) and debug probes (.Itx) files in
Vivado Lab Edition

You can use the existing .bit file and .1tx file from a previous implementation run in the
lab machine where Vivado Lab Edition is installed.

Typical flow would entail the following:

Create a New Vivado Lab Edition project.

Connect to the board.

Specify the .bit file and . 1tx file for the project.

You can either manually copy these files or point to them on a network drive.
Program the device.

Debug the design in your hardware.

Changes are continuously saved to the project

© N o kA w N R

User preferences, runtime manager debug dashboard, and window settings are
continuously saved to the project.

9. User preferences, runtime manager debug dashboard, and window settings are restored
at project reopen.

Using existing .lpr project from Vivado Design Suite Edition

Vivado Design Suite creates an . 1pr file at project startup and populates this file with
appropriate details when you use the Hardware Manager to program and/or debug the
design in the project. This file is located in the project_name.hw directory and is named
project_name.lpr. This project file can be opened in the Vivado Lab Edition.

Typical flow would entail:

+ Click the Open Project icon on the Vivado Lab Edition start page.

« Traverse to the project_name.hw directory, which is located inside the Vivado IDE
project directory

« Select the . 1pr project file inside the project_name . hw directory and click OK.

« Connect to your hardware.

Vivado Programming and Debugging N Send Feedback 17
UG908 (v2019.1) May 22, 2019 www.xilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=17

(: X”_INX® Chapter 2: Vivado Lab Edition

« Program and debug with the correct .bit file and . 1tx file from the appropriate
Vivado runs directory

« User preferences, runtime manager debug dashboard, and window settings are
restored at project open.

Programming Features

After the project is open and the Hardware Manager is connected with a target device, you
can use all the programming features that were available in the Vivado Design Suite from
the Vivado Lab Edition. All the programming related Tcl commands are supported in Vivado
Lab Edition. For more details on the programming features available refer to Chapter 6,
Programming Configuration Memory Devices.

Debug Features

After you open the project and connect the Hardware Manager with a target device, you can
use all the debug features that were available in the Vivado Design Suite from the Vivado
Lab Edition. All the debug related Tcl commands are supported in Vivado Lab Edition. For
more details on the debug features available refer to Chapter 11, Debugging Logic Designs
in Hardware of this user guide.

Vivado Programming and Debugging N Send Feedback 18
UG908 (v2019.1) May 22, 2019 www.xilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=18

& XILINX

Generating the Bitstream

Chapter 3

Before generating the bitstream data file, it is important to review the bitstream settings to
make sure they are correct for your design.

There are two types of bitstream settings in Vivado® IDE:

1. Bitstream file format settings.

2. Device configuration settings.

Select Settings > Bitstream in the Vivado Flow Navigator or Flow > Settings > Bitstream
Settings... menu selection to open the Bitstream section in the Settings popup window

(see Figure 3-1). Once the bitstream settings are correct, the bitstream data file can be

generated using the write_bistream Tcl command or by using the Generate Bitstream
button in the Vivado flow navigator.

¢ Settings

General

Elabaration
Synthesis
Implementation
Bitstream

> P

Tool Settings
Project
IP Defaults
Source File
Display
WebTalk
Help

» Text Editor
3rd Party Simulators

» Colors
Selection Rules
Shortcuts
Strategies

» Window Behavior

©)

Bitstream
Project Settings Specify various settings related to writing bitstream

Simulation @ Configure additional bitstream settings.

*~Write Bitstream (write_bitstream)

tclpre

tel.post
-raw_bitfile
-mask_file
-no_binary_biffile
-bin_file
-readback_file
-logic_location_file
-verbose

Maore Options

HH|

Figure 3-1: Bitstream Settings Panel
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Changing the Bitstream File Format Settings

By default, the write_bitstream Tcl command generates a binary bitstream (.bit) file
only. You can optionally change the file formats written out by the write_bitstream Tcl
command by using the following command switches:

-raw_bitfile: (Optional) This switch causes write_bitstream to write a raw bit file (. rbt),
which contains the same information as the binary bitstream file, but is in ASCII format.
The output file is named filename.rbt.

-mask_file: (Optional) Write a mask file (.msk), which has mask data where the
configuration data is in the bitstream file. This file determines which bits in the
bitstream should be compared to readback data for verification purposes. If a mask bit
is 0, that bit should be verified against the bitstream data. If a mask bit is 1, that bit
should not be verified. The output file is named file.msk.

-no_binary_bitfile: (Optional) Do not write the binary bitstream file (.bit). Use this
command when you want to generate the ASCII bitstream or mask file, or to generate a
bitstream report, without generating the binary bitstream file.

-logic_location_file: (Optional) Creates an ASCII logic location file (.11) that shows the
bitstream position of latches, flip-flops, LUTs, Block RAMs, and I/O block inputs and
outputs. Bits are referenced by frame and bit number in the location file to help you
observe the contents of FPGA registers.

-bin_file: (Optional) Creates a binary file (.bin) containing only device programming
data, without the header information found in the standard bitstream file (.bit).

-reference_bitfile <arg>: (Optional) Read a reference bitstream file, and output an
incremental bitstream file containing only the differences from the specified reference
file. This partial bitstream file can be used for incrementally programming an existing
device with an updated design.

Changing Device Configuration Bitstream Settings

The most common configuration settings that you can change fall into the device
configuration settings category. These settings are properties on the device model and you
change them by using the Edit Device Properties dialog for the selected synthesized or
implemented design netlist. The following steps describe how to set various bitstream
properties using this method:

1. Select Tools > Edit Device Properties.

2.

In the Edit Device Properties dialog, select one of the categories in the left-hand
column (see Figure 3-2).
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TIP: You can type a property in the Search field. For example, type jtag into the Search text field to find
O and select properties related to JTAG programming.

¢ Edit Device Properties @

Use this dialog to edit the programming and configuration properties for your current design; default values are set automatically.

y)

General

General Bitstream Properties

Configuration

Configuration Modes Enable Bitstream Compression FALSE v

Startup

Encryption Enable Cyclic Redundancy Checking (CRC) EMABLE ~

Readback
Enable debugging of Serial mode Bitstream MO w
Disable communication to the Boundary Scan (BSCAN) block via JTAG | NO ~
Enable JTAG Connection to XADC EMNABLE ~
Enable Single Erame Cyclic Redundancy Checking (CRC) NO ~
Enable Enhanced Linearity for XADC OFF w
Enable XADC Power Down DISABLE w

Figure 3-2: Edit Device Properties
3. Set the properties to the desired values, and click OK.
4. Select File > Constraints > Save to save the updated properties to the target XDC file.

You can also set the bitstream properties using the set_property command in an XDC
file. For instance, here is an example on how to change the start-up DONE cycle property:

set_property BITSTREAM.STARTUP.DONE_CYCLE 4 [current_design]

Additional examples and templates are provided in the Vivado Templates. Appendix A,
Device Configuration Bitstream Settings describes all of the device configuration settings.

f IMPORTANT: Edit only the Device Configuration Bitstream Settings relevant to the configuration mode
being used. Leave the other settings at their default values
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Chapter 4

Programming the FPGA Device

The next step after generating the bitstream data programming file is to download it into
the target FPGA device. Vivado® IDE has native in-system device programming capabilities
built in to do this.

Vivado Design Suite and Vivado Lab Edition includes functionality that allows you to
connect to hardware containing one or more FPGA devices to program and interact with
those FPGA devices. Connecting to hardware can be done from either the Vivado Lab
Edition, or Vivado Design Suite graphical user interface or by using Tcl commands. In either
case, the steps to connect to hardware and program the target FPGA device are the same:

1. Open the Hardware Manager.

2. Open a hardware target that is managed by a hardware server running on a host
computer.

3. Associate the bitstream data programming file with the appropriate FPGA device.

4. Program or download the programming file into the hardware device.

Opening the Hardware Manager

Opening the Hardware Manager is the first step in programming and/or debugging your
design in hardware. To open the Hardware Manager, do one of the following:

« If you have a project open, click the Open Hardware Manager button in the Program
and Debug section of the Vivado flow navigator.

+ Select Flow > Open Hardware Manager.

« In the Tcl Console window, run the open_hw command

Vivado Programming and Debugging N Send Feedback 22
UG908 (v2019.1) May 22, 2019 www.xilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=22

2: X”_INX® Chapter 4: Programming the FPGA Device

Opening Hardware Target Connections

The next step in opening a hardware target (for instance, a hardware board containing a
JTAG chain of one or more FPGA devices) is connecting to the hardware server that is
managing the connection to the hardware target. You can do this one of three ways:

+ Use the Open Target selection under Hardware Manager in the Program and Debug
section of the Vivado Flow Navigator to open new or recent hardware targets (see

Figure 4-1).
o General Information -
i i Setu Hold
~ PROGRAM AND DEBUG Timer Settings P
Design Timing Summa y i V © 0.656 y <
'H Generate Bitstream g g ! ry Norst Megative Slack (WNS). 0656 ns Norst Hold
Clock Summary (3 Total Negative Slack (TNS): 0000 ns Total Hald §
~ (Open Hardware Manager y PRV -
& truffle12:3121 xilink_tcfiDigilent/210203327976A PARAM FREQUENCY: 15000000 jmber of F
Open Target >

| B 1ocalhost3121 xilinx_tcfDigilent210203327463A PARAM FREQUENCY-15000000 |2 MUM9¢

Prograd Jlf Auto Connect

» Clear List

Rerent Targets

dd Col t?? g T e

ﬁ Open New Target...
Jpen a recently oper L

Figure 4-1: Using the Flow Navigator to Open a Hardware Target

« Use the Open Target ->Recent targets or Open Target -> Open New Target
selection on the green user assistance banner across the top of the Hardware
Manager window to open recent or new hardware targets, respectively (see
Figure 4-2).

HARDWARE MANAGER unconnected
o Mo hardware target is open. Open target

Jlf Auto Connect
Hardware

Recent Targets 3

a
ﬁ Open I\ﬁwTarget...

Figure 4-2: Using the User Assistance Bar to Open a Hardware Target

+ Use Tcl commands to open a connection to a hardware target.

O TIP: Use the Auto Connect selection to automatically connect to a local hardware target.
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Connecting to a Hardware Target Using hw_server

The list of compatible JTAG download cables and devices that are supported by hw_server
are:

«  Xilinx® SmartLynqg Data Cable (HW-SMARTLYNQ-G/DLC20)
+ Xilinx Platform Cable USB II (DLC10)

« Xilinx Platform Cable USB (DLC9G, DLCIOLP, DLC9)

« Digilent JTAG-HS1

« Digilent JTAG-HS2

« Digilent JTAG-HS3

« Digilent JTAG-SMT1

« Digilent JTAG-SMT2

The hw_server is automatically started by Vivado when connecting to targets on the local
machine. However, you can also start the hw_server manually on either local or remote
machines. For instance, in a full Vivado installation on a Windows platform, at a cmd prompt
run the following command:

C:\Xilinx\Vivado\<Vivado_version>\bin\hw_server.bat

If you are using a Hardware Server (Standalone) installation on a Windows platform, at a
cmd prompt run the following command:

c:\Xi1ilinx\HWSRVR\<Vivado_version>\bin\hw_server.bat

Follow the steps in the next section to open a connection to a new hardware target using
this agent.

For more information on using SmartLynq data cables, see the SmartLynqg Data Cable User
Guide, (UG1258) [Ref 12].

f IMPORTANT: /f Vivado Hardware Manager is connected to the hw_server, and the hw_server is stopped,
the Hardware Manager detects this condition automatically and disconnects from the server.

Opening a New Hardware Target

The Open New Hardware Target wizard provides an interactive way for you to connect to
a hardware server and target. The wizard process has the following steps:
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1. Select a local or remote server, depending on what machine your hardware target is
connected to:

« Local server: Use this setting if your hardware target is connected to the same machine
on which you are running the Vivado Lab Edition or Vivado IDE (See Figure 4-3). The
Vivado software automatically starts the Vivado hardware server (hw_server)
application on the local machine.

« Remote server: Use this setting if your hardware target is connected to a different
machine on which you are running the Vivado Lab Edition or Vivado IDE. Specify the
host name or IP address of the remote machine and the port number for the hardware
server (hw_server) application that is running on that machine (see Figure 4-4). Refer to
Connecting to a Remote hw_server Running on a Lab Machine, page 227 for more
details on remote debugging.

f IMPORTANT: When using remote server, you need to manually start the Vivado hardware server
(hw_server) application of the same version of Vivado software that you will use to connect to the
hardware server.

TIP: If you only want to connect to your lab machine remotely, you do not need to install the full
O Vivado design suite on that remote machine. Instead, you can install the light-weight Vivado Hardware
Server (Standalone) tool on the remote machine.

¢ Open New Hardware Target @

Hardware Server Settings

Select local or remote hardware server, then configure the host name and port settings. Use Local server ifthe ‘
targetis attached to the local machine; otherwise, use Remote server.

Connectto: | Local server (targetis on local machine w

Click Mext to launch andfor connect to the hw_server (port 3121) application on the local machine.

Figure 4-3: Using a Local Hardware Server

Vivado Programming and Debugging N Send Feedback 25
UG908 (v2019.1) May 22, 2019 www.xilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=25

& XILINX.

Chapter 4: Programming the FPGA Device

¢ Open New Hardware Target

Hardware Server Settings

Select local or remote hardware server, then configure the host name and port settings. Use Local server ifthe ‘
target is attached to the local machine; otherwise, use Remote server.

Connectto: | Remote server (target

is on remote maching)

Remote Server
Hostname: reishi1s

Port: 2

[defaultis 3121]

Click Mext to launch andfor connect to the hw_server (port 3121) application on the remote machine ‘reishi1s’.

==

Cancel

Figure 4-4:
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2. Select the appropriate hardware target from the list of targets that are managed by the
hardware server. Note that when you select a target, you see the various hardware
devices that are available on that hardware target.

¢ Open New Hardware Target @

Select Hardware Target

Select a hardware target from the list of available targets, then set the appropriate JTAG clock (TCK) frequency. If you ‘
do not see the expected devices, decrease the frequency or select a different target.

Hardware Targets
Type Mame JTAG Clock Frequency
@ wilinx_tcf  Digilent’21030841C484 | 15000000 Hz

3000000 Hz -

3750000 Hz

5000000 Hz

6000000 Hz

7500000 Hz

10000000 Hz

15000000 Hz B (XVC)
30000000 Hz -

Hardware Devices (for unknown devices, specify the Instruction Register (IR} length)

Mame ID Code IR Length
@ xou9p_0  04B31093 18

Hardware server: reishi15:3121

Figure 4-5: Selecting a Hardware Target

IMPORTANT: /f there are third party devices in the JTAG chain, use the instructions in Xilinx Answer
Record 61312 to add IDCODE, IR Length, and name for the unknown devices.

Troubleshooting a Hardware Target

You might run into issues when trying to connect to a hardware target. Here are some
common issues and recommendations on how to resolve them:

« If you are not able to correctly identify the hardware devices on your target, it might
mean that your hardware is not capable of running at the default target frequency. You
can adjust the frequency of the TCK pin of the hardware target or cable (see
Figure 4-5). Note that each type of hardware target may have different properties.
Refer to the documentation of each hardware target for more information about these
properties.

+  While the Vivado hardware server will attempt to automatically determine the
instruction register (IR) length of all devices in the JTAG chain, in some rare
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circumstances it might not be able to correctly do so. You should check the IR length
for each unknown device to make sure it is correct. If you need to specify the IR length,
you can do so directly in the Hardware Devices table of the Open New Hardware
Target wizard (see Figure 4-5).

Opening a Recent Hardware Target

The Open New Hardware Target wizard is also what populates a list of previously
connected hardware targets. Instead of connecting to a hardware target by going through
the wizard, you can re-open a connection to a previously connected hardware target by
selecting the Open recent target link in the Hardware Manager window and selecting one
of the recently connected hardware server/target combinations in the list. You can also
access this list of recently used targets through the Open Target selection under Hardware
Manager in the Program and Debug section of the Vivado flow navigator.

Opening a Hardware Target Using Tcl Commands

You can also use Tcl commands to connect to a hardware server/target combination. For
instance, to connect to the digilent_plugin target (serial number 210203339395A) that is
managed by the hw_server running on localhost 3121, use the following Tcl commands:

connect_hw_server -url localhost:3121

current_hw_target [get_hw_ targets */xilinx_tcf/Digilent/210203339395A]
set_property PARAM.FREQUENCY 15000000 [get_hw_targets \
*/xilinx_tcf/Digilent/210203339395A]

open_hw_target

Once you finish opening a connection to a hardware target, the Hardware window is
populated with the hardware server, hardware target, and various hardware devices for the
open target (see Figure 4-6).

Hardware ? 008 X
Q = 2 o
MName Status

~ B localhost (1 Connected
~ @ xiling_tcfiXilingPort_#0003Hu..  Open
~ {8 xcTk325t_0 (1) Mot programmed
& XADC (System Monitor

Figure 4-6: Hardware View after Opening a Connection to the Hardware Target
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Associating a Programming File with the Hardware
Device

After connecting to the hardware target and before you program the FPGA device, you need
to associate the bitstream data programming file with the device. Select the hardware
device in the Hardware window and make sure the Programming file property in the
Properties window is set to the appropriate bitstream data (.bit) file.

Note: As a convenience, Vivado IDE automatically uses the .bit file for the current implemented
design as the value for the Programming File property of the first matching device in the open
hardware target. This feature is only available when using the Vivado IDE in project mode. When
using the Vivado IDE in non-project mode, you need to set this property manually.

You can also use the set_property Tcl command to set the PROGRAM. FILE property of
the hardware device:

set_property PROGRAM.FILE {C:/design.bit} [lindex [get_hw_devices] 0]

Programming the Hardware Device

Once the programming file has been associated with the hardware device, you can program
the hardware device using by right-clicking on the device in the Hardware window and
selecting the Program Device menu option. You can also use the program_hw_device
Tcl command. For instance, to program the first device in the JTAG chain, use the following
Tcl command:

program_hw_devices [lindex [get_hw_devices] 0]
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Once the progress dialog has indicated that the programming is 100% complete, you can
check that the hardware device has been programmed successfully by examining the DONE
status in the Hardware Device Properties view.

Hardware Device Properties ? 00X
& %cT7k325t_0 o
Q = 2 |4 - 0 &
> PARTIAL_PROBES -~
> PROBES
> PROGRAM
~ REGISTER

> BOOT_STATUS 00000000000000000000000000000001

> CONFIG_STATUS 01000000000100000111111111111100

> CORO

> COR1 00000000

» EFUSE
~IR 110101
BITO_ALWAYS_ONE 1
BIT1_ALWAYS_ZERO 0
BIT2_ISC_DONE 1
BIT3_ISC_EMABLED 0
1
1

BIT4_INIT_COMPLETE
BIT5S_DONE
» TIMER 00000000
USERCODE i

General Properties

Figure 4-7: Checking the DONE Status of an FPGA Device

You can also use the get_property Tcl command to check the DONE status. For instance,
to check the DONE status of a Kintex®-7 device that is the first device in the JTAG chain, use
the following Tcl command:

get_property REGISTER.IR.BIT5_DONE [lindex [get_hw_devices] 0]

If you use another means to program the hardware device (for instance, a flash device or
external device programmer such as the iMPACT tool), you can also refresh the status of a
hardware device by right-clicking the Refresh Device menu option or by running the
refresh_hw_device Tcl command. This refreshes the various properties for the device,
including but not limited to the DONE status.

i? IMPORTANT: If your design contains debug cores, ensure that the JTAG clock is 2.5x times slower than
the debug hub clock.

ﬁ IMPORTANT: User SCAN Chain: Vivado Programmer tries to detect debug cores on the user scan chain
specified in the design by default. It does the detection by issuing a JTAG_CHAIN 1 command to the
device. If you have programmed a device with a design that does not have any debug cores or a debug
core with a user scan chain of 2, 3, or 4, you will see a Warning.
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To determine the user scan chain setting, open the implemented design and use:

get_property C_USER_SCAN_CHAIN

[get_debug_cores dbg_hub]

You can change the user scan chain used in the Vivado Hardware Manager. Note that the
BSCAN_SWITCH_USER_MASK is a bit mask value. See the following figure.

Alternatively you can specify the user scan chain value as an option to hw_server start-up.

hw_server -e

"set bscan-switch-user-mask <user-bit-mask>"

Hardware 700X
aQa =z = > » N ]
Name Status
~ B localhost(1 Connected
~ e xilink_tefXilingPort_#0003 Hu Open
~ {8 xcTk325t_0 (3) Programmed
em Monitar
& hw_jla_1(base_mb_ilsys.. O Idle
Hardware Device Properties 2 — 0 BX
& xc7Kk325t_0 4 £ -]
2 s 4 =0 i
BSCAN_SWITCH_USER_WMASK  |0001
Tw_device

DID

> FULL_PROBES
IDCODE
IDCODE_HEX
INDEX
IR_LENGTH
1S_SYSMON_SUPPORTED
MASK
MASK_HEX
NAME
PART

> PARTIAL_PROBES

» PROBES

» PROGRAM

» REGISTER
UNKNOWN_DEVICE

General | Properties

Ll i, b i R L i e s s

jsn-DLCY-Port_#0003.Hub_#0004-33651093-0

00110011011001010001000010010011

33651003
0
6
v
00001111111111111111111111111111
OFFFFFFF
xCTK3251_0

XCTR325t

Figure 4-8:

BSCAN Switch User Mask

hub at User Scan Chain of 2 or 4.

TIP: For designs prior to Vivado 2016.3 Xilinx recommends manually launching hw_server with -e
"set xsdb-user-bscan <C_USER_SCAN_CHAIN scan_chain_number>" to detect the debug
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Incorrect Bitstream Assignment Message

Vivado Hardware Manager generates an "incorrect bitstream assignment" message when:

« Attempting to program an FPGA device with a bitstream generated for a different
FPGA.

For example, the following error message appears when trying to program an XCKU115
with an XCVU190 bitstream.

Tel Consola
:3: INFO: [Labtoolstcl 44-466] Opening hw_target xcosmitha32:3l21/%11ink_tcf 20 Ting/Port #0003, Hub_#0004
iy current_hw_device [1index [get_hw_dewices xc7k3I25t_07] O]

(]

refresh_hw_device -update_hw_probes false [1index [get_hw_devices xc7k325t_0] O]

1l INFO: [Labtools 27-1435] Device xc7k325t (JTAG device index = 0) is not programmed (DONE status = 0).

___| set_property PROBES.FILE {/proj/ /xcoswmktossmithas 2016, 3 bash2systen_ilaroject_2_friday_build project_2_friday_huild
H set_property PROGRAM.FILE {/proi/ucoswmkto/smitha/2016,3 bash2/systen_ila/project_2_Triday_build/project_2_friday_buin
;-’-] @ Cprogran_tw_dewvices [Tindex [get_tw_dewvices xc7k325t_0] 0]

ﬁf . ERROR: [#UNDEF] Incorrect bitstream assigned to device. Bitfile 15 incompatible for this device.

" ERROR: [Labtools 27-3165] End of startup status: LOW

ERROR: [Common 17-397 'program_hw_devices' fajled due to earlier errars.

i J

5 Tcl Console 0 Messages | 27 IP Status % Serial 1f0 Links  [& Serial /0 Scans
Figure 4-9: Programming an xckul15 with an xcvu190 Bitstream
The solution is to specify the correct bitstream for the FPGA being programmed.

Attempting to Program an FPGA Device with a Bitstream Generated for a Different Silicon
Revision of the FPGA

Programming devices with a bitstream generated for a different silicon revision is not
supported, and might not function correctly, and could cause device damage.

- For example, the XCKU115 device comes in -esl and a later -es2 silicon version as
well as a production silicon version. These -esl or -es2 silicon version suffixes

appear in the part selector when you select an FPGA device for a Vivado IDE project.
The production version has no suffix.

- Do not program a device with a bitstream created for a different version of the
silicon. For example, do not program a bitstream created for -esl silicon into -es2
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silicon or program a bitstream created for -es2 silicon into -esl silicon. Either of
these causes the error message shown in the following figure to appear.

lessage

o There were two error messages while Program Configuration Memory Device

Messages

! ] [Labtools 27-2299] Incarrect bitstream assigned to device. Bitstream was generated
for part xckullS-fhvals17-1-i-es2, target device (with IDCODE revision 0) is
compatible with esl revision bitstreams.

Ta allow the bitstream to be programmed to the device, use "set_param
xicom. use_bitstream_version_check false” 1cl command

@ [Labtools 27-3165) End of startup status: LOW

| oK || Open Messages view |

Figure 4-10: Bitstream and Silicon Version Incompatibility

Attempting to Program Configuration Memory Attached to an FPGA Device.

To program configuration memory attached to an FPGA device, Vivado Hardware
Manager first downloads a flash controller bitstream to the FPGA device. Hardware
Manager then sends flash commands and data through the FPGA device's JTAG port to
be processed by the controller, which then sends the processed flash commands/data to
the configuration memory interface.

The controller bitstream downloaded by Hardware Manager is generated for the latest
silicon revision of the FPGA device. For example, the configuration memory controller
bitstream for the XCKU115 in 2016.3 and later was generated for XCKU115-es2 silicon.

When programming configuration memory attached to this FPGA, if the user has an
XCKU115-es1 device on the board, the error message shown in Figure 4-10 appears.
This is because Hardware Manager is attempting to download the -es2 flash controller
bitstream into the -esl device.

Closing the Hardware Target

You can close a hardware target by right-clicking on the hardware target in the Hardware
window and selecting Close Target from the popup menu. You can also close the hardware
target using a Tcl command. For instance, to close the xilinx_platformusb/USB21 target on
the localhost server, use the following Tcl command:

close_hw_target {localhost/xilinx tcf/Digilent/210203339395A}
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)

Vivado Programming and Debugging

IMPORTANT: /f the board is powered off or cable disconnected, Vivado IDE closes the hardware target
in the Hardware Manager. Any Vivado operation in the main Vivado thread is also canceled. If the
board is powered back on or the cable is reconnected, the Vivado IDE will attempt to re-open the
hardware target in the Hardware Manager.

Closing a Connection to the Hardware Server

You can close a hardware server by right-clicking on the hardware server in the Hardware
window and selecting Close Server from the popup menu. You can also close the hardware
server using a Tcl command. For instance, to close the connection to the localhost server,
use the following Tcl command:

disconnect_hw_server localhost

IMPORTANT: /f Vivado Hardware Manager is connected to the hw_server, and the hw_server is stopped,
the Hardware Manager detects this condition automatically and disconnects from the server.

Reconnecting to a Target Device with a Lower JTAG
Clock Frequency

The JTAG chain is as fast as the slowest device in the chain. Therefore, to lower the JTAG
clock frequency, connect to a target device whose JTAG clock frequency is less than the
default JTAG clock frequency.

You should attempt to open with a default JTAG clock frequency that is 15 MHz for the
Digilent cable connection and 6 MHz for the USB cable connection. If it is not possible to
connect at these speeds, Xilinx recommends that you lower the default JTAG clock
frequency even further as described below.
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To change the JTAG clock frequency, use the Open New Hardware Target wizard, from
Vivado Design Suite, as shown in Figure 4-11.

¢ Open New Hardware Target @

Select Hardware Target

Select a hardware target from the list of available targets, then setthe appropriate ‘
JTAG clock (TCK) frequency. If you do not see the expected devices, decrease the

Hardware Targets

Type Mame JTAG Clock Frequency

@ xilinx_tcf  Digilent’210308A1C484 | 15000000 Hz

3000000 Hz -
3750000 Hz
5000000 Hz
6000000 Hz
7500000 Hz
10000000 Hz

Add Xilinx Vil 15000000 Hz
30000000 Hz -

Hardware Devices (for unknown devices, specify the Instruction Register (IR} length)

Mame ID Code IR Length
@ xou9p_0  04B31093 18

Hardware server: reishi15:3121

et

Figure 4-11: Vivado Lower JTAG Frequency

Alternately, you can use the following sequence of Tcl commands:

open_hw
connect_hw_server -url machinename:3121
current_hw_target [get_hw_targets */xilinx_ tcf/Digilent/210203327962A]

set_property PARAM.FREQUENCY 250000 [get_hw_targets */xilinx_tcf/Digilent/210203327962A]
open_hw_target
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Connecting to a Server with More Than 32 Devices
in a JTAG Chain

It is possible to connect to a server which has more than 32 devices in its JTAG chain in
Vivado. You need to provide option max-jtag-devices at the startup of hw_server to
enable the ability to detect more devices in a scan chain. The default value for this setting
is 32. Note that increasing this number will slow down the device discovery process which
in turn can slow down cable access.

Specify the max-jtag-devices option at hw_server start-up as follows:

hw_server -e "set max-jtag-devices 64"

Usage

This option is used to start up the hw_server with the ability to enable ir lengths greater
than 64 bits. The default value for this setting is 64. You can increase this value for devices
in the JTAG chains whose ir length are wider (for example 93). Note that increasing this
number will slow the device discovery process, which in turn can slow cable access.
Therefore, you should only increase this value for systems with long ir lengths and device
counts.

This is how you specify the option at hw_server start-up:

hw_server -e "set max-ir-length 93"

Init Option

You may also use the --init=script.txt option to load this setting through a file. To
use the init option, create a initialization script as shown in the following example. In the
script, specify the set max-jtag-device parameter.

# Sample script.txt
set max-ir-length 93

Start the hw_server as shown in the following example:

hw_server --init=script.txt
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Chapter 5

Remote Debugging in Vivado

The need for remote debugging may arise in a variety of situations. It could be required in
the prototyping phase of a product, where you might want to debug a design in the lab
without physical access to the lab, or where you might want to share resources across your
organization. Remote debugging could also be required to perform in-the-field debug to
diagnose issues or extend product life cycle.

Xilinx provides multiple solutions to debug your design remotely. This can be done using
the Xilinx Hardware Server product to connect to a remote computer in the lab. You could
also implement the Xilinx Virtual Cable (XVC) protocol to connect to a network-connected
board. Each of these solutions are explained in detail in the sections below.

Using Vivado Hardware Server to Debug Over
Ethernet

You can connect to a remote lab machine using Vivado Hardware Server product. This is a
small sized (<100MB) standalone download available for install on the lab machine. This
option requires intranet or internet access and can be used internally just within your
organization as well.

VIVADO'

INTERNET / INTRANET

X14741-0623"

Figure 5-1: Debug via Internet/Intranet Using Hardware Server
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Xilinx Virtual Cable (XVC)

Vivado IDE supports the Xilinx Virtual Cable (XVC) protocol. Xilinx Virtual Cable provides a
means to access and debug a Xilinx device without using a USB or parallel configuration
cable. This capability helps facilitate Vivado IDE to debug for designs that:

+ Have the FPGA in a hard-to-access location, where a "lab-PC" is not close by.

« Do not have direct access to the device pins on the board - e.g. the JTAG pins are only
accessible via a local microprocessor interface.

XVCis an internet-based (TCP/IP) protocol that acts like a JTAG cable. It has very basic cable
commands. This allows XVC to provide the ability to debug a system over an intranet, or
even the internet. With this ability you can save on costly or impractical travel and reduce
the time it takes to debug a remotely located system.

Another common usage of XVC is for shared systems that are not co-located with teams
that need access to them. It can also be used when there are physical constraints to using
the system, as when the JTAG connector is not available or accessible. XVC implementation
is programming language and platform independent

Rather than using a dedicated JTAG header, an existing Ethernet connection can be used to
create the appropriate JTAG commands from a processor to a target device. With the XVC
v1.0 Protocol, Vivado can communicate the same JTAG commands over an Ethernet
connection and still support all of the existing Vivado debug features.

ﬁ IMPORTANT: If the Vivado Debug Bridge IP is used for XVC, Vivado IDE does not support programming
features. The assumption is that the device is programmed before using XVC to debug the design.

Vivado Debug Bridge IP and Xilinx Virtual Cable (XVC) Flow

The Vivado Debug Bridge IP core is a controller that provides multiple options to
communicate with the debug cores in the design. This design can be a flat design or a
Partial Reconfiguration (PR) design. In addition, the Debug Bridge IP core can also be
configured to take advantage of debugging designs using a JTAG cable or remotely through
Ethernet, PCle, or other interfaces without the need for a JTAG cable.

Different modes in Debug Bridge IP facilitate the support of various use cases.

Debug Bridge in XVC Modes

There are five modes in the Debug Bridge that are used in Xilinx Virtual Cable (XVC)
implementations.

Vivado Programming and Debugging N Send Feedback 38
UG908 (v2019.1) May 22, 2019 www.xilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=38

2: X”_INX® Chapter 5: Remote Debugging in Vivado

From AXI to BSCAN: In this mode, the Debug Bridge receives XVC Commands via
AXI4-Lite slave interface.

From JTAG to BSCAN: In this mode, the Debug Bridge receives XYC Commands via
JTAG slave interface driven by user logic.

From PClIe to BSCAN: In this mode, the Debug Bridge receives XYC Commands via
PCle Extended Configuration slave interface.

From PCle to JTAG: In this mode, the Debug Bridge receives XYC Commands via PCle
Extended Configuration interface. This Debug Bridge brings out the JTAG pins out of
the FPGA through I/O pins. This mode is mainly used to debug design on another
board over XVC.

From AXI to JTAG: In this mode, the Debug Bridge receives XVC commands via
AXI4-Lite interface to send over the JTAG pins to a target device.

In all of these modes the Debug Bridge can further communicate with other debug cores/
Debug Bridge instances in the design via the Soft-BSCAN (Boundary Scan) interface. The
Soft BSCAN master interface enables extension of the JTAG interface to internal USER
defined scan chains/Debug Bridge instances.

Using Debug Bridge IP in Partial Reconfiguration (PR) Designs

The Debug Bridge IP can be used in both flat and PR designs. Below are the details on the
Debug Bridge configurations used in the static or Reconfigurable Partition (RP) region of a
PR design. Multiple Debug Bridge instances are permitted in a partition depending on the
design requirements.

BSCAN Primitive: This mode is used when a Debug Bridge containing a BSCAN
primitive is required in the static region. The BSCAN master interface of this Debug
Bridge can be connected to another Debug Bridge instance in the static and/or PR
region(s) providing one or more communication pathways for debugging those
regions.

From BSCAN to Debug Hub: In this mode, the Debug Bridge uses the BSCAN slave
interface to communicate to Vivado Hardware Manager. It uses the Debug Hub
interface to communicate with the design cores within the relevant static or RP region.
You can also optionally add additional BSCAN Masters to the output of this Debug
Bridge, which enables debugging other debug cores like MicroBlaze Debug Module
(MDM) or other Debug Bridge instances.

Note: The tool automatically connects the debug cores in an RP to the Debug Bridge if this is the
only Debug Bridge instantiated in the partition.

From AXI to BSCAN: In this mode, the Debug Bridge receives XVYC Commands via
AXI4-Lite slave interface. This Debug Bridge can further communicate with other debug
cores/ Debug Bridge instances in the design via the Soft-BSCAN (Boundary Scan)
master interface. The Soft BSCAN interface enables extension of the JTAG interface to
internal USER defined scan chains/Debug Bridge instances.
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« From JTAG to BSCAN: In this mode, the Debug Bridge receives XVYC Commands via
JTAG slave interface driven by user logic. This Debug Bridge can further communicate
with other debug cores/ Debug Bridge instances in the design via the Soft-BSCAN
(Boundary Scan) master interface. The Soft BSCAN interface enables extension of the
JTAG interface to internal USER defined scan chains/Debug Bridge instances.

« From PClIe to BSCAN: In this mode, the Debug Bridge receives XYC Commands via
PCle Extended Configuration slave interface. This Debug Bridge can further
communicate with other debug cores/ Debug Bridge instances in the design via the
Soft-BSCAN (Boundary Scan) interface. The Soft BSCAN master interface enables
extension of the JTAG interface to internal USER defined scan chains/Debug Bridge
instances.

Note: This mode is only available for UltraScale+™ and UltraScale™ device architectures

+  From PCle to JTAG: In this mode, the Debug Bridge receives XVYC Commands via PCle
Extended Configuration interface. This Debug Bridge brings out the JTAG pins out of
the FPGA through I/O pins. This mode is mainly used to debug design on another
board over XVC.

Note: This mode is only available for UltraScale+™ and UltraScale™ device architectures.

*  From AXI to JTAG: In this mode, the Debug Bridge receives XVC commands via
AXI4-Lite interface to send over the JTAG pins to a target device.

JTAG Fallback Support

The XVC based debug solution can be used with AXI masters such as the PCle XDMA IP. If
the AXI master is in a hang situation or is otherwise not functioning properly, there are no
methods to debug those scenarios. To provide a JTAG-based fall back debug pathway that
is parallel to the XVC pathway, Xilinx recommends using the Debug Bridge in BSCAN
Primitive mode. A Debug Bridge in BSCAN Primitive mode can be instantiated in static
region and its BSCAN master interface can be connected to the BSCAN slave interface of a
second Debug Bridge that is configured with the JTAG Fallback Support enabled. There are
two JTAG Fallback Support types:

1. If the Debug Bridge that you want to provide JTAG Fallback for resides in a PR region,
you need to enable the External BSCAN Master JTAG Fallback Support.

2. If the Debug Bridge that you want to provide JTAG Fallback for resides in the static
region (orin a flat design), you should enable the Internal BSCAN Master JTAG Fallback
Support.

Microblaze Debug Module (MDM) Support

Debug access to Microblaze Debug Module (MDM) is also supported by the Debug Bridge.
The MDM BSCAN slave input can be connected to any Debug Bridge configuration mode
that supports multiple BSCAN master interfaces at the output (for example, AXI to BSCAN
with its BSCAN Master Count greater than zero).
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Multiple Debug Trees

The Debug Bridge IP supports the setup and configuration of multiple independent debug
trees in a design. You can use multiple independent debug trees in applications where it is
desirable to make specific debug logic visible to certain users (e.g., system administrators)
while hiding it from other users. This feature supports the setup of independent debug
trees both in a standalone and partial reconfiguration design. Each of these independent
debug trees can be connected to any of the supported debug cores (e.g. ILAs, VIOs etc).

To enable this feature, you need to instantiate one Debug Bridge IP in the appropriate
mode, either the "From AXI to BSCAN" or "From PCle to BSCAN" mode, for each of the
debug trees you want to enable. For instance, in a data center design where multiple classes
of users will access the DUT, you can instantiate a "From AXI to BSCAN" Debug Bridge IP in
the customer-visible address map while instantiating a second "From AXI to BSCAN" Debug
Bridge IP in the administrator-visible address map.

When the administrator and/or the customer are ready to debug the design, they will only
have to connect to the debug bridge using the Vivado Hardware Manager at the correct
device offset depending on how they are communicating with the debug cores (i.e. PCle or
JTAG pins). For more information on using the XVC flow with the PCle core and Debug
Bridge in this mode, and for an example design refer to UltraScale+ Devices Integrated Block
for PCI Express LogiCORE IP Product Guide, (PG213) [Ref 32].

Below is a table listing the different Debug Bridge modes and features available in those
modes:

Table 5-1: Debug Bridge Modes

Can be used In
Debug Bridge Mode s XVe Reconfigurable ITAG Fallback MDM
upport Partition Support Support

From AXI to BSCAN Yes Yesl Yes? Yes3
From JTAG to BSCAN Yes Yesl Yes? Yes3
From PCle to BSCAN Yes Yes! Yes? Yes3
From PCle to JTAG Yes Yes! NA NA

From BSCAN to No Yesl NA Yes3
DebugHub

BSCAN Primitive No No NA Yes3
From AXI to JTAG Yes Yes NA NA

1. BSCAN Master Count can be greater than 0 and can be connected to other Debug Bridge instances or
MicroBlaze/MDM core within the same RP only.

2. Internal BSCAN Mode can only be used when the Debug Bridge is in static partition while External BSCAN Mode
can be used when the Debug Bridge is in either the static or RPs.

3. BSCAN Master Count option must be greater than 0 and a BSCAN master is connected to the MicroBlaze/MDM
core.
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Below is an illustration of a design with the XVC Debug Bridge in an RP.

STATIC

Counter-RP Debug Bridge
(RM — count_down) (From BSCAN to

- DebugHub) ~  fesessssnees > LA
%| Debug Bridge
“|  AXI-to-BSCAN + Ext

BSCAN Primitive +
B] multiple BSCAN master

BSM — BSCAN Master

i

BSM

Debug Bridge

BSCAN Primitive + ifter-
multiple BSCEI;\T;\II Ir‘mlﬁeaster z SRhll\;tel’ T\F;t left
&) = (RM — shift_left) Debug Bridge
B 2 9| (FromBSCAN
M|

DebugHub)

[Bss |

BSS

Debug Bridge }»{ ila1
(From BSCAN to
DebugHub)

| ila2 1

Figure 5-2: Partial Reconfiguration Design with the XVC Debug Bridge in an RP

This is a PR design with two reconfigurable partitions, Counter RP and Shifter RPs. This
figure illustrates the different Debug Bridge modes used in both static and RP regions.

The static partition of design has two Debug Bridge IPs. The first Debug Bridge IP is in
BSCAN Primitive mode and configured to have three BSCAN master interfaces. Two of the
BSCAN master interfaces are connected to the Debug Bridge instances in Counter-RP and
Shifter-RP partitions providing a parallel path for debug. The third BSCAN master interface
is connected to another Debug Bridge instance within the static partition configured in the
From BSCAN to Debug Hub mode. The Debug Bridge configured in From BSCAN to
Debug Hub mode can communicates to the various Debug IPs (ILA, VIO, JTAG-to-AXI, etc.)
in the design, which in this case is the ILA IP.

In this system the Counter-RP partition contains a Debug Bridge instantiated in the
AXI-to-BSCAN mode. You can use this Debug Bridge in XVC mode, the Debug Bridge
receives XVC Commands via AXI4-Lite interface. This Debug Bridge can further
communicate with other Debug Bridge instances in the design via the Soft-BSCAN
(Boundary Scan) interface. Since this Debug Bridge is configured to contain two BSCAN
master interfaces it communicates with the MDM and the Debug Bridge instance
configured in From BSCAN to Debug Hub mode. The Debug Bridge configured in From
BSCAN to Debug Hub mode can communicates to the various Debug IPs (ILA, VIO,
JTAG-to-AXI etc.) in the design, which in this case is the ILA IP.

On the other hand, the Shifter-RP partition contains only one Debug Bridge instance
configured in From BSCAN to Debug Hub mode that can communicate with the various
Debug IPs (ILA, VIO, JTAG-to-AXI etc.) in the design, which in this case is the ILA IP.
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For more information see the Debug Bridge v2.0 LogiCORE IP Product Guide, (PG245)
[Ref 19].

An illustration of some of the Debug Bridge modes is presented below.

From AXI to BSCAN

This bridge type is intended for designs using Xilinx Virtual Cable (XVC) to remotely debug
an FPGA or SoC device through Ethernet or other interfaces without the need for JTAG
cable. In this mode, the Debug Bridge expects to receive Xilinx Virtual Cable commands via
AXI4-Lite interface. Use this mode to debug designs on the FPGA device over the Xilinx
Virtual Cable.

For more information, see the LogiCORE IP Debug Bridge Product Guide, (PG245) [Ref 33].

Target Board/FPGA € XILINX

Zynq Debug __Debug IP 1
[ ¢ > P - Bridge .|| Debug (eg ILA, VIO etc)
VIVADO XVC over TCP/IP XVC Server (FromAXI ¥ gsrpn | Hub | DebugiPn
to BSCAN) (eg ILA, VIO etc)
hw_server
- User Solution
Vivado Solution Data Center

X17961-092816

Figure 5-3: AXI to BSCAN Debug Bridge

From PCle to BSCAN

In a typical PCle setup - you can use the Debug Bridge in the PCle to BSCAN mode to
communicate with the debug cores. In this mode, Debug Bridge connects to the Extended
Configuration Interface of the PCle IP. This is a common data center use case where PCle is
the preferred communication pathway to the Host PC instead of JTAG. For more information
on using the XVC flow with the PCle core and Debug Bridge in this mode, and for an
example design refer to UltraScale+ Devices Integrated Block for PCl Express LogiCORE IP
Product Guide (PG213) [Ref 32].
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Target FPGA £ XILINX
. Debug
Pl i --- Debug Core 1
VIVADO! [[*xve Jrocessor - BN (cuenos PR BNICOUN DRSS LUV s
over . e ex N
TCP/IP A | Configuration) cfg to BSCAN) Debug Core n

hw_server

- User Solution
D Vivado Solution

Figure 5-4: PCle to BSCAN Debug Bridge Used with PCle Extended Configuration Interface

X17962-040517

From JTAG to BSCAN

This bridge type is intended for designs that use Xilinx Virtual Cable (XVC) to remotely
debug an FPGA or SoC device through Ethernet or other interfaces without the need for
JTAG cable. In this mode, the Debug Bridge expects to receive XVC commands via JTAG
interface driven by user logic. For more information see the LogiCORE IP Debug Bridge
Product Guide, (PG245) [Ref 33].

Target Board

Target FPGA € XILINX
Debug __DebugIP 1
\AVADO’ Processor g Bridge || Debug (eg ILA, VIO etc)
XVC over [LaMEEENERT] GPIO/Clistom | utag | (From JTAG fggoaN | Hub | DebugIPn
TCP/IP Interface User Logic to BSCAN) (eg ILA, VIO etc)
hw_server
- User Solution
D Vivado Solution Data Center
X17963-092816

Figure 5-5: JTAG to BSCAN Debug Bridge

From PCle to JTAG

In a PCle setup, you can use the Debug Bridge in the PCle to JTAG mode to communicate
with the debug cores. In this mode, Debug Bridge connects to the Extended Configuration

Vivado Programming and Debugging Send Feedback a4
UG908 (v2019.1) May 22, 2019 www.Xxilinx.com l—\/—l


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=44

8 X”_INX® Chapter 5: Remote Debugging in Vivado

Interface of the PCle® IP, which in turn can communicate over JTAG to the debug hub on a
different target FPGA.

Target Board

FPGA #1 £ XILINX FPGA#2 & XILINX
Debug
: ---Debug Core 1
PCle Bridge —> Debug | =777,
gl WMaster ’ ’ (From PCle Hub
PCle ext JTAG ---Debug Core n
cfg to JTAG)

X17964-040517

Figure 5-6: PCle® to JTAG Debug Bridge Used with PCle Extended Configuration Interface

From AXI to JTAG

This bridge type is intended for designs that use Xilinx Virtual Cable (XVC) to remotely
debug an FPGA or SoC device through Ethernet or other interfaces. In this mode, the Debug
Bridge receives XVC commands via AXI4-Lite interface to send over the JTAG pins to a target
device. For more information see the LogiCORE IP Debug Bridge Product Guide, (PG245)

[Ref 33].
Target Board
FPGA#1 £ XILINX FPGA#2 & XILINX
Debug Debug __Debug IP 1
~ Zynq Processor Bridge Bridge | Debug (eg ILA, VIO etc)
vel XVC Server AXI (From AXI to JTIAIG (From JTAG BSCAN Hub | |DebugIPn
P JTAG) to BSCAN) (eg ILA, VIO etc)
Data Center

X17966-092816

Figure 5-7: AXIl to JTAG Debug Bridge

XVC Server Implementation

You need to implement the XVC protocol to create an XVC server on the appropriate
processor.
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XVC Protocol

The XVC protocol allows Vivado IDE to communicate JTAG commands over ethernet to an
embedded system so that a target Xilinx device can be programmed and/or debugged. This
enables a vendor agnostic solution for debugging and programming a Xilinx device.
Programming capabilities include the same support as a traditional JTAG connection would
provide. Debugging capabilities include operability with Xilinx System Debugger (XSDB) or
with Vivado Hardware Debug IP.

The JTAG commands to the device are the same commands that would have been
transferred to the device if it were natively communicating with a programming cable or
using a Digilent module. This ensures functionality between all the existing Vivado
Hardware Debug tools.

User XVC 1.0 Commands

The XVC 1.0 Protocol commands are summarized in Table 5-2

Table 5-2: Description of XVC commands

Command | Description

getinfo Command format:
getinfo:

This command gets the XVC Service version. The service returns the following
string when it receives "getinfo:”

xvcServer_vl1.0:<xvc_vector_len>\n

<xve_vector_len> is the max width of the vector that can be shifted into
the service.
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Table 5-2: Description of XVC commands (Cont’d)

Command | Description

shift Command format:
shift: [num bits] [tms vector] [tdi wvector]

This command shifts in num_bits using the byte vectors tms_vector and
tdi_vector

« num_bits is an integer in little-endian mode.

This represents the number of TCK clk toggles needed to shift the vectors
out.

« tms_vector is a byte sized vector with all the TMS shift bits.
Bit 0 in Byte 0 of this vector is shifted out first.
The vector is num_bits and rounds up to the nearest byte.

e tdi_vector is like tms_vector but this represents all the tdi vectors to
be shifted in.

This command returns a byte vector of the same size as tms_vector with the
corresponding tdo bits sampled for every bit shifted in.

Bit 0 in Byte O of this vector is the first tdo value read from the shift

settck Command format:
settck: [period]
This command attempts to set the service tck period to [period].
e [period] is specified in ns.
This is a little-endian integer value
This command returns the applied period when it completes settck:.
¢ Returned value is specified in ns.
This is a little-endian integer value

Initializing Vivado IDE hw_server

When Vivado IDE hw_server is initialized with an XVC connection Vivado IDE discovers the
XVC cable just like any USB cable. To do that, start the Vivado IDE hw_server with these
arguments

hw_server -e "set auto-open-servers xilinx-xvc:localhost:10200"

The auto-open-servers option enables the XVC cable to be initialized by hw_server at
start up. You can initialize the hardware server to force a connection to an existing XVC
cable. The server will automatically discover the XVC cables in future connections.

The argument to auto-open-servers is as follows
xilinx-xvc:<xvc_host_name>:<xvc_port>

Multiple servers can be specified using comma separated strings. When the hardware
server starts, it attempts to establish connections to the specified XVC servers. Alternatively
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you can provide the XVC server details when connect
Hardware Manager Open New Hardware Target wiz

Chapter 5: Remote Debugging in Vivado

ing to the target using the Vivado
ard as shown in the following figure.

¢ Open New Hardware Target

Select Hardware Target

expected devices, decrease the frequency or select a different target.

Hardware Targets

Type Mame

 xilim_tef  XilinAdo1A11n0

JTAG Clock Frequency

6000000 hd

Select a hardware target from the list of available targets, then setthe appropriate JTAG clock (TCK) frequency. If you do not see the

==

¢

Hardware Devices (for unknown devices, specify the Instruction Register (IR) length)

Mo o

Hardware server: 172.20.8.216:3121

I Add Xilinx Virtual Cable (XVC) I

Cancel

Figure 5-8: Open New Hardware Target Dialog

Click the Add Xilinx Virtual Cable button. This brings
as shown in the following figure.

up the Add Virtual Cable dialog box

s Add Virtual Cable [l
Specify the host name and the port of the virtual cable ‘
Hostname: hd |
Port: 2542 [defaultis 2542]
©)

Figure 5-9: Add Virtual Ca

ble Dialog

You will then provide the XVC Hostname and Port number to connect to.

Refer to Xilinx Virtual Cable Running on Zynq-7000 Using the Petalinux Tools (XAPP1251)

[Ref 20] for an example of this.
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This application note shows how to get a Xilinx Virtual Cable (XVC) server running on a
Zynq®-7000 device with a Linux operating system generated with the PetaLinux Tools. A
reference design is provided for the Avnet MicroZed board. The target device in this

application note is on an AC701 board and will be programmed and debugged by the
MicroZed board running XVC on Linux.

Note: For an example XVC server implementation over TCP/IP, refer to the following github
repository: https://github.com/Xilinx/XilinxVirtualCable.
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Chapter 6

Programming Configuration Memory
Devices

The Vivado® device programmer feature enables you to directly program Xilinx® FPGA
devices via JTAG. Vivado can also indirectly program select Flash-based configuration
memory devices via JTAG. Do this by first programming the Xilinx FPGA device with a
special configuration that provides a data path between JTAG and the Flash device interface
followed by programming the configuration memory device contents using this data path.

The Vivado device configuration feature enables you to directly configure Xilinx FPGAs or
Memory Devices using either Xilinx or Digilent cables. See Connecting to a Hardware Target
Using hw_server, page 24 for a list of appropriate cables. Operating in Boundary-Scan

mode, Vivado can configure or program Xilinx FPGAs, and Configuration Memory Devices.

Refer to Appendix D, Configuration Memory Support for a complete list of configuration
memory devices supported by Vivado.

To program and boot from a Configuration Memory Device in Vivado follow the steps
below.

Generate bitstreams for use with configuration memory devices.
Create a Configuration Memory File (.mcs or .bin).

Connect to the Hardware target in Vivado.

1

2

3

4. Add the configuration memory device.

5. Program the configuration memory device using the Vivado IDE.
6

Boot the FPGA device (optional).
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Generate Bitstreams for use with Configuration
Memory Devices

On the synthesized or implemented design select Tools->Edit Device Properties to open
the Edit Device Properties dialog as shown below

On the synthesized or implemented design, from Flow Navigator, select Settings ->
Bitstream, and click the Configure additional bitstream settings link to open the Edit
Device Properties dialog as shown below.

¢ Edit Device Properties @

Use this dialog to editthe programming and configuration properties for your current design; default values are set automatically.

General

General Bitstream Properties

Configuration

Configuration Modes Enable Bitstream Compression FALSE -

Startup

Encryption Enable Cyclic Redundancy Checking (CRC) EMABLE

Readback
Enable debugging of Serial mode Bitstream MO hd
Disable communication to the Boundary Scan (BSCAN) blockvia JTAG | NO hd
Enable JTAG Connection to XADC EMABLE hd
Enable Single Erame Cyclic Redundancy Checking (CRC) MO hd
Enable Enhanced Linearity for XADC OFF hd
Enable XADC Power Down DISABLE w

Figure 6-1: Edit Device Properties: Search Field

Use the search field in the upper left of the dialog box to search for all SPI or BPI related
fields and select the appropriate option settings. See Appendix A, Device Configuration
Bitstream Settings for the device configuration settings.
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Creating a Configuration Memory File

Use the write_ cfgmem Tcl command to create the .mcs or .bin programming file. This
file will be used in programming the configuration memory device.

For example, to generate an .mcs file for a single 1Gbit BPI configuration memory device:

write_cfgmem -format mcs -interface bpixl6 -size 128 \
-loadbit "up 0x0 design.bit"-file design.mcs

Note: The -size argument to write_cfgmem is in megabytes, different from flash device capacity
which is based on megabits. Hence, a 1Gbit sized flash device is provided as 128 megabytes to
write_cfgmem in the example above. Note that write_cfgmem automatically sizes the
configuration memory file to the size of the bitstream.

Vivado IDE supports the ability to chain multiple .bit files together using the
write_cfgmem command. To generate an .mcs file for a single 1Gbit BPI configuration
memory device containing multiple bitstreams:

write_cfgmem -format mcs -interface bpixl6 -size 128 \
-loadbit "up 0 designl.bit up OXFFFFF design2.bit" \
-file designl_design2.mcs

For more information on write_cfgmem command refer to the Vivado Design Suite Tcl
Command Reference (UG835) [Ref 11].

O TIP: You can create configuration memory files in Vivado Lab Edition.
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You can also create the Configuration Memory file in Vivado IDE. Click on Tools > Generate
Memory Configuration File. This will bring up the Write Memory Configuration File
dialog box as shown below.

¢ Write Memory Configuration File @
Create a configuration file to program the device ‘
Format: MCS w
Memory Part: &
* Custom Memory Size (MB): 2
Filename: || HZ‘
Options

Interface: | SMAFxE w

Load bitstream files Daisy chain configuration file

Start address: Direction: Bitfile:

Load data files

Start address: Direction: Datafile:

Write checksum
Disable bit swapping

Overwrite

Command:  write_cfgmem -format mcs -size 2 -interface SMAPxE

Figure 6-2: Write Memory Configuration File

Select the relevant format and options, and click OK to generate the configuration memory
file.

Creating a Configuration Memory File for SPI Dual
Quad (x8) Devices

You can use the write_cfgmem Tcl command to generate .mcs images for a dual Quad SPI
(x8) device. This command automatically splits the configuration data into two separate
.mcs files.
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Note: The size specified when generating the .mcs for SPIx8 is the total size of the two Quad Flash
devices.

Note: The write_cfgmem Tcl command divides the start address by 2 when building .mcs files for
dual quad SPI (x8) mode.

Example write_cfgmem Usage

This example shows how to generate the .mcs files for a multiboot design with the
"golden" bitstream loaded at address 0 and the multiboot bitstream loaded at address
0x0100_0000.

Devices: 2x 256 Mib Quad SPI Flash devices: 256 Mib = 32 MiB
Total storage size: 2 * 32 MiB = 64 MiB
Load addresses:

Golden: 0*2 =0

Multiboot: 0x0100_0000 * 2 = 0x0200_0000

write_cfgmem -format mcs -interface spix8 -size 32 \
-loadbit "up 0 ./designl_spix8.bit up 0x02000000 ./design2_spix8.bit" \
-file designl_design2_spix8.mcs
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Connect to the Hardware Target in Vivado

To connect to a hardware target in Vivado, do the following:

1. Ensure the appropriate configuration mode (Master SPI or Master BPI) is selected on the
FPGA mode pins of the hardware target to configure the FPGA from a configuration
memory device.

For more information, see the appropriate Configuration User Guide for the device you
are targeting.

2. Follow the steps in Chapter 4, Programming the FPGA Device to connect to the
hardware target.

ﬁ IMPORTANT: /f the board is powered off or cable disconnected, Vivado IDE closes the hardware target.
Any Vivado operation in the main Vivado thread is also canceled.

Adding a Configuration Memory Device

To add the configuration memory device to a hardware target in Vivado device
programmer, do the following:
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1. After connecting to the hardware target as outlined above, add the configuration
memory device by right-clicking the hardware target as shown below and selecting Add
Configuration Memory Device.

Hardware ? 00 X hw_ila_1 * | MIG - MIG_1
Q| x| = > » N & c
MName Status
~ B reishi15 (1) Connected Hppernes
~ @ xling_tcfiDigilent21030841C4...  Open Name: MG %
~ {8 xovu9p_0 (4) — \LE
= Hardware Device Properties...
SE SysMon (Syste les
ZE MIG_1 (MIG) Program Device... bne
SE MIG_2 (MIG) Verify Device...
SE hw_ila_1 (hw] B  Run Trigger
»  Run Trigger Immediate
¢ \ M Stop Trigger
Enable Auto Re-trigger sk
Hardware Device Properties
& xcvu9p_0 Create User Defined Probe... r
ske
Name: xowgp_{ C Refresh Device
N (8
Part. xovugp Add Configuration Memory Device... L\\)
1D code: 04B310¢ Boot from Configuration Memary Device ke
IR length: 18
g Program BER Key... | De
Status: Program i
| Clear BBR Key... ime
Programming file: 3l ¢
1 Program eFUSE Registers... r
- - g
4

---------------------------- Exportto Spreadsheet... ratii
General Froperties —_——

Figure 6-3: Add Configuration Memory Device Menu Item
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On clicking on this menu item the Add Configuration Memory Device dialog box opens.

¢ Add Configuration Memory Device | &4
[0] Choose a configuration memory part. This can be changed later.
Device: & xc7k325t_0
Filter
Manufacturer | All ¥ Type |All ¥
Density (Mb) | All x Width | All bl
Reset All Filters

Select Configuration Memory Part
Search: | <
Name Part Manufacturer Alias Family Type Density (Mb) Width
*_28f00am2%ew-bpi-x16 28f00am29ew _Micron [ m2%ew __fbpi 1024 6 | <
% 28f00am29ew-bpi-x8 Zsfﬂﬂangew Micron m29ew bpi 1024 =
@ 28f00ap30b-bpi-x16 28f00ap30b Micron p30 bpi 1024 x16 b
% 28f00ap30e-bpi-x16 28f00ap30e Micron p30 bpi 1024 %16
& 28f00ap30t-bpi-x16 28f00ap30t Micron p30 bpi 1024 x16
% 28f00ap33b-bpi-x16 28f00ap33b Micron p33 bpi 1024 %16
@ 28f00ap33e-bpi-x16 28f00ap33e Micron p33 bpi 1024 x16
% 28f00ap33t-bpi-x16 28f00ap33t Micron p33 bpi 1024 x16
@ 28f00bm29ew-bpi-x16 28f00bm2%ew  Micron m2%ew bpi 2048 x16
% 28f00bm29ew-bpi-x8 28f00bm2%ew  Micron m29ew bpi 2048 %8 =
f‘& ZsfﬂﬂprUe bp| xlﬁ ZSFDDprDe Micron p30 bpi 2048 x16 =

0K ] [ Cancel ‘

Figure 6-4: Add Configuration Memory Device

2. Select the appropriate configuration memory part and click OK.

O TIP: Use the Search field to pare down the list using Vendor, Density, or Type information.

The configuration memory device is now added to the hardware target device.

Hardware ? 008 X
Q = 2 o
MName Status
~ B reishi15 (1) Connected
~ @ xilink_tcfiDigilent’210308A1C4..  Open
~ {8 xovu9p_0 (2) Programmed

& SysMon (System Monitor)
% 529g1128p-bpi-16

Figure 6-5: Configuration Memory Device Added to Hardware Target
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Programming a Configuration Memory Device

1. After creating the configuration memory device, Vivado device programmer prompts
"Do you want to program the configuration memory device now?" as shown below.

Figure 6-6:

D Don't show this dialog again

Add Configuration Memory Device Completed

o Do you want to program the configuration memory device now?

==

Prompt to Program Configuration Memory Device

Click OK to open the Program Configuration Memory Device dialog box.

’

Program Configuration Memaory Device

Select a configuration file and set programming options.

Memaory Device: {8 52001128p-bpi-x16

Configuration file: ||

PRM file:

State of non-config mem /O pins: | Pull-none w

Program Operations

Address Range: Configuration File Only
RS Pins: MOMNE
+| Erase
Blank Check
+'| Program
| Verify

Verify Checksum

SVF Options

Create SVF Only (no program operations)

| ooy |

Figure 6-7:

2. Set all the fields in this dialog box appropriately.
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2: X”_INX® Chapter 6: Programming Configuration Memory Devices

« Configuration file (.mcs or .bin) - Specifies the file to use for programming the
configuration memory device. The memory configuration file is created with the
write_cfgmem Tcl command. See Creating a Configuration Memory File, page 52 for
more information.

« State of non-config mem 1I/O pins:

- Pull-none - Specifies that the indirect configuration bitstream programmed into
the FPGA has the unused I/O pins set to pull-none.

o Pull-up - Specifies that the indirect configuration bitstream programmed into the
FPGA has the unused I/O pins set to pull-up.

o Pull-down - Specifies that the indirect configuration bitstream programmed into
the FPGA has the unused I/O pins set to pull-down.

f IMPORTANT: Ensure the state of non-config mem I/0 pins matches what you set in the
write_bitstream properties. The default value for this property is pull-down.

« Program Operations (performed on the configuration memory device):

- Address Range - Specifies the address range of the configuration memory device
to program. The address range values can be:

- Configuration File Only - Use only the address space required by the memory
configuration file to erase, blank check, program, and verify.

- Entire Configuration Memory Device - Erase, blank check, program, and verify
will be performed on the entire device.

« RS Pins - Optional. Revision Select Pin Mapping that is used with BPI configuration
memory devices only (where the upper two FPGA address pins on the flash are tied to
the FPGA RS[1:0]). When the option is enabled, Vivado drives the FPGA RS[1:0] for
programming. Refer to the appropriate FPGA Configuration User Guide on application
usage.

« Erase - Erases the contents of the configuration memory device.

« Blank Check - Checks the configuration memory device to make sure the device is void
of data prior to programming.

« Program - Programs the configuration memory device with the specified
Configuration File (.mcs or .bin).

« Verify - Verifies that the configuration memory device contents match the
Configuration File (.mcs or .bin) after programming.

« Verify Checksum - Validates the data programmed in the configuration memory
device. The tool calculates the checksum value based on the data programmed in the
configuration memory device and compares it to the checksum value specified in the
.prm file.
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0

¥

Vivado Programming and Debugging

TIP: User generates cfgmem file and specifies -checksum write_cftmem option. This step creates
the .prm files that contain checksum information about the cfgmem output file.

« Create SVF Only - Enabling this option allows for the creation of an .svf file with the
program operations that you specified. Other third party tools can use the .svf file to
program configuration memory devices outside of Vivado.

IMPORTANT: When this option is enabled, Vivado just generates the .svf file with the relevant program
options. It does not actually program the configuration memory device.

3. Click OK to start the Erase, Blank Check, Program, and Verify operations on the
configuration memory device per the selections in this dialog box. Vivado notifies you
as each operation finishes.

Note: Pressing Apply will store the configuration memory settings but will not program the
configuration memory device. If you press Cancel after pressing Apply the configuration
memory device will be set and programming can be performed at a later time.

Booting the Device

After programming the configuration memory device, you can issue a soft boot operation
(ie. JPROGRAM) to initiate the FPGA configuration from the attached configuration memory
device. If you want to perform a Boot operation on the target FPGA device select the target
device and right-click and select Boot from Configuration Memory Device.

Hardware ? 00X hw_i
Q = 2 o
MName Status @
~ B reishi15 (1 Connected 2
o
~ @ xling_tcfiDigilent21030841C4...  Open g
~ {8 xovu9p_0 (2) Programmed z
SE SysMon (Syste Hardware Device Properties...
% s29g1128p-opi Program Device...
Verify Device...
™ Refresh Device

Boot from Configuration Memory Device L\\,
Hardware Device Properties
Program BBR Key...

& xovu9p_0
P Clear BBR Key...
MName: xevu9p_( Program eFUSE Registers...
Part: xovug
n Exportto Spreadsheet..
ID code: 0483105 ——

Figure 6-8: Boot from Configuration Memory Device

IMPORTANT: There can be situations after booting from configuration memory where the debug cores
do not show up immediately due to system boot up considerations. Xilinx recommends that you wait for
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the specified time period as appropriate using the boot_hw_device Tcl command in the Vivado
Hardware Manager Tcl Console, as shown below:

boot_hw _device after 1000 [refresh hw device]

Where the 1000 can be the specified by you as the max "wait_on" value.
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Configuration Failures in Master Mode

Configuration failures can occur when a board is in Master BPI or Master SPI mode and the
JTAG cable is connected to the Vivado Hardware Manager. When the Hardware Manager
polling and recover feature interrupts the Master mode configuration, intermittent
configuration failures occur on power up. To avoid this issue, set the following parameter in
the Vivado Hardware Manager Tcl console to ensure that the configuration status registers
are not updated:

set_param xicom.allow_cfgin_commands false

Note: This parameter affects all devices in the chain.
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Chapter 7

Advanced Programming Features

Readback and Verify

Bitstream Verify and Readback

Vivado® IDE can verify and/or readback the configuration data (i.e., . bit file) downloaded
into an FPGA. When using write_bitstream to generate the .bit file, use the
-mask_file option to create a corresponding mask (.msk) file. Runwrite_bitstream
-help in the Vivado IDE Tcl Console for details on bitstream generation options.

When performing a verify operation, the verify_hw_devices Tcl command reads data
back from the FPGA and uses the .msk file to determine which readback data bits to skip
and which ones to compare against the corresponding bits in the .bit file.

Following is an example of a bitstream verify Tcl command sequence (the .bit and .msk
files were generated by a previous call to write_bitstream):

create_hw_bitstream -hw_device [current_hw device] \
-mask kculO5_cnt_ila_uncmpr.msk kcul05_cnt_ila_uncmpr.bit
verify hw_devices [current_hw devicel]
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You can use the Vivado Hardware Manager to verify the configuration data. Right click the
device, select Verify Device as shown below.

Hardware ? 008 X
Q = 2 o
MName Status
~ B localhost (1) Connected
~ @ xiling_tcfiXilingPort_#0003Hu..  Open
~ {8 xc7k325t0 (1) Nat nroaramm
£ XADC (System Hardware Device Properties...

Program Device...
Verify Device... L\\)
™ Refresh Device

Add Configuration Memory Device...

Boot from Configuration Memory Device

Hardware Device Properties Program BER Key...

Clear BBR Key...
8 xcTK325t_0

Program eFUSE Registers...
Mame: XCTK3IZ5E

Part: *CTR325t

Exportto Spreadsheet..

Figure 7-1: Verify Device Selection

This opens up the Verify Device dialog box.

¢ Verify Device @

Select a bitstream programming file and an associated mask file to verify your hardware device.

Bitstream file: || ”Z‘
Mask file: IZ‘

(2) -
\2) Verify Cancel

Figure 7-2: Verify Device Dialog

You need to enter the bit file and corresponding mask (.msk) file. Click Verify to execute
the verification.
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Use the readback_hw_device Tcl command with at least one of the following options to
read back the FPGA configuration data:
« To save readback data in ASCII format:
-readback_file <filename.rbd>
« To saves readback data in binary format:

-bin_file <filename.bin>
Example: Readback FPGA configuration data in both ASCII and binary formats

readback_hw_device [current_hw device] \
-readback_file kcul05_cnt_ila_uncmpr_rb.rbd \
-bin_file kculO5_cnt_ila_uncmpr_rb.bin

Note:

1. Bitstream, and readback operations are done through the Tcl Console.

2. Verify and readback operations do not work for FPGAs programmed with encrypted
bitstreams. Encrypted bitstreams contain commands that disable readback. Readback is
re-enabled by pulsing the FPGA PROG pin, or if the FPGA/board is powered down and
powered back up again.

3. The data readback using readback_hw_device contains configuration data only (no
configuration commands are included).

For more information on the readback and mask files, see the “Verifying Readback Data”
section in the UltraScale® Architecture Configuration User Guide (UG570) [Ref 15] or the 7
Series FPGAs Configuration User Guide (UG470) [Ref 13].

Configuration Memory Verify and Readback

You can convert a bitstream file (.bit) to an .mcs or .bin file and then program it into
a configuration memory device, such as serial/SPI or parallel/BPI flash, via the
write_cfgmem command. See the Vivado Design Suite Tcl Command Reference (UG835)
[Ref 11] for details.
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Verify the configuration memory device through the Vivado Design Suite Hardware
Manager as shown in Figure 7-3.

¢ Program Configuration Memory Device @

Select a configuration file and set programming options.

Memaory Device: {8} 28f00am29ew-bpi-x16 IZ‘

Configuration file: HZ‘
PRM file: IZ‘

State of non-config mem /O pins: | Pull-none w

Program Operations
Address Range: Configuration File Only w
RS Pins: MOMNE
+| Erase
Blank Check
+' Program
~| Verify

Verify Checksum

P
oo ] [om

Figure 7-3: Configuration Memory Verification

You can also verify the configuration memory device by setting the appropriate
HW_CFGMEM properties and calling program_hw_cfgmem as shown in the following
code:

set_property PROGRAM.ADDRESS_RANGE {use_file} [ get_property PROGRAM.HW_CFGMEM [lindex [get_hw_devices] 0 1]
set_property PROGRAM.FILES [list "H:/projects/k7_led/k7_led_325t_afx_x16_33v.mcs" ] \

[ get_property PROGRAM.HW_CFGMEM [lindex [get_hw_devices] 01]]

set_property PROGRAM.BPI_RS_PINS {none} [ get_property PROGRAM.HW_CFGMEM [lindex [get_hw_devices] 0 ]]
set_property PROGRAM.UNUSED_PIN_TERMINATION {pull-none} [ get_property \

PROGRAM.HW_CFGMEM [lindex [get_hw_devices] 0 ]]

set_property PROGRAM.BLANK_CHECK 0 [ get_property PROGRAM.HW_CFGMEM [lindex [get_hw_devices] 0 ]]
set_property PROGRAM.ERASE 0 [ get_property PROGRAM.HW_CFGMEM [lindex [get_hw_devices] 0 1]
set_property PROGRAM.CFG_PROGRAM 0 [ get_property PROGRAM.HW_CFGMEM [lindex [get_hw_devices] 0 ]1]
set_property PROGRAM.VERIFY 1 [ get_property PROGRAM.HW_CFGMEM [lindex [get_hw_devices] 0 ]1]

startgroup

if {![string equal [get_property PROGRAM.HW_CFGMEM_ TYPE [lindex [get_hw_devices] 0]] [get_property MEM_TYPE
[get_property CFGMEM_PART [get_property PROGRAM.HW_CFGMEM [lindex [get_hw_devices] 0 11111 } \

{ create_hw_bitstream -hw_device [lindex [get_hw_devices] 0] [get_property PROGRAM.HW_CFGMEM_BITFILE \

[ lindex [get_hw _devices] 0]]; program_hw_devices [lindex [get_hw_devices] 0]; };

program_hw_cfgmem -hw_cfgmem [get_property PROGRAM.HW_CFGMEM [lindex [get_hw_devices] 0 ]]

endgroup

The contents of the configuration memory can be readback through the Vivado Design
Suite Tcl Console using the following command sequence:

readback_hw_cfgmem -file test.bin -hw_cfgmem \
[get_property PROGRAM.HW_CFGMEM [lindex [get_hw_devices] 0]]

Note: Perform configuration memory readback operations through the Tcl Console only.
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For more information on these features, see the UltraScale Architecture Configuration User

Guide (UG570) [Ref 15] or the 7 Series FPGAs Configuration User Guide (UG470) [Ref 13]

Generating Encrypted and Authenticated Files for 7

Series Devices

Note: Foradditional information please refer to Using Encryption to Secure a 7 Series FPGA Bitstream

Application Note, (XAPP1239)

[Ref 23].

To generate an encrypted bitstream, open an implemented design in Vivado IDE. From the
main toolbar Select Flow > Bitstream Settings to make Settings dialog box appear. At the
top of the dialog box click Configure Additional Bitstream Settings.

¢ Settings

Project Settings
General
Simulation
Elaboration
Synthesis
Implementation
Bitstream

» P

Tool Settings

Project

IP Defaults

Source File

Display

WebTalk

Help

Text Editor

3rd Party Simulators
Colors

w

w

Selection Rules
Shortcuts
Strategies

> Window Behavior

Bitstream
Specify various settings related to writing bitstream

@ Configure additional bitstream settings.

~Write Bitstream (write_bitstream)
tcl.pre
tcl.post
-raw_hiffile
-mask_file
-no_binary_bitfile
-bin_file
-readback_file
-logic_location_file
-verbose

More Options

Select an option above to see a description of it

==

HIH
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This brings up the Edit Device Properties dialog box. Select Encryption in the left-hand
pane.

¢ Edit Device Properties @

Use this dialog to edit the programming and configuration properties for your current design; default values are set automatically.

y)

Encryption

General Encryption Settings

Configuration

Configuration Modes Enable Bitstream Encryption NO w
Startup
Encryption Select location of encryption key | BERAM  »
Readback BBRAM
EFUSE
Key Settings

HMAC Authentication key

AES encryption key (key0)

Input encryption file IZ‘

Starting cipher block chaining (CBC)value

Figure 7-5: 7 Series Configure Encryption Settings
In the Edit Device Properties dialog box, specify the encryption and key settings:

« Encryption Settings
- Set Enable Bitstream Encryption to YES.
- Set Select location of encryption key to either BBRAM or EFUSE.
- The key location will be embedded in the encrypted bitstream.

- When the encrypted bitstream is downloaded to the device, it instructs the
FPGA to use the key loaded into the BBR or the eFUSE key register to decrypt
the encrypted bitstream.
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+ Key Settings

- Specify HMAC authentication key and Starting cipher block chaining (CBC)
value.

- If these values are unspecified, Vivado generates a random value for you.

- These values will be embedded in the encrypted bitstream and do not have to
be programmed into the FPGA.

Note: These values will be stored in the current project constraints file unless an input
encryption file is specified. To avoid storing this value in the constraints file, specify the input
encryption file.

- Specify the AES encryption key to use when encrypting the bitstream. You can use
up to 64 hex characters to specify the 256-bit key.

- The key will be written to a file with the .nky file extension. Use this file when
loading the key into the BBR or when programming the key into the eFUSE key
register.

Note: These values will be stored in the current project constraints file unless an input
encryption file is specified. To avoid storing this value in the constraints file, specify the input
encryption file.

o Specify Input encryption file.
- Specify an existing .nky file to obtain the encryption key settings. This field is
optional and can be omitted if specifying the AES, HMAC and CBC manually.

After specifying the encryption settings, click OK to apply the settings to the project and
regenerate your bitstream. Upon successful completion of the write_bitstream
operation you will have a programming file along with a .nky, encryption file.

Generating Encrypted and Authenticated Files for
UltraScale and UltraScale+

Note: For additional information please refer to Using Encryption and Authentication to Secure an
UltraScale/UltraScale+ FPGA Bitstream Application Note, (XAPP1267) [Ref 24].
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To generate an encrypted bitstream, open an implemented design in Vivado IDE. From the
main toolbar select Flow > Bitstream Settings to make the Settings dialog box appear. At
the top of the dialog box, click Configure Additional Bitstream Settings

¢ Settings

Project Settings
General
Simulation
Elaboration
Synthesis
Implementation
Bitstream

» P

Tool Settings

Project

IP Defaults

Source File

Display

WebTalk

Help

Text Editor

3rd Party Simulators
Colors

w

w

Selection Rules
Shortcuts

Strategies

w

Window Behavior

Bitstream

Specify various settings related to writing bitstream

==

I@ Configure additional bitstream settings. I

~Write Bitstream (write_bitstream)
tcl.pre
tcl.post
-raw_hiffile
-mask_file
-no_binary_bitfile
-bin_file
-readback_file
-logic_location_file
-verbose

More Options

Select an option above to see a d

cription of it

HIH

©
Figure 7-6: UltraScale and UltraScale+ Configure Additional Bitstream Settings

Vivado Programming and Debugging
UG908 (v2019.1) May 22, 2019

www.Xxilinx.com

70

l Send Feedback I


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=70

2: X”_INX® Chapter 7: Advanced Programming Features

This brings up the Edit Device Properties dialog box. Select Encryption in the left-hand
pane.

¢ Edit Device Properties @

Use this dialog to edit the programming and configuration properties for your current design; default values are set automatically.

y)

Encryption

General Encryption Settings

Configuration

Configuration Modes Enable Bitstream Encryption NO w
Startup
Encryption Select location of encryption key | BERAM w
Readback
Enable obfuscated key load DISABLE  w
Authentication
Key Settings

Starting AES encryption key (key0)

Input encryption file IZ‘

Starting AES initial vector (IV0) value

Starting obfuscate initial vector (Obfuscate IV0) value

Key Rolling Settings

Mumber of encryption blocks per AES-256 key 0 :

4k

Mumber of frames per AES-256 key 0

Figure 7-7: UltraScale Configure Encryption Settings

In the Edit Device Properties dialog box, specify the Encryption Settings and Key
Settings:

« Encryption Settings
- Set Enable Bitstream Encryption to YES.
o Set Select location of encryption key to either BBRAM or EFUSE.
- The key location is embedded in the encrypted bitstream.

- When the encrypted bitstream is downloaded to the device, it instructs the
FPGA to use the key loaded into the BBR or the eFUSE key register to decrypt
the encrypted bitstream.

- Set Enable obfuscated key load to either ENABLE or DISABLE.

- When enabled, this user generated key is encrypted before being stored in the
BBRAM. If disabled, then the key is stored “as is” in the BBRAM.
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« Key Settings

- Specify the Starting AES encryption key (key0) to use when encrypting the
bitstream. You can use up to 64 hex characters to specify the 256-bit key.

- The key will be written to a file with an .nky file extension. Use this file when
loading the key into the BBR or when programming the key into the eFUSE key
register.

Note: This value will be stored in the current project constraints file unless an input
encryption file is specified. To avoid storing this value in the constraints file, specify the input
encryption file.

o Specify Input encryption file.

- Specify an existing .nky file to obtain the encryption key settings. This field is
optional and can be omitted if specifying the AES, HMAC, and CBC manually.

o Specify Number of encryption blocks per key and Number of frames per
AES-256 key.

- The number of encryption blocks and frames are used to specify how many
sections a bitstream will be broken into with distinct keys.

- Specify Starting AES initial vector (IV0) value.

- Initialization vector for the first key. Note that each key needs a separate
initialization vector value that can be supplied through the input encryption file.

Note: This value will be stored in the current project constraints file. To avoid storing this
value in the constraints file, specify the input encryption file.

- Specify Starting obfuscate initial vector (Obfuscate IV0) value.
- Initialization vector for the obfuscated key.

Note: This value will be stored in the current project constraints file. To avoid storing this
value in the constraints file, specify the input encryption file.
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Vivado Programming and Debugging

For authentication settings select Authentication in the left-hand pane

¢ Edit Device Properties @

Use this dialog to edit the programming and configuration properties for your current design; default values are set automatically.

Authentication

General Authentication Settings
Configuration
Configuration Modes
Startup

Encryption Input file containing RSA Private Key E

Readback

Authentication

Enable Bitstream Authentication NO A

Figure 7-8: Edit Device Properties - Authentication

In the Edit Device Properties-Authentication dialog box, specify the encryption and key
settings as follows:

« Authentication Settings
. Set Enable Bitstream Authentication to YES.

o Specify the Input file containing RSA Private Key.

Provide an RSA private key file after specifying the encryption and authentication settings,
Click OK to apply the settings to the project. Re-run Implementation and regenerate the
bitstream file. Upon successful completion of the write_bitstream operation, the
generated .nky encryption key file appears in the same directory as the encrypted
bitstream file.

You can protect IP in bitstreams by encrypting the bitstreams with a 256-bit Advanced
Encryption Standard (AES) key, and downloading the bitstreams to run only on authorized
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FPGAs. Do this by programming the 256-bit key into the BBR register of the authorized
FPGAs before downloading the encrypted bitstream.

Programming the AES Key for 7 Series Devices

To program the AES key into the BBR, right-click the FPGA device in the Hardware window,
and select Program BBR Key.

Hardware ? 008 X
Q = 2 o
MName Status

~ B localhost (1 Connected

~ @ xiling_tcfiXilingPort_#0003Hu..  Open
~ & xc7k3251 0 (1) Hardware Device Properties...
& XADC (System Monitor]
Program Device...
Verify Device...

™ Refresh Device

Add Configuration Memory Device...

Boot from Configuration Memory Device

Program BBR Key... l}

q Clear BBR Key...

Program eFUSE Registers...

Hardware Device Properties
Exportto Spreadsheet..

8k wrT7EA9R N - -

Figure 7-9: Program the BBR Key

In the Program BBR Key dialog box, specify the AES key (.nky) file by typing the file name
or navigating to the desired file. After specifying a valid .nky file, the AES key field
automatically fills in. Click OK, to have the Hardware Manager program/load the key into
the BBR.

¢ Program BBR Key @

To program the AES key into the Battery-Backed RAM (BBR), please select an AES key file.

AES key file (.nky): ||I|

Mot available

Figure 7-10: Program BBR Key - 7 Series
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After programming the key, program the FPGA with an encrypted bitstream that:

« was encrypted using the same AES key as was loaded into BBR.

« had BBRAM selected as the specified encryption key location.

Clearing the AES Key for 7 Series Devices
To clear the AES key manually, disconnect the Vbatt pins and power-cycle the board.

Note: Pressing or pulsing the PROG pin when the board/FPGA is powered up will not clear the BBR
register.

Alternatively, you can clear the AES key in Vivado IDE by right-clicking the FPGA device in
the Hardware window, selecting Clear BBR Key...

Hardware ? 008 X
Q = 2 o
MName Status

~ B localhost (1 Connected

~ @ xiling_tcfiXilingPort_#0003Hu..  Open
~ {8 xc7k325t_(
& XADC (4

Hardware Device Properties...

Program Device...
Verify Device...

™ Refresh Device
Add Configuration Memory Device...
Boot from Configuration Memory Device

Program BBR Key...

¢ Clear BBR Key... L\\)

Program eFUSE Registers...
Hardware Device Prop
Exportto Spreadsheet..

8 xcTK325t_0 ————gr—

Figure 7-11: Clearing the AES Key for 7 Series Devices

When the Clear BBR Key dialog box appears, click OK to clear the key from the device

s Clear BBR Key [l

o Are you sure that you want to clear the BBR key (setto all zeroes)?

Figure 7-12: Clear BBR Key Dialog Box

ﬁ IMPORTANT: When verify_ hw_devices is performed on the BBR key, an error will be shown. To
verify the BBR key, the user should test this by programming the FPGA with a bitstream that has the
key. Vivado does not support any post BBR program verify option to verify the programmed BBR key.
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Programming the AES Key for UltraScale and

UltraScale+ Devices

To program the AES key into the BBR, right-click the FPGA device in the Hardware window,

and select Program BBR Key.

Hardware ?

Q

Mame
~ B reishi15 (1)
~ @@ xiling_tcfiDigilent/210308A1C4...
~ {8 xovu9p_0 (1)

& SysMon (System Monitor)

- -~
= -

<

Hardware Device Properties ?

& xovup_0

Figure 7-13:

- 0Oo X

&

Status

Connected

Open

Programmed
Hardware Device Properties...
Program Device...
Verify Device...

Refresh Device

Add Configuration Memory Device...

Boot from Configuration Memory Device

Program BBR Key... L\\,
Clear BBR Key...

Program eFUSE Registers...

Exportto Spreadsheet..

Program the BBR Key from Hardware Window

The Program BBR Key dialog box appears.

¢ Program BBR Key

To program the AES key into the Battery-Backed RAM (BBR), please select an AES key file and BBR-specific DPA resistance options.

AES ke file (i) ||

Enable DPA_PROTECT

Mot available

Figure 7-14:
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In the Program BBR Key dialog box, specify the AES key file (.nky) and Enable DPA
PROTECT:

« AES key file (.nky)

- Specify the AES key file (.nky) by typing the file name or navigating to the desired
file. After specifying a valid .nky file, the AES key field automatically fills in.

« Enable DPA PROTECT
- Check the Enable DPA PROTECT check box.
- Specify the DPA_COUNT value. The valid range is 1-256 when enabled.

Note: For more details on the BBR AES key and DPA_PROTECT feature refer to the UltraScale
Architecture Configuration User Guide (UG570) [Ref 15].

Click OK, to have the Hardware Manager program load the key into the BBR.
After programming the key, program the FPGA with an encrypted bitstream that:

« was encrypted using the same AES key as was loaded into BBR.

« had BBRAM selected as the specified encryption key location.

i? IMPORTANT: For UltraScale devices, if you download an encrypted bitstream (which uses the BBR as
the key source) before programming the key into the BBR register, the FPGA device will lock up and you
will not be able to load the BBR key. You can still download unencrypted bitstreams, but you will not be
able to download encrypted bitstreams because the FPGA device will prevent you from downloading a
key into BBR. You must power-cycle the board to unlock the UltraScale device and then reload the BBR

key.

ﬁ IMPORTANT: When verify hw_devices is performed on the BBR key, an error will be shown. To
verify the BBR key, the user should test this by programming the FPGA with a bitstream that has the
key. Vivado does not support any post BBR program verify option to verify the programmed BBR key.

Clearing the AES Key for UltraScale, and UltraScale+ Devices
To clear the AES key manually, disconnect the Vbatt pins and power-cycle the board.

Note: Pressing or pulsing the PROG pin when the board/FPGA is powered up will not clear the BBR
register.
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Alternatively, you can clear the AES key in Vivado IDE by right-clicking the FPGA device in
the Hardware window, selecting Clear BBR Key...

Hardware Device Properties...

Program Device...
Werify Device...

' Refresh Device

Add Configuration Memory Device...

Boot from Configuration Memaory Device

Program BBR Key...

ClearE%Key...

Program eFUSE Registers...

Exportto Spreadsheet...

Figure 7-15: Clearing the AES Key for UltraScale, and UltraScale+ Devices

When the Clear BBR Key dialog box appears, click OK to clear the key from the device

s Clear BBR Key [l

o Are you sure that you want to clear the BBR key (setto all zeroes)?

Figure 7-16: Clear BBR Key Dialog Box
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eFUSE Register Access and Programming

7 Series, UltraScale, and UltraScale+™ devices have one-time programmable bits called
eFUSE bits that perform specific functions. The different eFUSE bit types are as follows:

« FUSE_DNA - Stores unique device identifier bits (non-programmable).

« FUSE_USER - Stores a 32-bit user-defined code.

« FUSE_KEY - Stores a key for use by the AES bitstream decryptor.

» FUSE_CNTL - Controls key use and read/write access to eFUSE registers.

e FUSE_SEC - Controls special device security settings in UltraScale and UltraScale+
devices.

ﬁ IMPORTANT: Programming eFUSE register bits is a one-time only operation. Once eFUSE register bits
are programmed (i.e., from unprogrammed state 0 to programmed 1 state), they cannot be reset to 0
and/or programmed again. You should take great care to double-check your settings before
programming any eFUSE registers.

& CAUTION! If any eFUSE register bits have been previously programmed (i.e., from
unprogrammed state 0 to programmed state 1) and an attempt is made to program them
again, the Vivado hardware manager issues a critical warning indicating that some bits have
already been programmed. However, despite this warning, subsequent eFUSE register bits that
have not been programmed during the previous operation (in unprogrammed state 0) will be
programmed.

ﬁ IMPORTANT: Xilinx recommends programming the FUSE_USER, FUSE_KEY, and FUSE_RSA registers
first, then rerunning the eFUSE programming wizard to program the FUSE_SEC bits to control the FPGA
security settings, and then finally, the FUSE_CNTL bits to control read/write access to these eFUSE bits.

Cable Support for eFUSE Programming

The list of compatible JTAG download cables and devices that support efuse programming
are:

+ Xilinx® SmartLynq Data Cable (HW-SMARTLYNQ-G/DLC20)
« Xilinx Platform Cable USB II (DLC10)

« Digilent JTAG-HS1

« Digilent JTAG-HS2

Vivado Programming and Debugging N Send Feedback 79
UG908 (v2019.1) May 22, 2019 www.xilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=79

(: X”_INX® Chapter 7: Advanced Programming Features

Vivado Programming and Debugging

« Digilent JTAG-HS3

eFUSE Register Access and Programming for 7
Series Devices

FUSE_DNA: Unique Device DNA

Each 7 Series device has a unique device ID called device DNA that has already been
programmed into it by Xilinx. 7 Series devices have a 64-bit DNA. You can read these bits by
running the following Tcl command in the Vivado Design Suite Tcl Console:

get_property [lindex [get_hw _device] 0] REGISTER.EFUSE.FUSE_DNA

You can also access the device DNA by viewing the eFUSE registers in the Hardware Device
Properties window in Vivado Design Suite as shown in the following Figure.

Hardware ? _ 00O X
Q| x| 2 o
Name Status
~ B localhost (1 Connected
~ @ xiling_tcfiXilingPort_#0003.Hu..  Open
~ {8 xcTk325t 0 (1) Mot programmed
& XADC (System Monitor

Hardware Device Properties ? 00X
& xc7k325t_0 o
Q = | 2 |4 0o
~ REGISTER m
> BOOT_STATUS 0000000000000000000000000000001
> CONFIG_STATUS 01000000000000000001111100001 11
> CORO
> COR1 00000000
~ EFUSE
DMNA_PORT 028C008402CD0O00
FUSE_CNTL 0000
FUSE_DMNA 000B340210031409
FUSE_KEY 0000000000000000000000000000001
FUSE_USER 00000000
> IR 010001
> TIMER 00000000
USERCODE biiiiiiig
___USRACCESS 00000000 v
General Properties

Figure 7-17: eFUSE DNA
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For more information on these features, see the 7 Series FPGAs Configuration User Guide

(UG470) [Ref 13].

Programming the eFUSE Registers

To program the eFUSE registers, right-click the FPGA device in the Hardware window, select
Program eFUSE Registers.

Hardware

Q - o
= >

Name

~ B localhost (1

Status
Connected

~ @ xiling_tcfiXilingPort_#0003.Hu..  Open

~ {8 xc7K325t 0 (1)

£ XADC (System Monitor

Mot programmed

Hardware Device Properties » OO X
& xc7k325t 0 o
Q = | 2 |4 0 i
~ REGISTER m
> BOOT_STATUS 0000000000000000000000000000001
> CONFIG_STATUS 01000000000000000001111100001 11
> CORO
> COR1 00000000
~ EFUSE
DMNA_PORT 028C008402CD0O00
FUSE_CNTL 0000
FUSE_DMNA 000B340210031409
FUSE_KEY 0000000000000000000000000000001
FUSE_USER 00000000
> IR 010001
> TIMER 00000000
USERCODE biiiiiiig
__USRACCESS 00000000 v
General Properties
Figure 7-18: Select Program eFUSE Registers
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The Program eFUSE Registers wizard appears as shown in the following figure, and guides
you to set the various options for the eFUSE registers.

¢ Program eFUSE Registers @

Program eFUSE Registers

VIVADO' This wizard will guide you through eFUSE programming.

HLx Editions
The eFUSEs in the selected device for the RSA key is already programmed.

& XILINX

ROGRAMMARLE.

Figure 7-19: Program eFUSE Registers Wizard

In the AES Key Setup pane, specify the following settings:

¢+ Program eFUSE Registers @

AES Key Setup (optional)

For 7 series FPGAs, programming the AES key programs the lower 8 bits of the USER reqgister atthe same time. If you program the ‘
AES key and do not specify a pattern for USER[7:0] these bits cannot be programmed later.

<+ Enable AES key programming

AES keyfile (nky): | C:NVivado_Debug/2017 . 1fproj_hdl_vio/proj_hdl_vio.runs/impl_1/sinegen_demo_inst_vio.nky E

SLROAES Key 3DC9_6092_0D09_8CY9E_SF4A_T35E_6348_D37D_04B3_9BB6_EBFB_CE8BC_2F8A_35F5_BCBO_E363

USER bits [7:0]: 0o

Enable programming of USER bits

Figure 7-20: eFUSE AES Key Setup
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« AES Key file

- Specify the AES key file (.nky) by typing the file name or navigating to the desired
file. After specifying a valid .nky file, the AES key field automatically fills in.

« USER bits [7:0] and USER bits [31:8]

o The USER eFUSEs bits are provided to allow users to program their own special
32-bit pattern. The lower eight FUSE_USER bits are programmed at the same time as
the 256-bit Advanced Encryption Engine (AES) key. The upper 24 user bits can be
programmed concurrently with AES key or at a later time

In the Control Register Settings pane, specify the following settings:

¢ Program eFUSE Registers @
Control Register Setup (optional)
Enable and select the Control Register bits to program. These bits provide security by disabling operations on different eFUSE ‘
registers.

Enable control register programming

Reqgister Bit Name BitP.. Description
CFG_AES_Only 0 Forces use of AES key stored in device

AES_Exclusive 1 Disables partial reconfiguration

W_EN_B_Key_User 2 Disables programming of AES key and of USER reqgister
R_EM_B_Key 3 Disables reading of AES key

R_EM_B_User 4 Disables reading of user code

Figure 7-21: Control Register Setup

CFG_AES_Only: When set, forces the use of the stored AES key.

AES_Exclusive: When set, disables use of partial reconfiguration.

W_EN_B_Key_User: When set, disables programing of AES key and User register.

R_EN_B_Key: When set, disables reading of AES key.

R_EN_B_User: When set, disables reading of user code.

W_EN_B_Cntl: When set, disables programing of this control register.

For more information on these features, see the 7 Series FPGAs Configuration User Guide
(UG470) [Ref 13].
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Review the eFUSE settings in the Program eFUSE Registers Summary page.

¢ Program eFUSE Registers @

Program eFUSE Registers Summary

VIVADO!

Hix Editions o AES key register entry field:
There are 2AES keys:
0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_7767
0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_0554_62AA_ABBS

o RSA key has been eFUSE programmed.

o USER register field: 0000A5CE

© USER 128 bit register field: 00000000000000000000000000000001
o Enabled 1 Control Register bits:0_0000_0001_0000_0000

o Enabled 1 Security Register bits:00_0001

& XILINX

To program eFUSE, click Finish

Figure 7-22: Program eFUSE Registers Summary

All bits set in the Program eFUSE Registers wizard panels are shown in this pane. In this
pane you will see individual bit settings in order to review the specific programming
settings. Review this summary page carefully to ensure every bit that is intended to be
programmed is set.

Click Finish to bring up the Program eFUSE confirmation dialog box:

¢ Program eFUSE @

o Program eFUSE cannot be reversed. Are you sure you have made the right settings?
OK to proceed eFUSE programming?

Figure 7-23: Program eFUSE Confirmation

Click OK the to program the specified fuse bits.
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eFUSE Register Access and Programming for
UltraScale and UltraScale+ Devices

FUSE_DNA: Unique Device DNA

Each UltraScale device has a unique device ID called device DNA that has already been
programmed into it by Xilinx. The FUSE_DNA is not user programmable. UltraScale devices
have a 96-bit DNA. You can read the FUSE_DNA by running the following Tcl command in
the Vivado Design Suite Tcl Console:

get_property [lindex [get_hw_device] 0] REGISTER.EFUSE.FUSE_DNA

You can also access the device DNA by viewing the eFUSE registers in the Hardware Device
Properties window in Vivado Design Suite as shown in the following figure.

Hardware
Q| = |2 o
MName Status
~ B reishi15 (1 Connected
~ @ xilinx_tcfDigilent’210308A1C4...  Open
~ {8 xovulp_0 (1) Programmed
& SysMon (System Monitor

Hardware Device Properties

& xovudp_0 - o
Q| x| < | 0
» PROGRAM ~
v REGISTER
> BOOT_STATUS 00000000000000000000000000000001
> CONFIG_STATUS 00010100100100000111101011111100
» CORD 3c4c3beb
> COR1
v EFUSE
DMNA_PORT 40000000010591E134F10505
FUSE_CNTL 000000
FUSE_DMNA 40000000010591E134F 10505
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FUSE_SECURITY oo
FUSE_USER 00000000
FUSE_USER_128 00000000000000000000000000000000000000000000

r IR 110101110101110101

-.Senéral . .P.rt.}.pe.r.ti.esn
Figure 7-24: eFUSE DNA UltraScale, UltraScale+

For more information on these features, see the UltraScale Architecture Configuration User
Guide (UG570) [Ref 15].
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Programming the eFUSE Registers

To program the eFUSE registers, right-click the FPGA device in the Hardware window, select

Program eFUSE Registers.

Hardware

Q = 2
MName

~ B reishi15 (1

~ @ xilinx_tcfiDigilent/210308A1C4. .
~ {8 xovu9p_0 (1)

& SysMon (System Monita
Hardware Device Properties c
& xovup_0
Q = 2 |4
> PROGRAM
~ REGISTER
> BOOT_STATUS oot
> CONFIG_STATUS 0007
> CORO 3cde
> COR1
Figure 7-25:
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The Program eFUSE Registers wizard appears as shown in the following figure, and guides
you to set the various options for the eFUSE registers.

’

Program eFUSE Registers

Program eFUSE Registers

VIVADO' This wizard will guide you through eFUSE programming.

HLx Editions
The eFUSEs in the selected device for the RSA key is already programmed.

& XILINX

ALL PROGRAMMARLE.

®

==

Cancel

Figure 7-26: Program eFUSE Registers Wizard

In the AES Key Setup pane, specify the following settings:

’

Program eFUSE Registers

Cryptographic Key Setup (optional)
Provide a cryptographic key file (.nky) to enable AES, RSA, or both encryption keys. Keys are displayed in HEX.

Cryptographic key file {.nky): | C:/Users/smitha/Documents/ug908_2017_1Hcku115_efuse_aes.nky

Enable AES key programming

v RSA Key Digestis eFUSE programmed
Current RSAvalue

Enable R5A Key Digest (384-bit) programming

Py

Figure 7-27: eFUSE Cryptographic Key Setup
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In the Cryptographic Key Setup wizard pane, specify these key settings:

« Cryptographic file key (.nky)
- Specify a .nky file containing eFUSE AES and RSA keys
« AES Key (256-bit)

o The 256-bit AES eFUSE key read in from specified .nky file used to decrypt loaded
encrypted bitstream.

« RSA Key Digest (384-bit)
o The 384-bit RSA eFUSE key read in from specified .nky file used by RSA.

In the USER Register Setup wizard pane, specify the 32 bit USER or 128 bit USER register

¢ Program eFUSE Registers @

USER register setup (optional)
Select a checkbox to specify a 32-bit USER reqgister value, a 128-bit USER128 register value, both, or neither. Specify the values in HEX format. ‘

¥ Specify 32-bitvalue to program into USER register
USER bits [31:0; | 0000_0000
Specify 128-bit value to program into USER128 register

USER bits [127:01: | 0000_0000_0000_0000_0000_0000_0000_0000

Figure 7-28: eFUSE USER Register Setup

In the USER register setup pane specify user define register bits. The 32 bit USER
(FUSE_USER) and 128 bit USER register (FUSE_USER128) registers are a set of user defined
one-time programmable eFUSE bits. The bits of these registers are cumulatively
programmable. This means that if you program only one USER bit in an eFUSE
programming session (e.g., USER = 0x0000_0001 or bit 0), then on subsequent eFUSE
programming sessions you can program any of the remaining 0 bits (e.g., USER =
0x0000_0002 or bit 1).

After programming the FUSE_USER and FUSE_USER_128 registers, these registers can be
read in several ways:
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Using the Tcl command

report_property [lindex [get_hw _device] 0] REGISTER.EFUSE.FUSE_USER
report_property [lindex [get_hw _devices] 0] REGISTER.EFUSE.FUSE_USER_128

Through the Vivado Hardware Device Properties window after running a
refresh_hw_device operation.

In the Control Register Setup wizard pane, specify the following settings:

¢ Program eFUSE Registers

Control Register Setup (optional)

Enable and select the Control Register bits to program. These bits provide security by disabling operations on different eFUSE registers.

Enable control register programming

Reqgister Bit Name BitP.. Description

R_DIS_KEY 0 Disable reading and programming of FUSE_KEY encryption key
R_DIS_USER 1 Disable reading and programming of FUSE_USER user code
R_DIS_SEC 2 Disable reading and programming of FUSE_SEC security settings
R_DIS_RSA 3] Disable reading and programming of FUSE_RSA authentication key
W_DIS_KEY 7 Disable programming of FUSE_KEY encryption key

W_DIS_USER 8 Disable programing of FUSE_USER user code

W_DIS_SEC 9 Disable programing of FUSE_SEC security settings

W_DIS_RSA 15 Disable programing of FUSE_RSA authentication key
W_DIS_USER128 16 Disable programming of FUSE_USER128

Figure 7-29: Control Register Setup Pane

In the Control Register Setup pane, specify the eFUSE control settings.

R_DIS_KEY: When set, disables CRC check that verifies the key & programming of the
FUSE_KEY encryption key.

R_DIS_USER: When set, disables reading and programming the 32 bit user bits
(FUSE_USER).

R_DIS_SEC: When set, disables reading and programming of the security register bits
(FUSE_SEC).

R_DIS_RSA: When set, disables reading and programming of the RSA key register
(FUSE_RSA).

W_DIS_USER: When set, disables programming of the 32 bit user bits (FUSE_USER).
W_DIS_SEC: When set, disables programming of the security register bits (FUSE_SEC).
W_DIS_RSA: When set, disables programming of the RSA key register (FUSE_RSA).
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«  W_DIS_USER_128: When set, disables programming of the 128 bit user bits
(FUSE_USER128).

For more details on the FUSE_SEC register refer to the UltraScale Architecture Configuration
User Guide (UG570) [Ref 15].

Disabling Control Registers Setup

To disable the Control Register programming, run the following Tcl command:
program_hw_devices -control_efuse {20} [lindex [get_hw_devices] S$deviceIldx]

Where $deviceIdx is setto the index of the UltraScale or UltraScale+ device on which you
are disabling the eFUSE Control Register bit programming.

This sets the W_DIS_CNTL bit, which in turn disables further eFUSE Control Register bit
programming.

f IMPORTANT: /fthe W_DIS_CNTL bit is programmed, the programming of other eFUSE control register
bits is disabled, preventing future edits to the control register of the device.

In the Security Register Setup wizard pane, specify the following settings:

¢ Program eFUSE Registers @

Security Register Setup (optional)

Enable and select the Security Register bits to program. These bits set the authentication and decryption key types, and other security control settings. ‘

Enable security register programming

Reqgister Bit Name BitP.. Description

CFG_AES_Only 0 Only allow encrypted bitstreams
EFUSE_KEY_Only 1 Only use eFUSE keys (BBRAM keys disabled)
RSA_AUTH 2 Force RSA Authentication of bitstream
SCAMN_DISABLE 4 Disable Xilinx Internal Test Access
CRYPT_DISABLE 5 Permanently disable the decryptor

Figure 7-30: eFUSE Security Register Setup

In the Security Register Setup wizard pane specify security control options over the type
of bitstreams allowed to load on the FPGA. The FUSE_SEC settings are:
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+ CFG_AES_Only: When set, only accept encrypted bitstreams.

« EFUSE_KEY_Only: When set, only the eFUSE key can be used for decryption.
« RSA_AUTH: When set, forces RSA Authentication of bitstreams.

« SCAN_DISABLE: When set, disables Xilinx access to internal test registers.

« CRYPT_DISBALE: When set, permanently disables the decryptor.

For more details on the FUSE_SEC register refer to the UltraScale Architecture Configuration
User Guide (UG570) [Ref 15].

Review the eFUSE settings in the Program eFUSE Registers Summary pane.

¢ Program eFUSE Registers @

Program eFUSE Registers Summary

VIVADO'

Hix Editions 0 AES key register entry field:
There are 2AES keys:
0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_7767
0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_0000_0554_62AA_ABBS

0 RSA key has been eFUSE programmed.

0 USER register field: 0000A5CE

© USER 128 bit register field: 00000000000000000000000000000001
0 Enabled 1 Control Register bits:0_0000_0001_0000_0000

0 Enabled 1 Security Register bits:00_0001

£ XILINX

To program eFUSE, click Finish

Figure 7-31: Program eFUSE Registers Summary

All bits set in the Program eFUSE Registers wizard panels are shown in this pane. In this
pane you will see individual bit settings in order to review the specific programming
settings. Carefully review this summary page to ensure every bit that is intended to be
programmed is set.
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Click Finish to bring up the Program eFUSE confirmation dialog box:

¢ Program eFUSE @

Program eFUSE cannot be reversed. Are you sure you have made the right settings?
OK to proceed eFUSE programming?

Figure 7-32: Program eFUSE Confirmation Dialog

Click OK the to program the specified fuse bits.

Disabling the JTAG interface
To disable the JTAG interface through the eFUSE registers, run the following Tcl command:
program_hw_devices -security_efuse {08} [lindex [get_hw_devices] $deviceIdx]

Where $deviceIdx is set to the index of the UltraScale or UltraScale+ device that will
have its JTAG interface disabled.

Note: This programming step should be performed as the last and final step after all desired eFUSE
bits have been programmed.

ﬁ IMPORTANT: /f the JTAG Disable bit is programmed, the JTAG interface will be disabled, preventing
future test and configuration access to the device. This bit should only be programmed if JTAG access
to the device is no longer required.

eFUSE NKZ File

In order to capture all eFUSE programming settings in one file, and so make it easier to
export eFUSE settings to other eFUSE programmer implementations, as well as to
mass-program the same eFUSE settings into many devices, Xilinx has defined a file format
called NKZ, designated by the file extension .nkz. The NKZ format is a superset of the
existing NKY format; that is, NKZ supports all NKY fields as well as any programmable
eFUSE register settings.

eFUSE Export NKZ File

Because you are advised to program eFUSE settings in multiple passes, eFUSE settings are
always exported to an externally visible NKZ file, which is updated during each eFUSE
operation. The intent of this file is to accumulate all eFUSE settings applied to a device,
even if they are applied over multiple eFUSE operations. This file is tracked by Vivado so
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that there is always a single eFUSE export file containing a device's cumulative eFUSE
settings in NKZ format. If no options are specified, the default name of this file is:

export_<FUSE_DNA>.nkz

where <FUSE_DNA> is the FUSE_DNA register value of the device.

This default file is located in the launch directory of the Vivado® IDE. You can change this
file by using the —~efuse_export_file option on the program_hw_devices Tcl
command, as in the following example:

program_hw_devices -user_efuse {1} -efuse_export_file {my_ settings.nkz}

Vivado IDE then starts using the specified NKZ file for exported eFUSE settings without
having to repeatedly specify this file in the Tcl options. Any previously created eFUSE export
file will not be removed; it will contain all eFUSE settings applied prior to changing the
eFUSE export file name. After all eFUSE operations are performed, all eFUSE settings are
stored in the current eFUSE export file.

There is also an option to only export eFUSE settings instead of actually programming the
device. This can be useful for creating an NKZ file containing all desired eFUSE settings
without affecting the device. In addition, any eFUSE programming mistakes made in this
mode can easily be corrected by simply removing the eFUSE export file and starting over.
This export-only mode can be utilized with the following Tcl command:

program_hw_devices -user_efuse {1} -only export_efuse

This option applies only to each individual command, so the option must be used in every
eFUSE operation to keep the device from being programmed. Since eFUSE settings are
always exported to an NKZ file regardless of whether or not programming occurs, Xilinx
highly recommends that you not intermix the programming flow with the export-only flow.
Otherwise, the resulting eFUSE export file may contain a mix of eFUSE settings actually
programmed into the device and those only exported to the NKZ file, which makes the true
state of the eFUSE registers in the device unclear. Using this export-only mode, the same
exact eFUSE export file in NKZ format is created as in the programming case, but no
programming is performed on the device.

System Monitor

The System Monitor (SYSMON) Analog-to-Digital Converter (ADC) measures die
temperature and voltage on the hardware device. The SYSMON monitors the physical
environment via on-chip temperature and supply sensors. The ADC provides a
high-precision analog interface for a range of applications.

The ADC can access up to 17 external analog input channels. Refer to UltraScale
Architecture System Monitor User Guide (UG580) [Ref 16], or 7 Series FPGAs and Zyng-7000
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SoC XADC Dual 12-Bit 1 MSPS Analog-to-Digital Converter User Guide (UG480) [Ref 14] for
more information on a specific device architecture.

HARDWARE MANAGER - reishi15/kiliny_tcf/Digilenti210308A1C484
@ There are no debug cores. Program device Refresh device
Hardware dashboard_1
a = = had SysMon (xcvu9p_0)
MName Status
B 2 -
~ B reishi15 (1 Connected ?a
~ @ xlinx_IciDigilent210308A1C4...  Open = W Temp 31.3°C
~ & xovu9p_0 (1 Programmed E
2 SysMon (System Monito §
]
=
System Monitor Core Properties ;
=1
& SysMon - -3 ®
T
2
Sensor Current Min Max £
TEMPERATURE 31.3°C 265°C 35.1°C & -
VCCINT 0718v o712y 0724V
VCCAUX 1.796V 1772V 1.805V
VCCBRAM 0847V 0.832v 0855V
VUSEROD 0.000vV 2,997V 0.000vV
VUSER1 0.000V 2.997v 0.000V 158:21:30 156:21:45
&l s manmnn AARAU._____Aneme A AR ~ Time (HH MMSS)
General Properties Sensors

Figure 7-33: System Monitor

The hw_sysmon data is stored in dedicated registers called status registers accessible
through the hw_sysmon_reg object. You can get the contents of the System Monitor
registers by using the get_hw_sysmon_reg command.

Every device that supports the System Monitor automatically has one or more hw_sysmon
objects created when refresh_hw_device is called. When the hw_sysmon object is
created, it is assigned a property for all the temperature and voltage registers, as well as the
control registers. On the hw_sysmon object, the values assigned to the temperature and
voltage registers are already translated to Celsius/Fahrenheit and Volts.

Although you can use the get_hw_sysmon_reg command to access the hex values stored in
registers of a System Monitor, you can also retrieve values of certain registers as formatted
properties of the hw_sysmon object. For example, the following code retrieves the
TEMPERATURE property of the specified hw_sysmon object rather than directly accessing
the hex value of the register:

set opTemp [get_property TEMPERATURE [lindex [get_hw_sysmons] 0]

Complete list of all the System Monitor commands can be found in Table 11-18.
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Chapter 8

Serial Vector Format (SVF) File
Programming

An alternative way to program FPGAs and configuration memory devices is through the use
of a serial vector format (SVF) file. The SVF file generated through Vivado® Design Suite
and Vivado Lab Edition contains low level JTAG instructions and data required to program
these devices. Once the file is generated it can be used by boundary scan test tools
independent of the Vivado IDE.

The general steps to create an SVF file are as follows:

Create an SVF offline target.

Open the created SVF target.

Add devices to the target to define the SVF JTAG scan chain.
Program FPGAs or configuration memory devices.

Write SVF.

Close SVF target.

N o v~ w N

(Optional) Execute SVF.

In step 4, the program operations are recorded in sequential order and stored a cached file.
The cached file is then written out to a target destination in step 5. After the file is created,
it can be used by boundary scan tools or executed through Vivado Design Suite or Vivado
Lab Edition tools.

ﬁ IMPORTANT: The XSVF file format is not supported in Vivado IDE.

Creating an SVF Target

The SVF target is similar to a live Xilinx Platform Cable USB or Digilent JTAG cable hardware
target. The properties and Tcl commands are all the same with the main distinction being
that the SVF target is not an active live cable. This means that any operations performed on
this target will not affect the hardware until the SVF is executed. Note that you do not need
to have a cable connected to your system to create an SVF.
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Using Vivado IDE

To create an SVF target in the Vivado Hardware Manager, open the Vivado Hardware
Manager by either launching Vivado or Vivado Lab Edition. You can create an SVF Target by
selecting Tools > Create SVF Target. This automatically opens a server on the local host,
and also opens the Create SVF Target dialog as box shown in Figure 8-2.

On any available server you can create an offline SVF target as shown below.

Hardware ? 008 X
Q = & &g o
MName Status

~ B localhost(1) = Cononscied
Ho xilinx_tefilingPort_#0003.] Hardware Server Properties...
* Refresh Server
Add Xilinx Virtual Cable (XVC)...
Create SVF Target... L\\,

Close Server

Exportto Spreadsheet..

Figure 8-1: Create SVF Target

The Create SVF Target dialog box opens as shown below.

¢ Create SVF Target @

Please specify the name for new SVF target. You can choose an existing target to copy into the
new SVF target.You can import device chain and SVF operations from a previously exported SVF ‘
file.

Mame: svitarget 0 |

Copy from target: @ localhost:3121klinx_tcfXilinwPort_#0003. Hub_#0004 w

Impaort file: IZ‘

Figure 8-2: Create SVF Target Dialog Box

TIP: You can copy an existing SVF chain by enabling the Copy from target option. Alternatively you

O can specify an SVF file that you created using the Vivado Hardware Manager from an earlier run of the
flow. Vivado IDE saves specifics of the SVF chain, so when it is read back, the SVF chain can be
recreated.
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The SVF Target that you just created appears Open under the your server in the Hardware

Chapter 8: Serial Vector Format (SVF) File Programming

window in Vivado Hardware Manager.

~ B localhost (2)
B xiliny_tcfiXilingPort_#0003.Hu...
B xilinx_tofilinsvitarget_0 (0)

Hardware ? 008 X
Q = 2 o
MName Status

Connected
Closed
Open

Figure 8-3: SVF Target in Hardware Window

To delete an existing SVF target, right-click the SVF target in the Hardware window and

select Delete.

Hardware ? 00X svftarget_0
Q = = & Device Chain
MName Status
+A
~ B localhost (2) Connected
B xilinx_tefiXilingPort_#0003.Hu...  Closed
B xilinx_tcfiilinsvitarget_0 (0) Open
Hardware Target Properties...
(™ Refresh Target
Close Target
¥ Delete DeleteL\\)
Exportto Spreadsheet..
< »

Figure 8-4: Delete SVF Target in Hardware Window

IMPORTANT: When you delete a target, all the devices created for that target are also deleted.
Moreover, a deleted target is also closed if it was previously opened.

You can also use the Vivado Tcl mode or the Tcl Console in the Vivado IDE to create the SVF
Target.
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Following are the steps needed to create an SVF target after initially launching Vivado or
Vivado Lab Edition:

Using the Command Line

Following are the steps needed to create an SVF target after initially launching Vivado or
Vivado Lab Edition:

open_hw

connect_hw_server

create_hw_target my_svf_target

if {[string length [get_hw_ targets -quiet -filter

{IS_OPENED == TRUE}]] > 0} \
{close_hw_target [get_hw_targets * -filter {IS_OPENED == TRUE}
1 3\

open_hw_target [get_hw_targets *my_svf_ target]
current_hw_target

The first two commands can be omitted if already connected to a server. When executed,
the create_hw_target command defines the my_svf_target. Note that you cannot
have two targets with the same name in a session. Finally, after closing any open target and
opening the svf target, the create_hw_target command is run. As a result, the final
command shows the full hardware target handle name of the created my_svf_target.

All standard operations on the target, such as get_hw_targets and open_hw_target

commands are supported. You can use the IS_SVF hardware target property to distinguish
between a live target and an SVF target. For instance, the following is a sample command
line that reads the IS_SVF property from a target named "my_svf_target".

get_property IS_SVF [get_hw targets -regexp .*my_svf_target]

Additionally, all the SVF hw_targets created in this session can be displayed by issuing
the following command:

get_hw_targets -filter {IS_SVF}

To delete the created target, use the delete_hw_target command. For instance, by
issuing the following command, the my_svf_target is deleted:

delete_hw_target [get_hw_targets -regexp .*my_svf_target]

f IMPORTANT: When a target is deleted, all the devices created for the target are also deleted. Moreover
a deleted target is also closed if it was previously opened.
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Adding Devices to an SVF Target

After the SVF target is created, devices can be added to it in order to define the SVF JTAG
device chain configuration. The SVF JTAG device chain configuration should match the
target hardware chain to ensure proper SVF file execution.

Using Vivado IDE

Click on the "+"” button to add either Xilinx or non-Xilinx parts to the SVF chain.

syftarget_0

Device Chain

Add Xilinx Part... %
Add Mon-Xilinx Part...

This device chain s empty. Press the + outton to add device.

Figure 8-5: Add Devices to SVF Target

When you click Add Xilinx Part... the Add Xilinx Device dialog box opens. You can now
choose the appropriate Xilinx device to append to the SVF chain.

Note: Devices can only be appended to an SVF device chain.

s Add Xilinx Device [l

Please choose a Xilink part to add to the device chain.

Search: HC (460 matches)
Alrdrn ~
*c7a100t

*CcTa200t

XCTa3s0t

*CTRTOt

XCTR160t

XcTk325

XCTK355

XCT k410t -

Figure 8-6: Add Xilinx Device Dialog Box

O TIP: This dialog box is slightly different Vivado Design Edition
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On selecting a Xilinx Device and clicking OK, the Xilinx Device is added to the SVF chain as
shown below.

svitarget_0 oo X
Device Chain

@ =)+

IO 8 [ TDO

Figure 8-7: Xilinx Device in SVF Chain

You can also add non-Xilinx parts to the SVF device chain by right-clicking the SVF chain
and selecting Add Non-Xilinx Part... as shown below.

svftarget_0 oG X
Device Chain
o} 3o+
oI 4§ | >TDO
) Hardware Device Properties...

Repeat Selected Device

Add Xilinx Part...

Add Mon-Xilinx Part... %
< l’\\ﬁ ’

Add Configuration Memory Device...
SVF Operations Add Program Device Operation...

L AR R

4

Figure 8-8: Adding a Non-Xilinx Part

Vivado Programming and Debugging N Send Feedback 100
UG908 (v2019.1) May 22, 2019 www.xilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=100

(: X”_INX® Chapter 8: Serial Vector Format (SVF) File Programming

This opens the Add Non-Xilinx Device dialog box as shown below.

# Add Non-Xilinx Device [l

Add a non-Xilinx device to JTAG chain

1D code (Hex):
IR Length:

Mask (Hex):

Figure 8-9: Add Non-Xilinx Device Dialog Box

Fill in the dialog box as follows:

« The Part Name can be any part name you choose.
« The ID Code is a Hex value that represents a valid device ID code.

« The IR length is a decimal numerical value that represents the Instruction Register
length.

« The Mask is a Hex bit mask value.

Note: The ID code, IR Length, and Mask values are typically provided by silicon vendors through
device BSDL files.

Click OK, and the Non-Xilinx part is added to the SVF Device chain.

svftarget_0 O X
Device Chain

bR

4

DI b 3¢ > TDO

xc7a200t_0

Figure 8-10: Non-Xilinx Device in SVF Chain
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Using the Command Line

To create the chain using the Vivado Tcl mode or the Tcl Console in the Vivado IDE, perform
sequential create_hw_device operations on an open SVF target. For instance, to add an
xcku9p part followed by an xcvu095 part perform the following steps:

current_hw_target my_svf_target
open_hw_target

create_hw_device -part xcku9p
create_hw_device -part xcvu095
refresh_hw_target
get_hw_devices

In this example, the first two steps can be skipped if the SVF is already created and opened.
The create_hw_device commands in the example define the devices of the JTAG chain
starting with the first device on the chain and onward.

Note: The create_hw_device command only creates devices on an open SVF hardware target.

To add user defined devices to the chain, add the -idcode, -irlength, and -mask
values along with the part type name using the -part options. For instance, if you have
a part called "my_part" with a JTAG idcode of 1234567, an ir length of 8, mask of ffffffff,
then you would create the device as shown below:

open_hw_target [current_hw_target]

create_hw_device -idcode 01234567 -irlength 8 -mask ffffffff -part my_ part

# print IR length for user defined devices

puts [get_property IR_LENGTH [lindex [get_hw_devices -filter {PART == my_part}] 0]]
puts $idcode_hex

close_hw_target

Note: The idcode for the create_hw_device should be a valid device ID code. ID code values and
IR lengths are typically provided by silicon vendors through device BSDL files.
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To see a report of the target and its devices, run the report_hw_targets command. The
report shows details for all active targets in the system. Use this report to obtain properties
of the server, target, and device as shown below:

report_hw_targets
INFO: Server Property Information: localhost:3121
CLASS: hw_server
HOST: localhost
NAME: localhost:3121
PORT: 3121
SID: TCP:localhost:3121
INFO: Target Property Information: localhost:3121/xilinx_tcf/Xilinx/my_svf_target
CLASS: hw_target
DEVICE_COUNT: 3
HW_JTAG: 0
IS_OPENED: 1
MAX_DEVICE_COUNT: 32
NAME: localhost:3121/xilinx_tcf/Xilinx/my_svf_target
FREQUENCY: 10000000
TYPE: xilinx_tcf
TID: jsn-XNC-my_svf_ target
UID: Xilinx/my_ svf_target
SVF: 1
Device: xcku9p_0
Device: xcvu095_1
Device: my part_2

Adding Configuration Memory Parts to Xilinx
Devices

Using Vivado IDE

When you right-click on a Xilinx device part in an SVF chain, you have the option of creating
and associating a Configuration Memory device to it.

svftarget_0

Device Chain

ol D_ 2; Hardware Device Properties.. -
Repeat Selected Device
Add Xilinx Part...
Add Non-Xilinx Part
Add Configuration Memory Device... Ik

Add Program Device Operation.

Figure 8-11: Adding a Configuration Memory Device
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This opens up the Add Configuration Memory Device dialog box as shown below.

¢ Add Configuration Memory Device @

o Choose a configuration memory part. This can be changed later.

Device: {8 xc7a200t_0

Filter

Manufacturer | All hd Type | All hd
Density (Mb) | All A Width | All A

Reset All Filters

Select Configuration Memory Part

Search:

Mame Part Manufact.. Alias Family Type Density (..  Width
& 28f00am29ew-bpi-x16 28f00am29ew Micron m29ew bpi 1024 x16 =
@ 28f00am29ew-bpi-«8 28f00am29ew Micron m29ew bpi 1024 x5

@ 28f00ap30b-bpix16 2Bf00ap30b Micron p3l bpi 1024 *¥16

@ 28f00ap30e-bpix16 28f00ap3le Micron p3l bpi 1024 *¥16

@ 28f00ap30t-bpi-«16 28f00ap30t Micron p3l bpi 1024 *¥16

@ 28f00ap33b-bpix16 28f00ap33b Micron p33 bpi 1024 *¥16

@ 28f00ap33e-bpix16 28f00ap3ie Micron p33 bpi 1024 *¥16

@ 28f00ap33t-bpi«16 2Bf00ap33t Micron p33 bpi 1024 *¥16 .
< »

Figure 8-12: Add Configuration Memory Device Dialog Box

Select the appropriate memory device and click OK. The device is associated with the Xilinx
device and appears in the SVF device chain as shown below.

svitarget 0 oo X

Device Chain

aQ a i +

oI {»TDO

xc7a200t_0 userpart_1

Figure 8-13: Configuration Memory Device in SVF Chain
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Using Command Line

To create and associate a configuration memory device using the Vivado Tcl mode or the Tcl
Console in the Vivado IDE, use the create_hw_cfgmem Tcl command as shown below.

create_hw_cfgmem -hw_device [lindex [get_hw_devices xc7a200t_0] 0]

[lindex
[get_cfgmem_parts {s25flll6k-spi-x1_x2_x4}] 0]

Operations on the SVF Chain

Once you have created an SVF chain that reflects all the devices and their configuration

memory in the right order, you can start adding programming operations to the devices in
the SVF chain.

For example, you can right click on the Xilinx a200t device in the chain and select Add
Program Device Operation... which bring up the Add Program Device Operation dialog
box as shown below. Specify the bitstream file to program the device with.

¢ Add Program Device Operation @
Add program device operation ‘
Device: ¥C7a200t 0 w
Bitstream file: HZ‘

Figure 8-14: Add Program Device Operation Dialog Box
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After you click OK, the program device operation is listed at the bottom of the SVF
Operations window.

syftarget_0
Device Chain

@ a H +

4

28f00am29%ew-bpi-x16

)

rl-ll
DI : ﬁ > TDO
userpart_1

< >
SVF Operations

+ -7

Device Command File

¥Cc7a200t_ 0 Program device

Y:2017_1_bash_2/project_mblaze/project_mblaze runs/impl_1/bas...

Export SVF...

Figure 8-15: SVF Operations Window

Similarly, you can program the configuration memory device by right clicking on the
memory device and selecting Add Program Configuration Memory... which bring up the
Add Program Configuration Memory dialog box as shown below. Specify the
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configuration file to program the memory device with. You can also select additional

programming options for memory devices like Erase, Blankcheck, and Verify.

After you click OK, the program configuration memory device operation is listed at the

¢ Add Program Configuration Memory Operation

=

Select a configuration file and set programming options

Device: ¥c7a200t_0

<

Configuration file: 5_8led_spix1.mcs

Siate of non-config mem /0 pins: | Pull-none ~

Program Operations
Address Range: | Configuration File Only

RS Pins: NOME  «
| Erase

Blank Check
~" Program

Veriy

Figure 8-16: Add Program Configuration Memory Dialog Box

bottom of the SVF Operations window.

svftarget 0 oo X
Device Chain
@ a 2 +

DI j::ﬁ 100

Xc7a200t_0 userpart_1

[ »
SVF Operations
+ =2t
Device Command File
¥£7a200t_0 Program device Y:12017_1_bash_2/project_mblaze/project_mblaze.runs/impl_1/bas...
XC7a200t_0

Program configuration Memory (.. Y:/kc705_8led_spixl.mcs

Export SVF...

Vivado Programming and Debugging
UG908 (v2019.1) May 22, 2019

Figure 8-17: Configuration Memory Device in SVF Operations Window

www.Xxilinx.com

| Send Feedback I 107


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=107

(: X”_INX® Chapter 8: Serial Vector Format (SVF) File Programming

Writing SVF Files

Using the Vivado IDE

The SVF chain setup along with its operations can be saved to a file by clicking Export
SVF... at the bottom of the SVF Operations window as shown below.

svitarget_0 Oon X

Device Chain

a a X +

DI { >»TDO
xc7a200t_0 userpart_1
4 Export SVF
< Export programming operations to SVF file bd
SVF Operations
+‘ o f File: |Y:J’S\.ﬂarget_0.sw ”Z‘
Device
¥c7a200t_0 h_2/project_mblaze/project_mblaze runsfimpl_1/bas...
¥Cc7a200t 0 | spixl.mcs

| Export SVF... |

Figure 8-18: Exporting the SVF Chain Setup

ﬁ IMPORTANT: You can recreate an existing SVF chain by specifying an SVF file that you created with the
Vivado Hardware Manager from an earlier run of the flow. Vivado IDE saves specifics of the SVF
chain to the file, so that when it is read back, the SVF chain can be recreated.

Using the Command Line

To write the SVF file using the Vivado Tcl mode or the Tcl Console in the Vivado IDE use the
write_hw_svf command.

The SVF chain, direct FPGA and indirect flash programming operations are captured in a
temporary file. When the write_hw_svf command is called, the temporary file is moved
to the filename passed to the command. After the write_hw_svf command is called, the
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temporary file is reset and a subsequent programing operation is added to the beginning
of the SVF file sequence.

The following code segment shows the Tcl commands used to create a file named
my_xcku9p.svf containing the direct programming of a xcku9p device:

create_hw_target my_svf_ target

open_hw_target

set devicel [create_hw device -part xcku9p]
set_property PROGRAM.FILE {my_xcku9p.bit} S$device0l
program_hw_devices S$devicel

write_hw_svf my xcku9p.svf

close_hw_target

In this sample code the xcku9p device is created using create_hw_device command
whose return value is set to a temporary variable called device0. This temporary value is
then used to reference the object when setting the PROGRAM. FILE property to the file
my_xcku9p.bit file. Next, the program_hw_device command is called using the
device0 reference. When this program_hw_device command runs, it creates a
temporary SVF file with the SVF operations necessary to program the my_xcku9p.bit file
on the xcku9p. Lastly, the write_hw_svf command takes the temporary file and moves it
to the final target destination, myxcku9p.svf. At this point, the SVF file creation process
is complete and the target can be closed.

TIP: A final note on writing SVF files is that you should first create all the devices for the JTAG chain
and then perform the programming operations. If you happen to interleave create_hw_device
commands in between programming commands you will produce an output SVF file that has two
different chain sequences.

« Example of Incorrect SVF File Creation Steps:

create_hw_target my_svf_target

open_hw_target

set devicelO [create_hw _device -part xcku9p]
set_property PROGRAM.FILE {my_xcku9pl.bit} $device0l
# this program command will produce SVF instructions
# which account for only deviceO in chain
program_hw_devices S$devicel

set devicel [create_hw device -part xcku9p]
set_property PROGRAM.FILE {my_xcku9p2.bit} S$devicel
# this program command will produce SVF instructions
# which account for device0 and devicel in chain
program_hw_devices $devicel

write_hw_svf my_bad_xcku9p.svf

close_hw_target

The first program command only captures the chain definition containing the first device.
The second program command includes both devices in the chain when writing out the SVF
instructions. Therefore, if you attempt to play this SVF file on a chain with two devices, the
first programming operations fail because the live chain gets two devices and not one as

the command expected.
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To correct this problem you run the create_hw_device commands first. Then after the
chain is completely defined, perform the program operations as shown below:

« Example of Correct SVF File Creation Steps

create_hw_target my_svf_ target

open_hw_target

# create device chain first

set devicelO [create_hw _device -part xcku9p]

set devicel [create_hw device -part xcku9p]

# program device0

set_property PROGRAM.FILE {my_xcku9pl.bit} $device0
program_hw_devices S$devicel

# program devicel

set_property PROGRAM.FILE {my_xcku9p2.bit} S$devicel
program_hw_devices S$devicel

write_hw_svf my good_xcku9p.svf

close_hw_target

Executing SVF Files

Once the SVF file is created, you can optionally execute the SVF file through Vivado IDE.
Vivado IDE can execute SVF files generated through the SVF generation feature and is
intended as the validation test tool. The execute_hw_svf command is not intended as a
general purpose SVF execution command; take care to only use SVF files created through
Vivado IDE.

To run an svf command you run the command on an open live target as follows:

execute_hw_svf my_file.svf

INFO: [Labtoolstcl 44-548] Creating JTAG TCL script from SVF file
INFO: [Labtoolstcl 44-549] Re-opening target in JTAG mode

INFO: [Labtoolstcl 44-551] Sourcing JTAG TCL script: my_file.tcl
Pass: SVF Execution completed with no errors

INFO: [Labtoolstcl 44-550] Restoring target to original mode
INFO: [Labtoolstcl 44-570] Execute SVF completed successfully

In this example, the file my_file.svf is executed. As part of the execution flow, the input
SVF file is converted via HW_JTAG Tcl operations into a temporary file. After this Tcl code is
created, the file is sourced in order to execute the converted SVF instructions. To see the

JTAG_TCL operations, you can run the execute_hw_svf command using the -verbose

option. Once the command completes you will see either the error at the instruction where
the execution failed or a "Pass” message at the end of the message log.
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Chapter 9

Debugging the Design

Debugging an FPGA design is a multi-step, iterative process. Like most complex problems,
it is best to break the FPGA design debugging process down into smaller parts by focusing
on getting smaller sections of the design working one at a time rather than trying to get the
whole design to work at once. Iterating through the design flow by adding one module at
a time and getting it to function properly in the context of the whole design is one example
of a proven design and debug methodology. You can use this design and debug
methodology in any combination of the following design flow stages:

* RTL-level design simulation
» Post-implemented design simulation

+ In-system debugging

RTL-Level Design Simulation

The design can be functionally debugged during the simulation verification process. Xilinx
provides a full design simulation feature in the Vivado® IDE. The Vivado design simulator
can be used to perform RTL simulation of your design. The benefits of debugging your
design in an RTL-level simulation environment include full visibility of the entire design and
ability to quickly iterate through the design/debug cycle. The limitations of debugging your
design using RTL-level simulation includes the difficulty of simulating larger designs in a
reasonable amount of time in addition to the difficulty of accurately simulating the actual
system environment. For more information about using the Vivado simulator, refer to the
Vivado Design Suite User Guide: Logic Simulation (UG900) [Ref 1].

Post-Implemented Design Simulation

The Vivado simulator can also be used to simulate the post-implemented design. One of
the benefits of debugging the post-implemented design using the Vivado simulator
includes having access to a timing-accurate model for the design. The limitations of
performing post-implemented design simulation include those mentioned in the previous
section: long run-times and system model accuracy.
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In-System Logic Design Debugging

The Vivado Design Suite also includes a logic analysis feature that enables you to perform
in-system debugging of the post-implemented design an FPGA device. The benefits for
debugging your design in-system include debugging your timing-accurate,
post-implemented design in the actual system environment at system speeds. The
limitations of in-system debugging includes somewhat lower visibility of debug signals
compared to using simulation models and potentially longer
design/implementation/debug iterations, depending on the size and complexity of the
design.

In general, the Vivado tool provides several different ways to debug your design. You can
use one or more of these methods to debug your design, depending on your needs.
Chapter 10, In-System Logic Design Debugging Flows focuses on the in-system logic
debugging capabilities of the Vivado Design Suite.

In-System Serial 1/0 Design Debugging

To enable in-system serial I/O validation and debug, the Vivado Design Suite includes a
serial I/O analysis feature. This allows you to measure and optimize your high-speed serial
I/O links in your FPGA-based system. The Vivado serial I/O analyzer features are designed
to help you address a range of in-system debug and validation problems from simple
clocking and connectivity issues to complex margin analysis and channel optimization
issues. The main benefit of using the Vivado serial I/O analyzer over some other external
instrumentation techniques is that you are measuring the quality of the signal after the
receiver equalization has been applied to the received signal. This ensures that you are
measuring at the optimal point in the TX-to-RX channel thereby ensuring real and accurate
data.

The Vivado tool provides the means to generate the design used to exercise the gigabit
transceiver endpoints as well as the run-time software to take measurements and help you
optimize your high-speed serial I/O channels. Chapter 14, Serial I/O Hardware Debugging
Flows guides you through the process of generating the IBERT design. Chapter 15,
Debugging the Serial I/O Design in Hardware guides you through the use of the run time
Vivado serial I/O analyzer feature.

Vivado Programming and Debugging N Send Feedback 112
UG908 (v2019.1) May 22, 2019 www.xilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=112

& XILINX

Chapter 10

In-System Logic Design Debugging Flows

The Vivado® tool provides many features to debug a design in-system in an actual
hardware device. The in-system debugging flow has three distinct phases:

1. Probing phase: Identifying what signals in your design you want to probe and how you
want to probe them.

2. Implementation phase: Implementing the design that includes the additional debug IP
that is attached to the probed nets.

3. Analysis phase: Interacting with the debug IP contained in the design to debug and
verify functional issues.

This in-system debug flow is designed to work using the iterative design/debug flow
described in the previous section. If you choose to use the in-system debugging flow, it is
advisable to get a part of your design working in hardware as early in the design cycle as
possible. The rest of this chapter describes the three phases of the in-system debugging
flow and how to use the Vivado logic debug feature to get your design working in hardware
as quickly as possible.

Probing the Design for In-System Debugging

The probing phase of the in-system debugging flow is split into two steps:

1. Identifying what signals or nets you want to probe

2. Deciding how you want to add debug cores to your design

In many cases, the decision you make on what signals to probe or how to probe them can
affect one another. It helps to start by deciding if you want to manually add the debug IP
component instances to your design source code (called the HDL instantiation probing
flow) or if you want the Vivado tool to automatically insert the debug cores into your
post-synthesis netlist (called the netlist insertion probing flow). Table 10-1 describes some
of the advantages and trade-offs of the different debugging approaches.
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Table 10-1: Debugging Strategies

Debugging Goal Recommended Debug Programming Flow
Identify debug signals in the HDL | » Use mark_debug property to tag signals for debugging in HDL.
source code while retaining « Use the Set up Debug wizard to guide you through the Netlist
f|eX|b|||ty to enab|9/disab|e Insertion probing flow.

debugging later in the flow.

Identify debug nets in synthesized |+ Use the Mark Debug right-click menu option to select nets for

design netlist without having to debugging in the synthesized design netlist.

modify the HDL source code. + Use the Set up Debug wizard to guide you through the Netlist
Insertion probing flow.

Automated debug probing flow « Use set_property Tcl command to set the mark_debug

using Tcl commands. property on debug nets.

+ Use Netlist Insertion probing flow Tcl commands to create debug
cores and connect to them to debug nets.

Explicitly attach signals in the HDL | « Identify HDL signals for debugging.

source to an ILA debug core « Use the HDL Instantiation probing flow to generate and
instance. instantiate an Integrated Logic Analyzer (ILA) core and connect
it to the debug signals in the design.

Using the Netlist Insertion Debug Probing Flow

Insertion of debug cores in the Vivado tool is presented in a layered approach to address
different needs of the diverse group of Vivado users:

« The highest level is a simple wizard that creates and configures Integrated Logic
Analyzer (ILA) cores automatically based on the selected set of nets to debug.

« The next level is the main Debug window allowing control over individual debug cores,
ports and their properties. The Debug window can be displayed when the Synthesized
Design is open by selecting the Debug layout from the Layout Selector or the Layout
menu, or can be opened directly using Window>Debug.

« The lowest level is the set of Tcl XDC debug commands that you can enter manually
into an XDC constraints file or replay as a Tcl script.

You can also use a combination of the modes to insert and customize debug cores.

Marking HDL Signals for Debug

You can identify signals for debugging at the HDL source level prior to synthesis by using
the mark_debug constraint. Nets corresponding to signals marked for debug in HDL are
automatically listed in the Debug window under the Unassigned Debug Nets folder.

Note: In the Debug window, the Debug Nets view is a more net-centric view of nets that you have
selected for debug. The Debug Cores view is a more core-centric view where you can view and set
core properties.
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The procedure for marking nets for debug depends on whether you are working with an RTL
source-based project or a synthesized netlist-based project. For an RTL netlist-based
project:

« Using the Vivado synthesis feature you can optionally mark HDL signals for debug
using the mark_debug constraint in VHDL and Verilog source files. The valid values for
the mark_debug constraint are “TRUE" or “FALSE". The Vivado synthesis feature does
not support the “SOFT" value.

For a synthesized netlist-based project:

« Using the Synopsys® Synplify® synthesis tool, you can optionally mark nets for debug
using the mark_debug and syn_keep constraints in VHDL or Verilog, or using the
mark_debug constraint alone in the Synopsys Design Constraints (SDC) file. Synplify
does not support the “SOFT"” value, as this behavior is controlled by the syn_keep
attribute.

« Using the Mentor Graphics® Precision® synthesis tool, you can optionally mark nets for
debug using the mark_debug constraint in VHDL or Verilog.

The following subsections provide syntactical examples for Vivado synthesis, XST, Synplify,
and Precision source files.

Icons and ILA Core

« The hollow green icon £ indicates nets with MARK_DEBUG property set, but not
connected to any ILA core.

e The full greenicon b3 indicates nets with MARK_DEBUG property set, and connected to
an ILA core.

+ The yellow icon e indicates that there is no MARK_DEBUG on the net, but it is
connected to an ILA core.

Vivado Synthesis mark_debug Syntax Examples

The following are examples of VHDL and Verilog syntax when using Vivado synthesis.

» VHDL Syntax Example

attribute mark _debug : string;
attribute mark debug of char_fifo_dout: signal is "true";

» Verilog Syntax Example

(* mark_debug = "true" *) wire [7:0] char_fifo_dout;
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Synplify mark_debug Syntax Examples
The following are examples of Synplify syntax for VHDL, Verilog, and SDC.

» VHDL Syntax Example

attribute syn_keep : boolean;

attribute mark_debug : string;

attribute syn_keep of char fifo_dout: signal is true;
attribute mark debug of char_fifo_dout: signal is "true";

» Verilog Syntax Example
(* syn_keep = "true", mark_debug = "true" *) wire [7:0] char_fifo_dout;
« SDC Syntax Example

define_attribute {n:char_fifo_din[*]} {mark_debug} {"true"}
define_attribute {n:char_fifo_din[*]} {syn_keep} {"true"}

f IMPORTANT: Net names in an SDC source must be prefixed with the “n:” qualifier.

Note: Synopsys Design Constraints (SDC) is an accepted industry standard for communicating
design intent to tools, particularly for timing analysis. A reference copy of the SDC specification is
available from Synopsys by registering for the TAP-in program at:
https://www.synopsys.com/Community/Interoperability/Pages/TapinSDC.aspx

Precision mark_debug Syntax Examples
The following are examples of VHDL and Verilog syntax when using Precision.

« VHDL Syntax Example

attribute mark _debug : string;
attribute mark debug of char_fifo_dout: signal is "true";

» Verilog Syntax Example

(* mark_debug = "true" *) wire [7:0] char_fifo_dout;

Synthesizing the Design

The next step is to synthesize the design containing the debug cores by clicking Run
Synthesis in the Vivado Design Suite or by running the following Tcl commands:

launch_runs synth_ 1
wait_on_run synth_1

You can also use the synth_design Tcl command to synthesize the design. Refer to the
Vivado Design Suite User Guide: Synthesis (UG901) [Ref 2] for more details on the various
ways you can synthesize your design.
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Marking Nets for Debug in the Synthesized Design

Open the synthesized design by clicking Open Synthesized Design in the Flow Navigator
and select the Debug window layout to see the Debug window. Any nets that correspond
to HDL signals that were marked for debugging are shown in the Unassigned Debug Nets
folder in the Debug window.

Tcl Console Messages Reports Design Runs | Debug X ? 00
Q T 2 % + o
Mame Driver... Driver.. Probe Type
> Unassigned Debug Mets (21 -
> IFid GPIO_BUTTONS_db (2 FORE Q
> IFid GPIO_BUTTONS_ dly (2 FORE Q
» M GPIO_BUTTONS_IBUF (2 IBUF 0
» IFid GPIO_BUTTONS re (2 FORE Q
> IFiE U_SINEGEN/sel (2 FORE Q
Debug Cores Debug Mets

Figure 10-1: Unassigned Debug Nets

« Selecting a net in any of the design views (such as the Netlist or Schematic windows),
then right-click select the Mark Debug option.

« Selecting a net in any of the design views, then dragging and dropping the nets into
the Unassigned Debug Nets folder.

« Using the net selector in the Set up Debug wizard (see Using the Set Up Debug Wizard
to Insert Debug Cores for details).

Using the Set Up Debug Wizard to Insert Debug Cores

The next step after marking nets for debugging is to assign them to debug cores. The
Vivado Design Suite provides an easy to use Set up Debug wizard to help guide you
through the process of automatically creating the debug cores and assigning the debug
nets to the inputs of the cores.

To use the Set up Debug wizard to insert the debug cores:
1. Optionally, select a set of nets for debugging either using the unassigned nets list or

direct net selection.

2. Select Tools > Set up Debug from the Vivado Design Suite main menu, or click Set up
Debug in the Flow Navigator under the Synthesized Design section.
3. Click Next to get to the Specify Nets to Debug panel (see Figure 10-2).

4. Optionally, click Find Nets to Add to add more nets or remove existing nets from the
table. You can also right-click a debug net and select Remove Nets to remove nets from

the table.
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f IMPORTANT: You can also select nets in the Netlist or other windows, then drag them to the list of Nets
to Debug.

5. Right-click a debug net and select Select Clock Domain to change the clock domain to
be used to sample value on the net.

Note: The Set up Debug wizard attempts to automatically select the appropriate clock domain
for the debug net by searching the path for synchronous elements. Use the Select Clock Domain
dialog window to modify this selection as needed, but be aware that each clock domain present
in the table results in a separate ILA core instance.

TIP: Refer to ILA Core and Timing Considerations in Configuration and Debug of the UltraFast Design
O Methodology Guide for the Vivado Design Suite (UG949) [Ref 5] for tips on helping to minimize timing
impact of the ILA Core.

6. Once you are satisfied with the debug net selection, click Next.

Note: The Set up Debug wizard inserts one ILA core per clock domain. The nets that were
selected for debug are assigned automatically to the probe ports of the inserted ILA cores. The
last wizard screen shows the core creation summary displaying the number of clocks found and
ILA cores to be created and/or removed.

7. If you want to enable either advanced trigger mode or basic capture mode, use the
corresponding check boxes to do so. Click Next to move to the last panel.

Note: The advanced trigger mode and basic capture mode features, when used in the Vivado
Hardware Manager, are described in more detail in Chapter 11, Debugging Logic Designs in
Hardware.
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8. If you are satisfied with the results, click Finish to insert and connect the ILA cores in
your synthesized design netlist

¢ SetUp Debug

Nets to Debug

Q = 2 +
MName Clock Domain
> IFid GPIO_BUTTONS_db (2 clk
> IFid GPIO_BUTTONS_ dly (2 clk
» M GPIO_BUTTONS_IBUF (2 clk
» IFid GPIO_BUTTONS re (2 clk
> IFiE U_SINEGEN/sel (2 clk
~ Jri U_SINEGEN/sine (20 clk
i sine[0] clk
I sine[1] clk
i sine[2] clk
i sine[3] clk
I sine[4] clk

Find Mets to Add...

Drriver Cell
FDRE
FDRE
IBUF
FDRE
FDRE
FDRE
FDRE
FDRE
FDRE
FDRE
FDRE

The nets below will be debugged with ILA cores. To add nets click "Find Nets to Add™. You can also ‘
select nets in the Metlist or other windows, then drag them to the list or click "Add Selected Nets”

Probe Type

Data and Trigger
Data and Trigger
Data and Trigger
Data and Trigger
Data and Trigger
Data and Trigger
Data and Trigger
Data and Trigger
Data and Trigger
Data and Trigger
Data and Trigger

Mets to debug: 31

==

< ¢ 4 ¢ <«

w

Cancel

Figure 10-2: Set Up Debug Wizard

9. Configure the ILA core general options such as ILA data depth (C_DATA_DEPTH),
number of input pipe stages (C_INPUT_PIPE_STAGES), enabling the capture control
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feature (C_EN_STRG_QUAL), and enabling the advanced trigger feature
(C_ADV_TRIGGER). Refer to Table 10-2 for descriptions of these options.

¢ SetUp Debug @

ILA Core Options
Choose features for the ILA debug cores. ‘

Sample of data depth: | 1024 w

Input pipe stages: 0 w

Trigger and Storage Settings
+'| Capture control

Ad\aancedtrigger

Fmny

Figure 10-3: Configuring ILA General Options

10. The debug nets are now assigned to the ILA debug core, as shown in Figure 10-4.

Tcl Console Messages Log Reports Design Runs Debug x ? 00
Q T ¢ % + o
Mame Driver... Driver.. Probe Type

~ fF dbg_hub (labtools_xsdbm_v3)

~ fF u_ila_0 (labtools_ila_vE)

> B oclk (1)

» & probe0 (2) Data and Trigger
» B probe1 (20) Data and Trigger
» & probe2 (2) Data and Trigger

Debug Cores Debug Mets

Figure 10-4: Assigned Debug Nets

Using the Debug Window to Add and Customize Debug Cores

The Debug Cores tab in the Debug window provides more fine-grained control over ILA
core and debug core hub insertion than what is available in the Set up Debug wizard. The
controls available in this window allow core creation, core deletion, debug net connection,
and core parameter changes.
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The Debug Cores tab of the Debug window:

« Shows the list of debug cores that are connected to the Debug Hub (dbg_hub) core.

« Maintains the list of unassigned debug nets at the bottom of the window.

You can manipulate debug cores and ports from the popup menu or the toolbar buttons on
the top of the window.

Creating and Removing Debug Cores

To create debug cores in the Debug window, click Create Debug Core. Using this interface,
you can change the parent instance, debug core name, and set parameters for the core. To
remove an existing debug core, right-click the core in the Debug window and select Delete.
Refer to Table 10-2, page 124 for a description of the ILA core options found in the Create
Debug Core dialog.

¢ Create Debug Core @

Specify name and options for the new debug core.

Mame: |u_ila_1 |

Type: ila w

Options
C_DATA_DEPTH 1024 b
C_TRIGIN_EN
C_TRIGOUT_EN
C_ADV_TRIGGER
C_INPUT_PIPE_STAGES 0 b
C_EN_STRG_QUAL
ALL_PROBE_SAME_MU v
ALL_PROBE_SAME_MU_CNT 1 b

Select an option above to see a description of it

Figure 10-5: Creating a New Debug Core
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Adding, Removing, and Customizing Debug Core Ports

In addition to adding and removing debug cores, you can also add, remove, and customize
ports of each debug core to suit your debugging needs. To add a new debug port:

Select the debug core in the Debug window.
Click Create Debug Port to open the dialog.
Select or type in the port width

Click OK.

A A

To remove a debug port, first select the port on the core in the Debug window, then
select Delete.

¢ Create Debug Core @

Specify name and options for the new debug core.

Mame: |u_ila_1 |

Type: ila w

Options
C_DATA_DEPTH 1024 b
C_TRIGIN_EN
C_TRIGOUT_EN
C_ADV_TRIGGER
C_INPUT_PIPE_STAGES 0 b
C_EN_STRG_QUAL
ALL_PROBE_SAME_MU v
ALL_PROBE_SAME_MU_CNT 1 b

Select an option above to see a description of it

Figure 10-6: Creating a New Debug Port

Connecting and Disconnecting Nets to Debug Cores

You can select, drag, and drop nets and buses (also called bus nets) from the Schematic or
Netlist windows onto the debug core ports. This expands the debug port as needed to
accommodate the net selection. You can also right-click any net or bus, and select Assign
to Debug Port.

To disconnect nets from the debug core port, select the nets that are connected to the
debug core port, and click Disconnect Net.
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Modifying Properties on the Debug Cores

Each debug core has properties you can change to customize the behavior of the core. To
learn how to change properties on the debug_core_hub debug core, refer to Changing
the BSCAN User Scan Chain of the Debug Core Hub, page 140.

You can also change properties on the ILA debug core. For instance, to change the number
of samples captured by the ILA debug core, do the following:

1. In the Debug window, select the desired ILA core (such as u_ila_0).
2. In the Cell Properties window, select the Debug Core Options view.

3. Using the C_DATA_DEPTH pull-down list, select the desired number of samples to be
captured.

Cell Properties ? 00X
£ u_ila_o o
C_DATA_DEPTH 1024 %J
C_TRIGIN_EN 1024
2043
C_TRIGOUT_EN 2095
C_ADV_TRIGGER* 8192

C_INPUT_FIPE_STAGES 16384
) 32768

C_EN_STRG_QUAL 55536

ALL_PROBE_SAME_MU 131072

ALL_PROBE_SAME_MU.. 4 A

C_DATA_DEPTH
Mumber of data samples to store

General Froperties Debug Core Options D1 =

Tcl Console Messages Log Reports Design Runs Debug x
Q T ¢ % +
Mame Driver... Driver.. Probe Type

~ fF dbg_hub (labtools_xsdbm_v3)

~ $E u_ila_0 (labtools_ila_vB)

> B oclk (1)

» & probe0 (2) Data and Trigger
» B probe1 (20) Data and Trigger
» & probe2 (2) Data and Trigger

Debug Cores Debug Mets

Figure 10-7: Changing the Data Depth of the ILA Core
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A full description of all ILA core properties can be found in Table 10-2.

Table 10-2: ILA Debug Core Properties

Debug Core Property

Description

Possible Values

C_DATA_DEPTH

Maximum number of data samples that can be
stored by the ILA core. Increasing this value causes
more block RAM to be consumed by the ILA core
and can adversely affect design performance.

1024 (Default)
2048

4096

8192

16384

32768

65536
131072

C_TRIGIN_EN

Enables the TRIG_IN and TRIG_IN_ACK ports of the
ILA core. Note that you need to use the advanced
netlist change commands to connect these ports
to nets in your design. If you wish to use the ILA
trigger input or output signals, you should
consider using the HDL instantiation method of
adding ILA cores to your design.

false (Default)
true

C_TRIGOUT_EN

Enables the TRIG_OUT and TRIG_OUT_ACK ports of
the ILA core. Note that you need to use the
advanced netlist change commands to connect
these ports to nets in your design. If you wish to
use the ILA trigger input or output signals, you
should consider using the HDL instantiation
method of adding ILA cores to your design.

false (Default)
true

C_ADV_TRIGGER

Enables the advanced trigger mode of the ILA core.
Refer to Chapter 11 for more details on this
feature.

false (Default)
true

C_INPUT_PIPE_STAGES

Enables extra levels of pipe stages (for example,
flip-flop registers) on the PROBE inputs of the ILA
core. This feature can be used to improve timing
performance of your design by allowing the
Vivado tools to place the ILA core away from
critical sections of the design.

0 (Default)

o Ul W N R

C_EN_STRG_QUAL

Enables the basic capture control mode of the ILA
core. Refer to Chapter 11 for more details on this
feature.

false (Default)
true
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Table 10-2: ILA Debug Core Properties (Cont’d)

Debug Core Property Description Possible Values
C_ALL_PROBE_SAME_MU Enables all PROBE inputs of the ILA core to have true (Default)
the same number of comparators (also called false (not
"match units”). This property should always be set | recommended)
to true.
C_ALL_PROBE_SAME_MU_CNT | The number of comparators (or match units) per 1
PROBE input of the ILA core. The number of 2
comparators that are required depends on the 3
settings of the C_ADV_TRIGGER and 4
C_EN_STRG_QUAL properties:
o If C_ADV_TRIGGER is false and >
C_EN_STRG_QUAL is false, can be setto 1 6
through 16. 7
« If C_ADV_TRIGGER is false and 8
C_EN_STRG_QUAL is true, can be set to 2 9
through 16. 10
« If C_ADV_TRIGGER is true and C_EN_STRG_QUAL | 11
is false, can be set to 1 through 16. 12
* If C_ADV_TRIGGER is true and C_EN_STRG_QUAL | ;5
is true, can be set to 2 through 16. 14
IMPORTANT: if you do not follow the rules above, 15
you will encounter an error during implementation
when the ILA core is generated. 16

Probe as Data or Trigger or both

You can customize a probe to be used as data or trigger or both in the Vivado Hardware
Manager. Probes that participate in trigger or capture compare values are configured as
"trigger” only probes. This optimizes the use of BRAMs by the ILA core. Typically, probes
whose data needs to be captured are configured as "data" only probes. Probes that
participate in both trigger compare values, and whose data needs to be captured should be
configured as "trigger and data".
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You can configure probes as data or trigger or both using the Set up Debug wizard as
shown in Figure 10-8.

Tcl Console Messages Log Reports Design Runs Debug x ? 00
Q T 2 % + & o
Mame Driver... Driver.. Probe Type

~ fF dbg_hub (labtools_xsdbm_v3)

~ fF u_ila_0 (labtools_ila_vE)

> B oclk (1)

> & probed (2)
» k& probet (20) Data and Trigger k
> B probe2(2) Data

» & probe3 (2) ;I'E_g_gir__m”__

» & probed (2) Data and Trigger
» B probe5 (2) Data and Trigger
> = probef (1) Data and Trigger

Unassigned Debug Mets (0)

Debug Cores Debug Mets

Figure 10-8: Configuring Probes as Data or Trigger or Both Using the Set Up Debug Wizard

When you program the device at runtime with a design containing probes configured as
"data" only, you will not be able to use these probes to configure trigger or capture setup
conditions. Conversely, you will not be able to use probes configured as "trigger” only in
the Waveform window.

Configuring the Number of Comparators Used

After you have inserted the ILA core on a post-synthesized netlist it is possible for you to
set the number of comparators used to anywhere from 1 to 16. To do that in the Vivado IDE,
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go to Debug Core Options tab of the ILA core and set the ALL_PROBE_SAME_MU_CNT
property to the desired number of comparators.

Cell Properties ? -0 X

£ u_ilad - &
C_DATA_DEPTH 1024 o
C_TRIGIN_EN
C_TRIGOUT_EN -
C_ADV_TRIGGER £
C_INPUT_PIPE_STAGES 0 hd —
C_EN_STRG_QUAL
ALL_PROBE_SAME_MU v
ALL_PROBE_SAME_MU_CNT 1 v |

ALL_PROBE_SAME_MU_CHNT

The match unit count value when setting the same value for all probes.

General Froperties Debug Core Options ~ Debug Ports 4 » =

Tcl Console Messages Log Reports Timing Design Runs IP Status

Q ¢ % +

Mame Driver... Driver.. Probe Type

~ fF dbg_hub (labtools_xsdbm_v3)
~ $E u_ila_0 (labtools_ila_vB)

> b k(1)

» & probe0 (2) Data and Trigger

» & probet (2) L\\» Data and Trigger

» & probe2 (2) Data and Trigger
Debug Cores Debug Mets

Figure 10-9: Debug Core Options

Alternatively you can set the ALL_PROBE_SAME_MU_CNT property in the Tcl Console as

follows:

set_property ALL_PROBE_SAME_MU_CNT 10

[get_debug_cores u_ila_0]

TIP: If Capture Control is enabled, you have a choice of using 1 to 15 comparators. One comparator is
used by the capture control data filtering mechanism.

IMPORTANT: /t is not possible to set different number of comparators for different probes in the ILA
using the insertion flow. Xilinx recommends that you use the HDL instantiation flow to achieve that.
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Using XDC Commands to Insert Debug Cores

In addition to using the Set up Debug wizard, you can also use XDC commands to create,
connect, and insert debug cores into your synthesized design netlist. Follow the these steps
by typing the XDC commands in the Tcl Console:

1. Open the synthesized design netlist from the synthesis run called synth_1.

open_run synth_1

ﬁ IMPORTANT: The XDC commands in the following steps are only valid when a synthesized design
netlist is open.

2. Create the ILA core black box.
create_debug_core u_ila_0 ila
3. Set the various properties of the ILA core.

set_property C_DATA_DEPTH 1024 [get_debug_cores u_ila_0]
set_property C_TRIGIN_EN false [get_debug _cores u_ila_0]
set_property C_TRIGOUT EN false [get_debug cores u_ila_0]
set_property C_ADV_TRIGGER false [get_debug cores u_ila_ 0]
set_property C_INPUT_PIPE_STAGES 0 [get_debug cores u_ila_ 0]
set_property C_EN_STRG_QUAL false [get_debug_cores u_ila_0]
set_property ALL_PROBE_SAME_MU true [get_debug_cores u_ila_0]
set_property ALL_PROBE_SAME_MU_CNT 1 [get_debug_cores u_ila_0]

4. Set the width of the clk port of the ILA core to 1 and connect it to the desired clock net.

set_property port_width 1 [get_debug_ports u_ila_0/clk]
connect_debug_port u_ila_0/clk [get_nets [list clk 1]

Note: You do not have to create the clk port of the ILA core because it is automatically created
by the create_debug_core command

f IMPORTANT: All debug port names of the debug cores are lower case. Using upper-case or mixed-case
debug port names will result in an error.

5. Set the width of the probe0 port to the number of nets you plan to connect to the port.
set_property port_width 1 [get_debug_ports u_ila_0/probel]

Note: You do not have to create the first probe port (probe0) of the ILA core because it is
automatically created by the create_debug_core command.

6. Connect the probe0 port to the nets you want to attach to that port.
connect_debug_port u_ila_0/probel [get_nets [list A_or_B]]

7. Optionally, create more probe ports, set their width, and connect them to the nets you
want to debug.
create_debug_port u_ila_0 probe

set_property port_width 2 [get_debug ports u_ila_0/probel]
connect_debug_port u_ila_0/probel [get_nets [list {A[0]} {A[1]1}]]
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For more information on these and other related Tcl commands, type help -category
ChipScope in the Tcl Console of the Vivado Design Suite.

Saving Constraints After Running Debug XDC Commands

You need to save constraints after using the Set up Debug wizard, using Vivado Design
Suite to create debug cores or ports, and/or running the following XDC commands:

e create_debug_core
e create_debug_port
e connect_debug_port

*+ set_property (on any debug_core or debug_port object)

The corresponding XDC commands are saved to the target constraints file and are used
during implementation to insert and connect the debug cores.

ﬁ IMPORTANT: Saving constraints to the target constraints file while in project mode may cause the
synthesis and implementation steps to go out-of-date. However, you do not need to re-synthesize the
design since the debug XDC constraints are only used during implementation. You can force the
synthesis step up-to-date by selecting the Design Runs window, right-clicking the synthesis run (e.g.,
synth_1), and selecting Force up-to-date.

Implementing the Design

After inserting, connecting and customizing your debug cores, you are now ready for
implementing your design (refer to Implementing the Design Containing the Debug Cores).

Debug Core Insertion in Non-Project Mode

Debug cores can be inserted in either Project Mode or Non-Project Mode. The following
sample Tcl script shows how to create the debug core, set debug core attributes, and
connect the debug core probes to the signals in the design being probed. In Non-Project
Mode, the insertion of the debug core needs to happen after synthesizing the design, and
prior to the opt_design step as shown below.

f IMPORTANT: Debug core insertion is only supported for ILA cores.
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The following Tcl script is an example of using the debug core insertion commands in a
Non-Project flow.

#read relevant design source files
read_vhdl [glob ./*.vhdl]
read_verilog [ glob ./Sources/*.v ]
read_xdc ./target.xdc

#Synthesize Design
synth_design -top top -part xc7k325tffg900-2

#Create the debug core
create_debug_core u_ila_0 ila

#set debug core properties

set_property C_DATA_DEPTH 1024 [get_debug_cores u_ila_0]
set_property C_TRIGIN_EN false [get_debug cores u_ila_0]
set_property C_TRIGOUT EN false [get_debug cores u_ila_0]
set_property C_ADV_TRIGGER false [get_debug cores u_ila_ 0]
set_property C_INPUT_PIPE_STAGES 0 [get_debug cores u_ila_ 0]
set_property C_EN_STRG_QUAL false [get_debug_cores u_ila_0]
set_property ALL_PROBE_SAME_MU true [get_debug_cores u_ila_0]
set_property ALL_PROBE_SAME_MU_CNT 1 [get_debug_cores u_ila_0]

#connect the probe ports in the debug core to the signals being probed in the design
set_property port_width 1 [get_debug ports u_ila_0/clk]

connect_debug_port u_ila_0/clk [get_nets [list clk 1]

set_property port_width 1 [get_debug_ports u_ila_0/probel]

connect_debug_port u_ila_0/probel [get_nets [list A_or_ B]]

create_debug_port u_ila_0 probe

#Optionally, create more probe ports, set their width,

# and connect them to the nets you want to debug

#Implement design

opt_design

place_design

report_drc -file ./placed_drc_rpt.txt

report_timing summary -file ./placed_timing_rpt.txt

route_design
report_drc -file ./routed_drc_rpt.txt

report_timing summary -file ./routed_timing_ rpt.txt

write_bitstream

HDL Instantiation Debug Probing Flow Overview

The HDL instantiation probing flow involves the manual customization, instantiation, and
connection of various debug core components directly in the HDL design source. The new
debug cores that are supported in this flow in the Vivado tool are shown in table Table 10-3.
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Table 10-3: Debug Cores in Vivado IP Catalog available for use in the HDL Instantiation Probing
Flow
Debug Core Version Description Run Time Analyzer Tool
ILA (Integrated v6.2 Debug core that is used to Vivado logic analyzer
Logic Analyzer) trigger on hardware events
and capture data at system
speeds.
VIO (Virtual v3.0 Debug core that is used to Vivado logic analyzer

Input/Output)

monitor or control signals in
design at JTAG chain scan
rates.

JTAG-to-AXI Master | v1.2

Debug core that is used to
generate AXI transactions to
interact with various AXI full
and AXI lite slave cores in a
system that is running in
hardware.

Vivado logic analyzer

The new ILA core has two distinct advantages over the legacy ILA v1.x core:

« Works with the integrated Vivado logic analyzer feature (refer to Chapter 11,
Debugging Logic Designs in Hardware).

* No ICON core instance or connection is required.

Using the HDL Instantiation Debug Probing Flow

The steps required to perform the HDL instantiation flow are:

1. Customize and generate the ILA and/or VIO debug cores that have the right number of
probe ports for the signals you want to probe.

2. (Optional) Customize and generate the JTAG-to-AXI Master debug core and connect it
to an AXI slave interface of an AXI peripheral or interconnect core in your design.

3. Synthesize the design containing the debug cores.

4. (Optional) Modify debug hub core properties.

5. Implement the design containing the debug cores.
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Use the IP Catalog button in the Project Manager to locate, select, and customize the
desired debug core. The debug cores are located in the Debug & Verification > Debug
category of the IP Catalog (see Figure 10-10). You can customize the debug core by
double-clicking on the IP core or by right-click selecting the Customize IP menu selection.

« For more information on customizing the ILA core, refer to Integrated Logic Analyzer

LogiCORE IP Product Guide(PG172) [Ref 29].

« For more information on customizing the VIO core, refer to Virtual Input/Output

LogiCORE IP Product Guide (PG159) [Ref 25].

« For more information on customizing the JTAG-to-AXI Master core, refer to JTAG to AXI
Master LogiCORE IP Product Guide (PG174) [Ref 30].

After customizing the core, click the Generate button in the IP customization wizard. This
generates the customized debug core and add it to the Sources view of your project.

IP Catalog

Cores | Interfaces

|

- -~

MName a1
> Vivado Repository

Alliance Partners

Automotive & Industrial

AXl Infrastructure

BaselP

Basic Elements

Communication & Networking

& v v v v v v

Debug & Verification
> Debug

¥ Debug Bridge
4 IBERT 7 Series GTX
4F ILA (Integrated Logic Analyzer)
T JTAG to AXI Master
I System ILA
4F VIO (Virtual InputiQutput)

Details

Select an IP or Interface or Repository to s

AXl4

AXl4, AXl4-Stream
AXl4

ee details

200X

&

License

~

Status

Production
Production
Production
Production
Production
Production

Included
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»

Figure 10-10:
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Configuring the Number of Comparators Used

During the process of customizing the ILA IP, it is possible for you to set the number of
comparators used. The range allowed is 1 to 16. It is possible to set a common number of
comparators for all the probes in the ILA IP.

¢ Customize IP @

ILA (Integrated Logic Analyzer) (6.2) P
© Documentation IP Location ' Switch to Defaults
Show disabled ports Component Name | ila_0

To configure more than 64 probe ports use Vivado Tcl Console

‘General Options
Monitor Type

* Native A

Number of Probes 1 [1..1024]
Sample Data Depth 1024 v

+| 8ame Number of Comparators for All Probe Ports

clk
Mumber of Comparators

probeQ[0:0]

Trigger Qut Port

Trigger In Port

Input Pipe Stages

o e W =

3}
Trigger And Storage Setl 7

Capture Control |8
9
Advanced Triggel 10

GUI configuration mode is limited to 64 probe ports.

Figure 10-11: ILA IP Comparators in General Options
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It is also possible to set the comparators for each IP as shown below. It is possible to have
multiple probes of different width within a single ILA. To do that you need to uncheck the
Same Number of Comparators for All Probe Ports field under General Options.

¢ Customize IP

ILA (Integrated Logic Analyzer) (6.2)

Show disabled ports

clk

probe0[0:0]

© Documentation IP Location (' Switch to Defaults

Component Name | ila_0

=
P

|Tn configure more than 64 probe ports use Vivado Tcl Console

‘General Options Probe_Ports(0..0)

Monitor Type

* Native AXl

MNumber of Probes | 1

Sample Data Depth 1024 ~

I +| Same Number of Comparators for All Probe Ports I

Number of Comparators | 1 v

Trigger Qut Port
Trigger In Port

Input Pipe Stages

Trigger And Storage Settings
Capture Control

Advanced Trigger

GUI configuration mode is limited to 64 probe ports.

Figure 10-12:
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You then set the exact number of comparators to be use per probe by selecting the
Probe_Ports tab and setting the Number of Comparators field with the desired number of

comparators.
¢ Customize [P @
ILA (Integrated Logic Analyzer) (6.2) P
© Documentation IP Location (' Switch to Defaults
Show disabled ports Component Name  ila_0
|Tn configure more than 64 probe ports use Vivado Tcl Console
General Options Probe_Ports(0..7)
Probe Port Probe Width [1..4096] MNumber of Comparators Probe Trigger or Data
PROBEO 1 DATAAND TRIGGER
PROBE1 1 1 | DATAAND TRIGGER
2
3
4
5
6
7
clk 8 ~
probeQ[0:0]
probe1[0:0]
Figure 10-13: Number of Comparators
O TIP: If Capture Control is enabled, you have a choice of using 1 tol5 comparators. One comparator is
used by the capture control data filtering mechanism.

TIP: Depending on the number of comparators chosen, the tool automatically recalculates the number
O of probes that you can use in the ILA IP. The maximum number of comparators allowed per ILA is 1024.
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Probe as Data or Trigger

Probes can be configured as data or trigger or both in the ILA IP Configuration wizard as
shown in Figure 10-14.

¢ Customize [P @

ILA (Integrated Logic Analyzer) (6.2) P
© Documentation IP Location ' Switch to Defaults

Show disabled ports Component Name | ila_0

To configure more than 64 probe ports use Vivado Tcl Console

Probe_Ports(0..7)
Probe Port Probe Width [1..4096] Number of Comparators Probe Trigger or Data
PROBED 1 7 ~  DATAAND TRIGGER
PROBE1 1 7 ~  DATAAND TRIGGER
PROBEZ2 1 1 ~  DATAAND TRIGGER
1 1

~ | DATAAND TRIGGER -

DATA AND TRIGGER
DATA
TRIGGER

PROBE3

clk
probe0[0:0]
probe1[0:0]

probez[0:0]
probe3[0:0]

Figure 10-14: Configurng Probes as Trigger and Data

Probes that participate in trigger or capture compare values are configured as "trigger” only
probes. This optimizes the use of BRAMs by the ILA core. Typically, probes whose data
needs to be captured are configured as "data" only probes. Probes that participate in both
trigger compare values, and whose data needs to be captured should be configured as
"trigger and data".

ILA Cross Trigger

ILA Cross Triggering feature enables cross triggering between ILA cores, and between ILA
cores and a processor for example, Zynq®-7000 SoC. This feature is useful for when you
want to trigger between two ILA cores that are in different clock domains, or perform
hardware/software cross triggering between a processor and an ILA core.

For using cross trigger feature, at core generation time, you should configure the ILA core
to have dedicated trigger input ports (TRIG_IN and TRIG_IN_ACK) and dedicated trigger
output ports (TRIG_OUT and TRIG_OUT_ACK). If you want to use the ILA trigger input or
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output signals, you must use the HDL instantiation method of adding ILA cores to your

design.
¢ Customize IP @
ILA (Integrated Logic Analyzer) (6.2) P
© Documentation IP Location ' Switch to Defaults
Show disabled ports Component Name | ila_0

To configure more than 64 probe ports use Vivado Tcl Console

‘General Options Probe_Ports(0..7)

Monitor Type

@ Mative Al
MNumber of Probes | 4 [1..1012]
Sample Data Depth 1024 v
clk
probel[0:0] @ame Number of Comparators for All Probe Ports
probe1[0:0] Trigger Out Port

probez[0:0]
probe3[0:0]

Trigger In Port

Input Pipe Stages 0 3

Trigger And Storage Settings
Capture Control
Advanced Trigger

GUI configuration mode is limited to 64 probe ports.

Figure 10-15: ILA Cross Trigger Feature

TRIG_OUT_ACK signal is an indication to the ILA core (another ILA, user design, or
processor) that TRIG_OUT is properly received and causes the ILA to lower the TRIG_OUT
signal on receiving TRIG_OUT_ACK.

In other words, TRIG_OUT will remain HIGH until TRIG_OUT_ACK is available. If
TRIG_OUT_ACK signal is tied to LOW then TRIG_OUT remains HIGH until the user re-arms
the ILA. Only then the TRIG_OUT goes LOW. You can rearm the ILA if TRIG_OUT_ACK is tied
to LOW.

A typical cross trigger setup is illustrated below where ILA2 cross triggers into ILAL. The
TRIG_OUT signal of ILA2 is connected to the TRIG_IN signal of ILAL. The TRIG_IN_ACK signal
of ILA 1 is connected to the TRIG_OUT_ACK signal of ILA2.

(ILA 2) trig_out -> (ILA 1) trig_in
(ILA 1) trig_in_ack -> (ILA 2) trig_out_ack
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ILA 1 ILA 2

trig_in | <«——— | trig_out

trig_in_ack | —— | trig_out_ack

trig_out | ——— | trig_in

trig_out_ack | «——— | trig_in_ack

X16408-031616

Figure 10-16: Typical Cross Trigger Setup

I
clk !

I I
trig_in : : ! !

trig_in_ack

|

trig_out

trig_out_ack :
I

Figure 10-17: ILA Cross Trigger Timing
« It is assumed that the logic driving the trig_in port is synchronous to the ILA clk.

« It takes 1 clk cycle for the trig_in_ack signal to get asserted after trig_in is
asserted.

« It takes 9 clk cycles for the trig_out signal to get asserted when trig_in is used or
trigger condition is met.

« The trig_in_ack and trig_out_ack signals go low only when trigger signals are
de-asserted.

For a detailed tutorial that covers using the Cross Trigger feature between the FPGA fabric
and the Zyng-7000 SoC processor, see the Vivado Design Suite Tutorial: Embedded Processor
Hardware Design (UG940) [Ref 21].
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Instantiating the Debug Cores

After generating the debug core, instantiate it in your HDL source code and connect it to
the signals that you wish to probe for debugging purposes. Following is an example of the
ILA instance in a Verilog HDL source file:

u_ila_ 0
(

.clk(clk),

.probel (countera) ,
.probel (counterB) ,
.probe2 (counterC) ,
.probe3 (counterD) ,
.probed (A_or_B),
.probe5(B_or_C),
.probe6 (C_or_D),
.probe7 (D_or_A)

)

Note: Unlike the legacy VIO and ILA v1.x cores, the new ILA core instance does not require a
connection to an ICON core instance. Instead, a debug core hub (dbg_hub) is automatically inserted
into the synthesized design netlist to provide connectivity between the new ILA core and the JTAG
scan chain.

Synthesizing the Design Containing the Debug Cores

In the next step, synthesize the design containing the debug cores by clicking Run
Synthesis in the Vivado Design Suite or by running the following Tcl commands:

launch_runs synth_1
wait_on_run synth_1

You can also use the synth_design Tcl command to synthesize the design. Refer to Vivado
Design Suite User Guide: Synthesis (UG901) [Ref 2] for more details on the various ways you
can synthesize your design.

Viewing the Debug Cores in the Synthesized Design

After synthesizing your design, you can open the synthesized design to view the debug
cores and modify their properties. Open the synthesized design by clicking Open
Synthesized Design in the Flow Navigator, and select the Debug window layout to see the
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Vivado Programming and Debugging

Debug window that shows your ILA debug cores connected to the debug hub core
(dbg_hub) (see Figure 10-18).

Tcl Console Messages Log Reports Design Runs Debug x ? 00
Q T ¢ % + o
Mame Driver Cell Driver Pin Probe Type
~ fF dbg_hub (labtoo m_t
~ & u_ila_0 (labt
> b k(1)
» & probe0 (2) Data and Trigger
» B probe1 (20) Data and Trigger
» & probe2 (2) Data and Trigger
» & probe3 (2) Data and Trigger
v & probed (2) Data and Trigger
@ Ch 0 (GPIO_BUTTONS_dbl0]) FORE Q
@ Ch1(GPIO_BUTTONS_db[1]) FORE Q
v & probe5 (2) Data and Trigger
@ Ch 0 (GPIO_BUTTONS_re[0]) FORE Q
@ Ch1(GPIO_BUTTONS_re[1]) FORE Q
» =% probed (1) Data and Trigger
Unassigned Debug Mets (0)
Debug Cores Debug Mets

Figure 10-18: Debug Window Showing ILA Core and Debug Core Hub

Changing the BSCAN User Scan Chain of the Debug Core Hub

You can view and change the BSCAN user scan chain index of the debug core hub by
selecting the dbg_hub in the Debug window, selecting the Debug Core Options view in
the Properties window, then changing the value of the C_USER_SCAN_CHAIN property
(see Figure 10-19).

IMPORTANT: The default values for C_USER_SCAN_CHAIN is 1 for the debug hub core. If using a scan
chain value other than 1 for the debug hub core, you must manually change them on the device in the
Hardware Manager. Refer to Programming the Hardware Device in Chapter 4 for more details.

IMPORTANT: If you plan to use the Microprocessor Debug Module (MDM) or other IP that uses the
BSCAN primitive with the Vivado logic debug cores, you need to set the C_USER_SCAN_CHAIN property
of the dbg_hub to a user scan chain that does not conflict with the other IPs Boundary Scan Chain
setting. Failure to do so results in errors later in the implementation flow.
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Figure 10-19:

Debug Mets

Changing the User Scan Chain Property of the Debug Core Hub

Debug Flow in IPI

The System ILA IP in IP Integrator (IPI) allows you to perform in-system debugging of
post-implemented designs on an FPGA device. Use this feature when you need to monitor
interfaces and signals in the IP Integrator Block Design. This feature enables you to debug
AXI Read and Write Transactions in addition to AXI Read and Write, Data, and Address
channel events in the Vivado Hardware Manager.

See this link in the Vivado Design Suite User Guide: Designing IP Subsystems Using IP
Integrator (UG994) [Ref 17] for the steps to debug interfaces and/or nets in the Block

Design.
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Debugging Nets and Interfaces in the IPI Block Design

In the IPI Block Design Canvas, you can debug both nets and interfaces. As shown below,
you can right-click an interface or net in the Block Design and select Debug. This sets the
Debug and MARK_DEBUG attributes to true. In addition, this also enables the Designer
Assistance to run Connection Automation, where you can choose the net and/or interface
to a System Interface ILA core, and also customize the various attributes of the debug core.
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Figure 10-20:

IPI Mark Debug

To clear a net and/or interface of debug attributes, right-click the net/interface and then

click Clear Debug.
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Viewing System ILA Debug Cores in the Synthesized Design

The System ILA IP in the IP Integrator Block Design must be instantiated. The figure below
is a snapshot of the Block Design with two debug cores instantiated in the design, the

System ILA, and the JTAG to AXI Master IP cores.

Diagram % Address Editor

e a X x 0 Q

4
+

E C 9 O

200

[rp—

—"HF’-':M“ MicroBlaze? ,

Figure 10-21:

Block Design

After this Block Design has been validated and synthesized, you can open the Debug
window in the synthesized design to view the debug cores instantiated and inserted into
the design. The System ILA and JTAG to AXI Master debug cores are displayed as shown

below.
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Figure 10-22:
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For more details on how these interfaces can be used for debug in the Hardware Manager
and to take advantage of the AXI Event level debug, see Debugging AXI Interfaces in the
Hardware Manager in Chapter 11.

Implementing the Design Containing the Debug
Cores

The Vivado software creates the debug core hub initially as a black box. This core must be
implemented prior to running the placer and router.

Implementing the Design

Implement the design containing the debug core by clicking Run Implementation in the
Vivado Design Suite or by running the following Tcl commands:

launch_runs impl_1
wait_on_run impl_1

You can also implement the design using the implementation commands opt_design,
place_design, and route_design. Refer to the Vivado Design Suite User Guide:
Implementation (UG904) [Ref 6] for more details on the various ways you can implement
your design.

ILA Core and Timing Considerations

The configuration of the ILA core has an impact in meeting the overall design timing goals.
Follow the recommendations below to minimize the impact on timing:

+ Choose probe width judiciously. The bigger the probe width the greater the impact on
both resource utilization and timing.

+ Choose ILA core data depth judiciously. The bigger the data depth, the greater the
impact on both block RAM resource utilization and timing.

« Ensure that the clocks chosen for the ILA cores are free-running clocks. Failure to do so
could result in an inability to communicate with the debug core when the design is
loaded onto the device.

« Ensure that the clock going to the dbg_hub is a free running clock. Failure to do so
could result in an inability to communicate with the debug core when the design is
loaded onto the device. You can use the connect_debug_port Tcl command to
connect the c1k pin of the debug hub to a free-running clock.
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« Close timing on the design prior to adding the debug cores. Xilinx does not
recommend using the debug cores to debug timing related issues.

« If you still notice that timing has degraded due to adding the ILA debug core, and the
critical path is in the dbg_hub, perform the following steps:

a. Open the synthesized design.

b. Find the dbg_hub cell in the netlist.

c. Go to the Properties of the dbg_hub.

d. Find property C_CLK_INPUT_FREQ_HZ.

e. Set it to frequency (in Hz) of the clock that is connected to the dbg_hub.
f. Find property C_ENABLE_CLK_DIVIDER and enable it.

g. Re-implement design.

* Make sure the clock input to the ILA core is synchronous to the signals being probed.
Failure to do so results in timing issues and communication failures with the debug
core when the design is programmed into the device.

« Make sure that the design meets timing before running it on hardware. Failure to do so
results in unreliable results.

Debug Cores Clocking Guidelines

The Vivado Hardware Manager uses the JTAG interface to communicate with the Vivado
Debug Hub core, which provides an interface between the JTAG Boundary Scan (BSCAN)
interface of the FPGA device and the Vivado Debug cores.

JTAG Clock - This clock synchronizes the internal state machine operation of the JTAG
Boundary Scan (BSCAN) interface. You will typically choose the JTAG clock frequency in the
Vivado Hardware Manager while connecting to the target device. If your design contains
debug cores, ensure that the JTAG clock is 2.5x times slower than the debug hub clock.

You can modify the JTAG frequency by using the Open New Hardware Target wizard or the
following Tcl command:

set_property PARAM.FREQUENCY 250000 [get_hw_targets
*/xilinx_tcf/Digilent/210203327962A]

Debug Hub Clock - The Vivado Debug Hub core, which provides an interface between the
JTAG Boundary Scan (BSCAN) interface of the FPGA device and the Vivado Debug cores. The
Debug Hub core is inserted automatically by the Vivado IDE during the design
implementation step if it detects debug cores in the design. The Vivado IDE chooses the
clock driving the Debug Hub core during the design implementation step.
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Xilinx recommends that the Debug Hub clock frequency be around 100 MHz or less because
the JTAG clock speeds do not require a particularly high frequency.

You can change the Debug Hub Clock using the following TCL command.

connect_debug_port dbg_hub/clk [get_nets <clock net name>]

Note: You need to run this command after the design has been synthesized, but before
implementation.

You can also reduce the Debug Hub Clock Frequency to a 100 MHz using the following TCL
commands.

set_property C_CLK_INPUT_FREQ_HZ 200000000 [get_debug_ cores dbg_ hub]
set_property C_ENABLE_CLK_DIVIDER true [get_debug_cores dbg_hub]

Note: You need to run this command after the design has been synthesized, but before
implementation. This is recommended for designs which have very high speed clocks. This command
enables the inclusion of an MMCM based clock divider inside of the Debug Hub core to achieve a
clock frequency of 100 MHz.

Debug Core Clocks

All of the debug cores available in the Vivado IP catalog require a clock, that ensures
synchronization with the input probes being monitored or any output signals being driven
by the debug cores. During core discovery and debug measurement phase, it is expected
that the clock is free running and stable. It is also expected that the clock is synchronous to
the signals being monitored or driven. Failure to do so could result in cycle inaccurate data.

The Debug Hub IP bridges between host machine (through BSCAN Primitive which supports
a serial interface) and debug cores on the chip (through XSDB interface which supports a
parallel interface). The BSCAN primitive clock shifts the data in and out of the chip to the
Debug Hub IP serially. The Debug Hub IP collects the data and sends it to all the debug
cores on parallel interface using the Debug Hub clock and vice versa. If any of the debug
core clocks are not free running or not stable, we end up with corrupted data which results
in a "Debug Cores not detected" message. To avoid any corruption of data, it is
important to ensure that the JTAG clock and Debug Hub clocks are stable and free running
during the debug core detection process.

1. The Debug Hub Clock must be free running and stable. Xilinx recommends that the
clock be driven from a clock driver that is properly constrained and whose timing is met.

2. If the clocks are driven from MMCM/PLL, ensure that the MMCM/PLL LOCKED signal is
high prior to any debug core measurements. If the clock is connected to the Debug Hub
or any of the debug cores and the MMCM/PLL LOCKED signal transitions to a 0 in the
middle of debug operations, the clock may have significant jitter that might result in
unpredictable behavior of the debug logic.

3. In order to detect the debug cores, take measurements using those cores and capture
data. It is required to have all the associated clocks free running and stable.
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The following table lists the various debugging phases and the clocks required during the

specific phases.

Table 10-4: Debugging Phase Clock Requirements
Debugging Phase JTAG Clock |Debug Hub Clock Delcaluogc'((lzore

Connect to Target | Stablel NA NA
Programming Stablel NA NA
Debug Core Stablel Stable NA
Discovery
Debug Core Stablel Stablel Stablel
Measurement3

1. Stable Clock: A clock that does not pause/stop during the event.

2. Assumes the Debug Core Clock is different from the Debug Hub Clock.
3. A Debug Core Measurement phase includes any step that does a get or set of properties on the debug core.

Vivado Hardware Manager Clocking Related Error Messages

If the JTAG Clock is inactive or unavailable, you will not be able to connect to the hardware

target.

If the Debug Hub Clock is inactive or unavailable, the Vivado Hardware Manager issues the
following error message:

INFO:

WARNING:
or 3.
Resolution:

1. Make sure the clock connected to the debug hub

[Labtools 27-1434]
design that has no supported debug core(s)
[Labtools 27-3123]

clock and is active OR

2. Manually launch hw_server with -e

Device xXxX

(JTAG device index = 0)
in it.
The debug hub core was not detected at User Scan Chain 1

(dbg_hub)

is programmed with a

core is a free running

"set xsdb-user-bscan <C_USER_SCAN_CHAIN

scan_chain_number>" to detect the debug hub at User Scan Chain of 2 or 4. To determine
the user scan chain setting,

C_USER_SCAN_CHAIN

open the implemented design and use:
[get_debug_cores dbg_hub].

get_property

If any of the Debug Core Clocks are inactive or unavailable, the Vivado Hardware Manager
issues the following error message:

INFO:

= 1, index =
Resolution:

[Labtools 27-2302]
design that has 1 ILA core(s).
CRITICAL WARNING:
with a design that has an unrecognizable debug core

Device xxx (JTAG device index = 1)

is programmed with a

[Labtools 27-1433] Device xxx (JTAG device index = 1) is programmed
(slave type =

17) at user chain

1) Ensure that the clock signal connected to the debug core and/or debug hub is clean
and free-running.
2) Ensure that the clock connected to the debug core and/or debug hub meets all timing

constraints.

3) Ensure that the clock connected to debug core and/or debug hub is faster than the
JTAG clock frequency.

Vivado Programming and Debugging
UG908 (v2019.1) May 22, 2019

www.Xxilinx.com

l Send Feedback I 147


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=147

8 X”_INX® Chapter 10: In-System Logic Design Debugging Flows

The following figure is an example of a design with 2 ILA cores:

Debug Hub Clock

XSDBCLK

Figure 10-23: Debug Core Clocking Example

The example design contains two ILA cores, ILA "A" and ILA"B".

The clocking topology of this debug network is as follows. After the design has been
programmed into the device, the Vivado Hardware Manager tries to discover the existence
of the Debug Hub core in the design. The Debug Hub in turn tries to discover and account
for all the debug cores connected to it. In this design the debug cores are ILA "A" and ILA
"B". Notice that CLKA drives both the ILA "A" and the Debug Hub core. CLKB drives the ILA
"B" debug core.

When you connect to the target and program the device, we expect an active JTAG clk. In
the Debug Core Discovery Phase, we expect a free running and stable clock driving the
Debug Hub core, which in this case is CLKA. During Debug Core Measurement phase (i.e.
anything that involves getting/setting properties on the debug core), we expect an active
JTAG, Debug Hub and Debug Core clocks. If we expect to trigger and capture data on ILA
"B", we expect free running and stable JTAG, Debug Hub (CLKA), and Debug Core (CLKB)
Clocks.
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Adding Vivado Debug Cores to a Partial
Reconfiguration Design

Vivado Debug cores can be instantiated in a Partial Reconfiguration design including within
the Reconfigurable Modules. There are specific requirements and a methodology to adding
and connecting these cores. See this link in the Vivado Design Suite User Guide: Partial
Reconfiguration (UG909) [Ref 3] for the methodology needed to add and connect these
Vivado Debug cores.

For an example of instantiating debug cores in a Partial Reconfiguration design as well as a
description of the functionality within the Vivado Hardware Manager, see this link in Vivado
Design Suite Tutorial: Partial Reconfiguration (UG947) [Ref 4].
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Chapter 11

Debugging Logic Designs in Hardware

Once you have the debug cores in your design, you can use the run time logic analyzer
features to debug the design in hardware.

Using Vivado Logic Analyzer to Debug the Design

The Vivado® logic analyzer feature is used to interact with new ILA, VIO, and JTAG-to-AXI
Master debug cores that are in your design. To access the Vivado logic analyzer feature,
click the Open Hardware Manager button in the Program and Debug section of the Flow
Navigator.

The steps to debug your design in hardware using an ILA debug core are:

Connect to the hardware target and program the FPGA device with the .bit file
Set up the ILA debug core trigger and capture controls.
. Arm the ILA debug core trigger.

1.

2.

3

4. View the captured data from the ILA debug core in the Waveform window.

5. Use the VIO debug core to drive control signals and/or view design status signals.
6

Use the JTAG-to-AXI Master debug core to run transactions to interact with various AXI
slave cores in your design.

Connecting to the Hardware Target and
Programming the FPGA Device

Programming an FPGA device prior to debugging are exactly the same steps described in
Programming the FPGA Device. After programming the device with the .bit file that
contains the new ILA, VIO, and JTAG-to-AXI Master debug cores, the Hardware window
now shows the debug cores with the RTL instance name shown in parenthesis, that were
detected when scanning the device.
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Figure 11-1: Hardware Window Showing Debug Cores

For more information on using the ILA core, refer to Setting up the ILA Core to Take a
Measurement. For more information on using the VIO core, refer to Setting Up the VIO Core
to Take a Measurement.

f IMPORTANT: Ensure the JTAG clock is slower than the clocks input to the debug cores. You can modify
the JTAG frequency using the Open New Hardware Target wizard or the following Tcl command:
set_property PARAM.FREQUENCY 250000 [get_hw_targets */xilinx_tcf/Digilent/210203327962A]

Vivado Hardware Manager Dashboards

The Vivado Hardware Manager Dashboards help you manage the various windows for your
System Monitor, ILA, and VIO Debug cores. The dashboards enable you to create, modify,
and save the configuration of these windows in your Vivado Design Suite project.

Default Dashboards

When debug cores are detected upon refreshing a hardware device, the default dashboard
for each debug core is automatically opened.
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Default Dashboard Windows

Every default dashboard contains windows relevant to the debug core the dashboard is
created for. The default dashboard created for the ILA debug core contains five windows:

+ Settings window

« Status window

« Trigger Setup window
« Capture Setup window

«  Waveform window

An example of the default ILA Dashboard can be seen below.

hw_ila_3

Waveform - hw_ila_3
a + e o » BB @ X o« 14 4 »l &

ILA Status:Idle

Dashboard Options

ddr(31:0

awburst{1:0]

: Z017-Mar

Settings - hw_ila_2 Trigger Setup - hw_ila_3
+ D,

Trigger Mode Settings

Trigger mode:  BASIC_ONLY v

Capture Mode Settings Pressthe =4 button to add probes
Capture mode: ALWAYS v
Number of windows: 1 [1-4096]

Windma data danth ANGA___ el [1-ANGF

Figure 11-2: Default ILA Dashboard
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You can start adding probes to the Trigger Setup window by clicking the "+" button in the
center of the window, and selecting probes from the Add Probes window as seen in
Figure 11-3.

Trigger Setup - hw_ila_3 x Capture Setup - hw_ila_3

+ )

F

Add Probes *

Search:

axi_araddr[31:0]
axi_arburst{1:0]
axi_arcache[3:0]
axi_arid
axi_arlen[7:0]

L=

L=

L=

L=

L=

= axi_arlock
s axi_arprot[2:0]
e axi_arqos[3:0]
= axi_arready
e axi_arsize[2:0]
L=

axi_arvalid

et muaam et A AT

Figure 11-3: Add Probes Window
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The VIO Default dashboard starts out empty to which you can add VIO probes to as shown

in Figure 11-4.

w_ila_1 » | dashboard_1

hw_vio_2

Dashboard Options

-
=

s
=

Search:

Add Probes

Probes for hw_vio_2 (26

~ & hw_vio_2

>

d ¢ & 6 & & 88§ & d 6 8 dF 8§ 6 a

Figure 11-4:

5 slow_vio_slice5_fb[4:0]

BUTTON_IBUF[1:0]
fastZslow_ila_trig
fast2slow_ila_trig_ack
LED_OBUF[1:0]
slow_cnt_count[31:0]
slow_cnt_count_en
slow_cnt_incr_val[30:0]
slow_cnt_load_en
slow_cnt_load_val[31:0]
slow_cnt_reset
slow_cnt_up_down
slow_vio_feedback[31:0]
slow_vio_feedback_2[31:0]
slow_vio_ila_trig
slow_vio_slice1_fb
slow_vio_slice1_fb_2
slow_vio_slicela_fb
slow_vio_slice1a_fo_2

dashboard_2 b

he + outton to add probes

Adding VIO Probes

To view a dashboard associated with a debug core, right-click the debug core object in the
Hardware window, select the Dashboard option, and click the dashboard name.
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Double-clicking a debug core in the hardware window will pop up the dashboards
associated with that debug core.

Hardware ? 00 X hw_ila_1
Q = £ > » H & ]
MName Status @ Q
~ B trumpet7? (1) Connected %
~ @ xiliny_tcfiDigilent’2102033279..  Open AR
~ {8 xcTK325t_0 (2) Programmed g Nz
& XADC (System Monitor) [ '
) _ ]
E‘g hw_lla A Faa ile= M [ Y "l
ILA Core Properties... i
P Run Trigger |
»»  Run Trigger Immediate
& B stop Trigger
ILA Core Properties Enable Auto Re-trigger
ZE hw_ila_1 tt
Create User Defined Probe...
Mame: Dashboard v P
Cell:

Exportto Spreadsheet...
Dievice: RGeS

Figure 11-5: Associated Dashboards

Window Controls within a Dashboard

Each window has the following title bar controls, which enable you to manipulate the
window:

e Minimize
«  Maximize

« Close

Moving Windows
To move windows:

1. Select the window tab or title bar, and drag the window. A gray outline indicates where
the window will be located after the move.

2. To commit to the placement, release the mouse button.

Note: Dropping one window onto an existing window places the two window tabs in the same
region.
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)

Vivado Programming and Debugging

IMPORTANT: You cannot move windows into or out of the workspace. However, you can resize and
move the windows within the workspace.

Resizing Windows

« To resize windows, click and drag a window border.

Note: The mouse cursor changes to a resize cursor when positioned over a window border or
drag handle, indicating that you can click and drag the window border to resize the window.

« To expand a window to use the all of the viewing environment, click the Maximize
button in the upper right corner of the window.

« Torestore a window to its original size, double-click the window title bar or tab.

Closing Windows

« To close windows, click the Close button in the upper right corner of the window.
Note: In some cases, this button is also available in the window tab.

« Right-click a window tab or title bar, and select Close from the popup menu.

Window Tabs

Each window has a tab that you can select to make that the window is active. The tab is at
the bottom of some windows, such as the Trigger Setup and Capture Setup windows.

TIP: To make the next tab active, press Ctrl+Tab. To make the previous tab active, press Ctrl+Shift+Tab.
To maximize or minimize the window, double-click the window tab.

Customizing Dashboards

Typically the windows in the default dashboards should be enough to debug your design
and view the results. However there are times when you might want to move windows
around (i.e. customize your dashboards). For example you may want to be able to view both
the ILA status and Waveform window in addition to controlling VIO probes in the same
dashboard. In those situations Xilinx recommends customizing the dashboard to fit your
needs.

Dashboard Options

Every dashboard has a Dashboard Options slideout on the left. Use the Dashboard
Options button on the left side of a dashboard to open its Dashboard Options settings. The
Dashboard Options settings allow you to control the windows that appear in a specific
dashboard. For example you may want to customize the ILA dashboard to include one of
the VIO windows as well. As shown below you click on the VIO window to include it in the
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& XILINX.

Dashboard Options and the VIO window shows up in the ILA Dashboard. You can now add
the VIO probes you are interested in and trigger the ILA window.

4 Vivado Lab Edition 2017.1 [
Eile Edit Tools  Window Layout  View  Help
I‘-‘A - =] E- 3 ¥  Dashboard - Default Layout ~
Hardware hw_ila_1
Q = e > » H hd Waveform - hw_ilz_1
Name Status -
B A + = 2 p » BB E @ Q@ H « KM M 1= o2 s of E
~ B trumpet7 (1 Connected %
~ @ siline_tchiDigilenti2102033279 Open g ILA Status:ldle
v @ xcTK3256 02 Programmed |l £
& XADC (System Wonito H
a
a8 hw_ila_1 (u_ila_0) O 1dle
< >
Updated at: 2017-Mar-2
> <
ILA Core Properties
& hw_ila_1 - o Settings - fw_ila_1 Trigger Setup - hw_ila_1
Name hw_ila_1 Trigger Mode Settings a + T,
Gell: u_ila_0 Trigger mode: | BASIC_ONLY v name OpeEicy GEES )
Device ® eTk325L0 U_SINEGEN/sine[19:0] = ~ B -
HW core: core_3 GPIO_BUTTONS_db[1:0] = - . X
GPIO_BUTTONS_dly[1:0] = ~ M X
Capture sample count 0 of 1024 Capture Mode Settings - -1l Hl
GPIO_BUTTONS_IBUF[1:0] = ~ M . x
Core status dle Caplure mode ALWAYS  ~
Number of windows: 1 1-1024
General  Properiies ‘Window data depth 1024~ [1-1024] ~ < >
Tcl Console
Q T 2 Il B E @
INFO: [Labtools 27-1364] The ILA core 'hw_ila 1' trigger was armed at 2017-Mar-26 23:01:32 B
wait on hw ila [get hw ilas -of obiects [get hw devices xc7k325t 0] -filter [CELL NAME=-"u ila 0"1] ~
< >

Figure 11-6: Adding Dashboard Options

Click the Dashboard Options button on the left side of a dashboard to open and close the
Dashboard Options slideout.
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Creating New Dashboards

In addition to customizing Default Dashboards using the Dashboard Options, you can also
create brand new dashboards. To do that right-click the debug core object in the Hardware
window and select the Dashboard > New Dashboard option as shown in Figure 11-7.

Hardware hw_ila_1

Q = e > » . ﬂ Waveform - hw_ila_1

Mame Status e
s Q + = < > » N

~ g trumpet7? (1 Connected =
j=X

~ @ xilin_tcfiDigilent2102033279..  Open S| | ILAStatus:idie
- @
~ {8 xcT7k325t_0 (2 Programmed % Name
ZF XADC (System Monitor E B4 GPIO_BUTTONS_re[1:0]

€ hw_ila_1(u_ila_0) TONS_diy[1:0]
OMNS_db{1:0]

P RunTrigger _IBUF[1:0]

»»  Run Trigger Immediate Nisel[1:0]

. Stop Trigger Misine[19:0]

Enable Auto Re-trigger

2 Create User Defined Probe. .. _
Dashboard P Nev\rDashboard..l/\\5

ILA Core Properties

ILA Core Properties...

5 hw ila 1 Exportto Spreadsheet... hw_ila_1

Figure 11-7: Creating New Dashboard
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When the New Dashboard dialog appears, you can customize the dashboard as necessary
and click OK.

¢ New Dashboard @

y

Specify the name and contents for a new dashboard.

Name: | dashboard_1 |

Contents
Q = =
~ |M| xcTk325t_0
~ W hw_ila_1 (u_ila_0)
v'| Status
| Settings
| Trigger Setup
| Capture Setup
¥'| Waveform
XADC (System Monitor)

)
\2) OK Cancel

Figure 11-8: New Dashboard Dialog

You can also use the Dashboard toolbar button to create new dashboards as shown below.

¢ Vivado Lab Edition 2017.1

File  Edit Tools Window  Layout View  Help Quick Access
= « = e ] J¥  Dashboard ~

+ NewDashboard...L\\;
Hardware ? 00 X

' Resetto Default
Q = 2 o Close Al
Mame Status

Q 4+ = 2 p

~ B trumpet7 (1) Connected

ILA Status:|dle

d Options |

~ @ xling_icfiDigilent’2102033279...  Open

Figure 11-9: Dashboard Toolbar Button

TIP: To view all the dashboards associated with a debug core, right click the debug core in the
O Hardware view and click on Dashboard. Alternatively double-click the debug core in the Hardware
view and the list of dashboards associated with the debug core pop-up.
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TIP: To float a single window in a dashboard, Xilinx recommends that you create a dashboard with just
O that window and float the dashboard.

ILA Waveform window in dashboards

Each ILA Waveform window can only appear in a single dashboard. If you click a Waveform
window that is located in another dashboard you will get a notification that the window is
being relocated as shown in Figure 11-10.

¢ View Waveform @

o The waveform for "hw_ila_1"is being viewed in dashboard ‘hw_ila_1". OK to relocate?

Figure 11-10: ILA Waveform Confirmation

Click OK, and the Waveform window relocates to the specified dashboard.

O TIP: Save ILA data when closing Waveform window.
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System Monitor Dashboards

You can also include the XADC/System Monitor window into another dashboard or its own

dashboard.

Hardware hw_ila_1

Q = ~ o Waveform - hw_ila_1

Mame Status @ Q + = o > » B @ a

~ B trumpet7? (1 Connected %

~ @ xiliny_tcfiDigilent’2102033279..  Open g ILA Status:Idle
~ {8 xcTR3251_0 (2 Programmed g Name

p— L
g XADC: {System Monitor) . System Monitor Core Properties. .
26 hw_ila_1 (u_ila_C ) Idle

* Refresh System Monitor
JTAG Scan Rate b

Dashboard » <4 MNewDashboard...

Exportto Spreadsheet...

< >| _

Curtnm Mlanitar TSars Draonarctine

Figure 11-11: System Monitor Dashboard

Resetting to Default Dashboards

You can reset the dashboards back to their default state by clicking Dashboard on the
toolbar and selecting Reset to Default.

¢ Vivado Lab Edition 2017.1
Eile Edit Tools Window Layout View Help
= E o ] ¥  Dashboard ~

e

4+ MNewDashboard...

Haidwace (' Resetto Default
Q| = = > » N L Clase All
MName Status pas
~ B trumpet? (1 Connected % Q=" i » || B =
~ Ee wliny_tcfiDigilent2102023279..  Open 2| | ILAStausIdle
v {8 xc7k325t 0 (2 Programmed E Name
£ XADC (System Manitc E M GPIO_BUTTONS_re[1:0]

SE hw_ila_1 (u_ila_0) (_ ldle 5 GPIO_BUTTONS_diy{1:0]

Figure 11-12: Resetting to Default Dashboard
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Closing Dashboards

You can close all the Dashboards by clicking Dashboard on the toolbar and selecting Close
All. This will delete all of the dashboards and the user settings in those dashboards.

You can also close a single dashboard by clicking the "X" button on the upper right hand
corner. This will delete the dashboard and all of the user settings in the dashboard.

Saving User Dashboard Preferences and Settings

User Dashboard settings and preferences are saved automatically by Vivado IDE. Upon
closing and reopening the project the user settings and preferences are restored back into
the Hardware Manager.

Setting up the ILA Core to Take a Measurement

The ILA cores that you add to your design appear in the Hardware window under the target
device. If you do not see the ILA cores appear, right-click the device and select Refresh
Device. This re-scans the FPGA device and refreshes the Hardware window.

Note: If you still do not see the ILA core after programming and/or refreshing the FPGA device,
check to make sure the device was programmed with the appropriate .bit file and check to make
sure the implemented design contains an ILA core. Also, check to make sure the appropriate . 1tx
probes file that matches the .bit file is associated with the device.
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Click the ILA core (called hw_ila_1 in Figure 11-1) to see its properties in the ILA Core
Properties window. You can see all the probes corresponding to the ILA core by using the

Windows->Debug Probes menu option, which displays the Debug Probes window as
shown in Figure 11-13.

25
¢ Vivado Lab Edition 2017.1
File Edit Tools Window Layout View Help
r:_ - (= & ¥  Dashboard ~
Hardware 15 > Debug Probes
aQa = ¢ > » N o Q =2 o
Name Status
B trumpet7 (1 Connected te DONT_EAT
~ He iin_{ciDigilent2102033279...  Open s GPIO_BUTTONS_db[1:0]
> @ xc7k325t 0 (2 Programmed s GPIO_BUTTONS_dy[1:0]
i XADC (System WMo s GPIO_BUTTONS_IBUFI:0]
1 % hw_ila_1(u_ila_0) O ldle || e crrosutTONS it
B U 1.0]
& U_SINEGEN/sing[19:0]
s user_probe_0[20:0]
ILA Core Properties
& hw_ila_1 - L]
Name hw_ila_1
cell u_ila_o
HW core core_3
Capture sample count. 0 of 1024
Core status: Idle
General | Froperties 5

hw_ila_1

Dashboard Options

Wavefo

a+ = ¢ »

ILA Status:idle

Seftings - hw_ila_1 x stz

Trigger Mode Settings

Trigger mode: | BASIC_ONLY

Capture Mode Settings

Capture mode: ALWAYS v
Number of windows: 1
Window data depth 1024 v 11

Trigger position in window: | §12

» B B aa X

=S BoE

Default Layout

(LN IR »l o

Trigger Setup - fw_ila_1 | Ca

Q + o,

Name Operator Radix Value
U_SINEGEN/sine[19:0] 18] TIXK
GPIO_BUTTONS_dbl1:0] H - X
GPID_BUTTONS_diy[1:0] = ~ H - x
GPID_BUTTONS_IBUF[1:0] = v~ H - x

Figure 11-13: Selection of the ILA Core in Various Views

Adding Probes

You can add relevant probes to specific windows in an ILA Dashboard by clicking on the "+"
button on the window toolbar or workspace.

Writing Debug Probes Information

The Debug Probes window contains information about the nets that you probed in your
design using the ILA and/or VIO cores. This debug probe information is extracted from your
design and is stored in a data file that typically has an .1tx file extension.

Normally, the debug probes file is automatically created during the implementation

process. However, you can also use the write_debug_probes Tcl command to write out
the debug probes information to a file:

1. Open the Synthesized or Netlist Design.

2. Runthe write_debug_probes filename.ltx Tcl command.
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f IMPORTANT: /f you are using non-project mode, you must manually call the write_debug probes
command immediately following the opt_design command.

Reading Debug Probes Information

The debug probes file is automatically associated with the hardware device if the Vivado
IDE is in project mode and a probes file is called debug_nets.1ltx is found in the same
directory as the bitstream programming (.bit) file that is associated with the device.

You can also specify the location of the probes file:

1. Select the hardware device in the Hardware window.
2. Set the Probes file location in the Hardware Device Properties window.

3. Right-click the hardware device in the Hardware window and select Refresh Device to
read the contents of the debug probes file and associate and validate the information
with the debug cores found in the design running in the hardware device.

You can also set the location using the following Tcl commands to associate a debug probes
file called C: \myprobes.1ltx with the first device on the target board:

o

set_property PROBES.FILE {C:/myprobes.ltx} [lindex [get_hw_devices] 0]
% refresh_hw_device [lindex [get_hw_devices] 0]

Renaming Debug Probes

You can use the Debug Probes window to rename debug probes that belong to an ILA or
VIO core. You can rename the debug probes and add them to an existing Waveform Viewer
for the core, or you can add them to the various trigger and/or capture windows of the ILA
Dashboard. These names could be the custom, long or short name associated with the
debug probe.

To perform these operations, right-click an ILA/VIO core's debug probe(s) and select one of
the following:

« Rename: Prompts you to rename the probe to a custom name.

« Name: Allows you to select the long, short, or custom name of the debug probe.
Subsequent references to the debug probe in the Vivado IDE window will use the name
that you selected.

- Long - Displays the full hierarchical name of the signal or bus being probed.
- Short - Displays the name of the signal or bus being probed.

- Custom - Displays the custom name given to the signal or bus when renamed.
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Using Multiple Comparators

If you have customized the probes and/or ILA debug cores to use more than 1 comparator
in the Basic/Advanced mode, you can use these comparators both in the Basic and
Advanced Trigger Setup window.

You can add the probe into the Basic trigger setup window and set up the trigger
conditions. The comparator usage column gives you information on the comparator used
within the probe for the specific compare condition out of the total number of comparators
associated with the probe.

Trigger Setup - hw_ila_1 = Capture Setup - hw_ila_1 ? -
Q + D,
Mame Operatoy = Value Port

Enable Col Filteri
U_SINEGEN/sine[19:0] = naple Lolumn Fienng 00, v probe5[19:0]
GPIO_BUTTONS_db[1:0] == X *  probe2[1:0]
GPIO_BUTTOMNS _diy[1:0] == Auto Resize This Column X *  probei[1:0]
GPIO_BUTTOMNS_IBUF[1:0] == Auto Resize All Columns X *  probe3[1:0]

Select All the Cells

Hide This Column "Operator”
Show All Hidden Columns

Mame

Operator

Radix

LN NN

Value 2
Compare Value

¥ Port

Comparator Usage l/\\s

Resetto Default

More...

Figure 11-14: Basic Trigger Setup - Comparator Usage

TIP: The Comparator Usage column is a hidden column. To enable this column right-click the Trigger
O Setup column title row as shown below and select Comparator Usage.
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Trigger Setup - hw_ila_1

aQ + = o

Mame Operator Radix Value Port Comparator Usage
S _FUEESUETER ] = > B v D0 v probeS[9:0] | 1of3
GPIO_BUTTONS_db[1:0] == + [H - X ~  probe2[1:0]
GPIO_BUTTONS_dly[1:0] == + [H - X ~  probel[1:0]
GPIO_BUTTONS_IBUF[1:0] == + [H - X ~  probe3[1:0]

4 b

Figure 11-15: Comparator Usage Column

Using the ILA Default Dashboard

The ILA Dashboard (see Figure 11-16) is a central location for all status and control
information pertaining to a given ILA core. When an ILA core is first detected upon
refreshing a hardware device, the Default ILA Dashboard for the core is automatically
opened. If you need to manually open or re-open the dashboard, just right-click the ILA
core object in the Hardware window and select Default Dashboard.

hw_ila_1

Waveform - hw_ila_1
Q + e » B E @ @ i o I + ol &

ILA Status:ldle

re[1:0]
diy[1:0]
db{1:0]
IBUF[1:0]

Dashboard Options

Settings - hw _ila_1 Trigger Setup - hw_ila_1
Trigger Mode Settings Q + o,
M Operat Rad V:
Trigger mode: | BASIC_ONLY - ZILE perator adix a
U_SINEGEM/sine[19:0] == - B - 11
GPIO_BUTTONS_db[1:0] == - M + %
Capture Mode Settings GPIO_BUTTONS_dly[1:0] == - H - X
GPIO_BUTTONS_IBUF[1:0] == - M ~ X
Capture mode: ALWAYS ~
MNumber of windows: 1
Window data depth: 1024 | [1-1024]

Trigger position in window: | 512

Figure 11-16: ILA Dashboard
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You can use the ILA Dashboard to interact with the ILA debug core in several ways:

« Set the trigger mode to trigger on various events in hardware:

o BASIC_ONLY: The ILA Basic Trigger Mode can be used to trigger the ILA core when a
basic AND/OR functionality of debug probe comparison result is satisfied.

- ADVANCED_ONLY: The ILA Advanced Trigger Mode can be used to trigger the ILA
core as specified by a user defined state machine.

o TRIG_IN_ONLY: The ILA TRIG_IN Trigger Mode can be used to trigger the ILA core
when the TRIG_IN pin of the ILA core transitions from a low to high.

o BASIC_OR_TRIG_IN: The ILA BASIC_OR_TRIG_IN Trigger Mode can be used to trigger
the ILA core when a logical OR-ing of the TRIG_IN pin of the ILA core and
BASIC_ONLY trigger mode is desired.

- ADVANCED_OR_TRIG_IN: The ILA ADVANCED_OR_TRIG_IN Trigger Mode can be
used to trigger the ILA core when a logical OR-ing of the TRIG_IN pin of the ILA
core and ADVANCED_ONLY trigger mode is desired.

« Set the trigger output mode.

« Use ALWAYS and BASIC capture modes to control filtering of data to be captured.
+ Set the number of ILA capture windows.

« Set the data depth of the ILA capture window.

« Set the trigger position to any sample within the capture window.

« Monitor the trigger and capture status of the ILA debug core.

User-Defined Debug Probes

Using user-defined debug probes (also called hw_probes) in the Hardware Manager allows
you the ability to create probes from combinations of physical ILA probe ports and constant
values. You can then use these probes in the Trigger Setup or Waveform windows in the
Hardware Manager. On successful creation of these probes, they are listed in the Debug
Probes window as part of the debug core they were associated with during creation.

You can create the following types of user defined probes:

* An ILA probe port.
« One or more constant values of 0 and/or 1.

« A mix of ILA probe port and constant values.

f IMPORTANT: User-defined probes that involve constant values can only be used in the Waveform
window. They cannot be used in the Trigger Setup window.
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TIP: You can only create user-defined probes on ILA debug cores. Creating user-defined debug probes
O for VIO cores is not currently supported.

Creating a User-Defined Debug Probe

GUI Flow

To create a user-defined debug probe in the Vivado IDE Hardware Manager, in the
Hardware window, right-click the ILA core that you want to probe and select Create User
Defined Probe.

E}*ﬂfdware ? 00 X hwe_ila_1
Q = ~ > » N 2 Wavefc
Mame Status

g Q
~ B trumpet7? (1 Connected %
~ @ xiliny_{cfiDigilent2102033279...  Open O ILast
~ {8 xcTk325t.0 (2 Programmed g Name
& XADC (System Monitor B
5E hw_jla, 4 ila Al e

ILA Core Properties...

P RunTrigger

»»  Run Trigger Immediate

B stop Trigger .
Enable Auto Re-trigger

ILA Core Properties
Create User Defined Probe...

2 hw_ila_1
Dashboard b
Mame:

Exportto Spreadsheet...

Cell: u_nEu T
Setting

Figure 11-17: Selecting Create User Defined Probe

This brings up the Create User Defined Probe dialog box. Select the ILA core you want to
create the probes on, the name of the new probe, and finally the probe bits, and/or
constants that make up this new probe.
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To add specific probe bits to this new probe, click the “+” button and select Add Probe.

¢ Create User Defined Probe

LA Core:

MNew Probe Mame: | user_probe_0

Probe Bits

%

Add Probe..
Add Constant

Create a user defined probe by selecting existing probes or constants.

hw_ila_1 4

Press the + putton to Add Probe or Add Constant

=5

Figure 11-18:
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This brings up the Add Probes dialog that allows you to choose an existing probe or

specific bits of an existing probe.

¢ Create User Defined Probe

ILA Core: hw_ila_1 «
Mew Probe Mame: | user_probe_0

Probe Bits
Add Probes
+

Fl

Search:

= DONT_EAT
GPIO_BUTTONS_db[1:0]
GPIO_BUTTONS_div[1:0]
GPIO_BUTTOMNS_IBUF[1:0]
GPIO_BUTTOMNS_re[1:0]
U_SINEGEN/sel[1:0]
U_SINEGEMN/sine[19:0]

@ & & & & &

dewvice im
ita_1 —of 4
:d to file
[k g e
OO0 X

Cancel

Sl

Create a user defined probe by selecting existing probes or constants.

" Add Constant

ILA core(s).

3 xcTk325t_0] -filter [CELL NAME=~"u_ila
.ab/.Kil/vivado lab-15148-xcosmitha3i/ba
rcta [get_hw_ilas -of objects [get_hw_de
ects [get_hw ilas -cf_cbjects [get_hw de

Figure 11-19: Add Probes Dialog Box
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You can also add or remove bits in the Create User Defined dialog box. Move specific bits
up or down as shown below.

¢

Tcl Flow

Create User Defined Probe

Create a user defined probe by selecting existing probes or constants.

LA Core: hw_ila_1 “
Mew Probe Mame: | user_probe_0[20:0]

Probe Bits

+ =+ §

Bit Probe Part
20  U_SINEGEM/sine[19] probes[19]
19  U_SINEGEN/sine[18] probe5[18]
18 U_SINEGEMIsine[17]  probes[17]
17 U_SINEGENIsine[16] probe5[16]
16  U_SINEGEM/sine[15] probes[15]

15  U_SINEGENMIsine[14
+

Add b Add Probe...
14 | 4
==  Remove Add Constant
13 U_SINEGEN/sine[13
3 + MoveUp
12 U_SINEGEM/sine[12
§  Move Down

11 U_SINEGEN/sine[1] w

Figure 11-20: Editing Bits in Create User Defined Probe Dialog Box

To create a user-defined debug probe use the create_hw_probe Tcl command.

create_hw_probe [-verbose] [-map <arg>] <name> <core>

Where:

* name is the name of the hw_probe. Must be unique for hw_probes belonging to the
same device. Bus probes must have their range specified. For example,
myNewProbe[31:0]

+ coreisthe hw_ila to associate the probe with.

« -map is the declaration of bits to base the user-defined probe on.
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Examples of creating user-defined debug probes:

Given a 512-bit counter "counterA[511:0]": Connects [255:223] to
ILA probe port 0 [31:0]
Create a user-defined probe called foobar pointing at the
ILA buffer specified range [255:223]
create_hw_probe -map {probe0[31:0]} {foobar [255:223]} [get_hw_ilas hw_ila_1]

H H H HF

# Constant only probe. NO triggering allowed on constant ONLY probes.
create_hw_probe -map {0} {my_constant_gnd[0:0]} [get_hw ilas hw_ila_ 1]

# Create a user-defined probe as a mix of constants and ILA probe ports
create_hw_probe -map {0000 probe0[31:0] 1010} {my_mixed_probe[47:8]} [get_hw_ilas

hw_ila_ 1]

# Creating scalar hw_probe called "foobar" from probel:

create_hw_probe -map {probel} foobar [get_hw ilas hw_ila_1]

# Creating scalar hw_probe called "foobar" from bit 3 of probe0l:

create_hw_probe -map {probe0[3]} foobar [get_hw_ilas hw_ila_1]

# Creating vector hw_probe called "foobar[0:0]" from probel:
create_hw_probe -map {probel} foobar[0:0] [get_hw_ilas hw_ila_1]
# Creating vector probe called "foobar[3:0]" from probeO:

create_hw_probe -map {probel} foobar[3:0] [get_hw_ilas hw_ila_1]
# Creating vector probe called "foobar[3:2]" from probeO[1:0]:
create_hw_probe -map {probel0[1:0]} foobar[3:2] [get_hw_ilas hw_ila_ 1]

Deleting a User-Defined Debug Probe

GUI Flow

To delete a user defined probe in the Vivado IDE Hardware Manager, select Window >
Debug Probe. This will bring up the Debug Probes window beside the Hardware Manager
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dashboards. Right-click the appropriate probe in this window and click Delete as shown
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hw_ila_1

Waveform - hw_ila_1

Q + LA o

ILA Status:idle

Hame

Create User Defined Probe. .. atu:

Deleting a Debug Probe

below.
Debug Probes N 4
Q = = o
€ hw_ila_1 o
= DOMNT_EAT %
= GPIO_BUTTOMNS_db[1:0] g
= GPIO_BUTTOMNS_dIy[1:0] E
= GPIO_BUTTONS_IBUF[1:0] §
= GPIO_BUTTONS re[1:0] o
= U_SINEGEN/sel[1:0]
= U_SINEGEMN/sine[19:0]
1= user_ T
Debug Probe Properties...
»  Delete
P RunTrigger
»»  Run Trigger Immediate
B stop Trigger
Enable Auto Re-trigger
Edit Enumeration...
Rename...
Mame
Add Probes to Waveform
< Dashboard
Figure 11-21:
Tcl Flow

You can delete user-defined debug probes using the delete_hw_probe Tcl command.

For example, to delete a probe foobar created earlier using create_hw_probe do the

following:

delete_hw_probe
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[get_hw_probes foobar -of_objects
[get_hw_devices xc7k325t_0]

com

[get_hw_ilas -of_objects
-filter {CELL_NAME=~"i_fast_ila"}]]
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Persistence of User-Defined Debug Probes

Any of the user-defined probes created in the Hardware Manager in the project flow are
automatically persisted by the tool. The next time the project is opened and you connect to
the hardware target using Vivado Hardware Manager, these user-defined probes are
resurrected. If these user-defined debug probes participated in Basic triggering or were
added to the Waveform window, on project open and connecting to the target in the
Hardware Manager, you will see the probe setup in all the windows exactly as when you
closed the project earlier.

Interacting with a User-Defined Probe

Any of the user-defined debug probes created in the Hardware Manager can participate in
Basic triggering, Advanced Triggering, and/or the Waveform window. The only exception
are user-defined debug probes that involve constant values. These types of debug probes
can only be used in the Waveform window.

Using Basic Trigger Mode

Use the basic trigger mode to describe a trigger condition that is a global Boolean equation
of participating debug probe comparators. Basic trigger mode is enabled when the Trigger
Mode is set to either BASIC_ONLY or BASIC_OR_TRIG_IN. Use the Basic Trigger Setup

window (see Figure 11-22) to create this trigger condition and debug probe compare
values.

Trigger Setup - hw_ila_1

Q + = D

Mame Operator Radix Value Port
U_SINEGEN/sine[19:0] == ~ @ ~ 0000, probeS[:0]
GPIO_BUTTONS_db[1:0] = + [H - X ~  probe2[1:0]
GPIO_BUTTONS_diy[1:0] = + [H - X ~  probed[1:0]
GPIO_BUTTONS_IBUF[1:0] = + [H - X ~  probe3[1:0]

Figure 11-22: ILA Basic Trigger Setup Window

You can also use the set_property Tcl command to change the trigger mode of the ILA
core. For instance, to change the trigger mode of ILA core hw_ila_1 to BASIC_ONLY, use
the following command:

set_property CONTROL.TRIGGER_MODE BASIC_ONLY [get_hw_ilas hw_ila_1]
Adding Probes to Basic Trigger Setup Window
The first step in using the basic trigger mode is to decide what ILA debug probes you want

to participate in the trigger condition. Do this by selecting the desired ILA debug probes
from the Debug Probes window and either right-click selecting Add Probes to Basic
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Trigger Setup or by dragging and dropping the probes into the Basic Trigger Setup
window.

Note: You can drag-and-drop the first probe anywhere in the Basic Trigger Setup window, but you
must drop the second and subsequent probes on top of the first probe. The new probe is always
added above the previously added probe in the table. You can also use drag-and-drop operations in
this manner to re-arrange probes in the table.

f IMPORTANT: Only probes that are in the Basic Trigger Setup window participate in the trigger
condition. Any probes that are not in the window are set to "don't care" values and are not used as part
of the trigger condition.

You can remove probes from the Basic Trigger Setup window by selecting the probe and
hitting the Delete key or by right-click selecting the Remove option.

Setting Basic Trigger Compare Values

Use the ILA debug probe trigger comparators to detect specific equality or inequality
conditions on the probe inputs to the ILA core. The trigger condition is the result of a
Boolean "AND", "OR", "NAND", or "NOR" calculation of each of the ILA probe trigger
comparator results. To specify the compare values for a given ILA probe, select the Value
cell in for a given ILA debug probe in the Basic Trigger Setup window to open the (see
Figure 11-23).

Trigger Setup - hw_ila_1 » Capture Setup - hw_ila_1 ? -0
Q + = o,

Mame Operator Radix Value Port
U_SINEGEN/sine[19:0] = * [B] T 0000000 probe5[19:0]

Value: k(xxx_xxxx_xxxx_xxxx_xxxx

mmmmmmmm Sme camW mads

i R =

Figure 11-23: ILA Probe Compare Value Dialog Box

O TIP: Prior to changing the Radix ensure that the value is set to a string that applies to the new Radix.
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ILA Probe Compare Value Settings

The Basic Trigger Setup window has three cells that you can configure in a specific row
corresponding to a probe:

1. Operator: This is the comparison operator that you can set to the following values:
o == (equal)
o I=(not equal)
o < (less than)
o <= (less than or equal)
o > (greater than)
- >= (greater than or equal)
2. Radix: This is the radix or base of the Value that you can set to the following values:
- [B] Binary
. [H] Hexadecimal
o [O] Octal
- [U] Unsigned Decimal
o [S] Signed Decimal

3. Value: This is the comparison value that will be compared (using the Operator) with the
real-time value on the net(s) in the design that are connected to the probe input of the
ILA debug core. Depending on the Radix settings, the Value string is as follows:

o Binary
- 0:logical zero
- 1:logical one
- X:don't care
- R:rising or low-to-high transition
- F: falling or high-to-low transition
- B: either low-to-high or high-to-low transitions

- N: no transition (current sample value is the same as the previous value)
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- Hexadecimal
- X: All bits corresponding to the value string character are "don't care" values
- 0-9: Values 0 through 9
- A-F: Values 10 through 15

o Octal
- X: All bits corresponding to the value string character are "don't care" values
- 0-7:Values 0 through 7

- Unsigned Decimal
- Any non-negative integer value

- Signed Decimal

- Any integer value

Setting Basic Trigger Condition

You can set up the trigger condition using the toolbar button on the left side of the Basic
Trigger Setup window that has an icon the shape of a logic gate on it (see Figure 11-24).
You can also use the set_property Tcl command to change the trigger condition of the
ILA core:

set_property CONTROL.TRIGGER_CONDITION AND [get_hw_ilas hw_ila_1]

The meaning of the four possible values is shown in Table 11-1.

Trigger Setup - hw_ila_1

Q + = oD

mar ¥ SetTrigger Condition to Global AMD* Operator Radix value Port

GPI Set Trigger Condition to "Global OR' == > [H - X - probe[1:0]

Set Trigger Condition to Global MAND"
Set Trigger Condition to 'Global NOR®

Figure 11-24: Setting the Basic Trigger Condition
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Table 11-1: Basic Trigger Condition Setting Descriptions

Trigger Condition |CONTROL.TRIGGER_CONDITION
Setting in GUI property value

Trigger Condition Output

Global AND AND Trigger condition is “true” if all
participating probe comparators
evaluate “true”, otherwise trigger
condition is “false.”

Global OR OR Trigger condition is "true" if at least
one participating probe comparator
evaluates "true", otherwise trigger
condition is "false."

Global NAND NAND Trigger condition is “true” if at least
one participating probe comparator
evaluates “false”, otherwise trigger
condition is “false.”

Global NOR NOR Trigger condition is "true" if all
participating probe comparators
evaluate "false", otherwise trigger
condition is "false."

ﬁ IMPORTANT: /f the ILA core has two or more debug probes that concatenated together to share a single
physical probe port of the ILA core, then only the "Global AND" (AND) and "Global NAND" (NAND)
trigger condition settings are supported. The "Global OR" (OR) and "Global NOR" (NOR) functions are
not supported due to limitations of the probe port comparator logic. If you want to use the "Global OR"
(OR) or "Global NOR" (NOR) trigger condition settings, then make sure you assign each unique net or
bus net to separate probe ports of the ILA core.

Using Advanced Trigger Mode

The ILA core can be configured at core generation or insertion time to have advanced
trigger capabilities that include the following features:

« Trigger state machine consisting of up to 16 states.
« Each state can consist of one-, two-, or three-way conditional branching.

« Up to four counters can be used in a trigger state machine program to keep track of
multiple events.

« Up to four flags can be used in a trigger state machine program to indicate when
certain branches are taken.

« The state machine can execute "goto", "trigger”, and various counter- and flag-related
actions.

If the ILA core in the design that is running in the hardware device has advanced trigger
capabilities, the advanced trigger mode features can be enabled by setting the Trigger
mode control in the ILA Properties window of the ILA Dashboard to ADVANCED_ONLY or
ADVANCED_OR_TRIG_IN.
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Specifying the Trigger State Machine Program File

When you set the Trigger mode to ADVANCED_ONLY or ADVANCED_OR_TRIG_IN, two
changes happen in the ILA Dashboard:

1. A new control called Trigger State Machine appears in the ILA Properties window

2. The Basic Trigger Setup window is replaced by a Trigger State Machine code editor
window.

If you are specifying an ILA trigger state machine program for the first time, the Trigger
State Machine code editor window will appear as the one shown in Figure 11-25.

Trigger Setup - hw_ila_1

Open existing trigger state machine

Create new trigger state machine

Figure 11-25: Creating or Opening a Trigger State Machine Program File

To create a new trigger state machine, click the Create new trigger state machine link,
otherwise click the Open existing trigger state machine link to open a trigger state
machine program file (. tsm extension). You can also open an existing trigger state machine

program file using the Trigger state machine text field and/or browse button in the ILA
Properties window of the ILA Dashboard.
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Editing the Trigger State Machine Program

If you created a new trigger state machine program file, the Trigger State Machine code
editor window will be populated with a simple trigger state machine by default (see
Figure 11-26).

Trigger Setup - hw_ila_1 = Capture Setup - hw_ila_1 ? 0

+ Q - B B N/ B %

L b
xR U B = |
m [ 1 1

(5}

17 state my_statel:
18 trigger;

w

< 4

Figure 11-26: Simple Default Trigger State Machine Program

The simple default trigger state machine program is designed to be valid for any ILA core
configuration regardless of debug probe or trigger settings. This means that you can click
the Run Trigger for the ILA core without modifying the trigger state machine program.

However, it is likely that you will want to modify the trigger state machine program to
implement some advanced trigger condition. The comment block at the top of the simple
state machine shown in Figure 11-26 gives some instructions on how to use the built-in
language templates in the Vivado IDE to construct a trigger state machine program (see
Figure 11-27). A full description of the ILA trigger state machine language, including
examples, is found in the section of this document called Appendix B, Trigger State Machine
Language Description.
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Figure 11-27: Trigger State Machine Language Templates

Compiling the Trigger State Machine

The trigger state machine is compiled every time you run the ILA trigger. If you would like
to compile the trigger state machine without running or arming the ILA trigger, click the
Compile trigger state machine button in the ILA Dashboard (see Figure 11-28).

Trigger Setup - hw_ila_1 % Capture Setup - hw_ila_1

+ Q « .X:EliflllEE‘?‘u%

Compile trigger state machine

17 E state my_statel:

Figure 11-28: Compiling the Trigger State Machine without Arming the Trigger
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Enabling Trigger In and Out Ports

The ILA core can be configured at core generation-time to have dedicated trigger input
ports (TRIG_IN and TRIG_IN_ACK) and dedicated trigger output ports (TRIG_OUT and
TRIG_OUT_ACK). If the ILA core has trigger input ports enabled, then you can use the
following Trigger Mode settings to trigger on events on the TRIG_IN port:

« BASIC_OR_TRIG_IN: used to trigger the ILA core when a logical OR-ing of the TRIG_IN
pin of the ILA core and BASIC_ONLY trigger mode is desired.

« ADVANCED_OR_TRIG_IN: used to trigger the ILA core when a logical OR-ing of the
TRIG_IN pin of the ILA core and ADVANCED_ONLY trigger mode is desired.

« TRIG_IN_ONLY: used to trigger the ILA core when the TRIG_IN pin of the ILA core
transitions from a low to high.

If the ILA core has trigger output ports enabled, then you can use the following TRIG_OUT
Mode to control the propagation of trigger events to the TRIG_OUT port:

« DISABLED: disables the TRIG_OUT port.

« TRIGGER_ONLY: enables the result of the basic/advanced trigger condition to
propagate to the TRIG_OUT port.

« TRIG_IN_ONLY: propagates the TRIG_IN port to the TRIG_OUT port.

« TRIGGER_OR_TRIG_IN: enables the result of a logical OR-ing of the basic/advanced
trigger condition and TRIG_IN port to propagate to the TRIG_OUT port.

Configuring Capture Mode Settings

The ILA core can capture data samples when the core status is Pre-Trigger, Waiting for
Trigger, or Post-Trigger (refer to the section called Viewing Trigger and Capture Status for
more details). The Capture mode control is used to select what condition is evaluated
before each sample is captured:

« ALWAYS: store a data sample during a given clock cycle regardless of any capture
conditions

« BASIC: store a data sample during a given clock cycle only if the capture condition
evaluates "true"

You can also use the set_property Tcl command to change the capture mode of the ILA
core. For instance, to change the capture mode of ILA core hw_ila_1 to BASIC, use the
following command:

set_property CONTROL.CAPTURE_MODE BASIC [get_hw_ilas hw_ila_1]

Vivado Programming and Debugging N Send Feedback 182
UG908 (v2019.1) May 22, 2019 www.xilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=182

(: XILINX® Chapter 11: Debugging Logic Designs in Hardware

Using BASIC Capture Mode

Use the basic capture mode to describe a capture condition that is a global Boolean
equation of participating debug probe comparators. Use the Basic Capture Setup window
(see Figure 11-29) to create this capture condition and debug probe compare values.

Capture Setup - hw_ila_1

Q + o,
Mame Set Capture Condition to Global AND” Radix WValue
GPIO_BUTTONS_dIy[1: Set Capture Condition to 'Gh}al OR’ > [E ¥ ONE -
Set Capture Condition to Global MAND®
Set Capture Condition to 'Global NOR®

Figure 11-29: Setting the Basic Capture Condition

Configuring the Basic Capture Setup Window

The process for configuring debug probes and basic capture condition in the Basic Capture
window is very similar to working with debug probes in the Basic Trigger Setup window:

« For information on adding probes to the Basic Capture Setup window, refer to the
section called Adding Probes to Basic Trigger Setup Window.

« For information on setting the compare values on each probe in the Basic Capture
Setup window, refer to the section called ILA Probe Compare Value Settings

« For information on setting the basic capture condition in the Basic Capture Setup
window, refer to the section called Setting Basic Trigger Condition. One key difference
is the ILA core property used to control the capture condition is called
CONTROL.CAPTURE_CONDITION.

Setting the Number of Capture Windows

The ILA capture data buffer can be subdivided into one or more capture windows, the depth
each of which is a power of 2 number of samples from 1 to (((buffer size) / (number of
windows)) - 1). For example, if the ILA data buffer is 1024 samples deep and is segmented
into four capture windows, then each window can be up to 256 samples deep. Each capture
window has its own trigger mark corresponding to the trigger event that caused the capture
window to fill.
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TIP: Clicking Stop Trigger before the entire ILA data capture buffer is full will upload and display all

O capture windows that have been filled. For example, if the ILA data buffer is segmented into four
windows and three of them have filled with data, clicking Stop Trigger will halt the ILA core and
upload and display the three filled capture windows.

The table below illustrates the interaction between the Vivado runtime software and
hardware when a you set the Number of Capture Windows to more than 1 and the
Trigger Position to 0.

Table 11-2: Number of Capture Windows > 1 and Trigger Position = 0

Software Hardware

User Runs Trigger on the ILA core « Window 0: ILA is armed

« Window 0: ILA triggers

* Window 0: ILA fills capture window 0
* Window 1: ILA is rearmed

« Window 1: ILA triggers

« Window 1: ILA fills capture window 1

¢ Window n-1: ILA is rearmed

* Window n-1: ILA triggers

« Window n-1: ILA fills capture window n
Entire ILA Capture Buffer is Full

Data is uploaded and displayed The ILA core is rearmed such that it is ready to trigger
on the clock cycle immediately following the last sample
captured of the previous window.
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The table below illustrates the interaction between the Vivado runtime software and
hardware when a you set the Number of Capture Windows to more than 1 and the
Trigger Position to greater than 0.

Table 11-3: Number of Capture Windows > 1 and Trigger Position > 0

Software Hardware
User Runs Trigger on the ILA core * Window 0: ILA is armed
« Window 0: ILA fills capture buffer up to trigger
position

« Window O: ILA triggers

« Window O: ILA fills the rest of capture window 0

* Window 1: ILA is rearmed

« Window 1: ILA fills capture buffer up to trigger
position

« Window 1: ILA triggers

« Window 1: ILA fills capture buffer

« Window 1: ILA fills window 1

« Window n-1:ILA is rearmed

« Window n-1: ILA fills capture buffer up to trigger
position

« Window n-1: ILA triggers

« Window n-1: ILA fills capture buffer

« Window n-1: ILA fills window n

Entire ILA Capture Buffer is Full

Data is uploaded and displayed Triggers could be missed between two windows since
the ILA now has to fill the capture data up to the trigger
position.

Setting the Trigger Position in the Capture Window

Use the Trigger position control in the Capture Mode Settings window (or the Trigger
Position property in the ILA Core Properties window) to set the position of the trigger
marker in the captured data window. You can set the trigger position to any sample number
in the captured data window. For instance, in the case of a captured data window that is
1024 samples deep:

« Sample number 0 corresponds to the first (left-most) sample in the captured data
window.

« Sample number 1023 corresponds to the last (right-most) sample in the captured data
window.

« Samples numbers 511 and 512 correspond to the two "center" samples in the captured
data window.
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You can also use the set_property Tcl command to change the ILA core trigger position:

set_property CONTROL.TRIGGER_POSITION 512 [get_hw_ilas hw_ila_1]

Setting the Data Depth of the Capture Window

Use the Data Depth control in the Capture Mode Settings window (or the Capture data
depth property in the ILA Core Properties window) to set the data depth of the ILA core's
captured data window. You can set the data depth to any power of two from 1 to the
maximum data depth of the ILA core (set during core generation or insertion time).

Note: Refer to the section called Modifying Properties on the Debug Cores for more details on how
to set the maximum capture buffer data depth on ILA cores that are added to the design using the
Netlist Insertion probing flow.

You can also use the set_property Tcl command to change the ILA core data depth:

set_property CONTROL.DATA_DEPTH 512 [get_hw ilas hw_ila_ 1]

Running the Trigger
You can run or arm the ILA core trigger in two different modes:

« Run Trigger: Selecting the ILA core(s) to be armed followed by clicking the Run
Trigger button on the ILA Dashboard or Hardware window toolbar arms the ILA core
to detect the trigger event that is defined by the ILA core basic or advanced trigger
settings.

* Run Trigger Immediate: Selecting the ILA core(s) to be armed followed by clicking the
Run Trigger Immediate button on the ILA Dashboard or Hardware window toolbar
arms the ILA core to trigger immediately regardless of the ILA core trigger settings.
This command is useful for detecting the "aliveness" of the design by capturing any
activity at the probe inputs of the ILA core.

You can also arm the trigger by selecting and right-clicking on the ILA core and selecting
Run Trigger or Run Trigger Immediate from the popup menu (see Figure 11-30).
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Figure 11-30: ILA Core Trigger Commands

TIP: You can run or stop the triggers of multiple ILA cores by selecting the desired ILA cores, then using

O the Run Trigger, Run Trigger Immediate, or Stop Trigger buttons in the Hardware window toolbar.
You can also run or stop the triggers of all ILA cores in a given device by selecting the device in the
Hardware window and click the appropriate button in the Hardware window toolbar.

Stopping the Trigger

You can stop the ILA core trigger by selecting the appropriate ILA core followed by clicking
on the Stop Trigger button on the ILA Dashboard or Hardware window toolbar. You can
also stop the trigger by selecting and right-clicking on the appropriate ILA core(s) and
selecting Stop Trigger from the popup menu (see Figure 11-30).

Using Auto Re-Trigger

Select the Enable Auto Re-Trigger right-click menu option (or corresponding button on
the ILA Dashboard toolbar) on the ILA core to enable Vivado IDE to automatically re-arm
the ILA core trigger after a successful trigger+upload+display operation has completed.
The captured data displayed in the waveform viewer corresponding to the ILA core will be
overwritten upon each successful trigger event. The Auto Re-Trigger option can be used
with the Run Trigger and Run Trigger Immediate operations. Click Stop Trigger to stop
the trigger currently in progress.

Vivado Programming and Debugging N Send Feedback 187
UG908 (v2019.1) May 22, 2019 www.xilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=187

2: X”_INX® Chapter 11: Debugging Logic Designs in Hardware

The table below illustrates the interaction between the Vivado IDE runtime software and
hardware when you invoke the Auto Re-Trigger option.

Table 11-4: Auto Re-Trigger

Software Hardware

Click the Auto Re-trigger option on | « ILA is armed

the ILA core - ILA triggers
« ILA fills capture buffer
« ILA is full

Data is uploaded and displayed e ILA is rearmed

« ILA triggers
« ILA fills capture buffer
« ILA is full

Lots of cycles are missed between the ILA "full"
event and display of the ILA data

ﬁ IMPORTANT: As there is a delay between the time the ILA data is full and the data is uploaded and
displayed in the GUI, there is a very high probability of missing cycles between these events where the
ILA could have triggered.

Viewing Trigger and Capture Status
The ILA debug core trigger and capture status is displayed in two places in Vivado IDE:

« In the Hardware window Status column of the row(s) corresponding to the ILA debug
core(s).

« In the Trigger Capture Status window of the ILA Dashboard.

The Status column in the Hardware window indicates the current state or status of each ILA
core (see Table 11-5).
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Table 11-5: ILA Core Status Description

ILA Core o
Status Description
Idle The ILA core is idle and waiting for its trigger to be run. If the trigger position is

0, then the ILA core will transition to the Waiting for Trigger status once the
trigger is run, otherwise the ILA core will transition to the Pre-Trigger status.

Pre-Trigger | TheILA core is capturing pre-trigger data into its data capture window. Once the
pre-trigger data has been captured, the ILA core will transition to the Waiting for
Trigger status.

Waiting for | The ILA core trigger is armed and is waiting for the trigger event to occur as
Trigger described by the basic or advanced trigger settings. Once the trigger occurs, the
ILA core will transition to the Full status if the trigger position is set to the last
data sample in the capture window, otherwise it will transition to the Post-Trigger
status.

Post-Trigger | The ILA core is capturing post-trigger data into its data capture window. Once the
post-trigger data has been captured, the ILA core will transition to the Full status.

Full The ILA core capture buffer is full and is being uploaded to the host for display.
The ILA core will transition to the Idle status once the data has been uploaded
and displayed.

The contents of the Trigger Capture Status window in the ILA Dashboard depend on the
Trigger Mode setting of the ILA core.

Partial Buffer Capture

Clicking Stop Trigger before the entire ILA data capture buffer is full uploads and displays
all capture windows that have been filled. For example, if the ILA data buffer is segmented
into four windows and three of them have filled with data, clicking Stop Trigger halts the
ILA core and uploads and displays the three filled capture windows. In addition, clicking
Stop Trigger will halt the ILA core and display a partially filled capture window so long as
the trigger event occurred in that capture window.

Basic Trigger Mode Trigger and Capture Status

The Trigger Capture Status window contains two status indicators when the Trigger Mode
is set to BASIC (see Figure 11-31):

« Core status: indicates the status of the ILA core trigger/capture engine (see Table 11-5
for a description of the status indicators).

« Capture status: indicates the current capture window, the current number of samples
captured in the current capture window, and the total number of samples captured by
the ILA core. These values are all reset to 0 once the ILA core status is Idle.
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Status - hw_ila_1

e b » N
Core status
ldle Waiting for Trigger FostTrigger Full
Capture status
Window 1 of 1 Window sample 0 of 1024 Total sample 0 of 1024
100% 0% 0%

Figure 11-31: Basic Trigger Mode Trigger Capture Status Window

Advanced Trigger Mode Trigger and Capture Status

The Trigger Capture Status window contains four status indicators when the Trigger
Mode is set to ADVANCED (see Figure 11-32):

« Core status: indicates the status of the ILA core trigger/capture engine (see Table 11-5
for a description of the status indicators).

« Trigger State Machine Flags: indicates the current state of the four trigger state
machine flags.

« Trigger State: when the core status is Waiting for Trigger, this field indicates the
current state of the trigger state machine.
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Capture status: indicates the current capture window, the current number of samples
captured in the current capture window, and the total number of samples captured by

the ILA core. These values are all reset to 0 once the ILA core status is Idle.

Status - hw_ila_1

* b » W G

Core status

ldle Waiting for Trigger FostTrigger Full

Trigger State Machine

Flag 0 Flag 1 Flag 2 Flag 3
Trigger state: my_statel (0}

Capture status

Window 1 of 1 Window sample 1 of 1024  Total sample 1 of 1024
100% 0% 0%

Figure 11-32: Advanced Trigger Mode Trigger Capture Status Window

Writing ILA Probes Information

The ILA Cores tab view in the Debug Probes window contains information about the nets
that you probed in your design using the ILA core. This ILA probe information is extracted
from your design and is stored in a data file that typically has an . 1tx file extension.

Normally, the ILA probe file is automatically created during the implementation process.

However, you can also use the write_debug_probes Tcl command to write out the debug
probes information to a file:

1. If you are in project mode, open the Synthesized or Netlist Design. If you are in
non-project mode, open the synthesized design checklist.

2. Runthe write_debug_probes filename.ltx Tcl command.
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Reading ILA Probes Information

The ILA probe file is automatically associated with the FPGA hardware device if the probes
file is called debug_nets.1ltx and is found in the same directory as the bitstream
programming (.bit) file that is associated with the device.

You can also specify the location of the probes file:

1. Select the FPGA device in the Hardware window.
2. Set the Probes file location in the Hardware Device Properties window.

3. Click Apply to apply the change.
You can also set the location using the set_property Tcl command:

set_property PROBES.FILE {C:/myprobes.ltx} [lindex [get_hw_devices] 0]

Viewing Captured Data from the ILA Core in the
Waveform Viewer
Once the ILA core captured data has been uploaded to the Vivado IDE, it is displayed in the

Waveform Viewer. See Chapter 12, Viewing ILA Probe Data in the Waveform Viewer for
details on using the Waveform Viewer to view captured data from the ILA core.

Using Waveform ILA Trigger and Export Features

You can use the icons in the waveform window to arm ILAs and run trigger, stop the trigger,
and export ILA data as shown below.
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Figure 11-33: Waveform ILA Trigger and Export Features

Enable Auto Re-Trigger: Select the Enable Auto Re-Trigger button on the Waveform
window toolbar to enable Vivado IDE to automatically re-arm the ILA core associated with
the Waveform window trigger after a successful trigger+upload+display operation has
completed.

The captured data displayed in the Waveform window corresponding to the ILA core is
overwritten upon each successful trigger event. The Auto Re-Trigger option can be used
with the Run Trigger and Run Trigger Immediate operations. Click the Stop Trigger button to
stop the trigger currently in progress.

Run Trigger: Arms the ILA core associated with the Waveform window to detect the
trigger event that is defined by the ILA core basic or advanced trigger settings.

Run Trigger Immediate: Arms the ILA core associated with the Waveform window to
trigger immediately regardless of the ILA core trigger settings. This command is useful for
detecting the "aliveness" of the design by capturing any activity at the probe inputs of the
ILA core.

Stop Trigger: Stops the ILA core trigger of the ILA associated with the Waveform window.
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Export ILA Data: Captures data from an ILA core and saves it to a file. The data can be
captured in either native, .csv, or .vcd format. On clicking this icon on the Waveform
window toolbar the following dialog box appears.

¢ ExportILA Data @
Export ILA waveform data in CSV, VCD or native format. Mative format files can
be imported using Import ILA Data’ command from File menu. ‘

ILA Core: | hw_ila_data_1 ~

Format: Mative w

File: jo_Debugﬂm?.1Iproj_netlistfproj_netlist.runsfimpl_‘h'iladata.ila| |E|

Figure 11-34: Export ILA Data Dialog Box

The ILA core is the name of the ILA debug core to export data for. The format is a selection
among Native, CSV, and VCD formats.

Vivado Programming and Debugging

Native format configures the write_hw_ila_data command to export the ILA data
in native ILA format.

This ILA file can be imported back into Vivado IDE so that you can view previously
captured ILA data. The read_hw_ila_data TCL command can be used to import the
ILA data back into Vivado IDE as shown in the example below:

read_hw_ila_data {./iladata.ila}

display_hw_ila_data

CSV format configures the write_hw_ila_data command to export the ILA data in
the form of a . csv file that can be used to import the data into a spreadsheet or
third-party application.

VCD file format configures the write_hw_ila_data command to export the ILA data
in the form of a .vcd file that can be used to import into a third-party application or
viewer.
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IMPORTANT: While ILA data can be exported in the CSV, VCD, and native ILA format, only the native
ILA format can be imported into Vivado. Also, native ILA data imported into Vivado is supported only
for offline viewing of previously captured data. The probe signals cannot be used for other purposes
such as triggering, etc.

Saving and Restoring Captured Data from the ILA
Core

In addition to displaying the captured data that is directly uploaded from the ILA core, you
can also write the captured data to a file then read the data from a file and display it in the
waveform viewer.

Saving Captured ILA Data to a File

Currently, the only way to upload captured data from an ILA core and save it to a file is to
use the following Tcl command:

wite hw.ila_ data ny_hw ila_data_file.ila [upload_hw_ ila_data hw.ila_1]

This Tcl command sequence uploads the captured data from the ILA core and writes it to an
archive file called my_hw_ila_data_file.ila. The archive file contains the waveform
database file, the waveform configuration file, a waveform comma separated value file, and
a debug probes file.

TIP: Use the -csv_file option to generate a comma-separated values (CSV) file. This configures the
write_hw_ila_data command to export the ILA data in the form of a CSV file that can be used to
import into a spreadsheet or third-party application, rather than the default binary ILA file format.

TIP: Use the -vcd_file option to generate a value change dump (VCD) file. This configures the
write_hw_ila_data command to export the ILA data in the form of a VCD file that can be used to
import into a third-party application or viewer, rather than the default binary ILA file format.

Probe Data Radix

Every probe has a DISPLAY_RADIX property associated with it. This property is set to HEX
for a multi-bit probe and BINARY for a one-bit probe by default. The exported probe data
in the . csv files use probe radix.

o l Send Feedback I 195
UG908 (v2019.1) May 22, 2019 www.xilinx.com


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=195

2: X”_INX® Chapter 11: Debugging Logic Designs in Hardware

You can change the DISPLAY_RADIX property of all the probes of all ILAs in the design as
follows in the Vivado Hardware Manager Tcl Console:

foreach probe [get_hw_probes -of [get_hw_ilas]] {
set_property DISPLAY RADIX binary S$probe
set_property DISPLAY AS_ENUM false S$Sprobe

}

Note: Here we are changing the radix of all the probes in all the ILAs to BINARY. To change the radix
to HEX, use the script below.

foreach probe [get_hw_probes -of [get_hw_ilas]] {
set_property DISPLAY_ RADIX hex Sprobe
set_property DISPLAY AS_ENUM false Sprobe
}

Listing data samples associated with a single probe

You can also list data samples associated with individual probes using the
list_hw_samples Tcl command.

An example of listing the samples associated with probe fast_cnt_incr_val_1 onILA
named i_fast_ila is shown below:

list_hw_samples [get_hw_probes fast_cnt_incr_val_1 -of_objects [get_hw_ilas
-of_objects [get_hw_devices xc7k325t_0] -filter {CELL_NAME=~"i_fast_ila"}]]
00000001 00000001 00000001 00000001 00000001 00000001 00000001 00000001 00000001
00000001 00000001 00000001 00000001 00000001 00000001 00000001 00000001 00000001
00000001 00000001 00000001 00000001 00000001 00000001 00000001 00000001 00000001
00000001 00000001 00000001 00000001 00000001 00000001 00000001 00000001 00000001...

Restoring Captured ILA Data from a File

Currently, the only way to restore captured data from a file and display it in the waveform
viewer is to use the following Tcl command:

display_hw_ila_data [read_hw_ila_data my_hw_ila data_file.ilal]

This Tcl command sequence reads the previously saved captured data from the ILA core and
displays it in the Waveform window.

Note: The waveform configuration settings (dividers, markers, colors, probe radices, etc.) for the ILA
Data Waveform window is also saved in the ILA captured data archive file. Restoring and displaying
any previously saved ILA data uses these stored waveform configuration settings.

f IMPORTANT: Do NOT use the open_wave_config command to open a waveform created from ILA
captured data. This is a simulator-only command and will not function correctly with ILA captured data
waveforms.
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Enumeration of Probe Values

This feature provides a way to refer to probe values, both during Trigger/Capture Setup to
compare values, and in the Waveform window, by symbolic names.

Some common use cases include the following.

« state machine state values

« op codes

« any probe match value, that you want to refer to by name, instead of value.

The process involves entering enumeration name-value pairs and associating them with a
probe. The enumeration name-value pair associations are available using Tcl commands
and are stored between sessions.

In cases where the mark_debug attribute is used to probe a state register in a state machine
with enumerated states, the state enumeration will be preserved though implementation,
and displayed automatically in the Waveform window.

15 (* mark_debug = "true"™ *) reg [1:0] pre_state;
1t (* mark_debug = “true™ *) reg [1:0] next_state:;

18 localparam stateA
19 1 localparam stateB
C
8]

! 1
20+ localparam state !
21 localparam state

[SENENEN]
oo oo
] =
—o e e

Figure 11-35: RTL with State Encoding

Waveform - hw_ila_1
a + o » BB @ a 3 o« o T ol o

ILA Status: Idle

Name Value

Figure 11-36: State Encoding Preserved and Displayed as a Probe Enumeration in the
Waveform Viewer

Probe compare values can be set using enumeration names in the Trigger Setup and
Capture Control Setup windows. Probes and their enumeration names corresponding to
values can be displayed in the Waveform window as well.
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Add/Edit Enumerations

Chapter 11: Debugging Logic Designs in Hardware

Define new Enumerations using the Hardware Manager

To associate a new enumeration name-value pair to a debug probe, right-click the debug
probe either in the Debug Probes window or the Trigger/Capture Setup window and

select Edit Enumeration.

Debug Probes

Q = 2

> € hw_vio_1

~ 2 hw_ila_1
e GPIO_BUTT
e GPIO_BUTI
= push_buttol
= push_buttol
e sine[19:0]
2 sineSel[1:0]

Figure 11-37:

>
»
|

- 0Oo X m

Debug Probe Properties...

Dashboard Options

Run Trigger
Run Trigger Immediate
Stop Trigger
Enable Auto Re-trigger

Create User Defined Probe...

Edit Enumeration... [}
Rename...

MName 3
Add Probes to Waveform

Add Probes to Basic Trigger Setup

Dashboard 3
T

Edit Enumeration from Trigger Setup Window

Editing Enumeration Associated with a Debug Probe in the Trigger Setup

Window

You can also associate a new enumeration name-value pair to a debug probe by selecting
the debug probe in the Debug Probes window or Trigger Setup window. The
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Enumeration tab of the Debug Probe Properties window also allows you to associate a
new enumeration name-value pair to the probe.

Debug Probe Properties ?_0O00 X
t GPIO_BUTTOMS_dIy[1:0] - o

Mame Radix Value

Edit Enumeration...

General Properties Enumeration

Figure 11-38: Debug Probe Properties Dialog

Vivado Programming and Debugging Send Feedback 199
UG908 (v2019.1) May 22, 2019 www.Xxilinx.com I—\/—l


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=199

(: X”_INX® Chapter 11: Debugging Logic Designs in Hardware

Click Edit Enumeration, to open the Edit Enumeration dialog box.

¢ Edit Enumeration S @
Add, remaove or modify names and values for the enumeration for the debug probe
"GPIO_BUTTONS_dly[1:0T ‘

Enumerations

+

Mame Radix Value

enum_1 Hexadecimal *~ 0

)

Figure 11-39: Edit Enumeration Dialog

"u o

Select the name-value pair and use the “+"” and "-" buttons on the left to add or delete
enumerations. You can change the name, radix, and values fields in the table.
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Add Enumerations Using Tcl Commands

The add_hw_probe_enum command, associates an enumeration name-value pair to a
debug probe. You can add add_hw_probe commands to a Tcl file, to have the definitions
appear in a separate file. The enumeration names maintain the case they were entered in,
but lookup is case-insensitive.

Example:

set probe [get_hw_probes fast_cnt_count -of_objects [get_hw_ilas -of_objects
[get_hw_devices xc7k325t_0] -filter {CELL_NAME=~"i_fast_ila"}]]

add_hw_probe_enum ZERO eg5'h00 S$Sprobe
add_hw_probe_enum TWELVE eg5'ul2 S$probe
add_hw_probe_enum THIRTEEN eqg5'ul3 S$probe
add_hw_probe_enum FOURTEEN eg5'uld S$probe
add_hw_probe_enum FIFTEEN eg5'ul5 S$probe
add_hw_probe_enum SIXTEEN eg5'ul6 Sprobe
add_hw_probe_enum SEVENTEEN egb5'ul7 S$probe

Delete Enumerations using Tcl commands

Use the remove_hw_probe_enum command to remove explicitly named enumerations
entries, or all enumerations for a hw_probe.

Example:

remove_hw_probe_enum -list {zero } [get_hw probes U_SINEGEN/sel -of_objects
[get_hw_ilas -of_objects [get_hw_devices xc7k325t_0] -filter
{CELL_NAME=~"u_ila_0"}1]

TIP: Using the -remove_all option on remove_hw_probe_enum removes all of the enumerations
O associated with the probe.

Access Enumeration

Enumerations are stored as hw_probe properties, so set_property, get_property,
and report_property commands can be used on these properties.

The enumeration properties have a prefix ENUM, which needs to be used when using it with
set_property and get_property commands. See the following example.
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get_property ENUM.FIFTEEN -of_objects [get_hw ilas -of_objects [get_hw_devices
xc7k325t_0] -filter {CELL_NAME=~"i_fast_ ila"}]]
eg5'ulb

report_property [get_hw probes fast_vio_slice5_fb -of_objects [get_hw_ilas
hw_ila_1]] ENUM*

Property Type Read-only Visible Value

ENUM.FIFTEEN string true true eg5'ulb
ENUM . FOURTEEN string true true egb'uld
ENUM. SEVENTEEN string true true eg5'ul’
ENUM. SIXTEEN string true true eg5'ulé
ENUM.THIRTEEN string true true eg5'ul3
ENUM.TWELVE string true true eg5'ul2
ENUM. ZERO string true true eg5'h00

set_property ENUM.FIFTEEN eg5'hOF [get_hw_probes fast_vio_slice5_fb -of_objects
[get_hw_ilas hw_ila_1]]

Using Enumerations in Trigger Setup window

Setting compare values with enumerations in the Trigger Setup window, has similar syntax
to numeric compare values. The radix char is 'e'. Only the operators 'eq' and 'neq' are
supported for enumeration compare values.

Trigger Setup - hw_ila_1 = Capture Setup - hw_ila_1 ? _ 0
Q + = o
MName Operator Radix Value
GPIO_BUTTONS_dIy[1:0] == - [B] (Binary) WX -
[B] (Binary)
[H] (Hexadecimal)
[O] (Octal)

[U] (Unsigned Decimal)
[S] (Signed Decimal)
[E] (Enumeratitg}

Figure 11-40: Enumerations in Trigger Setup Window

set_property TRIGGER_COMPARE_VALUE eg2'ethree [get_hw_probes U_SINEGEN/sel
-of_objects [get_hw _ilas -of_objects [get_hw_devices xc7k325t_0] -filter
{CELL_NAME=~"u_ila_0"3}1]]
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Using Enumerations in Capture Setup window

You can also compare values using enumeration in the Capture Setup window in the
Vivado IDE or using Tcl commands.

Capture Setup - hw_ila_1

Q + = o

F i
Name Operator Radix Value
GPIO_BUTTOMS_diy[1:0] == * [B] (Binary) X A
[B] (Binary)
[H] (Hexadecimal)
[O] (Octal)
[Ul (Unsigned Decimal)
[3] (Signed Decimal)
[E] (Enumeration)
%

Figure 11-41: Enumerations in Capture Setup Window

set_property CAPTURE_COMPARE_VALUE eg2'eone [get_hw_probes locked -of_objects
[get_hw_ilas -of_objects [get_hw_devices xc7k325t_0] -filter
{CELL_NAME=~"u_ila_0_0"}]]

Advanced Trigger

You can compare values using enumeration in the Advanced Trigger State Machine scripts
as in the following example.

state my_statel:
if (fast_ila_slice5_fb == 5'eFIFTEEN) then
set_flag $flagl;
goto my_statel;

elseif (fast_ila_slice5_fb == 5'eTWELVE) then
trigger;
else

clear_flag $flagl;
goto my_statel;
endif

Using Enumerations in the Waveform window

You can show enumerations in the Waveform window by choosing the Show as
Enumeration option for each signal. Right-click the signal in the Waveform window and
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select Show as Enumeration in the menu that appears. When not shown as an
enumeration, bus values are displayed according to regular radix selection.

hw_ila_1

Waveform - hw_ila_1
Q + =2 » » BB @ @ i » K M = 2 +

ILA Status:1dle

Dashboard Options

db[1:0]
m

Cut

Copy

Paste
Delete

Find

Find Yalue...
Select All
Expand

Rename Updaved av: Z017-Mar-Z
> <€

MName 3

.
Settings - hw_ila_1 Waveform Style * Trigger Setup - hw_ila_1

Signal Colar 3
Trigger Mode Setting Q + - 1)"
MName Operator Radix Value
Trigger mode: | | Radix
GPIO_BUTTONS_dly[1:0] == -~ @ - W

Edit Enumeration

Show as Enumeration
Capture Mode Settin [y
Reverse Bit Order

Capture mode
Mew Group

MNew Divider
New Virtual Bus

Create User Defined Probe

BUTTONS_dly] [GFIC_EUT (3 ExportILAData [U_SINEGEN/sine} }
Figure 11-42: Show as Enumeration option in the Waveform Window

Enumeration information is saved to waveform data files and is used in subsequent displays
of waveform data. The default for waveform probes that have Enumerations defined is to
have the Enumerations displayed.

Waveform - hw_ila_1
Q + = 2 » BB @ Q X o MM = 2 o d

ILA Status: Post-trigger Capture (1 out of 1024 samples)

Figure 11-43: Waveforms with Enumerations
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When a waveform object has Show as Enumeration selected, enumeration names are
displayed. If there is no matching Enumeration for the waveform value, it will instead be
displayed according to the selected radix.

f IMPORTANT: /f the waveform has been created prior to creating the enumerations, you can apply new
enumerations to the waveform by saving the waveform ILA data using the Tcl commands below:

write_hw _ila_data -force data_ila_3.ila [upload_hw_ila_data hw_ila_ 3]

display_hw_ila_data [read_hw_ila_data ./data_ila_3.ila]

Debugging AXI Interfaces in the Hardware Manager

The System ILA IP in IP Integrator (IPI) allows you to perform in-system debugging of
designs on an FPGA device. Use this feature when there is a need to monitor interfaces and
signals in the IPI Block Design.

See this link in the Vivado Design Suite User Guide: Designing IP Subsystems Using IP
Integrator (UG994) [Ref 17] for the steps to debug interfaces and/or nets in the Block
Design.

If you have instantiated System ILA debug cores in your IP Integrator Block Design, you can
debug and monitor AXI transactions and their corresponding read and write events in the
waveform window.

Waveform and AXI Interfaces

The System ILA debug core enables you to debug and monitor interfaces as slots. Each slot
corresponds to an interface being debugged in IP Integrator (IPI) Block Design. In the figure
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below there are 2 AXI Memory Map interfaces being probed by the System ILA IP in slot O,
slot 1.

systerr_ila

Z)-PELOT_0_AXI
) =FSLOT_1_AX|
2] -PSLOT_2_Ax
» clk

1 prosbe [0:0]

System ILA

_0_axi_periph

Figure 11-44: Probing 2 AXI Memory Map Interfaces

AXI Transactions in the Waveform Viewer

Transactions associated with AXI3, AXI4, and AXI4-Lite interfaces that are being debugged
by the System ILA can be viewed in the waveform viewer as shown in the following figure

hw_ilal % hwvios X

Waveform - fw_ila_1
Q + e b > BB Q@ i o MM I Te
ILA Status: dle

Name

Dashfoard Options

Vi te (1030 Addri 0xc0201c00)
—

—
Vi e (1D:0 Addri0xc0001800)
birite (I1D:0 Addri(:c0001400)

Read (1D:0 Addr: 0xc0030c00)
——
d (1D:0 Add r: 0xc0000800)

Read Address Command
Sample(s) = from 2362 to 2616
D=0

Address = 0xc0000c00

Burst Type = NjA

Burst Length = 256 beats

BUFSt Size = 4 bytes per beat

Memory Type = Nortnal Non-cacheable Bufferable

Quality of Service = N/A

Figure 11-45: AXI Transactions in the Waveform Viewer
AXI transactions are defined as follows:

« Read transactions start with the beginning of the Address Command event on the AR
(Read Address) channel.

« Read transactions end with the Last Read Data event on the R (Read Data) channel.
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« Write transactions start with the beginning of the Address Command event on the AW
(Write Address) channel.

« Write transactions end with the Write Response event on the B (Write Response)
channel.

Transactions are only shown when the address, data, and/or response events have matching
IDs. In addition, transactions are only shown in the waveform if both the start and end
events occur within the captured data waveform. When multiple outstanding/overlapping
transactions are displayed in the Waveform window, multiple transaction rows are used.

It is possible that the transactions on the interface can cause the outstanding transaction
tracking logic within the System ILA IP to overflow as shown in the following figure.

hw_ila_1

‘Waveform - hw_ila_1
Q + =2 »r » BB Q@ X « MM = 2 ] [«
ILA Status: Idle

Name

Dashboard Optiohs

dr ( e O Addr Cnd Addr Cnd fadd. ..
Data geat | W TEw| Che

Data Beat

OVERFLOW

‘Write Transaction Overflow
- Address = 0x030
OVERFLOW D=3
Addr Cmd ¥ Starting Sample = 115
Conditian: Outstancing transaction for unicue D limit reachect
Data Beat . N— SO A ———

Data Beat

Figure 11-46: AXI Transaction Counter Overflow Condition

Two overflow conditions can result:

« The number of outstanding transactions for a particular ID overflow the transaction
counter capacity.

« The number of IDs that have outstanding transactions overflow the number of available
counters.
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In either case, an overflow condition can be resolved by re-customizing the System ILA core
in the IP Integrator block design to increase the number of outstanding read and/or write
transactions. See the following figure.

A Re-customize IP x
System ILA (1.0) P
@ Documentation IP Location
IPSymbol | Resources Component Name | system_ila_0
. 5RAM To configure more than 64 probe ports use Vivado Tcl Console
Resource Estimates _ -
General Options | Probe_Ports(0..7) | Interface Options
100.0 Configuration for Slot | SLOTO
90.0 Imerface Typa xiling. com:imerface:aximm rti:1.0 ~
80.0 (@) Ruta ) AXI-MM ID Wicth AUTO
—
e 700 (@) Auta” ) AXI-MM Data Widih AUTO
£ 00 (@) RGES ) AXI-MM Address Wicth AuTO
5 s00
a
40.0
| Enable AXI-MM /Stream Protocol Checker
30.0
| Monitor APC Status signals
200
10.0 /| Enable Transaction Tracking Counters
0.0 Number Of Outstanding Read Transactions 2 ~
0.0 10
Number Of Outstanding Write Transactions 2 ~

Data and/or Trigger configurion for AXI-MM Interface channel
Resource Usage
Read Address  Read Data | Write Address | Write Data | Write Response
BRAM Slice: 107
/| Configure AXI Read Address Channel signals as Data

/| Configure AXI Read Addrass Channel signals as Trigger

Read Address Channel arid, arvalid and arready signals are configured as Daia & Trigger

Figure 11-47: Increasing the Number of Outstanding Transactions That Can Be Tracked by
System ILA

AXI Interface Events

In the Vivado Hardware Manager, if you debug a design AXI interface with a System ILA IP,
the Waveform window displays the interface slots, events, and signal groups corresponding
to the interfaces being probed by the System ILA. As you can see in the figure below, the
Waveform window displays both of the 2 interface slots that were probed by the System ILA
IP. You can see the AXI Transactions, Write Address Channel Events, the Write Data Channel
Events on slot 1. You can also see the Write Data CAXI interface slots in the Waveform
window.
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‘Waveform - hw_ila_1
a + r e » BB @ H « T of L

ILA Status:ldle

slot_0: microblaze_0_axi_periph_MO00_AXI : Interface
L : ze Xi_periph_| a N ! s o Read Addr Cmds

periph_Mo1 El a Ho Read Data Beats

periph_Mo1 a Al Ho Urite addr Cnds
—

periph_Mo1

No Read Addr Cnds

Mo Read Data Bests

Adcr Cmd
_periph_|
)_axi_periph_|

Updated

Figure 11-48: AXl Interface Transactions and Events

This waveform reports AXI interface related transactions and events on the Read, Write,
Address, and Data channel events.

AXI Transactions

The AXI Transaction reports on the Read and Write Transactions of the AXI Read Address,
AXI Read Data, Write Address, and Write Data channels.

Hovering over a specific read or write Transaction in the Waveform window brings up a
window that highlights the Address, ID, Start, End, and Duration associated with the specific
transaction as shown below.

Waveform - hw_ila_1
Q + = 2 » » BB B @ Q 2 = 14 »l = =2 =+ wl o

ILA Status:Idle

Address = 0x0a4
D=0

Start = 840

End =845

Duration = 6 samples

No Read Data Beats

—— —
Addr Cmd

Figure 11-49: AXI Transactions
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AXI Channel Events

The AXI Channel Events group reports on the AXI events in the AXI Read Address (AR), Read
Data (R), Write Address (AW), and Write Data (W), and Write Response (B) channels.

Read Address (AR) Channel Events

Name

Description

No Read Addr Cmds

Indicates that no address command events occurred on the Read

Address channel.

Addr Cmd

Indicates a valid address command phase of a read transaction. This
event starts when ARVALID = '1". This event ends when both ARVALID
='1" and ARREADY = '1"in the same clock cycle.

Read Address Channel Signal Group

This signal group is composed of all the signals that participate in a Read Address Channel
Event. The signals are as follows:

Net Name

ARVALID

ARREADY

ARID

ARADDR

ARBURST

ARLEN

ARSIZE

ARCACHE

ARPROT

ARLOCK

ARQOS

AR_CNT
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Read Data Channel Events

Name

Description

No Read Data Beats

Indicates that no events occurred on the Read Data channel

Data Beat Indicates a (non-last) data beat of a read transaction. This event occurs
when RAVLID = '1' and RREADY = '1" in the current clock cycle.
Last Data Indicates the last data beat of a read transaction. This event occurs

when RVALID = '1' and RREADY = '1' and RLAST = '1" in the current
clock cycle.

Read Data Channel Signal Group

This signal group is composed of all the signals that participate in a Read Data Channel
Event. The signals are as follows:

Net Name

RVALID

RREADY

RLAST

RID

RDATA

RRESP

R_CNT

Write Address Channel Events

Name

Description

No Write Addr Cmds

Indicates that no address command events occurred on the Write
Address channel.

Addr Cmd

Indicates a valid address command phase of a write transaction. This
event starts when AWVALID = '1". This event ends when both AWVALID
='1" and AWREADY = '1"in the same clock cycle.
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Write Address Channel Signal Group

This signal group is composed of all the signals that participate in a Write Address Channel
Event. The signals are as follows:

Net Name

AWVALID

AWREADY

AWID

AWADDR

AWBURST

AWLEN

AWSIZE

AWCACHE

AWPROT

AWLOCK

AWQOS

AW_CNT

Write Data Channel Events

Name

Description

No Write Data Beats

Indicates that no events occurred on the Write Data channel.

Data Beat Indicates a (non-last) data beat of a write transaction. This event occurs
when WVALID = '1' and WREADY = '1" in the current clock cycle, and
either of the two signals were '0' in the previous clock cycle.

Last Data Indicates the last data beat of a write transaction. This event occurs

when WVALID = '1' and WREADY = '1' and WLAST = '1' in the current

clock cycle.
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Write Data Channel Signal Group

This signal group is composed of all the signals that participate in a Write Data Channel
Event. The signals are as follows:

Net Name

WVALID

WREADY

WLAST

WDATA

WSTRB

Write Response Channel Events

Name

Description

No Write Responses

Indicates that no events occurred on the Write Response channel.

Write Response

Indicates response phase of a write transaction. This event occurs when
BVALID = '1' and BREADY = '1'"in the current clock cycle.

Write Response Channel Signal Group

This signal group is composed of all the signals that participate in a Write Response
Channel Event. The signals are as follows:

Net Name

BVALID

BREADY

BID

BRESP

B_CNT

Triggering on AXI Address Command and Data Beats

Debugging AXI interfaces often involves triggering on three specific kinds of AXI events:
End of the Address Command, End of Data Beat, and Write Response. It is often required to
trigger on one or more of these events on different interface channels. For instance, to
implement the trigger condition of "End of Read Address Command OR End of Write
Address Command", the following equation is required:

Trigger Condition = (((ARVALID == 1) && (ARREADY == 1)) | | ((AWVALID == 1) && (AWREADY

==1)))
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However, this requires a "Sum of Products" or "SOP"-style Boolean equation that is not
possible to implement when the required AXI signals (such as ARVALID and ARREADY)
reside on different probe ports. To facilitate this type of triggering, the required *VALID,
*READY, and *LAST control signals are concatenated together onto a single probe port as
shown in the following table.

Table 11-6: AXI Channel Control Signal Probes

Description Probe Name Bit 2 Bit 1 Bit 0

Read Address channel control *ar_ctrl[1:0] N/A ARREADY ARVALID
signals

Read Data channel control signals *r_ctrl[2:0] RLAST RREADY RVALID
Write Address channel control *aw_ctrl[1:0] N/A AWREADY AWVALID
signals

Write Data channel control signals *w_ctrl[2:0] WLAST WREADY WVALID
Write Response channel control *b_ctrl[1:0] N/A BREADY BVALID
signals

The following table shows how to use both the individual AXI control signal probes as well
as the AXI channel control probes to implement useful basic trigger and capture control
equations. The following figure shows how to implement the "End of Read Address
Command OR End of Write Address Command" event using the basic trigger setup GUL

Table 11-7: Trigger and/or Capture Control Event

AXI Event

Individual AXI Control Signals

Combined AXI
Channel Control
Probe

End of the Read Address
Command

((ARVALID == 1) && (ARREADY == 1))

(*ar_ctrl == 2'b11)

End of the Last Read Data Beat

((RVALID == 1) && (RREAD 1) && (RLAST == 1))

(*r_ctrl == 3'b111)

End of the (Non-Last) Read Data
Beat

Y ==
((RVALID == 1) && (RREADY == 1) && (RLAST == 0))

(*r_ctrl == 3'b011)

End of the Write Address ((AWVALID == 1) && (AWREADY == 1)) (*aw_ctrl == 2'b11)
Command

End of the Write Read Data Beat | (WVALID == 1) && (WREADY == 1) && (WLAST == 1)) | (*w_ctrl == 3'b111)
End of the (Non-Last) Read Data | (WVALID == 1) && (WREADY == 1) && (WLAST == 0)) | (*w_ctrl == 3'b011)

Beat
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Trigger Setup - hw_ila_1 * Capture Setup - hw_ila_1 ? -0
— — ((ARREADY == 1) && (ARVALID == 1)) ]

Q + j}nﬁ Set to "Global OR j C ' -

Mame Operator Radix Value Fort

design_1_i/system_ila_0/inst/net_slot_0_axi_ar_ctrl[1:0]
design_1_i/system_ila_0/inst/net_slot_0_axi_aw_ctri[1.0]

~ [B] ~ "11 ~ probe39[1:0]
- [B] ~ 11 =~ probe3&6[1:0]

C: (AWREADY == 1) && (AWVALID == 1) ;_.j

Figure 11-50: Basic Trigger Setup for "End of Read Address Command OR End of Write Address
Command" Event

Setting Up the VIO Core to Take a Measurement

The VIO cores that you add to your design appear in the Hardware window under the
target device. If you do not see the VIO cores appear, right-click the device and select
Refresh Hardware. This re-scans the FPGA device and refreshes the Hardware window.

Note: If you still do not see the VIO core after programming and/or refreshing the FPGA device,
check to make sure the device was programmed with the appropriate .bit file and check to make
sure the implemented design contains an VIO core. Also, check to make sure the appropriate .1tx
probes file that matches the .bit file is associated with the device.

Click the VIO core (called hw_vio_1 in Figure 11-51) to see its properties in the VIO Core
Properties window. By selecting the VIO core, you should also see the probes
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corresponding to the VIO core in the Debug Probes window as well as the corresponding

VIO Dashboard in the Vivado IDE workspace (see Figure 11-52).

Hardware ? 00O X
Q = = &
Mame Status
~ B localhost (1) Connected
~ Ee ilin_tefdlingPort_#0003.Hu...  Open
~ {8 xcTK3Z5L 0 (7) Programmed
& XADC (System Monitor)
SE hw_ila_1 (i fast ila) ) 1dle
& hw_vio_1 (i_fast_via) oK
SE hw_axi_1 (400
£ hw_ila_2 (i_slow_ila) O dle
SE hw_vio_2 (i sl Ok - Outputs Reset
£ hw_ila_3 (u_ila_0_0) O dle
4 >

Figure 11-51:

VIO Core in the Hardware Window

Chapter 11: Debugging Logic Designs in Hardware

HARDWARE MANAGER - localhostxilim_teffXilimdPort_#0003 Hub_#0004 ?
Hardware ? 00X Debug Probes _ O X x|hwia1 x hwila2 X|hwia_3 x =200
Q = = o Q = = o hw_vio 1 X hw vio 2 2 _0O
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~ B localnost (1 Connected > g slow_vio_slice5_fo[4:0] 2

=
~ He xiline_tefXilingPor_#0003Hu..  Open > i slow_vio_slices_fo_2[4:0] O| priizme vaiue Aty S
v @) xcTK32500 (7 Programmed > ig slow_vio_slice15_fo[14:0] § ¥ & BUTTONIBUF 1132) HI0 Input
& XADG (System Monitor; > g slow_vio_slice15_fo_2[14:C § 1 BUTTON_IBUF_1[3] ] Input
5 hw_ila_1(i_fast ila O 1dle > 5 slow_vio_slice34_fo[33:0] a I BUTTON_IBUF_1(2] Q Input
¢ hw_vio_1 (_fast_vio) ‘ oK I > ig slow_vio_slice34_fo_2[33:C > s fast_vio_feedback_2[31:0] [H] AAS5_9966 Input
2 hw_axi_1 (4K > i slow_vio_slice200_fo[199:C e fast_vio_slicel_fo_2 ° Input
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e e ) ‘a fast_cnt_up_down wd

General Properties < y e ¢ 2

Figure 11-52:

Selection of the VIO Core in Various Views

The VIO core can become out-of-sync with the Vivado IDE. Refer to Viewing the VIO Core
Status for more information on how to interpret the VIO status indicators.

The VIO core operates on an object property-based set/commit and refresh/get model:

« Toread VIO input probe values, first refresh the hw_vio object with the VIO core values.
Observe the input probe values by getting the property values of the corresponding
hw_probe object. Refer to the section called Interacting with VIO Core Input Probes for
more information.
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« To write VIO output probe values, first set the desired value as a property on the
hw_probe object. These property values are then committed to the VIO core in
hardware in order to write these values to the output probe ports of the core. Refer to
the section called Interacting with VIO Core Output Probes for more information.

Viewing the VIO Core Status

The VIO core can have zero or more input probes and zero or more output probes (note

that the VIO core must have at least one input or output probe). The VIO core status shown
in the Hardware window is used to indicate the current state of the VIO core output probes.
The possible status values and any action that you need to take are described in Table 11-8.

Table 11-8: VIO Core Status and Required User Action

VIO Status Description Required User Action

OK — Outputs Reset | The VIO core outputs are in sync | None
with the Vivado IDE and the
outputs are in their initial or
"reset” state.

OK The VIO core outputs are in sync | None
with the Vivado IDE, however, the
outputs are not in their initial or
“reset” state.

Outputs out-of-sync | The VIO core outputs are not in You must choose one of two user actions:

sync with the Vivado IDE. « Write the values from the Vivado IDE to
the VIO core by right-clicking the VIO core
in the Hardware window and selecting
the Commit VIO Core Outputs option.

+ Update the Vivado IDE with the current
values of the VIO core output probe ports
by right-clicking the VIO core in the
Hardware window and selecting the
Refresh Input and Output Values from
VIO Core option.

Viewing VIO Cores in the Debug Probes Window

The “+" button in the VIO Dashboard window is used to view, add, and delete the debug
probes that belong to VIO core.
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Using the VIO Dashboard

The VIO Default Dashboard starts out empty to which you can add VIO probes to as
showing Figure 11-53.

hw_vio_2

Add Probes
z s o
Search:

Probes for hw_vio_2 (26 v
~ 3E hw_vio_2

> % BUTTON_IBUF[1:0]
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= fast2slow_ila_trig_ack
g LED_OBUF[1:0]
i slow_cnt_count{31:0]

‘= slow_cnt_count_en

&5 slow_cnt_incr_val[30:0]

= slow_cnt_load_en

3 slow_cnt_load_val[31:0]

= slow_cnt_reset

= slow_cnt_up_down

&5 slow_vio_feedback]31.0]

& slow_vio_feedback_2[31:0]
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= slow_vio_slice1_fb d
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7 [get_hw vies -ef _ck; ‘= slow_vio_slice1_fo_2 HAME=-"i
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1 -of_cbjects [get_hw, Hlter {C
> i3 slow_vio_slice5_fb[4:0] v NAME=-"i

Cancel

:n -of obiects [get hw vios -of cbiects [get hw devices xc7k325t 01 -filter |

3 [get_hw_vies —of_ob;

Figure 11-53: VIO Default Dashboard

The VIO Dashboard is a central location for all status and control information pertaining to
a given VIO core. When a VIO core is first detected upon refreshing a hardware device, the
VIO Dashboard for the core is automatically opened. If you need to manually open or
re-open the dashboard, right-click the VIO core object in either the Hardware or Debug
Probes windows and select Open Dashboard.

Interacting with VIO Core Input Probes

The VIO core input probes are used to read values from a design that is running in an FPGA
in actual hardware. The VIO input probes are typically used as status indicators for a
design-under-test. VIO debug probes need to be added manually to the VIO Probes
window in the VIO Dashboard. Refer to the section called Viewing VIO Cores in the Debug

Vivado Programming and Debugging N Send Feedback 218
UG908 (v2019.1) May 22, 2019 www.xilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=218

2: X”_INX® Chapter 11: Debugging Logic Designs in Hardware

Probes Window on how to do this. An example of what VIO input probes look like in the VIO
Probes window of the VIO Dashboard is shown in Figure 11-54.

hw_vio_1 X hw_vio_2 2?2 _ 0
Q ¢ + -
Name Value Activity D.. ~1 vio
~ & BUTTON_IBUF_1[3:2] [HIO Input hw_vio_1 =
I BUTTON_IBUF_1[3] - Input hw_vio_1
I BUTTON_IBUF_1[2] - Input hw_vio_1
> ig fast_vio_feedback_2[31:0] [H] AASS_9966 Input hw_viao_1
1= fast_vio_slice1_fo_2 . Input hw_vio_1
~ g fast_vio_slice5_fb_2[4:0] [H] 00 Input hw_viao_1
[ fast_vio_slice5_fb_2[4] [+] Input hw_viao_1
I fast_vio_slice5_fb_2[3] [+] Input hw_viao_1
I fast_vio_slice5_fb_2[2] [+] Input hw_viao_1
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» i fast_cnt_count_1[31:0] [H] 58C4_BC34 £ 5 Input hw_viao_1
1= fast_vio_slice1a_fb_2 [B1O Input hw_vio_1 .

Figure 11-54: Core Input Probes

Reading VIO Inputs Using the VIO Cores View

The VIO input probes can be viewed using the VIO Probes window of the VIO Dashboard
window. Each input probe is viewed as a separate row in the table. The value of the VIO
input probes are shown in the Value column of the table (see Figure 11-54). The VIO core
input values are periodically updated based on the value of the refresh rate of the VIO core.
You can set the refresh rate by changing the Refresh Rate (ms) in the VIO Properties
window or by running the following Tcl command:

set_property CORE_REFRESH_RATE MS 1000 [get_hw vios hw_vio_1]

Note: Setting the refresh rate to 0 causes all automatic refreshes from the VIO core to stop. Also
note that very small refresh values may cause your Vivado IDE to become sluggish. Xilinx
recommends a refresh rate of 500 ms or longer.

If you want to manually read a VIO input probe value, you can use Tcl commands to do so.
For instance, if you wanted to refresh and get the value of the input probe called
BUTTON_IBUF of the VIO core hw_vio_1, run the following Tcl commands:

refresh_hw_vio [get_hw_vios {hw_vio_1}]
get_property INPUT_VALUE [get_hw_probes BUTTON_IBUF]
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Setting the VIO Input Display Type and Radix

The display type of VIO input probes can be set by right-clicking a VIO input probe in the
VIO Probes window of the VIO Dashboard window and selecting:

« Text to display the input as a text field. This is the only display type for VIO input probe
vectors (more than one bit wide).

« LED to display the input as a graphical representation of a light-emitting diode (LED).
This display type is only applicable to VIO input probe scalars and individual elements
of VIO input probe vectors. You can set the high and low values to one of four colors:

Gray (off)
Red
Green

Blue

When the display type of the VIO input probe is set to Text, you can change the radix by
right-clicking a VIO input probe in the VIO Probes window of the VIO Dashboard window
and selecting:

« Radix > Binary to change the radix to binary.

+ Radix > Octal to change the radix to octal.

« Radix > Hex to change the radix to hexadecimal.

« Radix > Unsigned to change the radix to unsigned decimal.

« Radix > Signed to change the radix to signed decimal.

You can also set the radix of the VIO input probe using a Tcl command. For instance, to
change the radix of a VIO input probe called "BUTTON_IBUF”, run the following Tcl
command:

set_property INPUT_VALUE_RADIX HEX [get_hw_probes BUTTON_IBUF]

Observing and Controlling VIO Input Activity

In addition to reading values from the VIO input probes, you can also monitor the activity
of the VIO input probes. The activity detectors are used to indicate when the values on the
VIO inputs have changed in between periodic updates to the Vivado IDE.

The VIO input probe activity values are shown as arrows in the activity column of the VIO
Probes window of the VIO Dashboard window:

« Anup arrow indicates that the input probe value has transitioned from a 0 to a 1 during
the activity persistence interval.
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« A down arrow indicates that the input probe value has transitioned fromaltoa0
during the activity persistence interval.

« A double-sided arrow indicates that the input probe value has transitioned from a 1 to
a 0 and from a 0 to a 1 at least once during the activity persistence interval.

The persistence of how long the input activity status is displayed can be controlled by
right-clicking a VIO input probe in the VIO Probes window of the VIO Dashboard window
and selecting:

« Activity Persistence > Infinite to accumulate and retain the activity value until you
reset it.

« Activity Persistence > Long (80 samples) to accumulate and retain the activity for a
longer period of time.

« Activity Persistence > Short (8 samples) to accumulate and retain the activity for a
shorter period of time.

You can also set the activity persistence using a Tcl command. For instance, to change the
activity persistence on the VIO input probe called BUTTON_IBUF to a long interval, run the
following Tcl command:

set_property ACTIVITY_ PERSISTENCE LONG [get_hw probes BUTTON_IBUF]

The activity for all input probes for a given core can be reset by right-clicking the VIO core
in the Hardware window and selecting Reset All Input Activity. You can also do this by
running the following Tcl command:

reset_hw_vio_activity [get_hw_vios {hw_vio_1}]

TIP: You can change the type, radix, and/or activity persistence of multiple scalar members of a VIO
O input probe vector by right-clicking the whole probe or multiple members of the probe, then making a
menu choice. The menu choice applies to all selected probe scalars.

Interacting with VIO Core Output Probes

The VIO core output probes are used to write values to a design that is running in an FPGA
device in actual hardware. The VIO output probes are typically used as low-bandwidth
control signals for a design-under-test. VIO debug probes need to be added manually to
the VIO Probes window in the VIO Dashboard. Refer to the section called Viewing VIO
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Cores in the Debug Probes Window on how to do this. An example of what VIO output
probes look like in the VIO Probes window of the VIO Dashboard is shown in Figure 11-55.

hw_vio_1

Me !

Q $ +

MName Value Acti.. D.. 1 VIO

> 5 fast_cnt_load_val[31:0] [H] 0000_0000 - OQutput hw_viao_1

> g fast_cnt_incr_val[30:0] [H] 0000_0001 - OQutput hw_viao_1
a fast_cnt_up_down 1 Output hw_vio_1
a fast_vio_ila_trig 0 Output hw_vio_1
a fast_vio_slice1_fb 0 Output hw_vio_1

> 5 fast_vio_slice5_fb[4:0] [H] 00 - OQutput hw_viao_1
a fast_cnt_count_en 1 hw_vio_1
a fast_cnt_load_en 0 Output hw_vio_1
la fast_cnt_reset_1 0 Output hw_vio_1

> 5 fast_vio_feedback[31:0] [H] AASS_9966 - OQutput hw_viao_1
a fast_vio_slice1a_fb 0 Output hw_vio_1

> 5 fast_vio_slice15_fb[14:0] [H] 0000 - OQutput hw_viao_1

Figure 11-55: VIO Outputs in the VIO Probes window of the VIO Dashboard

Writing VIO Outputs Using the VIO Cores View

The VIO output probes can be set using the VIO Probes window of the VIO Dashboard
window. Each output probe is viewed as a separate row in the table. The value of the VIO
output probes are shown in the Value column of the table (see Figure 11-55). The VIO core
output values are updated whenever a new value is entered into the Value column. Clicking
on the Value column causes a pull-down dialog to appear. Type the desired value into the
Value text field and click OK.

You can also write out a new value to the VIO core using Tcl commands. For instance, if you
wanted to write a binary value of "11111" to the VIO output probe called
vio_slice5_£fb_2 whose radix is already set to BINARY, run the following Tcl commands:

set_property OUTPUT _VALUE 11111 [get_hw_probes vio_slice5_fb_2]
commit_hw_vio [get_hw probes {vio_slice5_fb_2}]

Setting the VIO Output Display Type and Radix

The display type of VIO output probes can be set by right-clicking a VIO output probe in the
VIO Probes window of the VIO Dashboard window and selecting:

« Text to display the output as a text field. This is the only display type for VIO input
probe vectors (more than one bit wide).
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« Toggle Button to display the output as a graphical representation of a toggle button.
This display type is only applicable to VIO output probe scalars and individual elements
of VIO input probe vectors.

When the display type of the VIO output probe is set to “Text”, you can change the radix by
right-clicking a VIO output probe in the VIO Cores tabbed view of the Debug Probes
window and selecting:

« Radix > Binary to change the radix to binary.

+ Radix > Octal to change the radix to octal.

« Radix > Hex to change the radix to hexadecimal.

+ Radix > Unsigned to change the radix to unsigned decimal.

« Radix > Signed to change the radix to signed decimal.

You can also set the radix of the VIO output probe using a Tcl command. For instance, to

change the radix of a VIO output probe called "vio_slice5_fb_2" to hexadecimal, run the
following Tcl command:

set_property OUTPUT_VALUE_RADIX HEX [get_hw_probes vio_slice5_fb_2]

Resetting the VIO Core Output Values

The VIO v2.0 core has a feature that allows you to specify an initial value for each output
probe port. You can reset the VIO core output probe ports to these initial values by
right-clicking the VIO core in the Hardware window and selecting the Reset VIO Core
Outputs option. You can also reset the VIO core outputs using a Tcl command:

reset_hw_vio_outputs [get_hw vios {hw_vio_1}]

Note: Resetting the VIO output probes to their initial values may cause the output probe values to
become out-of-sync with the Vivado IDE. Refer to the section called Synchronizing the VIO Core
Output Values to the Vivado IDE on how to handle this situation.

Synchronizing the VIO Core Output Values to the Vivado IDE

The output probes of a VIO core can become out-of-sync with the Vivado IDE after resetting
the VIO outputs, re-programming the FPGA, or by another Vivado tool instance setting
output values before the current instance has started. In any case, if the VIO status indicates
"Outputs out-of-sync”, you need to take one of two actions:

« Write the values from the Vivado IDE to the VIO core by right-clicking the VIO core in
the Hardware window and selecting the Commit VIO Core Outputs option. You can
also do this running a Tcl command:

commit_hw_vio [get_hw_vios {hw_vio_1}]
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Vivado Programming and Debugging

« Update the Vivado IDE with the current values of the VIO core output probe ports by
right-clicking the VIO core in the Hardware window and selecting the Refresh Input
and Output Values from VIO Core option. You can also do this running a Tcl
command:

refresh_hw _vio -update_output_values 1 [get_hw_vios {hw_vio_1}]

Hardware System Communication Using the
JTAG-to-AXI Master Debug Core

The JTAG-to-AXI Master debug core is a customizable core that can generate the AXI
transactions and drive the AXI signals internal to an FPGA at run time. The core supports all
memory mapped AXI and AXI-Lite interfaces and can support 32- or 64-bit wide data
interfaces.

The JTAG-to-AXI Master (JTAG-AXI) cores that you add to your design appear in the
Hardware window under the target device. If you do not see the JTAG-AXI cores appear,
right-click the device and select Refresh Hardware. This re-scans the FPGA device and
refreshes the Hardware window.

Note: If you still do not see the ILA core after programming and/or refreshing the FPGA device,
check to make sure the device was programmed with the appropriate .bit file and check to make
sure the implemented design contains an ILA core.

Click to select the JTAG-AXI core (called hw_axi_1 in Figure 11-56) to see its properties in
the AXI Core Properties window.

Hardware ? 008 X
Q = 2 o
MName Status
~ B localhost (1 Connected -
~ @ xiling_tcfiXilingPort_#0003Hu..  Open
~ {8 xcTk3Z5L 0 (7 Programmed
& XADC (System Monitor
SE hw_jla_1 (i_fast_i O 1dle
S hw_vio_1 (i_fast_vio OK - Outputs Reset
SE hw_axi_1 (AXI)
SE hw_jla_2 (i_slow_ila O 1dle

FE huae win B closs uin A Mudnote Dot e
>

Figure 11-56: JTAG-to-AXI Master Core in the Hardware Window
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Interacting with the JTAG-to-AXI Master Debug Core in
Hardware

The JTAG-to-AXI Master debug core can only be communicated with using Tcl commands.
You can create and run AXI read and write transactions using the create_hw_axi_txn
and run_hw_axi commands, respectively.

Resetting the JTAG-to-AXI Master Debug Core

Before creating and issuing transactions, it is important to reset the JTAG-to-AXI Master
core using the following Tcl command:

reset_hw_axi [get_hw_axis hw_axi_1]

Creating and Running a Read Transaction

The Tcl command used to create an AXI transaction is called create_hw_axi_txn. For
more information on how to use this command, type "help create_hw_axi_txn" at the
Tcl Console in the Vivado IDE. Here is an example on how to create a 4-word AXI read burst
transaction from address O:

create_hw_axi_txn read_txn [get_hw axis hw_axi_1] -type READ -address 00000000 -len 4
where:

« read_txn is the user-defined name of the transaction
* [get_hw_axis hw_axi_1] returns the hw_axi_1 object
e -—address 00000000 is the start address

« -len 4 setsthe AXI burst length to 4 words

The next step is to run the transaction that was just created using the run_hw_axi
command. Here is an example on how to do this:

run_hw_axi [get_hw_axi_txns read_txn]

The last step is to get the data that was read as a result of running the transaction. You can
use either the report_hw_axi_txn or report_property commands to print the data
to the screen or you can use the get_property command to return the value for use
elsewhere.
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report_hw_axi_txn [get_hw axi_txns read_txn]

0 00000000 00000000
8 00000000 00000000

report_property [get_hw axi_txns read_txn]

Property Type Read-only Visible Value
CLASS string true true hw_axi_txn
CMD . ADDR string false true 00000000
CMD.BURST enum false true INCR
CMD.CACHE int false true 3

CMD.ID int false true 0

CMD.LEN int false true 4

CMD.SIZE enum false true 32

DATA string false true 00000000000000000000000000000000
HW_AXT string true true hw_axi_1
NAME string true true read_txn
TYPE enum false true READ

Creating and Running a Write Transaction
Here is an example on how to create a 4-word AXI write burst transaction from address 0:

create_hw_axi_txn write_txn [get_hw_axis hw_axi_1] -type WRITE -address 00000000 \
-len 4 -data {11111111_22222222_33333333_44444444}%

where:

« write_txn is the user-defined name of the transaction

* [get_hw_axis hw_axi_1] returns the hw_axi_1 object
« -address 00000000 is the start address

« -len 4 setsthe AXI burst length to 4 words

e -data {11111111 22222222 33333333_44444444}- The -data direction is LSB
to the left (i.e., address 0) and MSB to the right (i.e., address 3).

The next step is to run the transaction that was just created using the run_hw_axi
command. Here is an example on how to do this:

run_hw_axi [get_hw_axi_txns write_txn]

f IMPORTANT: /f you reprogram the device, all the existing jtag_axi transactions will be deleted. You may
need to recreate these transactions again.

TIP: The -queue optional argument to the run_hw_axi Tcl command allows you to specify hw_axi
O transactions in queue mode.
Queued operation allows up to 16 read and 16 write transactions to be queued in the JTAG to AX/
Master FIFO and issued back-to-back for low latency and higher performance between the
transactions. Non-queued transactions are simply run as submitted.
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Using Vivado Logic Analyzer in a Lab Environment

The Vivado logic analyzer feature is integrated into the Vivado IDE and Vivado Lab Edition.
To use Vivado logic analyzer feature to debug a design that is running on a target board
that is in a lab environment, you need to do one of three things:

« Install and run the Vivado Lab Edition on your lab machine. For more details refer to
Chapter 2, Vivado Lab Edition of this user guide.

« Install and run the full Vivado IDE on your lab machine.

« Install latest version of the Vivado Design Suite or Vivado Hardware Server
(Standalone) on your remote lab machine, and use the Vivado logic analyzer feature on
your local machine to connect to a remote instance of the Vivado Hardware Server
(hw_server).

Connecting to a Remote hw_server Running on a Lab Machine

If you have a network connection to your lab machine, you can also connect to the target
board by connecting to a Hardware Server that is running on that remote lab machine. Here
are the steps to using the Vivado logic analyzer feature to connect to a Vivado Hardware

Server (hw_server.bat on Windows platforms or hw_server on Linux platforms) that is
running on the lab machine:

1. Install the latest version of the Vivado Design Suite or Vivado Hardware Server
(Standalone) on the lab machine.

ﬁ IMPORTANT: You do NOT need to install the full Vivado Design Suite or Vivado Lab Edition on the lab
machine to only use the remote hardware server feature. However, if you do want to use the Vivado
Hardware Manager features (such as the Vivado logic analyzer or Vivado serial I/O analyzer) on the lab
machine, then you will need to install the Vivado Lab Edition on the lab machine. Also, you do NOT
need any software licenses to run the Hardware Server, any of the Hardware Manager features of the
Vivado Design Suite, or the Vivado Lab Edition.

2. Start up the hw_server application on the remote lab machine. Assuming you installed
the Vivado Hardware Server (Standalone) to the default location and your lab machine
is a 64-bit Windows machine, here is the command line:

C:\Xilinx\VivadoHWSRV\vivado_release.version\bin\hw_server.bat

3. Start Vivado IDE in GUI mode on a different machine than your lab machine.

4. Follow the steps in the Connecting to the Hardware Target and Programming the FPGA
Device section to open a connection to the target board that is connected to your lab
machine. However, instead of connecting to a Vivado CSE server running on localhost,
use the host name of your lab machine.
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5. Follow the steps in the Setting up the ILA Core to Take a Measurement section and
beyond to debug your design in hardware.

Description of Hardware Manager Tcl Objects and
Commands

You can use Tcl commands to interact with your hardware under test. The hardware is
organized in a set of hierarchical first class Tcl objects (see Table 11-9).

Table 11-9: Hardware Manager Tcl Objects

Tcl Object Description

hw_server Object referring to hardware server. Each hw_server can
have one or more hw_target objects associated with it.

hw_target Object referring to JTAG cable or board. Each hw_target can
have one or more hw_device objects associated with it.

hw_device Object referring to a device in the JTAG chain, including
Xilinx FPGA devices. Each hw_device can have one or more
hw_ila objects associated with it.

hw_ila Object referring to an ILA core in the Xilinx FPGA device.
Each hw_ila object can have only one hw_ila_data object
associated with it. Each hw_ila object can have one or more
hw_probe objects associated with it.

hw_ila_data Object referring to data uploaded from an ILA debug core.
hw_probe Object referring to the probe input of an ILA debug core.
hw_vio Object referring to a VIO core in the Xilinx FPGA device.

For more information about the Hardware Manager commands, run the help -category
hardware Tcl command in the Tcl Console.

Description of hw_server Tcl Commands

Table 11-10 contains descriptions of all Tcl commands used to interact with hardware
servers.

Table 11-10: Descriptions of hw_server Tcl Commands

Tcl Command Description

connect_hw_server Open a connection to a hardware server.
current_hw_server Get or set the current hardware server.
disconnect_hw_server Close a connection to a hardware server.

get_hw_servers Get list of hardware server names for the hardware servers.
refresh_hw_server Refresh a connection to a hardware server.
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Description of hw_target Tcl Commands

Table 11-11 contains descriptions of all Tcl commands used to interact with hardware
targets.

Table 11-11: Descriptions of hw_target Tcl Commands

Tcl Command Description

close_hw_target Close a hardware target.

current_hw_target Get or set the current hardware target.

get_hw_targets Get list of hardware targets for the hardware servers.

open_hw_target Open a connection to a hardware target on the hardware
server.

refresh_hw_target Refresh a connection to a hardware target.

Description of hw_device Tcl Commands

Table 11-12 Descriptions of hw_device Tcl Commands contains descriptions of all Tcl
commands used to interact with hardware devices.

Table 11-12: Descriptions of hw_device Tcl Commands

Tcl Command Description

current_hw_device Get or set the current hardware device.
get_hw_devices Get list of hardware devices for the target.
program_hw_device Program Xilinx FPGA devices.
refresh_hw_device Refresh a hardware device.

Description of hw_ila Tcl Commands

Table 11-13 Descriptions of hw_ila Tcl Commands contains descriptions of all Tcl commands
used to interact with ILA debug cores.

Table 11-13: Descriptions of hw_ila Tcl Commands

Tcl Command Description

current_hw_ila Get or set the current hardware ILA.

get_hw_ilas Get list of hardware ILAs for the target.
reset_hw_ila Reset hw_ila control properties to default values.
run_hw_ila Arm hw_ila triggers.

wait_on_hw_ila Wait until all data has been captured.
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Description of hw_ila_data Tcl Commands

Table 11-14 Descriptions of hw_ila_data Tcl Commands contains descriptions of all Tcl
commands used to interact with captured ILA data.

Table 11-14: Descriptions of hw_ila_data Tcl Commands

Tcl Command Description

current_hw_ila_data Get or set the current hardware ILA data.

display_hw_ila_data Display hw_ila_data in waveform viewer.

get_hw_ila_data Get list of hw_ila_data objects.

list_hw_samples Lists data samples associated with an individual hardware
probe.

read_hw_ila_data Read hw_ila_data from a file.

upload_hw_ila_data Stop the ILA core from capturing data and upload any
captured data.

write_hw_ila_data Write hw_ila_data to a file.

Description of hw_probe Tcl Commands

Table 11-15 contains descriptions of all Tcl commands used to interact with captured ILA
data.

Table 11-15: Descriptions of hw_probe Tcl Commands

Tcl Command Description

create_hw_probe Creates a new hardware probe from physical ILA probe
ports and/or constant values.

delete_hw_probe Deletes a user-defined hardware probe creating using the
create_hw_probe command

get_hw_probes Get list of hardware probes.
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hw_vio Tcl Commands

Table 11-16 contains descriptions of all Tcl commands used to interact with VIO cores.

Table 11-16: Descriptions of hw_vio Tcl Commands

Tcl Command

Description

commit_hw_vio

Write hw_probe OUTPUT_VALUE properties values to VIO
cores.

get_hw_vios

Get a list of hw_vios

refresh_hw_vio

Update hw_probe INPUT_VALUE and ACTIVITY_VALUE
properties with values read from VIO cores.

reset_hw_vio_activity

Reset VIO ACTIVITY_VALUE properties, for hw_probes
associated with specified hw_vio objects.

reset_hw_vio_outputs

Reset VIO core outputs to initial values.

Description of hw_axi and hw_axi_txn Tcl Commands

Table 11-17 contains descriptions of all Tcl commands used to interact with JTAG-to-AXI

Master cores.

Table 11-17: Description of hw_axi and hw_axi_txn Tcl Commands

Tcl Command

Description

create_hw_axi_txn

Creates hardware AXI transaction object.

delete_hw_axi_txn

Deletes hardware AXI transaction objects.

get_hw_axi_txns

Gets a list of hardware AXI transaction objects.

get_hw_axis

Gets a list of hardware AXI objects.

refresh_hw_axi

Refreshes hardware AXI object status.

report_hw_axi_txn

Reports formatted hardware AXI transaction data.

reset_hw_axi

Resets hardware AXI core state.

run_hw_axi

Runs hardware AXI read/write transactions and update transaction
status in the corresponding hw_axi object.
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Description of hw_sysmon Tcl Commands

Table 11-18 contains descriptions of all Tcl commands used to interact with System Monitor

core.

Table 11-18: Descriptions of hw_sysmon Tcl commands

Tcl Command

Description

commit_hw_sysmon

Commits the current property values defined on a
hw_sysmon object to the System Monitor registers
on the hardware device.

get_hw_sysmon_reg

Returns the hex value of the System Monitor
register defined at the specified address of the
specified hw_sysmon object.

get_hw_sysmons

Returns the list of Sysmon debug core objects
defined on the current hardware device.

refresh_hw_sysmon

Refreshes the properties of the hw_sysmon object
with the values on the System Monitor from the
current hw_device.

set_hw_sysmon_reg

Sets the System Monitor register at the specified
address to the hex value specified.

Note: Detailed help for each of these commands can be obtained by typing <command name>

-help on the Vivado Tcl Console.

Using Tcl Commands to Interact with a JTAG-to-AXI

Master Core

Below is an example Tcl command script that interacts with the following example system:

« One KC705 board's Digilent JTAG-SMTL1 cable (serial number 12345) accessible via a
Vivado hw_server running on localhost:3121.

« Single JTAG-to-AXI Master core in a design running in the XC7K325T device on the

KC705 board.

« JTAG-to-AXI Master core is in an AXI-based system that has an AXI BRAM Controller

Slave core in it.
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Example Tcl Command Script

# Connect to the Digilent Cable on localhost:3121
connect_hw_server -url localhost:3121

current_hw_target [get_hw_targets */xilinx_ tcf/Digilent/12345]
open_hw_target

# Program and Refresh the XC7K325T Device

current_hw_device [lindex [get_hw_devices] 0]

refresh_hw device -update_hw_probes false [lindex [get_hw_devices] 0]
set_property PROGRAM.FILE {C:/design.bit} [lindex [get_hw_devices] 0]
set_property PROBES.FILE {C:/design.ltx} [lindex [get_hw_devices] 0]
program_hw_devices [lindex [get_hw_devices] 0]

refresh_hw_device [lindex [get_hw_devices] 0]

# Reset the JTAG-to-AXI Master core
reset_hw _axi [get_hw axis hw_axi_1]

# Create a read transaction bursts 128 words starting from address 0
create_hw_axi_txn read_txn [get_hw axis hw_axi_1] -type read \
-address 00000000 -len 128

# Create a write transaction bursts 128 words starting at address 0

# using a repeating fill value of 11111111 22222222 33333333_44444444
# (where LSB is to the left)

create_hw_axi_txn write_txn [get_hw_axis hw_axi_1] -type write \
-address 00000000 -len 128 -data {11111111_22222222_33333333_44444444}

# Run the write transaction
run_hw_axi [get_hw_axi_txns wrte_txn]

# Run the read transaction
run_hw_axi [get_hw_axi_txns read_txn]

Using Tcl Commands to Take an ILA Measurement

Below is an example Tcl command script that interacts with the following example system:

« One KC705 board’s Digilent JTAG-SMTL1 cable (serial number 12345) accessible via a
Vivado CSE server running on localhost:3121.

« Single ILA core in a design running in the XC7K325T device on the KC705 board.

« ILA core has a probe called counter[3:0].
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Example Tcl Command Script

# Connect to the Digilent Cable on localhost:3121
connect_hw_server -url localhost:3121

current_hw_target [get_hw_targets */xilinx_ tcf/Digilent/12345]
open_hw_target

# Program and Refresh the XC7K325T Device

current_hw_device [lindex [get_hw_devices] 0]

refresh_hw device -update_hw_probes false [lindex [get_hw_devices] 0]
set_property PROGRAM.FILE {C:/design.bit} [lindex [get_hw_devices] 0]
set_property PROBES.FILE {C:/design.ltx} [lindex [get_hw_devices] 0]
program_hw_devices [lindex [get_hw_devices] 0]

refresh_hw_device [lindex [get_hw_devices] 0]

# Set Up ILA Core Trigger Position and Probe Compare Values
set_property CONTROL.TRIGGER_POSITION 512 [get_hw_ilas hw_ila_1]
set_property COMPARE_VALUE.O eg4'b0000 [get_hw_probes counter]

# Arm the ILA trigger and wait for it to finish capturing data
run_hw _ila hw _ila_ 1
wait_on_hw ila hw_ila_ 1

# Upload the captured ILA data, display it, and write it to a file
current_hw_ila_data [upload_hw_ila _data hw_ila_1]
display_hw_ila_data [current_hw_ila_data]

wite hwila data ny_hw.ila data [current_hw_ il a_data]

Trigger At Startup

The Trigger at Startup feature is used to configure the trigger settings of an ILA core in a
design .bit file so thatitis pre-armed to trigger immediately after device startup. You do
this by taking the various trigger settings that ordinarily get applied to an ILA core running
in a design in hardware, and applying them to the ILA core in the implemented design.
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i} IMPORTANT: The following process for using Trigger at Startup assumes that you are have a valid ILA
design working in hardware, and that the ILA core has NOT been flattened during the synthesis flow.

To use the Trigger at Startup feature perform the following steps:

1. Run through the first pass of the ILA flow as usual to set up the trigger condition.
a. Open the target, configure the device, and bring up the ILA Dashboard.
b. Enter the trigger equations for the ILA core in the ILA Dashboard.

2. From the Vivado Tcl command line, export the trigger register map file for the ILA core.
This file contains all of the register settings to "stamp" back on to the implemented
netlist. The output from this is a single file.

% run_hw _ila -file ila_trig.tas [get_hw_ilas hw_ila_1]

3. Go back and open the previously implemented routed design in Vivado IDE. There are
two ways to do this depending on your project flow.

a. Project Mode: Use the Flow Navigator to open the implemented design.

b. Non-Project Mode: Open your routed checkpoint: $open_checkpoint
<file>.dcp

4. AttheImplemented Design Tcl Console, apply the trigger settings to the current design
in memory, which is your routed netlist.

%apply_hw_ila_trigger ila_trig.tas

Note: If you see an ERROR indicating that the ILA core has been flattened during synthesis, you
will need to regenerate your design and force synthesis to preserve hierarchy for the ILA core.
Ensure that you are have a valid ILA design working in hardware, and that the ILA core has NOT
been flattened during the synthesis flow.

5. At the Implemented Design Tcl Console, write the bitstream with Trigger at Startup
settings.

ﬁ IMPORTANT: To pick up the routed design changes do this at the Tcl command console only:

write_bitstream trig_at_startup.bit

6. Go back to the Hardware Manager and reconfigure with the new .bit file that you
generated in the previous step. You will have to set the property for the updated .bit
file location either through the GUI or through a Tcl command. Make sure you set the
new .bit file as the one to use for configuration in the hardware tool.

a. Select the device in the hardware tree.
b. Assign the .bit file generated in step 5.

7. Program the device using the new .bit file.
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Once programmed, the new ILA core should immediately arm at startup. You should see an
indication in the Trigger Capture Status for the ILA core. If trigger or capture events have
occurred, the ILA core is now populated with captured data samples.

Memory Calibration Debug

Memory Interface IPs in Vivado support calibration debug. They store useful core
configuration, calibration, and data window information within an internal BRAM. The
Memory Calibration Debug can be used at any point to read out this information and get
valuable statistics and feedback from the memory interface IPs. The information can be
viewed through a Memory Calibration Debug GUI in the Vivado Hardware Manager or
through available Memory Calibration Debug Tcl commands.

Memory Calibration Debug GUI Usage

Upon configuring the device, the memory interfaces are visible in the Vivado Hardware
Manager.

Memory calibration content are shown in a a debug interface that can be used to very
quickly identify calibration status, and read and write window margin. This debug interface
is always included in the generated Memory Interface (UltraScale™, and UltraScale+™)
designs.
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Figure 11-57: Memory Calibration Debug Interface
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Memory Calibration Debug Tcl Usage

Use the following Tcl commands in the Vivado Tcl Console when connected to the hardware
in Vivado Hardware Manager to output all memory calibration debug content that is
displayed in the Vivado IDE.

e get_hw_migs

- Displays what memory interfaces exist in the design.
e refresh_hw _mig [lindex [get_hw_migs] 0]

o Refreshes only the memory interfaces denoted by index (index begins with 0).
e report_properyl[lindex [get_hw_migs] 0]

o Reports all of the parameters available for the memory interface.

- Where 0 is the index of the memory interface to be reported (index begins with 0).

For more specific details see the UltraScale or 7 Series Memory Calibration debug
commands in the following documents:

« Xilinx Answer 43879, MIG 7 Series DDR3/DDRZ2 - Hardware Debug Guide.

e UltraScale Architecture-Based FPGAs Memory IP LogiCORE IP Product Guide (PG150)
[Ref 35].

Debugging Partial Reconfigurable Designs in
Vivado Hardware Manager

Vivado® Hardware Manager supports debugging on Partial Reconfigurable designs. In
order to successfully debug such a design it is necessary to program the full design
bitstream before programming the partial bitstream to replace specific reconfigurable
modules.

For an example of instantiating debug cores in a Partial Reconfiguration design, as well as
functionality within the Vivado Hardware Manager, see this link in Vivado Design Suite
Tutorial: Partial Reconfiguration (UG947) [Ref 4].

High Bandwidth Memory (HBM) Monitor

Certain Virtex® UltraScale+™ FPGAs include an integrated High Bandwidth Memory (HBM)
controller and memory stacks. The integrated HBM controller and memory stacks contain
both performance counters and temperature sensors. The HBM monitor can be used at any
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time to gain real-time access, capture, and export of performance monitoring and
temperature sensors on the HBM die.

HBM Monitor GUI Usage

After configuring an HBM enabled device with a design that contains an instance of the AXI
High Bandwidth Memory Controller, you can see the HBM interfaces in the Vivado
Hardware Manager.

Support for the HBM monitor is always included in the generated High Bandwidth Memory
Controller. The HBM monitor displays the stack temperature, read, write, and overall
throughput.

You can export the captured data to a comma separated value (CSV) formatted text file for
further post-processing or analysis.
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Figure 11-58: Viewing Live Performance

HBM Monitor Tcl Usage

Use the following Tcl commands in the Vivado Tcl Console when connected to the hardware
in the Vivado Hardware Manager to interact with the HBM Monitor.

« get_hw_hbms - Displays a list of the HBM interfaces that exist in the design.

| Send Feedback I 238

www.Xxilinx.com


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=238

2: X”_INX® Chapter 11: Debugging Logic Designs in Hardware

e refresh hw _hbm [lindex [get_hw_hbms] 0] - Refreshes the status of the
specified hardware HBM(s), in this case the HBM denoted by index 0.

« report_property [lindex [get_hw_hbms] 0] - Reports all the parameters
available for the HBM interface specified, in this case for the HBM interface denoted by
index 0.

* run_hw_hbm_amon [lindex [get_hw_hbms] 0] - Enables the activity monitor
runs for the specified hardware HBM(s).

 stop_hw_hbm_amon [lindex [get_hw_hbms] 0] - Disables the Activity Monitor
runs for the specified hardware HBM(s).

More specific details and examples can be found in Appendix D of AXI High Bandwidth
Memory Controller, LogiCORE IP Product Guide, (PG276) [Ref 35].
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Introduction

The ILA waveform viewer in the Vivado® Integrated Design Environment (IDE) provides a
powerful way to analyze data captured from the ILA Debug Core. After successfully
triggering an ILA core and capturing data, Vivado automatically populates a corresponding
waveform viewer with data collected from the ILA core. When using Vivado in project mode,
configurable waveform settings such as coloring, radix selection, and signal ordering
persist and are conveniently remembered between Vivado sessions.

ILA Data and Waveform Relationship

It is useful to understand the relationship between the hw_ila_data captured ILA data object
and the waveform, as shown in Figure 12-1.

Waveform Display

hw_ila hw_ila_data
trigger

WDB
Transitions

Figure 12-1: ILA Data and Waveform Relationship

The hw_ila Tcl object represents the ILA core in hardware. Every time an ILA core uploads
captured data, it is stored in memory in a corresponding Tcl hw_ila_data object. These
objects are named predictably so the first ILA core in hardware 'hw_1ila_1" produces data
in a corresponding Tcl data object named 'hw_ila_data_1" after trigger and upload.
When working online with hardware, every waveform is backed by the in-memory
hw_ila_data object and has a 1:1 correspondence with this object illustrated by the
diagram in Figure 12-1. For each Tcl hw_ila_data object, a wave database (WDB) file and
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wave configuration (WCFG) file are created and automatically tracked in a directory of the
Vivado project. Figure 12-1 illustrates the flow of data from the hardware hw_ila on the left
through to the waveform display on the right.

The combination of the wave configuration, WCFG, file and wave transition database, WDB,
file contain the waveform database and customizations displayed in the Vivado waveform
user interface. These waveform files are automatically managed in the Vivado ILA flow and
users are not expected to modify the WDB or WCFG files directly. The wave configuration
can be modified by changing objects in the waveform viewer (such as signal color, bus
radix, signal order, markers, etc). This automatically saves the wave configuration changes
to the appropriate WCFG file in the Vivado project.

It is possible to archive waveform configurations and data for later viewing by using the Tcl
command write _hw_ila_data. This stores the hw_ila_data, wave database and wave
configuration in an archive for later viewing offline. See the section, Saving and Restoring
Captured Data from the ILA Core for details on using read_hw_ila_data and
write_hw_ila_data for offline storage and retrieval of waveforms.

Waveform Viewer Layout

The ILA waveform viewer (sometimes referred to as waveform configuration) is composed
of several dynamic objects working together to provide a complete visualization tool for the
captured ILA data, as shown in Figure 12-2.

Waveform - hw_ila_1 £l
Q|+ e b » H B @ Q| « | |4 » T Tm ol o

ILA Status:idle

X18959-032717

Figure 12-2: Waveform Viewer Showing Captured ILA Data
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The description for the labeled objects in Figure 12-2 is as follows:

Net or Bus Name from the ILA probes file (. 1tx)
Net or Bus Value at the cursor

Trigger Markers (red lines)

Cursor (yellow line)

Markers (blue line)

ILA capture window transitions (alternating clear/grey regions)

N o v A W N e

Floating measurement ruler (yellow bar)

Waveform Viewer Operation

The scalars and buses shown in the Name column of the wave viewer represent the names
of the probe design objects in the waveform (see Figure 12-3). These correspond to the
hardware probes of the ILA core (see the get_hw_probes Tcl command).

Waveform - hw_ila_1

Q + > > » H B @ Q
ILA Status:ldle

Name Value
B fast_cnt_count[31:0] 4ee3b77h
BT cnt_load_val_1[31:

cnt_incr_val_1[30:0

cnt_reset
t_cnt_load_en_1

cnt_count_en_1

cnt_up_down_1

Figure 12-3: ILA Probe Names and Values Shown in Waveform Viewer

Immediately after triggering and uploading ILA data for the first time, the waveform viewer
populates with all probes connected to the ILA core. It is possible to customize probes in
the viewer in addition to removing existing probes or adding new probes to the viewer. This
section covers the basic operation of the waveform viewer.
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Removing Probes from the Waveform

All probes by default are added to the waveform during the first trigger and upload
operation. If you do not want the waveform to contain all probes, it is simple to remove
probes from the viewer.

To remove a probe from the waveform viewer, right-click the scalar or bus to delete in the
Name column and select Delete from the pop up menu. Alternatively, select the signal or
bus to delete and press the Delete key. Probe transition data is not actually deleted from
memory it is just hidden from view when probes are removed.

Adding Probes to the Waveform

To add probes to the waveform, select the Probes to add for the associated ILA core in the
Debug Probes window, right-click, and select Add Probes to Waveform from the pop-up
menu.

To add another copy of a signal or bus to the Waveform window, select the signal or bus in
the Waveform window. Then select Edit > Copy or type Ctrl+C. This copies the object to
the clipboard. Select Edit > Paste or type Ctrl+V to paste a copy of the object in the
waveform.

You can do the same using the Tcl command add_wave as shown below.

add_wave -into {hw_ila_data_1.wcfg} -radix hex { {counterl} }

In this example, probe counterl is added to the Waveform Configuration window of
hw_ila_1 and its display radix in the Waveform window is set to hex.
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Using Waveform ILA Trigger and Export Features

Run Trigger Immediate

Run Trigger Stop Trigger

Auto Re-Trigger Export ILA Data
Waveform - hw_ila_l l ? - 0O X
Q + e > » W B @ g X = 4 [ Te o o

ILA Status:ldle

Hame

0
ni_load_en_1 0

ni_count_en_1 1

ni_up_down_1 1
o_ila_trig 0

o_feedback_1[31:0

Updated at: Z01l7-Mar-z1 15:2

¥

X16755-032717

Figure 12-4: Waveform ILA Trigger and Export Features

Enable Auto Re-Trigger: Select the Enable Auto Re-Trigger button on the Waveform
window toolbar to enable Vivado IDE to automatically re-arm the ILA core associated with
the Waveform window trigger after a successful trigger+upload+display operation has
completed.

The captured data displayed in the Waveform window corresponding to the ILA core is
overwritten upon each successful trigger event. The Auto Re-Trigger option can be used
with the Run Trigger and Run Trigger Immediate operations. Click the Stop Trigger button to
stop the trigger currently in progress.

Run Trigger: Arms the ILA core associated with the Waveform window to detect the
trigger event that is defined by the ILA core basic or advanced trigger settings.

Run Trigger Immediate: Arms the ILA core associated with the Waveform window to
trigger immediately regardless of the ILA core trigger settings. This command is useful for
detecting the "aliveness" of the design by capturing any activity at the probe inputs of the
ILA core.

Stop Trigger: Stops the ILA core trigger of the ILA associated with the Waveform window.
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Export ILA Data: Captures data from an ILA core and saves it to a file. The data can be
captured in either native, .csv, or .vcd format. On clicking this icon on the Waveform
window toolbar the following dialog box appears.

¢ ExportILA Data @

Export ILA waveform data in CSV, VCD or native format. Mative format files can
be imported using ‘Import ILA Data’ command from File menu.

ILA Core: | hw_ila_data_1 w

Format: Mative w

File: jo_Debugs’2U1?.‘h’proj_netlistl'proj_netlist.runss’impl_1fi|adata.i|a| HZ‘

Figure 12-5: Export ILA Data Dialog Box

The ILA core is the name of the ILA debug core to export data for. The format is a selection
among Native, CSV, and VCD formats.

» Native format configures the write_hw_ila_data command to export the ILA data
in the form of a default ILA file format file that can be used to import into Vivado and
back again at another point in time so that you can view previously captured ILA data.

« CSV format configures the write_hw_ila_data command to export the ILA data in
the form of a . csv file that can be used to import the data into a spreadsheet or
third-party application.

« VCD file format configures the write_hw_ila_data command to export the ILA data
in the form of a .vcd file that can be used to import into a third-party application or

viewer.

ﬁ IMPORTANT: While ILA data can be exported in the CSV, VCD, and native ILA format, only the native
ILA format can be imported into Vivado. Also, native ILA data imported into Vivado is supported only
for offline viewing of previously captured data. The probe signals cannot be used for other purposes

such as triggering, etc.

Using the Zoom Features

Toolbar buttons provide quick access to waveform zooming features (see Figure 12-6).
Alternatively, use the mouse wheel combined with the Ctrl key to zoom in and out of the
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currently selected waveform. It is important to note the zoom level is not persistent and will
be reset between Vivado sessions.

@ a <

Figure 12-6: Waveform Zoom Buttons

Waveform Settings

The waveform viewer allows you do customize the way objects are displayed.

When you select the Waveforms Settings button the Waveform Settings window in
Figure 12-7 opens:

? —_0OX

o

General | Colors Cc X
Radix: Hexadeci..

Elide Setting: | Middle  +
+' Draw waveform shadow
Show signal indices

< Show grid lines
+'| Show trigger markers
< Snap to Transition

+'| Floating Ruler

Figure 12-7: Waveform Settings

The options are as follows:

Vivado Programming and Debugging

Colors tab: Lets you choose custom colors for waveform objects
Radix: Sets the default radix for bus probes

Draw waveform shadow: Displays a light green shadow under scalar '1' to help
differentiate between '1' and '0’

Show signal indices: Display index position number to the left side of scalar and bus
names

Show trigger markers: Show (or hide) the red trigger markers in the wave viewer
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Customizing the Configuration

You can customize the Waveform configuration using the features that are listed and briefly
described in Table 12-1; the feature name links to the subsection that fully describes the
feature.

Table 12-1: Customization Features in the Waveform Configuration

Feature Description

Cursors The main cursor and secondary cursor in the Waveform
window let you display and measure time, and they form the
focal point for various navigation activities.

Markers You can add markers to navigate through the waveform, and
to display the waveform value at a particular time.

Dividers You can add a divider to create a visual separator of signals.

Using Groups You can add a group, that is a collection to which signals and

buses can be added in the wave configuration as a means of
organizing a set of related signals.

Using Virtual Buses You can add a virtual bus to your wave configuration, to which
you can add logic scalars and arrays.

Renaming Objects You can rename objects, signals, buses, and groups.

Radixes The default radix controls the bus radix that displays in the

wave configuration, Objects panel, and the Console panel.

Bus Bit Order You can change the Bus bit order from Most Significant Bit
(MSB) to Least Significant Bit (LSB) and vice versa.

Cursors

Cursors are used primarily for temporary indicators of sample position and are expected to
be moved frequently, as in the case when you are measuring the distance (in samples)
between two waveform edges.

TIP: For more permanent indicators, used in situations such as establishing a time-base for multiple
O measurements, add markers to the Wave window instead. See Markers for more information.

You can place the main cursor with a single click in the Waveform window.

To place a secondary cursor, Ctrl+Click and hold the waveform, and drag either left or right.
You can see a flag that labels the location at the top of the cursor.

Alternatively, you can hold the Shift key and click a point in the waveform. The main cursor
remains the original position, and the other cursor is at the point in the waveform that you
clicked.
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Note: To preserve the location of the secondary cursor while positioning the main cursor, hold the
Shift key while clicking. When placing the secondary cursor by dragging, you must drag a minimum
distance before the secondary cursor appears.

To move a cursor, hover over the cursor until you see the grab symbol, and click and drag
the cursor to the new location.

As you drag the cursor in the Waveform window, you see a hollow or filled-in circle if the
Snap to Transition button is selected, which is the default behavior.

« A hollow circle © indicates that you are between transitions in the waveform of the
selected signal.

. Afilled-in circle @ indicates that you are hovering over the waveform transition of the
selected signal. A secondary cursor can be hidden by clicking anywhere in the
Waveform window where there is no cursor, marker, or floating ruler.

Markers

Use a marker when you want to mark a significant event within your waveform in a
permanent fashion. Markers allow you to measure distance (in samples) relevant to that
marked event.

You can add, move, and delete markers as follows:

« You add markers to the wave configuration at the location of the main cursor.

a. Place the main cursor at the sample number where you want to add the marker by
clicking in the Waveform window at the sample number or on the transition.

b. Select Edit > Markers > Add Marker, or click the Add Marker button. +r

A marker is placed at the cursor, or slightly offset if a marker already exists at the
location of the cursor. The sample number of the marker displays at the top of the line.

« You can move the marker to another location in the waveform using the drag and drop
method. Click the marker label (at the top of the marker) and drag it to the location.

- The drag symbol BE indicates that the marker can be moved. As you drag the
marker in the Waveform window, you see a hollow or filled-in circle if the Snap to
Transition button is selected, which is the default behavior.

- Afilled-in circle @ indicates that you are hovering over a transition of the
waveform for the selected signal or over another marker.

o For markers, the filled-in circle is white.

- Ahollow circle O indicates that are you between transitions in the waveform of the
selected signal.

- Release the mouse key to drop the marker to the new location.
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* You can delete one or all markers with one command. Right-click over a marker, and do
one of the following:

o Select Delete Marker from the popup menu to delete a single marker.
o Select Delete All Markers from the popup menu to delete all markers.
Note: You can also use the Delete key to delete a selected marker.

- Use Edit > Undo to reverse a marker deletion.

Trigger Markers

The red trigger marker (whose label is a red letter 'T') a special marker that indicates the
occurrence of the trigger event in the capture buffer. The position of the trigger marker in
the buffer directly corresponds to the Trigger Position setting (see Using the ILA Default
Dashboard).

Note: The trigger markers are not movable using the same technique as regular markers. Set their
position using the ILA core's Trigger Position property setting.

Dividers

Dividers create a visual separator between signals. You can add a divider to your wave
configuration to create a visual separator of signals, as follows:

1. In a Name column of the Waveform window, click a signal to add a divider below that
signal.

2. From the popup menu, select Edit > New Divider, or right-click and select New Divider.

The change is visual and nothing is added to the HDL code. The new divider is saved with
the wave configuration file when you save the file.

You can move or delete Dividers as follows:

« Move a Divider to another location in the waveform by dragging and dropping the
divider name.

« To delete a Divider, highlight the divider, and click the Delete key, or right-click and
select Delete from the popup menu.

You can also rename Dividers; see Renaming Objects.
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Using Groups

A Group is a collection of expandable and collapsible categories, to which you can add
signals and buses in the wave configuration to organize related sets of signals. The group
itself displays no waveform data but can be expanded to show its contents or collapsed to
hide them. You can add, change, and remove groups.

To add a Group:

1. In a wave configuration, select one or more signals or buses to add to a group.
Note: A group can include dividers, virtual buses, and other groups.

2. Select Edit > New Group, or right-click and select New Group from the popup menu.
A Group that contains the selected signal or bus is added to the wave configuration.

A Group is represented with the Group button. '

The change is visual and nothing is added to the ILA core.

You can move other signals or buses to the group by dragging and dropping the signal or
bus name.

You can move or remove Groups as follows:

« Move Groups to another location in the Name column by dragging and dropping the
group name.

+ Remove a group, by highlighting it and selecting Edit > Wave Objects > Ungroup, or
right-click and select Ungroup from the popup menu. Signals or buses formerly in the
group are placed at the top-level hierarchy in the wave configuration.

Groups can be renamed also; see Renaming Objects.

C CAUTION! The Delete key removes the group and its nested signals and buses from the wave
configuration.

Using Virtual Buses

You can add a virtual bus to your wave configuration, which is a grouping to which you can
add logic scalars and arrays. The virtual bus displays a bus waveform, which shows the
signal waveforms in the vertical order that they appear under the virtual bus, flattened to a
one-dimensional array. You can then change or remove virtual buses after adding them.
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To add a virtual bus:

1. In a wave configuration, select one or more signals or buses you want to add to a virtual
bus.

2. Select Edit > New Virtual Bus, or right-click and select New Virtual Bus from the
popup menu.

The virtual bus is represented with the Virtual Bus button =
The change is visual and nothing is added to the HDL code.

You can move other signals or buses to the virtual bus by dragging and dropping the signal
or bus name. The new virtual bus and its nested signals or buses are saved when you save
the wave configuration file. You can also move it to another location in the waveform by
dragging and dropping the virtual bus name.

You can rename a virtual bus; see Renaming Objects.

To remove a virtual bus, and ungroup its contents, highlight the virtual bus, and select
Edit > Wave Objects > Ungroup, or right-click and select Ungroup from the popup menu.

C CAUTION! The Delete key removes the virtual bus and its nested signals and buses from the wave
configuration.

Renaming Objects

You can rename any object in the Waveform window, such as signals, dividers, groups, and
virtual buses.

Select the object name in the Name column.
Select Rename from the popup menu.

Replace the name with a new one.

> w N

Press Enter or click outside the name to make the name change take effect.

You can also double-click the object name and then type a new name. The change is
effective immediately. Object name changes in the wave configuration do not affect the
names of the nets attached to the ILA core probe inputs.
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Radixes

Understanding the type of data on your bus is important. You need to recognize the
relationship between the radix setting and the data type to use the waveform options of
Digital and Analog effectively. See Bus Radixes for more information about the radix setting
and its effect on Analog waveform analysis.

You can change the radix of an individual signal (ILA probe) in the Waveform window as
follows:

Right-click a bus in the Waveform window.
2. Select Radix and the format you want from the drop-down menu:
- Binary
- Hexadecimal
- Unsigned Decimal
- Signed Decimal
- Octal

i? IMPORTANT: Changes to the radix of an item in the Objects window do not apply to values in the
Waveform window or the Tcl Console. To change the radix of an individual signal (ILA probe) in the
Waveform window, use the Waveform window popup menu.

« Maximum bus width of 64 bits on real. Incorrect values are possible for buses wider
than 64 bits.

« Floating point supports only 32- and 64-bit arrays.

Using the Floating Ruler

The floating ruler assists with sample measurements using a sample number base other than the
absolute sample numbers shown on the standard ruler at the top of the Waveform window.

You can display (or hide) a floating ruler and move it to a location in the Waveform window. The
sample base (sample 0) of the floating ruler is the secondary cursor, or, if there is no secondary
cursor, the selected marker.

The floating ruler button and the floating ruler itself are visible only when the secondary cursor (or
selected marker) is present.

1. Do either of the following to display or hide a floating ruler:
- Place the secondary cursor.

- Select a marker.
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2. Select View > Floating Ruler.

You only need to follow this procedure the first time. The floating ruler displays each
time the secondary cursor is placed or a marker is selected.

Select the command again to hide the floating ruler.

Bus Bit Order

You can reverse the bus bit order in the wave configuration to switch between MSB-first
and LSB-first signal representation.

To reverse the bit order:

1. Select a bus.

2. Right-click and select Reverse Bit Order.

The bus bit order is reversed. The Reverse Bit Order command is marked to show that this
is the current behavior.

Bus Radixes

Bus values are interpreted as numeric values, which are determined by the radix setting on
the bus wave object, as follows:

« Binary, octal, hexadecimal, ASCII, and unsigned decimal radixes cause the bus values to
be interpreted as unsigned integers. The format of data on the bus must match the
radix setting.

« Any non-0 or -1 bits cause the entire value to be interpreted as 0.

« The signed decimal radix causes the bus values to be interpreted as signed integers.
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Viewing Analog Waveforms

To convert a digital waveform to analog, do the following:

1. In the Name area of a Waveform window, right-click the bus.

2. Select Waveform Style and then Analog Settings to choose an appropriate drawing

setting.

The digital drawing of the bus converts to an analog format.

You can adjust the height of either an analog waveform or a digital waveform by selecting
and then dragging the rows.

Figure 12-8 shows the Analog Settings dialog box with the settings for analog waveform

drawing.

¢ Analog Settings

Please specify the display settings for viewing the selected
objects as analog waveforms.

Row height | 100 . pixels

¥ Range
* Auto

Fixed

x5

Interpolation style: (® Linear Hold
Off scale: * Hide Clip Overlap
+'| Horizontal line I\Jalue:lu |
@ [cren | [ |

Figure 12-8: Analog Settings Dialog Box

The Analog Settings dialog box options are as follows:

« Row Height: Specifies how tall to make the select wave objects, in pixels. Changing the
row height does not change how much of a waveform is exposed or hidden vertically,
but rather stretches or contracts the height of the waveform.
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When switching between Analog and Digital waveform styles, the row height is set to an
appropriate default for the style (20 for digital, 100 for analog).

* Y Range: Specifies the range of numeric values to be shown in the waveform area.

o

Auto: Specifies that the range should continually expand whenever values in the
visible time range of the window are discovered to lie outside the current range.

Fixed: Specifies that the time range is to remain at a constant interval.
Min: Specifies the value displays at the bottom of the waveform area.

Max: Specifies the value displays at the top.

Both values can be specified as floating point; however, if radix of the wave object
radix is integral, the values are truncated to integers.

+ Interpolation Style: Specifies how the line connecting data points is to be drawn.

o

Linear: Specifies a straight line between two data points.

Hold: Specifies that of two data points, a horizontal line is drawn from the left point
to the X-coordinate of the right point, then another line is drawn connecting that
line to the right data point, in an L shape.

Off Scale: Specifies how to draw waveform values that lie outside the Y range of the
waveform area.

Hide: Specifies that outlying values are not shown, such that a waveform that
reaches the upper or lower bound of the waveform area disappears until values are
again within the range.

Clip: Specifies that outlying values be altered so that they are at the top or bottom
of the waveform area, such that a waveform that reaches the upper- or lower-bound
of the waveform area follows the bound as a horizontal line until values are again
within the range.

Overlap: Specifies that the waveform be drawn wherever its values are, even if they
lie outside the bounds of the waveform area and overlap other waveforms, up to
the limits of the wave window itself.

» Horizontal Line: Specifies whether to draw a horizontal rule at the given value. If the
check-box is on, a horizontal grid line is drawn at the vertical position of the specified Y
value, if that value is within the Y range of the waveform.

As with Min and Max, the Y value accepts a floating point number but truncates it to an
integer if the radix of the selected wave objects is integral.

IMPORTANT: Analog settings are saved in a wave configuration; however, because control of zooming

ﬁ in the Y dimension is highly interactive, unlike other wave object properties such as radix, they do not
affect the modification state of the wave configuration. Consequently, zoom settings are not saved with
the wave configuration.
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Bus Plot Viewer

In addition to the analog waveform viewer the Vivado® Hardware Manager also supports
the Bus Plot Viewer, which allows viewing a bus's values over time, or one bus' values vs.
another bus' values plotted on an X vs Y axis.

It can be helpful to view a Bus Plot when it is necessary to perform either of the following:

» Plotting analog sample data vs. time

« Plotting analog sample data vs. analog sample data

Vivado 2019.1.0 - 8 x

Ele Edt Tools Reports Window Llayout View Help

= - 2] o ¥ Dashboard - Serial 0 Analyzer

MANAGER - (s - #0002.Hub_#0005

x| hwila2 x|hwila3 x| hwilad x hwila5 x| hwila6 x|hwvios x| ILABusPlots (hw_ila_data3.ila) x

-3 Ivivado-1. PN (_ila_data_3.ila

Lt =2 °

M Plot 0 : dds_sine vs Sample in Buffer

W Plot 1 : dds_cosine vs Sample in Buffer |

OK - Outputs Reset

1o OK - Outputs Reset v

Debug Probe Properties

dds_sine(7:0] - 3

Source: NETUST
Type: LA

Probe type: Data and Trigger
Width: 8 )

Enumeration 0 250 500 750 1000

x Messages | Ser
B = a

INFO: [Labtools 27-1966] The ILA
INFO: [Labtools 27-3304] ILA Waveforn

oz
e
o

e ‘hw_ila_3' triggered at 2019-Mar-18 10:54:22 <
3 saved to Tile /hone/mpiazza/.Xil/Vivado-12094-xcordevi135/backup/hv_ila_data_3.ila. Use Tcl connand ‘read_hw_ila_data’ or Vivado File->Inport-=Inport ILA Data menu iten to inport the previously saved data

Figure 12-9: Bus Plot Showing Trigger Data vs. the Sample in Buffer

Creating a Bus Plot

The Bus Plot viewer can be used to plot previously captured ILA trace data. As such, it
requires the path to an ILA bus plot data file (either .csv or .ila). By default, the Show
Bus Plot dialog selects the last auto-saved ILA trigger data.

Example of Bus Plot Creation

1. To create a Bus Plot, open the Vivado Hardware Manager and select Tools>Show Bus
Plot.

2. The Show Bus Plot dialog box appears allowing the selection of a previously saved ILA
data file. By default, the auto-saved ILA data file corresponding to the last ILA trace is
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auto-selected. To select a previously saved ILA data file, enter the path to the
corresponding .ila or .csv file.

Show Bus Plot... x

Select an ILA bus plot data file (.csv or .ila). NOTE: 'Run Trigger' at least once to
get .ila bus plot data file

ILA bus plot data file: |GlAivado-12094-xcordevil 35/backup/hw_ila_data_3.ila| |_

o T
Figure 12-10: Show Bus Plot Dialog

3. Click OK and a blank Bus Plot window appears. To add a Bus Plot, click the “+" symbol,
and a dialog box appears with options to configure the new Bus Plot.

Add a new bus plot x

Add & new bus plot in current plots view,

/’
Data for X Axis:  Sample in Buffer v
¥ Axis Radix Unsigned Integer v
Data for ¥ Axis:  dds_data_tvalid v
¥ Axls Radbe Signed Integer v
Graph Type: Line w
Line Width: 1 v
Plot Color: Bl ooc v
“ | cancel |

Figure 12-11: Add New Bus Plot Dialog Box

The Add New Bus Plot options are as follows:

o Data for X Axis: Specifies the bus data to use for the X axis.
- Sample in Buffer: ILA sample number in the ILA capture buffer.

- Sample in Window: ILA sample number in the capture window. If one capture
window is selected, this number is the same as the sample in buffer, however if
you use multiple capture windows, this number indicates the sample number for
the given capture window.

- TRIGGER: Trigger position in the capture window.
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o X Axis Radix: Specifies the radix to use when plotting the X Axis data.
- Signed Integer.
- Unsigned Integer.

- Data for Y Axis: Specifies the bus data to use for the Y axis.
- Sample in Buffer: ILA sample number in the ILA capture buffer.

- Sample in Window: ILA sample number in the capture window. If one capture
window is selected, this number is the same as the sample in buffer, however if
you use multiple capture windows, this number indicates the sample number for
the given capture window.

- TRIGGER: Trigger position in the capture window.
- Y Axis Radix: Specifies the radix to use when plotting the Y Axis data.

Signed Integer.

Unsigned Integer.

- Graph Type
- Line: Display bus plot as a continuous line connected between discreet samples.
- Point: Display bus plot as points representing discreet samples.

o Line Width: Specifies the width to use for drawing the signals in the Bus Plot viewer.

o Plot Color: Allows choosing a different color to draw the Bus Plot.
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4. After configuring the Bus Plot, click OK to add the Bus Plot to the Vivado Hardware
Manager. The Bus Plot is displayed.

Vivado 2019.1.0 - s x
Ele Edt Tools Reports Window Llayout View Help
= - (=} o ¥ Dashboard + Serial 0 Analyzer v
MANAGER - (s - #0002.Hub_#0005 2 x
Hardware 2 _oox| [hwilal x|hwila2 x|hwila3 x T « hwila6 x hwvios x ILABusPlots (hw_ila_data 3.la) x oo
Qlx|® -3 IVivado-1. devi; (_ila_data_3.ila
Name status + s c °
~ E xilin tcfXilingPort_#0002.H Open ~
Programmed [ W Piot 0 : dds_cosine vs dds_sine |
0K - Outputs Reset
0K - Outputs Reset 100
I 0K - Outputs Reset
dle
I OK- Outputs Reset
50
1o OK - Outputs Reset v
Debug Probe Properties 2 _0OX
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Source: NETUST
Type: LA
Probe type: Data and Trigger
Width: 8 LY
Display Name
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100
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Q T 2 Il B @@
INFO: [Labtools 27-1966] The ILA core ‘hw_ila_3' triggered at 2019-Mar-18 10:54:22
INFO: [Labtools 27-3304] ILA Waveforn data saved to Tile /home/mpiazza/.Xil/Vivado-12004-xcordevl135/backup/hv_ila_data_3.ila. Use Tcl comnand *read_hw_ila_data’ or Vivado File->Inport->Inport ILA Data menu iten to import the previously saved data

<

Figure 12-12: Bus Plot Showing Trigger Data vs. Trigger Data (Sine vs. Cosine)

Note: Bus Plot settings are not saved when exiting the Vivado Hardware Manager. Be sure that all
desired measurements are completed before closing Vivado IDE.
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Zoom Gestures

In addition to the zoom gestures supported for zooming in the X dimension, when over an
analog waveform, additional zoom gestures are available, as shown in Figure 12-13.

Reset Zoom'Y
Zoom Fit Zoom QutY
Zoom In X Zoom Out X
Zoom In'Y Zoom X Range

Zoom'Y Range

Figure 12-13: Analog Zoom Options

To invoke a zoom gesture, hold down the left mouse button and drag in the direction
indicated in the diagram, where the starting mouse position is the center of the diagram.

The additional Zoom gestures are as follows:

« Zoom Out Y: Zooms out in the Y dimension by a power of 2 determined by how far
away the mouse button is released from the starting point. The zoom is performed
such that the Y value of the starting mouse position remains stationary.

« Zoom Y Range: Draws a vertical curtain which specifies the Y range to display when
the mouse is released.

¢« ZoomInY: Zooms in toward the Y dimension by a power of 2 determined by how far
away the mouse button is released from the starting point.

The zoom is performed such that the Y value of the starting mouse position remains
stationary.

* Reset Zoom Y: Resets the Y range to that of the values currently displayed in the wave
window and sets the Y Range mode to Auto.

All zoom gestures in the Y dimension set the Y Range analog settings. Reset Zoom Y sets
the Y Range to Auto, whereas the other gestures set Y Range to Fixed.
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Chapter 13

Debugging Designs Post Implementation

You might want to modify, add, or delete your debug cores post implementation. There are
two ways to do it in Vivado® Design Suite.

If you want to replace the existing connections to the ILA cores, Xilinx recommends that you
use the ECO flow. The ECO flow operates on an implemented checkpoint (DCP) and could
save you time that could otherwise be spent in a complete re-route of the design.

If you want to add new ILA cores, delete existing ILA cores, or modify existing ILA cores (eg
resizing probe width, changing the data depth etc.), Xilinx recommends that you use the
Incremental Compile flow. The Incremental flow for debug cores operates on a synthesized
design or checkpoint (DCP) and uses a reference implemented checkpoint (ideally from a
previous run of implementation). This could save you time that could otherwise be spent in
a complete re-implementation of the design.

The sections below discuss each of these debug related flows in detail.

Using Vivado ECO Flow to Replace Existing Debug
Probes

It is possible to replace debug nets connected to an ILA core in a placed and routed design
checkpoint. You can do this by using the Engineering Change Order (ECO) flow. This is an
advanced design flow used for designs that are nearing completion, where you need to
swap nets connected to an ILA probe port. This method serves two purposes:

« It saves you time. This feature lets you swap existing debug nets that are being
probed for different nets.

« Itis minimally invasive. After replacing probed nets, it is necessary to route those nets
to the inputs of the debug core. The rest of the design remains intact, thereby not only
preserving previous implementation results, but also reducing the possibility that a
re-implementation will hide the bug you are trying to find.

i? IMPORTANT: This flow is only applicable to designs where ILA cores have already been instantiated or
inserted.
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Figure 13-1 shows the process of replacing debug nets using the ECO design flow.

ECO FLOW

Bitstream LTX
(-bit) (.Itx)

Open
Routed
Checkpoint

Y Y

Program Device, Start

Debug Change Vivado GUI

!

Replace Debug Probes

\ \

Need to swap \_Yes Write Write Write Debug
nets probed Checkpoint Bitstream Probe
by ILA (DCP)(optional) (LTX)

No

Done

X16399-040516

Figure 13-1: Debug ECO Design Flow

Replacing Debug Probes on a Placed and Routed
Design Checkpoint

When using the Vivado Hardware Manager to debug a design that has been programmed
on a device, the nets being probed for debug sometimes need to be swapped for other
alternative nets. Instead of going back and changing your RTL code, or changing the nets
being probed in the inserted debug cores, you can use the ECO flow to replace the debug
nets.
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To use the ECO flow, open the placed and routed design checkpoint (DCP), in the Vivado

IDE, and change the layout to ECO.

¢ sinegen_demo_routed.dcp - [C:/Vivado_Debug/2017.1/proj_netlist/proj_netlist.runs/impl_1/sinegen_demo_routed.dcp] - Vivado 2017.1

(=8 Eos )

Q
' total of 734 instances were transformed.
CFGLUTS => CFGLUTS (SRLC32E, SRLIGE): 696 instances

RAM32M => RAM32M (RAMS32, RAMS32, RAMD32, RAMD32, RAMD32, RAMD32, RAMD32, RAMD32): § instances
RAMGAM => RAMGAM (RAMDG4E, RAMDG4E, RAMDGLE, REMDGAE): 32 instances

| INFO: [Project 1-604] Checkpoint was created with Vivado v2017.1 (64-bit) build 1812560

open_checkpoint: Time (s): cpu = 00:01:25 ; elapsed = 00:01:03 . Memory (MB): peak = 1962.723 : gain = 1038.313

File  Edit Flow Tools Window Layout View Help Quick Access
=, @& H O o Debug v
CHECKPOINT DESIGH - xc7k325tg900-2 Default Layout
10 Planning
Hetlist ? 00X Schematic Floorplanning
- [y A i Debug
= H & - Q e XN B O C | 35Cells 9UOPorts 114 Ng
Timing Analysis
[ sinegen_demo
ECO
> Nets (114
> LeafCells (31 Save As New Layout...
» & dbg_hub (dic Reset Layout F5
> U_DEBOUNCE_D (c
> U_DEBOUNCE_1 (c
> U_FSM (fsm
> 2 u_ila_0(u ila 0 C
> U_SINEGEN (sinegen
| ——
Properties ? 00X ;B—| r%]—‘l i
] E
u‘ ! %
L=
Select an objectto see properties
TclConsole X Messages Debug 7 — o] [gf
= s I 8 E 10

Figure 13-2: Selecting the ECO Layout
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The Flow Navigator now changes to ECO Navigator with a different set of options

Chapter 13: Debugging Designs Post Implementation

¢ sinegen_demo_routed.dcp - [C:Nivado,Debung()l?.l,"projfnetlistlproj,netlist.rum,fimpl,l,{}inegenﬁdemo,muted.dcp] - Vivado 20171

File Edit  Flow

=

Tools

Window

Layout  View  Help Quick Access

o H O o &

(=5 Bl =)

ECO ~
'

CHECKPOINT DESIGN - xc7k325iffg200-2 ? X
ECO Navigator — Scratch F Propertie Neth x 2 _ O Schematic X Device x| Package X 00
Edit PN~ & - @ @ M ml o C  35cCells 910Pors >

Creats Nat 31 sinegen_demo
Nets (114)
Create Cell LeafCells
Create Port dbg_hub | _CV
i U_DEBOQUNCE_0 (
Create Fin U_DEBOUNCE_1 (debounce_0)
Connect Net U_FSM (fsm)

Disconnect Net
Replace Debug Probes
Place Cell

Unplace Cell

Check ECO

Optimize Logical Design
Place Design

Optimize Physical Design

Route Design

Report

Edit Timing Constraints
1 Report Timing Summary
1 Report Clock Netwarks

Report Clock Interaction

> 8 u_ila_0 (u_ila_|
> U_SINEGEN (sin

Report DRC
Report Utilization

& Report Pawer

Program

Save Checkpoint As
¥ Generate Bitstream
[3 write Debug Probes

Open Hardware Manager

TciConsole %
aQ = = 1

! INFO: [Pzoject 1-111] Unisim Transformation Summary:

") open_checkpoint: Time (s): cpu = 00:01:25 ; elapsed = 00:01:03

Messages Package Pins

B E O

10 Ports

& total of 734 instances were transformed.

CFGLUTS => CFGLUTS (SRLC32E, SRL16E): 696 instances

REM32M => REM32M (RAMS32, REMS32, RAMD32, REMD32, RAMD32, REMD32, RAMD32, REMD32):
RAMELM => RAM64M (RAMDGAE, RAMD64E, RAMDE4E, RAMDSAE): 32 instances

INFO: [Broject 1-604] Checkpoint was created with Vivado v2017.1 (§4-bit) build 1812560

& instances

. Memory (MB): peak = 1962.723 ; gain = 1032.313

Figure 13-3:

Vivado Programming and Debugging

UG908 (v2019.1) May 22, 2019

www.Xilin

ECO Navigator

X.com

Send Feedback

264


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=264

2: X”_INX® Chapter 13: Debugging Designs Post Implementation

In the ECO Navigator, click Replace Debug Probes to bring up the Replace Debug Probes

dialog box.
¢ Replace Debug Probes @
Use the Edit Probes button to replace one or more debug probes. To reflectthese
changes in the Vivado Hardware Manager, regenerate the debug probes file (LTX). ‘
= s 72 C t 3
Search
Name Probe
~ & dbg_hub (labtools_xsdbm_v3 =
~ mclk(1
@cho I ck
~ & u_ila_0 (labtools_ila_vB
~ B ck(1
@cho T el
~ & probe0 (2
@cho T'# GPIO_BUTTONS_re[0]
@ch1 I# GPIO_BUTTONS re[1]
~ k& probet (2
@ Cho I'# GPIO_BUTTONS_dIy[0] ”i
@ch1 T# GPIO_BUTTONS_diy[1] f
~ & probe2 (2
@cho T# GPIO_BUTTONS_dbi0]
@ch1 I# GPIO_BUTTONS_dbi1]
~ b probe3 (2
@cho I'# GPIO_BUTTONS_IBUF[0]
@ch1 % GPIO_BUTTONS_IBUF[1]
~ & probed (2 ~
Probes changed: 0

Figure 13-4: Replace Debug Probes Dialog Box

In the Replace Debug Probes dialog box, highlight the probes whose nets you want to
change, and click the Edit Probes button. Use the Edit Probes button to the right of each
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probe to change individual nets. Alternatively, you can use the Edit Probes button on the

left edge of the window to change the nets for multiple probes.

¢ Replace Debug Probes

=5

Use the Edit Probes button to replace one or more debug probes. To reflectthese
changes in the Vivado Hardware Manager, regenerate the debug probes file (LTX). ‘

EéCfl

Search

Name

~ & dbg_hub (labtools_xsdbm_v3

v k(1
@cho
~ 3E u_ila_0 (labtools_ila_v6
~ B ck(1
@cho
~ & probe0 (2
@cho
@ch1
~ b probel (2
@ Cho
@ch1
~ & probe2 (2
@cho
@ch1
~ k& probed (2
@cho
@ch1
~ & probed (2
Probes changed: 0

Probe
I ok

T clk

% GPIO_BUTTONS_re[0]
% GPIO_BUTTONS_ref]

I'# GPIO_BUTTONS_dIy[0]
I'# GPIO_BUTTONS_diy[1]

% GPIO_BUTTONS_db{0]
% GPIO_BUTTONS_dbi1]

% GPIO_BUTTONS_IBUFI0]
% GPIO_BUTTONS_IBUF[1]

Cancel

Figure 13-5:

Edit Probes Button

Click the Edit Probes button to bring up the Choose Nets dialog box, where you can
choose nets to replace the existing ones.

Enter the Find criterion to select the nets you want to replace the existing nets. If the Find
criterion returns more than 10000 nets, refine you criterion and try again. Select the
preferred nets on the Find Results on the left and click the arrow (->) to add those nets to
the Selected Names column on the right. Ensure the nets in the Selected Names column
on the right correspond to the number of nets being replaced. Click OK to continue.
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¢ Choose Nets

Choose nets to replace existing probes.

Properties

NAME | | contains

| | “clear

Reqular expression /| Search hierarchically /| Display unique nets

Of objects:

Found: 63

T dbg_hublinstBSCANID.u_xsdbm_idiCORE_XSDB.U ™

I U_DEBOUNCE _0iclear

Selected: 107 1

I U_DEBOUNCE _Oiclear

I u_ila_0iinstila_core_inst/u_ila_regs/CNT CNT_SRL
I u_ila_0iinstila_core_inst/u_ila_regs/CNT CNT_SRL
I u_ila_0iinstila_core_inst/u_ila_regs/CNT CNT_SRL
I u_ila_0iinstila_core_inst/u_ila_regs/CNT CNT_SRL

I u_ila_0iinstila_core_inst/u_ila_regs/MU_SRL{0].mu
I u_ila_0iinstila_core_inst/u_ila_regs/MU_SRL[1].mu.

Copy selected Nets into the Selection List

I u_ila_0iinstila_core_inst/u_ila_regs/MU_SRL[Z]. mu

]
1
]
]

[
[
I u_ila_0iinstila_core_instu_ila_regs/MU_SRL:
[

3].mu,

I u_ila_0iinstila_core_inst/u_ila_regs/MU_SRL[4]. mu

<

A

Figure 13-6:

Choose Nets Dialog Box

i? IMPORTANT: Once you have completed replacing all the debug probes necessary, rerouted them, and
regenerated the bitstream, you must regenerate the debug probes file (. 1tx).

TIP: You can also choose multiple nets or a bus by clicking on the Edit Probes button on the left in the
O Replace Debug Probes dialog box.

After you replace all the desired nets on the debug cores, click OK to bring up a
confirmation dialog box to confirm the changes about to be made.

f IMPORTANT: Check the Tcl Console to ensure that there are no Warnings/Errors.

Tcl Console

Q==

B E

Debug

Tine (s): cpu = 00:00:26 ;
INFO: [Physoot 32-8611 Swappring nets in arous of 12:

Starting Physical Synthesis Task

elapsed = 00:00:20 .

Phase 1 Physical Synthesis Inftialization
INFO: [Physopt 32-721] Multithreading enabled for phys_opt_design using a maxinun of & CPUs

INFO: [Physopt 32-668] Current Timing Summary | WNS=7.320 | TNS=0.000 | WHS=0.031 | THS=0.000 |
Phase 1 Physical Synthesis Initialization | Checksun: 25304cf25

elapsed = 00:00:00.01 .

Menory (MB): peak = 10048.645 ;

wodify_debug_ports -probes [1ist {design_1_i/top_0/systen_ilad/inst/i1a lib/probed O s1_spart0_L[161}]
Netlist sorting complete. Time (s): cpu - 00:00:00.02 ;
INFO: [Vivado_Tcl 4-363] Removed DONT_TOUCH property on net design_l_i/top_0/vio_O_probe_outO to prepars for debug probe changes.

INFO: [Vivado 12-3773] the DONT_TOUCH property on this net is implied by a MARK_DEBUC. Setting the DONT_TOUCH property to FALSE or O will enable the implementation tools to gf

Menory (MB): peak — 3813.992 ; gain = 0.000 ; free physical = 27249 ; free virtual - 62953

gain = 228.652 ; free physical = 27122 ; free virtual = 62844

Figure 13-7: Maodify Debug Probe Tcl Messages
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2: X”_INX® Chapter 13: Debugging Designs Post Implementation

Deleting any net segment on the path of a net being probed could have an impact on the
probe names displayed in the Hardware Manager. Vivado IDE picks the net segment closest
to the net being probed with a MARK_DEBUG attribute on it. If there is no net segment with
a MARK_DEBUG attribute, then the top level net is picked. If there is more than one net
segment with a MARK_DEBUG attribute, the tool randomly selects one of those nets.

After you have replaced all the debug probe ports, you can save your modifications to a
new checkpoint using the Save Checkpoint As option in the ECO Navigator. The Replace
Debug Probes command in the ECO Navigator needs to be run to generate a new . 1tx file
for the debug probes. You should then generate a new bit file to program the device. You
can then connect to the Vivado Hardware Manager to debug the design with the new
changes.

Vivado ECO TCL Flow to Replace Existing Debug
Probes

You can use the Vivado Tcl flow as an alternative to the GUI flow described in the previous
sections. Use the following Tcl command to modify nets being probed by the debug cores.

modify debug_ports -probes [list {top/x_ila/probel 0 top/inst_A/net_0} \
{top/x_ila/probel 1 top/inst_A/net_a} {top/x_ila/probel 2 top/inst_A/net_b}]

This command performs all of the netlist modifications to disconnect existing net
connections to the specified probe ports. In this example the existing net connections to
probe port 0 at index 0, probe port 1 at index 1 and index 2 of the ILA are disconnected.
Then each of these probes are connected to the net specified net_0, net_a, and net_b
respectively. The modified connections are also routed automatically. Nets that become
disconnected during the process are left unconnected.

Incremental Compile with Debug Core (ILA)
Modifications

Incremental Compile is an advanced design flow for designs that are nearing completion,
where small changes are required. After resynthesizing these small changes, the flow:

« Speeds up place and route run time.

« Preserves QoR predictability by reusing prior placement and routing from a reference
design. The flow is most effective when synthesis changes result in at least 95 percent
similarity to the reference design.
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Incremental Debug changes are applied to a placed and routed design by re-implementing
the design using the Incremental Compile design flow. This flow is recommended in
situations where:

« The debug cores are absent from the existing implemented design or,
« You need to modify existing debug cores by changing probe widths, data depth, etc. or,

*  You need to delete debug cores from the design.

Incremental Compile Flow Designs

The Incremental Compile flow involves two different designs, the reference design and the
current design with debug core modifications.

Reference Design

The reference design is usually an earlier iteration or variation of the current design that has
been synthesized, placed, and routed. However, you can use a checkpoint that has any
amount of placement, routing, or both. The reference design checkpoint (DCP) might be the
product of many design iterations involving code changes, floorplanning, and revised
constraints necessary to close timing. After the current design is loaded, load the reference
design checkpoint using the read_checkpoint -incremental <dcp> command.
Loading the reference design checkpoint with the -incremental option enables the
Incremental Compile design flow for subsequent place and route operations.

Current Design

The current design incorporates small debug related design changes or variations from the
reference design. These changes or variations can include:

+ Debug core RTL instantiation changes
« Debug core insertion changes

« Both debug core related RTL changes and insertion changes

To insert, delete, or modify debug cores to an existing design that has been implemented,
open the synthesized DCP or design, and use the debug insertion flow. Details on the
debug insertion flow can be found in Using the Netlist Insertion Debug Probing Flow in
Chapter 10.

You can also modify existing debug cores or instantiate new debug cores into your existing
RTL design. The Incremental Compile flow reuses placement and routing from the reference
design along with the new debug related modifications. Details on the debug instantiation
flow can be found in HDL Instantiation Debug Probing Flow Overview in Chapter 10.
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Using Incremental Compile

In both Project Mode and Non-Project Mode, incremental place and route mode is entered
when you load the reference design checkpoint using the read_checkpoint
-incremental <reference_dcp_file> command where <reference_dcp_file>
specifies the path and file name of the reference design checkpoint. Loading the reference
design checkpoint with the -incremental option enables the Incremental Compile
design flow for subsequent place and route operations. In Non-Project Mode,
read_checkpoint -incremental should: (1) follow opt_design and; (2) precede
place_design. If using the debug insertion flow the debug core related XDC commands
should precede opt_design.

Using Incremental Compile in Non-Project Mode

To specify a design checkpoint file (DCP) to use as the reference design, and to run
incremental place in Non-Project Mode:

1. Load the current design.
2. Run debug core commands.

3. Run opt_design.

f IMPORTANT: Make sure the opt_design options and directives match those used in the original
reference run as closely as possible.

4. Run read_checkpoint -incremental <reference_dcp_file>.
5. Run place_design.
6. Run route_design.

# to load the current design
link_design;

#Create the debug core

create_debug_core u_ila_0 ila

#set debug core properties

set_property C_DATA_DEPTH 1024 [get_debug_cores u_ila_0]
set_property C_TRIGIN_EN false [get_debug_cores u_ila_0]
set_property C_TRIGOUT _EN false [get_debug cores u_ila_ 0]
set_property C_ADV_TRIGGER false [get_debug cores u_ila_ 0]
set_property C_INPUT_PIPE_STAGES 0 [get_debug_cores u_ila_ 0]
set_property C_EN_STRG_QUAL false [get_debug cores u_ila_0]
set_property ALL_PROBE_SAME_MU true [get_debug cores u_ila_0]
set_property ALL_PROBE_SAME_MU_CNT 1 [get_debug_cores u_ila_0]

#connect the probe ports in the debug core to the signals being probed in the design
set_property port_width 1 [get_debug_ports u_ila_0/clk]

connect_debug_port u_ila_0/clk [get_nets [list clk ]]

set_property port_width 1 [get_debug ports u_ila_0/probel]

connect_debug_port u_ila_0/probel [get_nets [list A_or_B]]

create_debug_port u_ila_0 probe
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opt_design

read_checkpoint -incremental <reference_dcp_file>
place_design

route_design

ﬁ IMPORTANT: You must open the synthesized checkpoint to modify the debug cores in the design.
Insertion of debug cores by opening a post-routed checkpoint is not supported.

Using Incremental Compile in Project Mode
In Project Mode, you can set the incremental compile option in the Design Runs window.
To set the incremental compile option:

1. Select a run in the Design Runs window.
2. Click Set Incremental Compile from the context menu.

3. In the Set Incremental Compile window, select a reference design checkpoint. This
enables incremental compile mode for the run.

4. Open the Synthesized netlist and optionally modify/add the debug cores instantiated in
the RTL.

5. Use the Set Up Debug wizard to insert/delete/modify debug cores inserted into the
design.

6. Implement Design.

ﬁ IMPORTANT: You must open the synthesized design to modify the debug cores in the design. Insertion
of debug cores by opening a post-routed design is not supported.

For more information on the Incremental Compile feature, see this link in the Vivado Design
Suite User Guide: Implementation (UG904) [Ref 6].

Examining the Similarity Between the Reference Design and the
Current Design

Run report_incremental_reuse to examine and report the similarity between a
reference design checkpoint file and the current design. The
report_incremental_reuse command compares the netlist from the reference design
checkpoint with the current in-memory design, and reports the percentage of matching of
cells, nets, and ports.

A higher degree of design similarity results in more effective reuse of placement and
routing from the reference design. The greater the percentage of similarity between the
reference design and current design, the greater the opportunity for placement and routing
reuse.
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Chapter 14

Serial I/O Hardware Debugging Flows

Introduction

The Vivado® IDE provides a quick and easy way to generate a design that helps you debug
and verify your system that uses Xilinx high-speed gigabit transceiver (GT) technology. The
in-system serial I/O debugging flow has three distinct phases:

1.

IBERT Core generation phase: Customizing and generating the IBERT core that best
meets your hardware high-speed serial I/O requirements.

. IBERT Example Design Generation and Implementation phase: Generating the example

design for the IBERT core generated in the previous step.

Serial I/O Analysis phase: Interacting with the IBERT IP contained in the design to debug
and verify issues in your high-speed serial I/O links.

The rest of this chapter shows how to complete the first two phases. The third phase is
covered in the Chapter 15, Debugging the Serial I/O Design in Hardware.

Generating an IBERT Core using the Vivado IP
Catalog

The first phase of getting a suitable hardware design to help debug and validate your
system's high-speed serial I/O interfaces is to generate the IBERT core. The following steps
outline how to do this:

1.
2.

Vivado Programming and Debugging

Open the Vivado IDE

On the first panel, choose Manage IP > New IP Location, then click Next when the
Open IP Catalog wizard opens.

Select the desired part, target language, target simulator, and IP location. Click Finish.

In the IP Catalog under Debug and Verification > Debug, you will find one or more
available IBERT cores as shown in the following figure, depending on the device selected
in the previous step.

o l Send Feedback I 272
UG908 (v2019.1) May 22, 2019 www.xilinx.com


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=272

(: X”_INX® Chapter 14: Serial 1/0 Hardware Debugging Flows

5. Double-click the desire IBERT architecture to open the Customize IP Wizard for that
core.

Customize the IBERT core for your given hardware system requirements. For details on the
various IBERT cores available, see the following IP Documents: Integrated Bit Error Ratio
Tester for 7 Series GTX Transceivers LogiCORE IP Product Guide (PG132) [Ref 26], Integrated
Bit Error Ratio Tester for 7 Series GTP Transceivers LogiCORE IP Product Guide (PG133)

[Ref 27], Integrated Bit Error Ratio Tester for 7 Series GTH Transceivers LogiCORE IP Product
Guide (PG152) [Ref 28].

Project Summary x| IPCatalog  x P
Cores | Interfaces
I @

Name Al axa Status License VLNY
» AXIS Infrastructure

Q@
o

> BaselP
> Basic Elements
» Communication & Networking
> Debug & Verification
~ Debug
4F Debug Bridge Production Included xilinx.com:ip:debug_bridge:2.0
4 IBERT 7 Series GTX Production Included  xilinx.com:ip:ibert_7series_gbc3.0
4 ILA (Integrated Logic Analyzer) AX|4, AXl4-Stream  Production Included  xilinx. comvipila:s 2
I JTAG to AXI Master AXl4 Production Included Hlinx com:ip:jtag_axi:1.2
4 System ILA Production Included  xilimccom:ip:system_ila:1.0
F VIO (Virtual Input’Qutput) Production Included xlinx.com:ipvio:3.0
4 Discontinued Simulation Clock Generator Discontinued Included  xlinx.com:ipiclk_gen:1.0
4F Discontinued Simulation Reset Generator Discontinued Included xlinx.com:iporst_gen:1.0
4 Simulation Clock Generator Production Included  dlimccom:ip:sim_clk_gen:1.0
#F Simulation Reset Generator Production Included  wlimccomip:sim_rst_gen:1.0

» Digital Signal Processing

< >
Details
Name: IBERT 7 Series GTX
Version: 3.0 (Rev. 16)

Description: The IBERT 7 Series GTX core is customizable and designed for evaluating and monitoring 7 Series FPGA GTX transceivers. This core includes pattern generators
and checkers that are implemented in FPGA logic, and access to ports and the dynamic reconfiguration port attributes of the GTX transceivers. Communication logic
is also included to allow the design to be run-time accessible through Joint Test Action Group (JTAG). Run-time interaction with this core requires the use ofthe
Vivado serial /0 analyzer feature.

Status: Production

License: Included

Figure 14-1: 1P Catalog Showing the IBERT 7 Series GTX Core

Generating and Implementing the IBERT Example
Design

After generating the IBERT IP core, it appears in the Sources window as
"ibert_7series_gtx" or something similar. To generate the example design, right-click
the IBERT IP in the Sources window and select Open IP Example Design, then specify the
desired location of the example design project in the resulting dialog window. This

Vivado Programming and Debugging Send Feedback 273
UG908 (v2019.1) May 22, 2019 www.Xxilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=273

(: X”_INX® Chapter 14: Serial 1/0 Hardware Debugging Flows

Vivado Programming and Debugging

command opens a new Vivado project window for the example design and adds the proper
top-level wrapper and constraints file to the project, as shown in Figure 14-2.

Once the example design is generated, you can implement the IBERT example design
through bitstream creation core by clicking Generate Bitstream in the Program and
Debug section of the Vivado IDE flow navigator or by running the following Tcl commands:

launch_runs impl_1 -to_step write_bitstream
wait_on_run impl_1

Refer to the Vivado Design Suite User Guide: Design Flows Overview (UG892) [Ref 8] for more
details on the various ways you can implement your design.

¢ ibert_7series_gtx_0_ex - [c:/Vivado_Debug/2017.1/ibert_7series_gtx_0_ex/ibert_7series_gtx_0_ex.xpr] - Vivado 2017.1 E@
File Edt Flow Tools Window Layout View Help ccess wiite_bitstream Complete  +/
!‘." b‘ B g X Default Layout v

Flow Navigator SR PROJECT MANAGER - ibert_7series_gt_0_ex ? X

~ PROJECT MANAGER

Sources ? 000X Project Summary 200X
£ Settings -
Q =z & + o
Add Sources Seftings ~ Edit
y et ~ = Design Sources (2
anguage Templates i i
» @2 example_ibert_Tseries_gtx_0 (example_iberl 7series_ ESvjedname Tt Azl 61U (o
£F IP Catalog N —— Project location cNivado_Debugi2017.1fibert_7series_gt_0_ex
> Constraints (1 Product family. Kintex-7
v P INTEGRATOR > [ Simulation Sources (1 Project part Kintex-7 KC705 Evaluation Platform (xc7k325t900-2
Create Block Design Top module name example_ibert_Tseries_gt_0
Open Block Desion < > Target language VHDL
Hierarchy IP Sources Libraries Compile Order Simulator language: Mixed
Generate Block Design
Properties ?-_00GEX
v SIMULATION Boarpart
o
Run Simulation Display name: Kintex-7 KC705 Evaluation Platiorm
Board part name: xilink.com:kc705:pant0:1.5
v RTLANALYSIS TIOEEE
> Open Elaborated Design Selectan object o see properties P path; C: 17. |_files
URL: www.xiling.com/ke705
v SYNTHESIS Board overview: Kintex-7 KC705 Evaluation Platiorm o
P Run Synthesis 8 D
» Open Synthesized Design TciConsole | Messages | Log | Reports | DesignRuns X 7?00
Q = 2 + %
¥ IMPLEMENTATION
Name Constraints ~ Status WNS TNS WHS THS TPWS TotalPower FalledRoutes LUT FF ~' URAM DSP
P Run Implementation
~ syth_1 consts_1  synth_design Complete! 13926 26979 0 (
> Open Implemented Design </ mp_1  consts_1  write_bitstream Complete! 1816 0.0.. 0040 00.. 0000 3454 0 11249 24114 0 (
~ PROGRAM AND DEBUG
1 Generate Bitstream
> Open Hardware Manager
< >

Figure 14-2: IBERT Example Design

In-System IBERT System Serial I/0 Design
Debugging Flows

Introduction

The In-System IBERT IP lets you perform 2-D eye scans of UltraScale® and UltraScale+
transceivers in your design, using the Vivado Serial IO Analyzer tool. This IP uses data from
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the design to plot the eye scan of the transceivers in real time while they interact with the
rest of the system. This IP can be integrated with user logic in the design or Xilinx
transceiver based IPs (for example GT Wizard or Aurora, etc).

The In System Serial I/O Debugging flow has three distinct phases:

1. In-System IBERT Core Generation phase: Customizing and generating the In-System
IBERT core that best meets your hardware high-speed serial I/O requirements.

2. Integration phase: Instantiating the IP and integrating it into your design.

3. Serial I/0 Analysis phase: Interacting with the In-System IBERT IP contained in the
design to debug and verify issues in your high-speed serial I/O links.

ﬁ IMPORTANT: The In-System IBERT core is only available for the UltraScale and UltraScale+ device
families.

Details of the In-System IBERT Core Generation phase and the Integration phase are
covered the remainder of this section. For details of the Serial I/O Analysis phase, see
Chapter 15, Debugging the Serial I/O Design in Hardware.

Generating an In-System IBERT Core Using the Vivado IP Catalog

The first phase of debugging your design’s high-speed serial I/O interfaces is to generate
the In-System IBERT core.

To do this, follow these steps:

1. Open the Vivado IDE

2. On the first panel, choose Manage IP > New IP Location, then click Next when the
Open IP Catalog wizard opens.

3. Select the desired part, target language, target simulator, and IP location. Click Finish.

4. In the IP Catalog under Debug and Verification > Debug, you will find one or more
available In-System IBERT cores depending on the device selected in the previous step.

5. Double-click the desired In-System IBERT architecture to open the Customize IP Wizard
for that core

Customize the In-System IBERT core for your given hardware system requirements. For
details on the In-System IBERT cores, see the following IP Document: LogiCORE IP In-System
IBERT Product Guide (PG246) [Ref 34].
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Instantiating the IP and integrating In-System IBERT IP in the User Design
After generating the In-System IBERT IP core do the following:

1. Open your top level RTL file to edit and add the In-System IBERT core generated in the
above step.

2. Copy the instantiation template of the In-System IBERT core generated by the tool and
instantiate it in the RTL file.

3. Connect the ports of your transceiver to the In-System IBERT IP.
For a detailed example of how to integrate In-System IBERT into the user design, see

Chapter 5 "Example Designs" of the following IP Document: LogiCORE IP In-System IBERT
Product Guide (PG246) [Ref 34].

TIP: Ensure that you have read the FAQ section of the IP Document LogiCORE IP Devices In-System
O IBERT Product Guide, (PG246) [Ref 34], which lists some recommendations for issues you could
encounter while integrating this IP into your design.

4. Synthesize and Implement the design.
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Chapter 15

Debugging the Serial I/O Design in
Hardware

Once you have IBERT core implemented, you can use the run time serial I/O analyzer
features to debug the design in hardware. Only IBERT cores version v3.0 and later can be
accessed using the serial I/O analyzer feature.

Using Vivado Serial I/0 Analyzer to Debug the
Design
The Vivado® serial I/0 analyzer feature is used to interact with IBERT debug IP cores that

are in your design. To access the Vivado serial I/O analyzer feature, click the Open
Hardware Manager button in the Program and Debug section of the Flow Navigator.

The steps to debug your design in hardware are:

Connect to the hardware target and programming the FPGA device with the bit file.
Create Links.

Modify link settings and examine status.

Bl S

Run scans as needed.

Connecting to the Hardware Target and Programming the FPGA
Device

Programming an FPGA device prior to debugging involves exactly the same steps described
in Programming the FPGA Device. After programming the device with the .bit file that
contains the IBERT core, the Hardware window now shows the components of the IBERT
core with the RTL instance name shown in parenthesis, that were detected when scanning
the device (see Figure 15-1).

ﬁ IMPORTANT: /n designs using the In-System IBERT IP for UltraScale and UltraScale+ designs, you will
see the In-System IBERT core being detected in the Hardware window.
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Hardware ? 008 X
Q = 2 o
MName Status
~ B localhost (1 Connected
~ @ xiling_tcfiXilingPort_#0003Hu..  Open
~ {8 xc7k325t_0 (2) Programmed
& XADC (System Monitor

~ ZE |BERT (IBERT
~ I Quad_117 (5

COMMON_X0Y2 Locked
R MGT_X0Y8 Mo Link
B MGT_X0Y9 Mo Link
B9 MGT_X0Y10 Mo Link
B MGT_X0Y11 Mo Link
~ B Quad_118 (5
COMMON_X0Y3 Locked
B MGT_X0Y12 Mo Link
B9 MGT_X0Y13 Mo Link
B MGT_X0Y14 Mo Link
B9 MGT_X0Y15 Mo Link

< >

Figure 15-1: Hardware Window Showing the IBERT Core

Creating Links and Link Groups

The IBERT core present in the design appears in the Hardware window under the target
device. If you do not see the core appear, right-click the device and select the Refresh
Hardware command. This re-scans the FPGA device and refreshes the Hardware window.

Note: If you still do not see the IBERT core after programming and/or refreshing the FPGA device,
check to make sure the device was programmed with the appropriate .bit file. Also check to make
sure the implemented design contains an IBERT v3.0 core.

The Vivado serial I/O analyzer feature is built around the concept of links. A link is
analogous to a channel on a board, with a transmitter and a receiver. The transmitter and
receiver may or may not be the same GT, on the same device, or be the same architecture.
To create one or more links, go to the Links tab in Vivado, and click either the Create Links
button, or right-click and choose Create Links. This causes the Create Links dialog window
to appear, as shown in Figure 15-2.

When an IBERT core is detected, the Hardware Manager notes that there are no links
present, and shows a green banner at the top. Click Create Links to open the Create Links
dialog box, as shown in Figure 15-2.
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¢ Create Links =]
To create a new link select a TX GT and/or an RX GT, then click the Add button on the Mew Links toolbar. ‘
TXGTs RX GTs
Search: | Q; Search: | ©.
MGT_X0Y9/TX (xc7k32 Juad_117) MGT_X0Y9/RX (xc7k32 17)
[> MGT_X0Y10/TX (xC a < MGT_XOY10/RX (xc7k3 17)
[> MGT_X0Y11/TX (x < MGT_X0Y11/RX
[i> MGT_X0Y12/TX (> < MGT_X0Y12/RX
[> MGT_X0Y13/TX (x GT_X0Y13/RX
[i> MGT_X0Y14/TX (x < MGT_X0Y14/RX
[> MGT_X0Y15/TX (> <& MGT_XOY15/RX (xc7k:
New Links
= Description  TX RX Internal Loopback
== % Link 0 MGT_X0Y8/TX (xc7k325t_0/Quad_117) MGT_XO0Y8/RX (xc7k325t_0/Quad_117 |w]
|| create link group
Link group description: | Link Group 0
@gpen Serial I/O Analyzer layout
[ el |

Figure 15-2: Create Links Dialog Box

Choose a TX and/or an RX from the list available. Or type in a string into the search field to
narrow down the list. Then click the Add “+" button to add the link to the list. Repeat for all

links desired.

IMPORTANT: A given TX or RX endpoint can only belong to one link.

Links can also be a part of a link group. By default, all new links are grouped together. You
can choose not to add the links to a group by unchecking Create link group check box. The
name of the link group is specified in the Link group description field.

Viewing and Changing Links Settings Using the Links Window

Once links are created, they are added to the Links view (see Figure 15-3) which is the
primary and best way to change link settings and view status.
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Tcl Console Messages Serial VO Links » Serial 'O Scans

Q = s +

MName TX R Status Bits Errors BER BERT Reset  TiX Pattern R
Ungrouped Links (0}

~ & Link Group SMA (1) PRBS7-bit v P
“% Link0 MGT_XO0YBMX MGT_XO0YB/RX 7.988 Gbps 1.343E12 2.645E11  1.969E-1 PRBS7-bit v P

~ & Link Group Internal... PRBS7-bit v P
S Link1 MGT_X0YSTX MGT_X0YWRX 7.987 Gbps 3.805E12 2.079E12 5.465E-1 FPRBS 7-bit » P
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Figure 15-3: Links Window
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Each row in the Links window represents a link. Common and useful status and controls are
enabled by default, so the health of the links can be quickly seen. The various settings that
can be viewed in the Links window's table columns are shown in Table 15-1.

Table 15-1: Links Window Settings

Link View Column Name

Description

Name The name of the link

X The GT location of the transmitter

RX The GT location of the receiver

Status If linked (meaning the incoming RX data as expected). Status displays the
measured line rate. Otherwise, it displays “No Link".

Bits The measured number of bits received.

Errors The measured number of bit errors by the receiver.

BER Bit Error Ratio = (1 + Errors) / (Bits).

BERT Reset Resets the received bits and error counters.

RX Pattern Selects which pattern the receiver is expecting.

TX Pattern Selects which pattern the transmitter is sending.

TX Pre-Cursor

Selects the pre-cursor emphasis on the transmitter.

TX Post-Cursor

Selects the post-cursor emphasis on the transmitter.

TX Diff Swing

Selects the differential swing values for the transmitter.

DFE Enabled

Selects whether the Decision Feedback Equalizer is enabled on the receiver (not
available for all architectures).

Inject Error

Injects a single bit error into the transmit path.

TX Reset

Resets the transmitter.

RX Reset

Resets the receiver and BERT counters (see BERT Reset).

Loopback Mode

Selects the loopback mode on the receiver GT.

Warning: Changing this value might effect the link status depending on the
system topology.

Termination Voltage

Selects the termination voltage of the receiver.

RX Common Mode

Selects the RX Common Mode setting of the receiver.

TXUSERCLK Freq

Shows the measured TXUSERCLK frequency in MHz.

TXUSERCLK2 Freq

Shows the measured TXUSERCLK2 frequency in MHz.

RXUSERCLK Freq

Shows the measured RXUSERCLK frequency in MHz.

RXUSERCLK2 Freq

Shows the measured RXUSERCLK2 frequency in MHz.

TX Polarity Invert

Inverts the polarity of the transmitted data.

RX Polarity Invert

Inverts the polarity of the received data.

It is possible to change the values of a given property for all links in a link group by
changing the setting in the link group row. For instance, changing the TX Pattern to "PRBS
7-bit" in the "Link Group 0" row changes the TX Pattern of all the links to "PRBS 7-bit". If not
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all the links in the group have the same setting, "Multiple" appears for that column in the
link group row.

When the In System IBERT IP is used in your design, only a subset of the link settings apply.
The table below lists the applicable link settings.

Table 15-2: In System IBERT Link Window Settings

Link view column name Description
X The GT location of the transmitter
RX The GT location of the receiver
TX Pre-Curser Selects the pre-curser emphasis on the transmitter.
TX Post-Cursor Selects the post-cursor emphasis on the transmitter.
TX Diff Swing Selects the differential swing values for the transmitter.
DFE Enabled Selects whether the Decision Feedback Equalizer is enabled on the
receiver (not available for all architectures).

Creating and Running Link Scans

To analyze the margin of a given link, it is often helpful to run a scan of the link using the
specialized Eye Scan hardware of the Xilinx 7 Series FPGA transceivers. The Vivado serial I/O
analyzer feature enables you to define, run, save, and recall link scans.

A scanrunson alink. To create a scan, select a link in the Link window, and either right-click
and choose Create Scan, or click the Create Scan button in the Link window toolbar. This
brings up the Create Scan dialog (see Figure 15-4). The Create Scan dialog shows the
settings for performing a scan, as shown in Table 15-3.

There are two types of scans that can be generated, the 2D Eyescan or the 1D Bathtub Plot.
Both these scans use the same settings specified in the Create Scan dialog shown below.
The Scan type field in the dialog below determines the type of scan generated.
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¢ Create Scan @
Setthe description and other properties to create and optionally run a scan
on the selected link. ‘

Link: Link 0 (MGT_X0Y8/TX, MGT_X0Y&/RX)

Description: | Scan 83

Scan Properties

Scan type:

| 1D Bathtub v|

Horizontal increment. | 8

W

Horizontal range: -0.500 Ul'to 0.500 U1 w
Vertical increment:

Vertical range:

(2)
\2) oK Cancel

Figure 15-4: Create Scan Dialog

Scan Settings

Scan Setting

Description

Description

A user-defined name for the scan.

Scan Type

The type of scan to run. This can be a 2D Eyescan or a 1D Bathtub plot.

Horizontal Increment

Allows you to choose to scan the eye at a reduced resolution, but at increased
speed by skipping horizontal codes.

Horizontal Range

Reducing the horizontal range increases the scan speed. By default, the entire
eye is scanned (-1/2 of a unit interval to +1/2 in reference to the center of the
eye).

Vertical Increment

Allows you to choose to scan the eye at a reduced resolution, but increased
speed by skipping vertical codes.

Vertical Range

Reducing the vertical range increases the scan speed. By default, the entire eye
is scanned.

Dwell BER Each pointin the chart is scanned for a certain amount of time. Dwell BER allows
you to choose the scan depth by selecting the desired Bit Error Ratio.
Dwell Time Dwell Time allows you to choose the scan depth by inputting the desired time

in seconds.
Note: The Dwell time setting is not supported on designs that use In System IBERT IP.
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By default, the scan is run after it is created. If you do not want to run the scan, and only
define it, uncheck the Run Scan check box.

If a scan is created, but not run, it can be subsequently run or run by right-clicking on a scan
in the Scans window and choosing Run Scan (see Figure 15-5). While a scan is running, it
can be prematurely stopped by right-clicking on a scan and choosing Stop Scan, or clicking

the Stop Scan button in the Scans window toolbar.

s sages | SeriallOLinks | Serialli0 Scans X ?_00
Q = 2 » [
Name Link  LinkSetings ~ ResstRX  ScanType  Status

Progress OpenArea  OpenUl%  Homlner  HorzRange Vetiner  VertRange  Dwell Dwell BER  DwellTime  StartTime  End Time

Scans (1
8 ~ -0500UIt0500UI ~ 8 v 100% v~ BER v 1e5 v 0 2017-Mar. 2017-Mar.

[ scan 0 |Linko 2d_full_eye Done —100% 9600 66.67

Figure 15-5: Scans Window

Creating and Running Link Sweeps

To analyze the margin of a given link, it can be helpful to run multiple scans of the link with
different MGT settings. This helps determine which settings are the best. The Vivado serial
I/O analyzer feature enables you to define, run, save, and recall link sweeps, which are a

collection of link scans.
A sweep runs on a link. To create a sweep, select a link in the Link window, and either
right-click and choose Create Sweep, or click the Create Sweep button in the Link window

toolbar. This will bring up the Create Sweep dialog box, which looks similar to the Create
Scan dialog box, except that it has additional options for defining which properties to

sweep, and how.
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Time:

Sweep Properties

Sweep mode Semi Custom

Set Properties & Values P

+

Order Property Name
1 RXTERM

2 THDIFFSWING
3 THPOST

4 THPRE

Reset RX after applying Settings

| Run sweep
(2)
NI

¢ Create Sweep @

Select the sweep properties and values to create and optionally run 3 set of scans on the selected link. ‘

Link: Link 0 (MGT_X0Y8/TX, MGT_X0Y2/RX)

Description: | Sweep 0 |

Scan Properties

Scan type: 2D Full Eyescan ~
Horizontal increment. 8 -
Harizontal range: -0.500 Ul'to 0.500 UI ~
Vertical increment: 8 -
Vertical range: 100% -

Dwell
* BER | 1e-5 v

+~  Foreach properly selectvalues to be swept. The sweep will cover all combinations of property values.

review 21 Scans

Values to Sweep #of Values
100 mV,550 mV, 1100 mV 3

269 mV (0000),741 mV (0111),1118 mV (1111)
0.00 dB (00000),4.08 dB (01111),12.96 dB (11111)
0.00 dB (00000),4.08 dB (01111),6.02 dB (11111)

44 4

3
3
3
for each scan

Table 15-4: Sweep Settings

Figure 15-6: Create Sweep Dialog Box

Sweep Setting

Description

Description

A user-defined name for the sweep.

Scan Type

The type of scan to run. This can be a 2D Eyescan or a 1D Bathtub
plot.

Horizontal Increment

Allows you to scan the eye at a reduced resolution, but at increased
speed by skipping horizontal codes.

Horizontal Range

Reducing the horizontal range increases the scan speed. By default,
the entire eye is scanned (-1/2 of a unitinterval to +1/2 in reference
to the center of the eye).

Vertical Increment

Allows the user to choose to scan the eye at a reduced resolution,
but increased speed by skipping vertical codes.

Vertical Range

Reducing the vertical range increases the scan speed. By default,
the entire eye is scanned.

Dwell BER

Each point in the chart is scanned for a certain amount of time.
Dwell BER allows you to choose the scan depth by selecting the
desired Bit Error Ratio (BER).
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Sweep Setting

Description

Dwell Time Dwell Time allows you to choose the scan depth by inputting the
desired time in seconds.
Sweep Mode The type of sweep to run. The choices are Semi Custom, Full

Custom, and Exhaustive.

After these settings are chosen, the next step is to choose the Sweep Properties. Any
writable properties of the link can be swept. To add a property, click the “+" button on the
left to add another row to the table. Click the Property Name to choose a property to

sweep.

To change the values, click the Values to Sweep Cell, and use the chooser to select which
values to sweep. If the property does not have enumerated values, type one hex value on
each line of the text area provided.

Scan Properties

©)

¢ Create Sweep

Description: Sweep 0

Set Properties 8 Values

Select the sweep properties and values fo create and optionally run a set of scans on the selected link.

Link: Link 0 (MGT_X0YS/TX, MGT_X0Y8/RX)

Scan type 2D Full Eyescan v
Horizontal increment. | 8 ~
Horizontal range: -0.500 Ul to 0.500 UI v
Vertical increment: 8 ~
Vertical range: 100% ~
Dwell
® BER: | 1e5 v
Time
Sweep Properties
Sweep mode: | Full Custom ~ Foreach property select values to be swept. Repeated values are allowed. The sweep will cover the specified property

values in lefi-to-right order.

cans

+ -
Order Property Name Values to Sweep # of Values
NIA RXTERM ~ | 100 mV,550 mV, 1100 mV 3
NiA TXDIFFSWING ~ 269 mV (0000),741 mV (01 ) | a
¢ Select Values for RXTERM (duplicates are allowed)

NiA TXPOST ~  0.00dB (00000),4.08 dB (i |3
NiA TXPRE ~ 0.00 dB (00000),4.08 dB ({ Available values: 16 Selected values: 3 2 3
NIA 100 mv oo toomv " 0
B 200 mv 550 mv o [2

250 mv € 1100mv &

300 mv = T

350 mv i

- 1

400 mv =

500 mv

550 mv

600 my

Reset RX after applying Settings for each scan ~
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¢ In the Semi Custom case shown in Figure 15-8, every combination of the properties
chosen is defined for a single scan, and that scan is performed according to the sweep
properties. The number of sweeps that are performed, and in what order can be
previewed by selecting the Preview & Scans tab.

« In the Full Custom case, the first choice for each of the properties listed is used for the
first scan, the second choice for each of the properties is used for the second scan, etc.
If one of the properties has fewer choices than other properties, the last choice will be
used for all subsequent scans. With the same properties choices but Full Custom as the
sweep Mode, only three scans would be performed.

¢ Create Sweep @
Selectthe sweep properties and values to create and optionally run a set of scans on the selected link. '
Link: Link 0 (MGT_XOYB/TX, MGT_X0Y8/RX)
Description:  Sweep 1
Scan Properties
Scan type: 2D Full Eyescan v
Horizontal increment. 8 v
Horizontal range: -0.500 Ul'to 0.500 U1 v
Vertical increment: 8 v
Vertical range. 100% v
Dwell
® BER: 1e5 -

Time:

Sweep Properties

Sweep mode: | Full Custom ~| Foreach property selectvalues to be swept. Repeated values are allowed. The sweep will cover the specified property

values in left-to-right order,

Set Properties & Values

+
Order Property Name Values to Sweep # of Values
MNIA RXTERM ~ 100 mV,550 mV¥,1100 mY > 3
N/A TXDIFFSWING ~ 269 mV (0000),741 mV (0111),1118 mV (1111) > 3
MNIA THPOST ~ 0.00 dB (00000),4.08 dB (01111),12.96 dB (11111) > 3
N/A TXPRE ~ 0.00dB (00000),4.08 dB (01111),6.02 dB (11111) > 3
Reset RX after applying Settings for each scan
+| Run sweep
@

Figure 15-8: Sweep Properties Dialog Box

« In the Exhaustive case, the Values to Sweep is no longer editable, as all values are
chosen for a given property.

When all the properties are set, to run each of the scans sequentially, keep Run Sweep
checked. The list of scans is elaborated in the Scan window once you click OK.

During the sweep, the progress is tracked in the Scan window, and the latest Scan result is
displayed.
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Displaying and Navigating the Scan Plots

After a scan is created, it automatically launches the Scan Plots window for that scan. For
2D Eyescan, the plot is a heat map of the BER value.

Scan Plots - Scan 1

-0.5
123

Voltage (Codes)

-7

-127

Summary

Name: SCAN_1

- @ e

-0.4

Description

Scan 1

?0O0OX

C 1 [@ [contourFicy

-03

Metrics

Openarea: 3374
Open Ul %: 5231

Settings

Unit Interval BER

3.1e-01
1.0e-01
5.0e-02
1.0e-02
5.0e-03
1.0e-03
5.0e-04
1.0e-04
5.0e-05

1.0e-05
5.0e-06
1.0e-08

Link settings: N/A
Horizon tal incremen it 1

Vivado Programming and Debugging
UG908 (v2019.1) May 22, 2019

Started: 2017-Apr-06 17:17:04
Ended: 2017-Apr-06 17:17:23

Horizontal range: -0.500 Ul to 0.500 UI
Vertical increment: 1

Vertical range 100%

Figure 15-9: Scan Plot Window

As in other charts and displays within the Vivado IDE, the mouse gestures for zooming in
the eye scan plot window are as follows:

« Zoom Area: left-click drag from top-left to bottom-right
« Zoom Fit: left-click drag from bottom-right to top-left

« Zoom In: left-click drag from top-right to bottom-left

e Zoom Out: left-click drag from bottom-left to top-right

Also, when the mouse cursor is over the Plot, the current horizontal and vertical codes,
along with the scanned BER value is displayed in the tooltip. You can also change the plot
type by clicking the Plot Type button in the plot window, and choosing Show Contour
(filled), Show Contour (lines), Bathtub (Center Horizontal Line), and Heat Map.

A summary view is present at the bottom of the scan plot, stating the scan settings, along
with basic information like when the scan was performed. During the 2D Eyescan, the
number of pixels in the scan with zero errors is calculated (taking into account the
horizontal and vertical increments), and this result is displayed as Open Area. The Scan
window contents are sorted by Open Area by default, so the scans with the largest open
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area appear at the top. The following figure is a Bathtub plot for the same scan as shown in
Figure 15-9.

Scan Plots - Scan 1

- @ @ | C| [@ [sanubcentertoiontiiineg

-03 -02 -01 0 01 0.2

-05 -0.4

10910(BER)

7

-8

Summary Metrics Settings
Name: SCAN_1 Open area 3374 Link settings: NIA

Description: Scan 1 Open Ul %: 52.31 Horizontal increment. 1
-0.500 Ul'to 0.500 UI

1

Started 2017-Apr-06 17:17:04 Harizontal range:
Ended: 2017-Apr-08 17:17:23 Vertical incremen it
Vertical range. 100%

Figure 15-10: Bathtub Plot

Writing the Scan Results to a File

When scan data exists due to a partial or full 2D Eyescan, these results can be written to a
CSV file by clicking the Write Scan button in the Scans window. This saves the scan results
to comma-delimited file, with the BER values in a block that replicated the scan plot.

Properties Window

Whenever a GT or a COMMON block in the hardware window, a Link in the Links window,
or a scan in the Scans window is selected, the properties of that object shows in the
Properties window. For GTs and COMMONs, these include all the attribute, port, and other
settings of those objects. These settings can be changed in the Properties window (see
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Figure 15-11), or by writing Tcl commands to change and commit the properties. Some

properties are read-only and cannot be changed.

GT Properties

R MGT_X0Y8

Q = 2|4 i ]
CLASS

CPLLREFCLKSEL

CPLL_FBDIV

CPLL_FBDIV_45
CPLL_REFCLK_DIV
DISPLAY_NAME
> DRP
ES_HORZ_MIN_MAX
GT_TYPE
LINE_RATE
LOGIC
LOOPBACK
MAME
PARENT
PLL_STATUS
PORT
RXDFEEMABLED
RXOUTCLKSEL
RXOUT_DIV
RKPLL

w

w

General Properties PLLs

? 00X

% C
hw_sio_gt
GTREFCLKO
1
4
1
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< ¢ < <

32
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7.980

Mear-End PMA A
localhost 3121 ilin_tcfixili
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9 v
RXOUTCLKPCS hd
9 v
w
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Figure 15-11: Properties Window

Description of Serial I/O Analyzer Tcl Objects and Commands

You can use Tcl commands to interact with your hardware under test. The hardware is
organized in a set of hierarchical first class Tcl objects (see Table 15-5).
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Table 15-5: Serial 1/0 Analyzer Tcl Objects

Tcl Object

Description

hw_sio_ibert

Object referring to an IBERT core. Each IBERT object can have one or more
hw_sio_gt, or hw_sio_common objects associated with it.

hw_sio_gt

Object referring to a single Xilinx Gigabit Transceiver (GT).

hw_sio_gtgroups

Object referring to a logical grouping of GTs, could be a Quad or an Octal.

hw_sio_common

Object referring to a COMMON block.

hw_sio_tx Object referring to the transmitter side of a hw_sio_gt. Only the TX related ports,
attributes, and logic properties flows to the hw_sio_tx.

hw_sio_rx Object referring to the receiver side of a hw_sio_gt. Only the RX related ports,
attributes, and logic properties flows to the hw_sio_rx.

hw_sio_pll Object referring to a PLL in either an hw_sio_gt or an hw_sio_common object.
Only the related ports, attributes, and logic properties flow to the hw_sio_pll.

hw_sio_link Object referring to a link, a TX-RX pair.

Note: A link can also consist of a TX only or an RX only.

hw_sio_linkgroup

Object referring to a group of links.

hw_sio_scan

Object referring to a margin analysis scan.

For more information about the Hardware Manager commands, run the help -category
hardware Tcl command in the Tcl Console.

Description of Tcl Commands to Access Hardware

Table 15-6 contains descriptions of all Tcl commands used to interact with the IBERT core.

IMPORTANT: Using the get_property or set_property command does not read or write information
to/from the IBERT core. You must use the refresh_hw_sio and commit_hw_sio commands to read and
write information from/to the hardware, respectively.

Table 15-6: Descriptions of hw_server Tcl Commands

Tcl Command

Description

refresh_hw_sio

Read the property values out of the provided object. Works for any hw_sio
object that refers to hardware.

commit_hw_sio

Writes property changes to the hardware. Works for any hw_sio object that
refers to hardware.
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Description of hw_sio_link Tcl Commands

Table 15-7 contains descriptions of all Tcl commands used to interact with links.

Table 15-7: Descriptions of hw_sio_link Tcl Commands

Tcl Command Description

create_hw_sio_link Create an hw_sio_link object with the given hw_sio_rx and/or hw_sio_tx objects.

remove_hw_sio_link Deletes the given link.

get_hw_sio_links Get list of hw_sio_links for the given object.

Description of hw_sio_linkgroup Tcl Commands

Table 15-8 contains descriptions of all Tcl commands used to interact with linkgroups.

Table 15-8: Descriptions of hw_sio_linkgroup Tcl Commands

Tcl Command Description

create_hw_sio_linkgroup Create an hw_sio_linkgroup object with the hw_sio_link objects.

remove_hw_sio_linkgroup | Deletes the given linkgroup.

get_hw_sio_linkgroups Get list of hw_sio_linkgroups for the given object.

Description of hw_sio_scan Tcl Commands

Table 15-9 contains descriptions of all Tcl commands used to interact with scans.

Table 15-9: Descriptions of hw_sio_scan Tcl Commands

Tcl Command Description

create_hw_sio_scan Creates a scan object.

remove_hw_sio_scan | Deletes a scan object.

run_hw_sio_scan Runs a scan.

stop_hw_sio_scan Stops a scan.

wait_on_hw_sio_scan | Blocks the Tcl console prompt until a given run_hw_sio_scan operation is
complete.

display_hw_sio_scan | Displays a partial or complete scan in the Scan Plot.

write_hw_sio_scan Writes the scan data to a file.
read_hw_sio_scan Reads scan data from a file into a scan object.
get_hw_sio_scans Get a list of hw_sio_scan objects.
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Description of Tcl Commands to Get Objects

Table 15-10 contains descriptions of all Tcl commands used to get serial I/O objects.

Table 15-10: Descriptions of Tcl Commands to Get Objects

Tcl Command Description
get_hw_sio_iberts Get list of IBERT objects.
get_hw_sio_gts Get list of GTs.

get_hw_sio_commons Get list of COMMON blocks.

get_hw_sio_txs Get list of transmitters.
get_hw_sio_rxs Get list of receivers.
get_hw_sio_plls Get list of PLLs.
get_hw_sio_links Get list of links.

get_hw_sio_linkgroups | Get list of linkgroups.

get_hw_sio_scans Get list of scans.

Using Tcl Commands to Take an IBERT Measurement

Below is an example Tcl command script that interacts with the following example system

+ One KC705 board's Digilent JTAG-SMTL1 cable (serial number 12345) accessible via a
hw_server running on localhost:3121

« Single IBERT core in a design running in the XC7K325T device on the KC705 board
« IBERT core has Quad 117 and Quad 118 enabled
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Example Tcl Command Script

# Connect to the Digilent Cable on localhost:3121
connect_hw_server -url localhost:3121

current_hw_target [get_hw_targets */digilent_plugin/SN:12345]
open_hw_target

# Program and Refresh the XC7K325T Device

current_hw_device [lindex [get_hw_devices] 0]

refresh_hw_device -update_hw_probes false [lindex [get_hw_devices] 0]
set_property PROGRAM.FILE {C:/design.bit} [lindex [get_hw_devices] 0]
program_hw_devices [lindex [get_hw_devices] 0]

refresh_hw_device [lindex [get_hw_devices] 0]

# Set Up Link on first GT

set tx0 [lindex [get_hw_sio_txs] 0]

set rx0 [lindex [get_hw sio_rxs] 0]

set 1ink0 [create_hw_sio_link $tx0 $rx0]

set_property DESCRIPTION {Link 0} [get_hw_sio_links $1ink0]

# Set link to use PCS Loopback, and write to hardware
set_property LOOPBACK "Near-End PCS" $1inkO0
commit_hw_sio $1ink0

# Create, run, display and save scan

set scan0 [create_hw_sio_scan 2d_full_eye [get_hw_sio_rxs -of $1ink0]]
run_hw_sio_scan $scan0

display_hw_sio_scan S$scan0

write_hw_sio_scan "scanO.csv" $scan0

Viewing Slicer Eye, Histogram, and Signal-to-Noise
Ratio (GTM Transceivers Only)

Because the GTM receiver is ADC-based, the conventional eyescan as used in the previous
families of transceivers (such as GTH or GTY transceivers) is cannot be used. For this reason,
the IBERT dashboard for GTM shows three plots: Slicer-Eye, Histogram, and Signal to Noise
Ratio (SNR) instead of the traditional Scan Plot Window.

IBERT GTM Real-Time Scan Plots

c Dual 120 CHO

Slicer Eye O Histogram Signal-to-Noise Ratio

100 100

Amplitude (%)
Amplitude (%)

1600 3200 4800 6400 8000

3000 6000 9000 12000
ES Sample count SNR sample

52 78

Figure 15-12: Slicer Eye, Histogram, and Signal-to-Noise Ratio Plots
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Once a link is created, the Slicer-Eye, Histogram, and Signal to Noise Ratio (SNR) plots are
displayed for the link. If you created multiple links, the active link can be changed by
selecting the desired DUAL and Channel in the upper-right corner.

For more information on the Slicer-Eye and GTM Transceiver Architecture see the Virtex
UltraScale+ GTM Transceivers User Guide, (UG581) [Ref 18].

For more info on IBERT GTM, see the IBERT for UltraScale GTM Transceivers LogiCORE IP
Product Guide, (PG342) [Ref 37].
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Appendix A

Device Configuration Bitstream Settings

7 Series Bitstream Settings

The device configuration settings for 7 Series devices available for use with the
set_property <Setting> <Value> [current_design] Vivado® tool Tcl command
are shown in Table A-1.

Note: Bitstream settings for BPI are not valid for Spartan®-7 devices.

Table A-1: 7 Series Bitstream Settings

Setting

Default
Value

Possible
Values

Description

BITSTREAM.CONFIG.
BPI_1ST_READ_CYCLE

1,23, 4

Helps synchronize BPI configuration with the timing
of page mode operations in flash devices. It allows
you to set the cycle number for a valid read of the

first page. The BPI_page_size must be set to 4 or 8

for this option to be available.

BITSTREAM.CONFIG.
BPI_PAGE_SIZE

1,48

For BPI configuration, this option lets you specify
the page size which corresponds to the number of
reads required per page of flash memory.

BITSTREAM.CONFIG.
BPI_SYNC_MODE

Disable

Disable,
Typel,
Type2

Sets the BPI synchronous configuration mode for
different types of BPI flash devices.

 Disable (the default) disables the synchronous
configuration mode.

» Typel enables the synchronous configuration
mode and settings to support the Micron G18(F)
family.

« Type2 enables the synchronous configuration
mode and settings to support the Micron
(Numonyx) P30 and P33 families.

BITSTREAM.CONFIG.
CCLKPIN®

Pullup

Pullup,
Pullnone

Adds an internal pull-up to the Cclk pin. The
Pullnone setting disables the pullup.

Vivado Programming and Debugging
UG908 (v2019.1) May 22, 2019

o l Send Feedback I 235
www.Xxilinx.com


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=295

& XILINX.

Appendix A: Device Configuration Bitstream Settings

Table A-1: 7 Series Bitstream Settings (Cont’d)
. Default Possible _—

Setting Value Values Description
BITSTREAM.CONFIG. Disable Disable, Enables or disables the loading of a default
CONFIGFALLBACK Enable bitstream when a configuration attempt fails.

If the MultiBoot solution setting
BITSTREAM.CONFIG.NEXT_CONFIG_ADDR is used
then the BITSTREAM.CONFIG.FALLBACK setting will
be enabled.
Note: Fallback MultiBoot is not supported in Virtex-7 HT
devices.
BITSTREAM.CONFIG. 3 3,69 12, Uses an internal oscillator to generate the
CONFIGRATE 16, 22, 26, configuration clock, Cclk, when configuring in a
33, 40, 50, master mode. Use this option to select the rate for
66 Cclk.
BITSTREAM.CONFIG. AsRequired | AsRequired, | Controls how often the Digitally Controlled
DCIUPDATEMODE Continuous, | Impedance circuit attempts to update the
Quiet impedance match for DCI IOSTANDARDs.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up to the DONE pin. The
DONEPIN@ Pullnone Pullnone setting disables the pullup. Use DonePin
only if you intend to connect an external pull-up
resistor to this pin. The internal pull-up resistor is
automatically connected if you do not use DonePin.
BITSTREAM.CONFIG. Disable Disable, Allows an external clock to be used as the
EXTMASTERCCLK_EN Div-1, configuration clock for all master modes. The
Div-2, external clock must be connected to the
Div-4, Div-8 | dual-purpose EMCCLK pin.
BITSTREAM.CONFIG. Pullup Pullup, Specifies whether you want to add a Pullup resistor
INITPIN® Pullnone to the INIT pin, or leave the INIT pin floating.
BITSTREAM.CONFIG. Enable Enable, When Enabled, the INIT_B pin asserts to '0" when a
INITSIGNALSERROR Disable configuration error is detected.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to
MOPIN®@ Pulldown, the MO pin. Select Pullnone to disable both the
Pullnone pull-up resistor and the pull-down resistor on the
MO pin.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to
M1PIN® Pulldown, the M1 pin. Select Pullnone to disable both the
Pullnone pull-up resistor and the pull-down resistor on the
M1 pin.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to
M2PIN? Pulldown, the M2 pin. Select Pullnone to disable both the
Pullnone pull-up resistor and the pull-down resistor on the
M2 pin.
BITSTREAM.CONFIG. None <string> Sets the starting address for the next configuration

NEXT_CONFIG_ADDR

in a MultiBoot set up, which is stored in the WBSTAR
register.
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Appendix A: Device Configuration Bitstream Settings

Table A-1: 7 Series Bitstream Settings (Cont’d)

. Default Possible A
Setting Value Values Description

BITSTREAM.CONFIG. Enable Enable, When set to Disable the IPROG command is removed

NEXT_CONFIG_REBOOT Disable from the .bit file. This allows the Golden image to
load upon power up rather than jumping to the
multiboot image in a multiboot setup.

BITSTREAM.CONFIG. No No, Yes Maintains the configuration logic access to the

PERSIST multi-function configuration pins after
configuration. Primarily used to maintain the
SelectMAP port after configuration for readback
access, but can be used with any configuration
mode. Persist is not needed for JTAG configuration
since the JTAG port is dedicated and always
available. PERSIST and ICAP cannot be used at the
same time.
Refer to the user guide for a description. Persist is
needed for Readback and Partial Reconfiguration
using the SelectMAP configuration pins, and should
be used when either SelectMAP or Serial modes are
used.

BITSTREAM.CONFIG. 00 00, 01, 10, Specifies the internal value of the RS[1:0] settings in

REVISIONSELECT 11 the Warm Boot Start Address (WBSTAR) register for
the next warm boot.

BITSTREAM.CONFIG. Disable Disable, Specifies whether the RS[1:0] 3-state is enabled by

REVISIONSELECT_ Enable setting the option in the Warm Boot Start Address

TRISTATE (WBSTAR).
« 0: Enable RS 3-state
« 1: Disable RS 3-state

BITSTREAM.CONFIG. Enable Enable, Enables or disables the SelectMAP mode Abort

SELECTMAPABORT Disable sequence. If disabled, an Abort sequence on the
device pins is ignored.

BITSTREAM.CONFIG. No No, Yes Enables SPI 32-bit address style, which is required

SPI_32BIT_ADDR for SPI devices with storage of 256 Mb and larger.

BITSTREAM.CONFIG. NONE NONE, 1, 2, | Sets the SPI bus to Dual (x2) or Quad (x4) mode for

SPI_BUSWIDTH 4 Master SPI configuration from third party SPI flash
devices.

BITSTREAM.CONFIG. No No, Yes Sets the FPGA to use a falling edge clock for SPI data

SPI_FALL_EDGE capture. This improves timing margins and may
allow faster clock rates for configuration.

BITSTREAM.CONFIG. Pullup Pullup, Adds a pull-up, a pull-down, or neither to the TCK

TCKPIN@ Pulldown, pin, the JTAG test clock. The Pullnone setting shows

Pullnone that there is no connection to either the pull-up or

the pull-down.

BITSTREAM.CONFIG. Pullup Pullup, Adds a pull-up, a pull-down, or neither to the TDI

TDIPIN@ Pulldown, pin, the serial data input to all JTAG instructions and

Pullnone JTAG registers. The Pullnone setting shows that

there is no connection to either the pull-up or the
pull-down.
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Appendix A: Device Configuration Bitstream Settings

Table A-1: 7 Series Bitstream Settings (Cont’d)
. Default Possible _—

Setting Value Values Description
BITSTREAM.CONFIG. Pullup Pullup, Adds a pull-up, a pull-down, or neither to the TDO
TDOPIN@ Pulldown, pin, the serial data output for all JTAG instruction

Pullnone and data registers. The Pullnone setting shows that
there is no connection to either the pull-up or the
pull-down.

BITSTREAM.CONFIG. None <8-digit Enables the Watchdog Timer in Configuration mode

TIMER_CFG hex string> | and sets the value. This option cannot be used at the
same time as TIMER_USR.

BITSTREAM.CONFIG. 0x00000000 | <8-digit Enables the Watchdog Timer in Configuration mode

TIMER_USR hex string> | and sets the value. This option cannot be used at the
same time as TIMER_CFG.

BITSTREAM.CONFIG. Pullup Pullup, Adds a pull-up, pull-down, or neither to the TMS pin,

TMSPIN@ Pulldown, the mode input signal to the TAP controller. The TAP

Pullnone controller provides the control logic for JTAG. The
Pullnone setting shows that there is no connection
to either the pull-up or the pull-down.

BITSTREAM.CONFIG. Pulldown Pulldown, Adds a pull-up, a pull-down, or neither to unused
UNUSEDPIN Pullup, SelectlO pins (I0Bs). It has no effect on dedicated

Pullnone configuration pins. The list of dedicated
configuration pins varies depending upon the
architecture. The Pullnone setting shows that there
is no connection to either the pull-up or the
pull-down.

BITSTREAM.CONFIG. OXFFFFFFFF | <8-digit Used to identify implementation revisions. You can

USERID hex string> | enter up to an 8-digit hexadecimal string in the User
ID register.

BITSTREAM.CONFIG. None None, Writes an 8-digit hexadecimal string, or a timestamp

USR_ACCESS <8-digit into the AXSS configuration register. The format of

hex string>, | the timestamp value is ddddd MMMM yyyyyy hhhhh

TIMESTAMP | mmmmmm ssssss : day, month, year (year 2000 =
00000), hour, minute, seconds. The contents of this
register may be directly accessed by the FPGA fabric
via the USR_ACCESS primitive.

BITSTREAM.ENCRYPTION. No No Yes Encrypts the bitstream.

ENCRYPT

BITSTREAM.ENCRYPTION. bbram bbram, Determines the location of the AES encryption key to
ENCRYPTKEYSELECT efuse be used, either from the battery-backed RAM

(BBRAM) or the eFUSE register.
Note: This property is only available when the Encrypt
option is set to True.
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Appendix A: Device Configuration Bitstream Settings

Table A-1: 7 Series Bitstream Settings (Cont’d)
. Default Possible A
Setting Value Values Description
BITSTREAM.ENCRYPTION. None <hex HKey sets the HMAC authentication key for
HKEY string> bitstream encryption. 7 series devices have an
on-chip bitstream-keyed Hash Message
Authentication Code (HMAC) algorithm
implemented in hardware to provide additional
security beyond AES decryption alone. These
devices require both AES and HMAC keys to load,
modify, intercept, or clone the bitstream.
To use this option, you must first set Encrypt to Yes.
BITSTREAM.ENCRYPTION. None <hex KeyO sets the AES encryption key for bitstream
KEYO string> encryption. To use this option, you must first set
Encrypt to Yes.
BITSTREAM.ENCRYPTION. None <string> Specifies the name of the input encryption file (with
KEYFILE a .nky file extension). To use this option, you must
first set Encrypt to Yes.
BITSTREAM.ENCRYPTION. None <32-bit hex | Sets the starting cipher block chaining (CBC) value.
STARTCBC string>
BITSTREAM.GENERAL. False True, False Uses the multiple frame write feature in the
COMPRESS bitstream to reduce the size of the bitstream, not just
the Bitstream (.bit) file. Using Compress does not
guarantee that the size of the bitstream shrinks.
BITSTREAM.GENERAL. Enable Enable, Controls the generation of a Cyclic Redundancy
CRC Disable Check (CRC) value in the bitstream. When enabled, a
unique CRC value is calculated based on bitstream
contents. If the calculated CRC value does not match
the CRC value in the bitstream, the device will fail to
configure. When CRC is disabled a constant value is
inserted in the bitstream in place of the CRC, and the
device does not calculate a CRC.
The CRC default value is Enable, except when
BITSTREAM.ENCRYPTION.ENCRYPT is Yes, the CRCis
disabled.
BITSTREAM.GENERAL. No No, Yes Lets you create a debug bitstream. A debug

DEBUGBITSTREAM

bitstream is significantly larger than a standard
bitstream. DebugBitstream can be used only for
master and slave serial configurations.
DebugBitstream is not valid for Boundary Scan or
Slave Parallel/SelectMAP. In addition to a standard
bitstream, a debug bitstream offers the following
features:
» Writes 32 Os to the LOUT register after the
synchronization word.

» Loads each frame individually.

» Performs a Cyclic Redundancy Check (CRC) after
each frame.

» Writes the frame address to the LOUT register
after each frame.
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Appendix A: Device Configuration Bitstream Settings

Table A-1: 7 Series Bitstream Settings (Cont’d)
. Default Possible .

Setting Value Values Description
BITSTREAM.GENERAL. No No, Yes Disables communication to the Boundary Scan
DISABLE_JTAG (BSCAN) block via JTAG after configuration.
BITSTREAM.GENERAL. Enable Enable, Enables or disables the JTAG connection to the
JTAG_XADC Disable, XADC.

StatusOnly
BITSTREAM.GENERAL. No No, Yes Inserts CRC values at regular intervals within
PERFRAMECRC bitstreams. These values validate the integrity of the
incoming bitstream and can flag an error (shown on
the INIT_B pin and the PRERROR port of the ICAP)
prior to loading the configuration data into the
device. While most appropriate for partial
bitstreams, when set to Yes, this property inserts the
CRC values into all bitstreams, including full device
bitstreams.
BITSTREAM.GENERAL. Off Off, On Disables some built-in digital calibration features
XADCENHANCEDLINEARITY that make INL look worse than the actual analog
performance.
BITSTREAM.READBACK. No No, Yes Prevents the assertions of GHIGH and GSR during
ACTIVERECONFIG configuration. This is required for the active partial
reconfiguration enhancement features.
BITSTREAM.READBACK. Auto Auto, Top, Selects between the top and bottom ICAP ports.
ICAP_SELECT Bottom
BITSTREAM.READBACK. False True, False Lets you perform the Readback function by creating
READBACK the necessary readback files.
BITSTREAM.READBACK. None None, Specifies whether to disable Readback and
SECURITY Levell, Reconfiguration.
Level2 Note: Specifying Security Levell disables Readback.
Specifying Security Level2 disables Readback and
Reconfiguration.
BITSTREAM.READBACK. Disable Disable, When Disabled XADC can work continuously during
XADCPARTIALRECONFIG Enable Partial Reconfiguration. When Enabled XADC works
in Safe mode during partial reconfiguration.
BITSTREAM.STARTUP. Yes Yes, No Tells the FPGA device to wait on the CFG_DONE
DONEPIPE (DONE) pin to go High and then wait for the first
clock edge before moving to the Done state.
BITSTREAM.STARTUP. 4 4,1, 2, 3,5, |Selects the Startup phase that activates the FPGA
DONE_CYCLE 6, Keep Done signal. Done is delayed when DonePipe=Yes.
BITSTREAM.STARTUP. 5 5,1, 2, 3,4, | Selects the Startup phase that releases the internal
GTS_CYCLE 6, Done, 3-state control to the I/O buffers.
Keep
BITSTREAM.STARTUP. 6 6,1, 2, 3,4, | Selects the Startup phase that asserts the internal
GWE_CYCLE 5, Done, write enable to flip-flops, LUT RAMs, and shift
Keep registers. GWE_cycle also enables the BRAMS. Before

the Startup phase, both block RAMs writing and
reading are disabled.
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Appendix A: Device Configuration Bitstream Settings

Table A-1: 7 Series Bitstream Settings (Cont’d)

. Default Possible A
Setting Value Values Description
BITSTREAM.STARTUP. NoWait NoWait, 0, Selects the Startup phase to wait until DLLs/
LCK_CYCLE 1,2, 3,4,5 | DCMs/PLLs lock. If you select NoWait, the Startup
6 sequence does not wait for DLLs/DCMs/PLLs to lock.
BITSTREAM.STARTUP. Auto Auto, Specifies a stall in the Startup cycle until digitally
MATCH_CYCLE NoWait, 0, controlled impedance (DCI) match signals are
1,2,3,4,5 | asserted. DCI matching does not begin on the
6 Match_cycle. The Startup sequence waits in this cycle
until DCI has matched. Given that there are a number
of variables in determining how long it takes DCI to
match, the number of CCLK cycles required to
complete the Startup sequence may vary in any
given system. Ideally, the configuration solution
should continue driving CCLK until DONE goes high.
Note: When the Auto setting is specified,
write_bitstream searches the design for any DCI1/O
standards. If DCI standards exist, write_bitstreamuses
BITSTREAM.STARTUP.MATCH_CYCLE=2. Otherwise,
write_bitstream uses
BITSTREAM.STARTUP.MATCH_CYCLE=NoWait.
BITSTREAM.STARTUP. Cclk Cclk, The StartupClk sequence following the
STARTUPCLK UserClk, configuration of a device can be synchronized to
JtagClk either Cclk, a User Clock, or the JTAG Clock. The

default is Cclk.

» Cclk lets you synchronize to an internal clock
provided in the FPGA device.

» UserClk lets you synchronize to a user-defined
signal connected to the CLK pin of the STARTUP
symbol.

« JtagClk lets you synchronize to the clock provided
by JTAG. This clock sequences the TAP controller
which provides the control logic for JTAG.

Note: The Spartan7 7s6/ 7s15 devices, do not support the

STARTUPE2.CLK (UserClk) user startup clock pin.

a. For the dedicated configuration pins Xilinx recommends that you use the bitstream setting default.

Zyng-7000 Bitstream Settings

The device configuration settings for Zynq®-7000 devices available for use with the
set_property <Setting> <Value>
are shown in Table A-2.

[current_design] Vivado tool Tcl command

Note: Bitstream settings for encryption are not valid for Zyng-7000 devices.
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Appendix A: Device Configuration Bitstream Settings

Table A-2: 2ynq-7000 Bitstream Settings
. Default Possible .

Setting Value Values Description
BITSTREAM.CONFIG. 1 1,23, 4 Helps synchronize BPI configuration with the timing
BPI_1ST_READ_CYCLE of page mode operations in flash devices. It allows

you to set the cycle number for a valid read of the

first page. The BPI_page_size must be set to 4 or 8

for this option to be available.

BITSTREAM.CONFIG. 1 1,438 For BPI configuration, this option lets you specify
BPI_PAGE_SIZE the page size which corresponds to the number of
reads required per page of flash memory.
BITSTREAM.CONFIG. Disable Disable, Sets the BPI synchronous configuration mode for
BPI_SYNC_MODE Typel, different types of BPI flash devices.
Type2 « Disable (the default) disables the synchronous
configuration mode.

» Typel enables the synchronous configuration
mode and settings to support the Micron G18(F)
family.

» Type2 enables the synchronous configuration
mode and settings to support the Micron
(Numonyx) P30 and P33 families.

BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up to the Cclk pin. The
CCLKPIN®@ Pullnone Pullnone setting disables the pullup.
BITSTREAM.CONFIG. Enable Disable, Enables or disables the loading of a default
CONFIGFALLBACK Enable bitstream when a configuration attempt fails.
BITSTREAM.CONFIG. 3 3,6,9, 12, Uses an internal oscillator to generate the
CONFIGRATE 16, 22, 26, configuration clock, Cclk, when configuring in a
33, 40, 50, master mode. Use this option to select the rate for
66 Cclk.
BITSTREAM.CONFIG. AsRequired | AsRequired, | Controls how often the Digitally Controlled
DCIUPDATEMODE Continuous, | Impedance circuit attempts to update the
Quiet impedance match for DCI IOSTANDARD:s.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up to the DONE pin. The
DONEPIN@ Pullnone Pullnone setting disables the pullup. Use DonePin
only if you intend to connect an external pull-up
resistor to this pin. The internal pull-up resistor is
automatically connected if you do not use DonePin.
BITSTREAM.CONFIG. Pullup Pullup, Specifies whether you want to add a Pullup resistor
INITPIN® Pullnone to the INIT pin, or leave the INIT pin floating.
BITSTREAM.CONFIG. Enable Enable, When Enabled, the INIT_B pin asserts to '0' when a
INITSIGNALSERROR Disable configuration error is detected.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to
MOPIN?® Pulldown, the MO pin. Select Pullnone to disable both the
Pullnone pull-up resistor and the pull-down resistor on the

MO pin.
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Appendix A: Device Configuration Bitstream Settings

Table A-2: Zynq-7000 Bitstream Settings (Cont’d)
. Default Possible A
Setting Value Values Description
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to
M1PIN@ Pulldown, the M1 pin. Select Pullnone to disable both the
Pullnone pull-up resistor and the pull-down resistor on the
M1 pin.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to
M2PIN? Pulldown, the M2 pin. Select Pullnone to disable both the
Pullnone pull-up resistor and the pull-down resistor on the
M2 pin.
BITSTREAM.CONFIG. None <string> Sets the starting address for the next configuration
NEXT_CONFIG_ADDR in a MultiBoot set up, which is stored in the WBSTAR
register.
BITSTREAM.CONFIG. Enable Enable, When set to Disable the IPROG command is
NEXT_CONFIG_REBOOT Disable removed from the .bit file. This allows the Golden
image to load upon power up rather than jumping
to the multiboot image in a multiboot setup.
BITSTREAM.CONFIG. Disable Disable, Enables the device to shut down when the XADC
OVERTEMPPOWERDOWN Enable detects a temperature beyond the acceptable
operational maximum. An external circuitry set up
for the XADC is required to use this option.
BITSTREAM.CONFIG. No No, Yes Maintains the configuration logic access to the
PERSIST multi-function configuration pins after
configuration. Primarily used to maintain the
SelectMAP port after configuration for readback
access, but can be used with any configuration
mode. Persist is not needed for JTAG configuration
since the JTAG port is dedicated and always
available. PERSIST and ICAP cannot be used at the
same time.
Refer to the user guide for a description. Persist is
needed for Readback and Partial Reconfiguration
using the SelectMAP configuration pins, and should
be used when either SelectMAP or Serial modes are
used.
BITSTREAM.CONFIG. 00 00, 01, 10, Specifies the internal value of the RS[1:0] settings in
REVISIONSELECT 11 the Warm Boot Start Address (WBSTAR) register for
the next warm boot.
BITSTREAM.CONFIG. Disable Disable, Specifies whether the RS[1:0] 3-state is enabled by
REVISIONSELECT_ Enable setting the option in the Warm Boot Start Address
TRISTATE (WBSTAR).
» RS[1:0] pins 3-state enable
+ 0: Enable RS 3-state
« 1: Disable RS 3-state
BITSTREAM.CONFIG. Enable Enable, Enables or disables the SelectMAP mode Abort
SELECTMAPABORT Disable sequence. If disabled, an Abort sequence on the

device pins is ignored.
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Table A-2: Zynq-7000 Bitstream Settings (Cont’d)
. Default Possible —

Setting Value Values Description
BITSTREAM.CONFIG. No No, Yes Enables SPI 32-bit address style, which is required
SPI_32BIT_ADDR for SPI devices with storage of 256 Mb and larger.
BITSTREAM.CONFIG. NONE NONE, 1, 2, | Sets the SPI bus to Dual (x2) or Quad (x4) mode for
SPI_BUSWIDTH 4 Master SPI configuration from third party SPI flash

devices.
BITSTREAM.CONFIG. No No, Yes Sets the FPGA to use a falling edge clock for SPI data
SPI_FALL_EDGE capture. This improves timing margins and may
allow faster clock rates for configuration.
BITSTREAM.CONFIG. Pullup Pullup, Adds a pull-up, a pull-down, or neither to the TCK
TCKPINa Pulldown, pin, the JTAG test clock. The Pullnone setting shows
Pullnone that there is no connection to either the pull-up or
the pull-down.
BITSTREAM.CONFIG. Pullup Pullup, Adds a pull-up, a pull-down, or neither to the TDI
TDIPIN2 Pulldown, pin, the serial data input to all JTAG instructions and
Pullnone JTAG registers. The Pullnone setting shows that
there is no connection to either the pull-up or the
pull-down.
BITSTREAM.CONFIG. Pullup Pullup, Adds a pull-up, a pull-down, or neither to the TDO
TDOPINA@ Pulldown, pin, the serial data output for all JTAG instruction
Pullnone and data registers. The Pullnone setting shows that
there is no connection to either the pull-up or the
pull-down.
BITSTREAM.CONFIG. None <8-digit Enables the Watchdog Timer in Configuration mode
TIMER_CFG hex string> | and sets the value. This option cannot be used at the
same time as TIMER_USR.
BITSTREAM.CONFIG. 0x00000000 | <8-digit Enables the Watchdog Timer in Configuration mode
TIMER_USR hex string> | and sets the value. This option cannot be used at the
same time as TIMER_CFG.
BITSTREAM.CONFIG. Pullup Pullup, Adds a pull-up, pull-down, or neither to the TMS
TMSPIN? Pulldown, pin, the mode input signal to the TAP controller. The
Pullnone TAP controller provides the control logic for JTAG.
The Pullnone setting shows that there is no
connection to either the pull-up or the pull-down.
BITSTREAM.CONFIG. Pulldown Pulldown, Adds a pull-up, a pull-down, or neither to unused
UNUSEDPIN Pullup, SelectIO pins (IOBs). It has no effect on dedicated
Pullnone configuration pins. The list of dedicated
configuration pins varies depending upon the
architecture. The Pullnone setting shows that there
is no connection to either the pull-up or the
pull-down.
BITSTREAM.CONFIG. OxFFFFFFFF | <8-digit Used to identify implementation revisions. You can
USERID hex string> | enter up to an 8-digit hexadecimal string in the User

ID register.
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Table A-2:

Appendix A: Device Configuration Bitstream Settings

Zyng-7000 Bitstream Settings (Cont’d)

Setting

Default
Value

Possible
Values

Description

BITSTREAM.CONFIG.
USR_ACCESS

None

<8-digit
hex string>,
TIMESTAMP

Writes an 8-digit hexadecimal string, or a timestamp
into the AXSS configuration register. The format of
the timestamp value is ddddd MMMM yyyyyy hhhhh
mmmmmm ssssss : day, month, year (year 2000 =
00000), hour, minute, seconds. The contents of this
register may be directly accessed by the FPGA fabric
via the USR_ACCESS primitive.

BITSTREAM.ENCRYPTION.
ENCRYPTKEYSELECT

bbram

bbram,
efuse

Determines the location of the AES encryption key
to be used, either from the battery-backed RAM
(BBRAM) or the eFUSE register. (7 Series)

Note: This property is only available when the Encrypt
option is set to True.

BITSTREAM.GENERAL.
COMPRESS

False

True, False

Uses the multiple frame write feature in the
bitstream to reduce the size of the bitstream, not
just the Bitstream (.bit) file. Using Compress does
not guarantee that the size of the bitstream shrinks.

BITSTREAM.GENERAL.
CRC

Enable

Enable,
Disable

Controls the generation of a Cyclic Redundancy
Check (CRC) value in the bitstream. When enabled, a
unique CRC value is calculated based on bitstream
contents. If the calculated CRC value does not match
the CRC value in the bitstream, the device will fail to
configure. When CRC is disabled a constant value is
inserted in the bitstream in place of the CRC, and the
device does not calculate a CRC.

The CRC default value is Enable, except when
BITSTREAM.ENCRYPTION.ENCRYPT is Yes, the CRCis
disabled.

BITSTREAM.GENERAL.
DISABLE_JTAG

No

No, Yes

Disables communication to the Boundary Scan
(BSCAN) block via JTAG after configuration.

BITSTREAM.GENERAL.
JTAG_XADC

Enable

Enable,
Disable,
StatusOnly

Enables or disables the JTAG connection to the
XADC.

BITSTREAM.GENERAL.
XADCENHANCEDLINEARITY

Off

Off, On

Disables some built-in digital calibration features
that make INL look worse than the actual analog
performance.

BITSTREAM.GENERAL.
PERFRAMECRC

No

No, Yes

Inserts CRC values at regular intervals within
bitstreams. These values validate the integrity of the
incoming bitstream and can flag an error (shown on
the INIT_B pin and the PRERROR port of the ICAP)
prior to loading the configuration data into the
device. While most appropriate for partial
bitstreams, when set to Yes, this property inserts the
CRC values into all bitstreams, including full device
bitstreams.

BITSTREAM.READBACK.
ACTIVERECONFIG

No

No, Yes

Prevents the assertions of GHIGH and GSR during
configuration. This is required for the active partial
reconfiguration enhancement features.
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Appendix A: Device Configuration Bitstream Settings

Table A-2:  Zyng-7000 Bitstream Settings (Cont’d)
. Default Possible A
Setting Value Values Description
BITSTREAM.READBACK. Auto Auto, Top, | Selects between the top and bottom ICAP ports.
ICAP_SELECT Bottom
BITSTREAM.READBACK. False True, False | Lets you perform the Readback function by creating
READBACK the necessary readback files.
BITSTREAM.READBACK. None None, Specifies whether to disable Readback and
SECURITY Levell, Reconfiguration.
Level2 Note: Specifying Security Levell disables Readback.
Specifying Security Level2 disables Readback and
Reconfiguration.
BITSTREAM.READBACK. Disable Disable, When Disabled XADC can work continuously during
XADCPARTIALRECONFIG Enable Partial Reconfiguration. When Enabled XADC works
in Safe mode during partial reconfiguration.
BITSTREAM.STARTUP. Yes Yes, No Tells the FPGA device to wait on the CFG_DONE
DONEPIPE (DONE) pin to go High and then wait for the first
clock edge before moving to the Done state.
BITSTREAM.STARTUP. 4 4,1, 2, 3,5, |Selects the Startup phase that activates the FPGA
DONE_CYCLE 6, Keep Done signal. Done is delayed when DonePipe=Yes.
BITSTREAM.STARTUP. 5 5,1, 2, 3,4, | Selects the Startup phase that releases the internal
GTS_CYCLE 6, Done, 3-state control to the I/O buffers.
Keep
BITSTREAM.STARTUP. 6 6,1, 2, 3,4, | Selects the Startup phase that asserts the internal
GWE_CYCLE 5, Done, write enable to flip-flops, LUT RAMs, and shift
Keep registers. GWE_cycle also enables the BRAMS.
Before the Startup phase, both block RAMs writing
and reading are disabled.
BITSTREAM.STARTUP. NoWait NoWait, 0, | Selects the Startup phase to wait until DLLs/
LCK_CYCLE 1,2, 3,4,5 | DCMs/PLLs lock. If you select NoWait, the Startup
6 sequence does not wait for DLLs/DCMs/PLLs to lock.
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Table A-2: Zynq-7000 Bitstream Settings (Cont’d)

Default Possible

Setting Value Values

Description

BITSTREAM.STARTUP. Auto Auto, Specifies a stall in the Startup cycle until digitally
MATCH_CYCLE NoWait, 0O, controlled impedance (DCI) match signals are

1,2, 3,4,5 | asserted. DCI matching does not begin on the

6 Match_cycle. The Startup sequence waits in this
cycle until DCI has matched. Given that there are a
number of variables in determining how long it
takes DCI to match, the number of CCLK cycles
required to complete the Startup sequence may vary
in any given system. Ideally, the configuration
solution should continue driving CCLK until DONE
goes high.

Note: When the Auto setting is specified,
write_bitstream searches the design for any DCI1/O
standards. If DCI standards exist, write_bitstreamuses
BITSTREAM.STARTUP.MATCH_CYCLE=2. Otherwise,
write_bitstream uses
BITSTREAM.STARTUP.MATCH_CYCLE=NoWait.

BITSTREAM.STARTUP. Cclk Cclk, The StartupClk sequence following the
STARTUPCLK UserClk, configuration of a device can be synchronized to
JtagClk either Cclk, a User Clock, or the JTAG Clock. The
default is Cclk.

» Cclk lets you synchronize to an internal clock
provided in the FPGA device.

» UserClk lets you synchronize to a user-defined
signal connected to the CLK pin of the STARTUP
symbol.

« JtagClk lets you synchronize to the clock provided
by JTAG. This clock sequences the TAP controller
which provides the control logic for JTAG.

a. For the dedicated configuration pins Xilinx recommends that you use the bitstream setting default.
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Appendix A: Device Configuration Bitstream Settings

UltraScale Bitstream Settings

The device configuration settings for UltraScale™ devices available for use with the

set_property <Setting> <Value>

are shown in Table A-3.

[current_design] Vivado tool Tcl command

Table A-3: UltraScale Bitstream Settings
. Default Possible A
Setting Value Values Description
BITSTREAM. No Yes, No Indicates whether or not to use RSA authentication. If
AUTHENTICATION. No then AES_GCM is used.
AUTHENTICATE
BITSTREAM. None <string> Specifies the OpenSSL .pem file that contains the key
AUTHENTICATION. pairs that should be used to sign the RSA-2048
RSAPRIVATEKEYFILE authenticated bitstream.
BITSTREAM.CONFIG. 1 1,234 Helps synchronize BPI configuration with the timing
BPI_1ST_READ_CYCLE of page mode operations in flash devices. It allows
you to set the cycle number for a valid read of the
first page. The BPI_page_size must be set to 4 or 8 for
this option to be available.
BITSTREAM.CONFIG. 1 1,48 For BPI configuration, this option lets you specify the
BPI_PAGE_SIZE page size which corresponds to the number of reads
required per page of flash memory.
BITSTREAM.CONFIG. Disable Disable, Sets the BPI synchronous configuration mode for
BPI_SYNC_MODE Typel, Type2 | different types of BPI flash devices.

« Disable (the default) disables the synchronous
configuration mode.

« Typel enables the synchronous configuration
mode and settings to support the Micron G18(F)
family.

« Type2 enables the synchronous configuration
mode and settings to support the Micron
(Numonyx) P30 and P33 families.

BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up to the Cclk pin. The Pullnone
CCLKPIN® Pullnone setting disables the pullup.
BITSTREAM.CONFIG. Enable Disable, Enables or disables the loading of a default bitstream
CONFIGFALLBACK Enable when a configuration attempt fails.
BITSTREAM.CONFIG. 3 3,6,9, 12,22, | Uses an internal oscillator to generate the
CONFIGRATE 33,40, 50, 57, | configuration clock, Cclk, when configuring in a
69, 82, 87,90, | master mode. Use this option to select the rate for
110,115,130, | Cclk.
148
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to the
D00_MOSIa Pulldown, D00_MOSI pin. Select Pullnone to disable both the
Pullnone pull-up resistor and the pull-down resistor on the

D00_MOSI pin.
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Appendix A: Device Configuration Bitstream Settings

Table A-3: UltraScale Bitstream Settings (Cont’d)
. Default Possible A
Setting Value Values Description
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to the
D01_DIN?® Pulldown, DO1_DIN pin. Select Pullnone to disable both the
Pullnone pull-up resistor and the pull-down resistor on the
DO1_DIN pin.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to the
D022 Pulldown, D02 pin. Select Pullnone to disable both the pull-up
Pullnone resistor and the pull-down resistor on the D02 pin.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to the
D032 Pulldown, D03 pin. Select Pullnone to disable both the pull-up
Pullnone resistor and the pull-down resistor on the D03 pin.
BITSTREAM.CONFIG. AsRequire | AsRequired, | Controls how often the Digitally Controlled
DCIUPDATEMODE d Continuous, | Impedance circuit attempts to update the impedance
Quiet match for DCI IOSTANDARD:s.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up to the DONE pin. The
DONEPIN@ Pullnone Pullnone setting disables the pullup. Use DonePin
only if you intend to connect an external pull-up
resistor to this pin. The internal pull-up resistor is
automatically connected if you do not use DonePin.
BITSTREAM.CONFIG. Disable Disable, Allows an external clock to be used as the
EXTMASTERCCLK_EN Div-1, Div-2, | configuration clock for all master modes. The
Div-3, Div-4, | external clock must be connected to the
Div-6, Div-8, | dual-purpose EMCCLK pin.
Div-12,
Div-16,
Div-24,
Div-48
BITSTREAM.CONFIG. Pullup Pullup, Specifies whether you want to add a Pullup resistor
INITPIN® Pullnone to the INIT pin, or leave the INIT pin floating.
BITSTREAM.CONFIG. Enable Enable, When Enabled, the INIT_B pin asserts to '0' when a
INITSIGNALSERROR Disable configuration error is detected.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to the
MOPIN?® Pulldown, MO pin. Select Pullnone to disable both the pull-up
Pullnone resistor and the pull-down resistor on the MO pin.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to the
M1PIN® Pulldown, M1 pin. Select Pullnone to disable both the pull-up
Pullnone resistor and the pull-down resistor on the M1 pin.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to the
M2PIN® Pulldown, M2 pin. Select Pullnone to disable both the pull-up
Pullnone resistor and the pull-down resistor on the M2 pin.
BITSTREAM.CONFIG. none <string> Sets the starting address for the next configuration in

NEXT_CONFIG_ADDR

a MultiBoot set up, which is stored in the WBSTAR
register.
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Appendix A: Device Configuration Bitstream Settings

Table A-3: UltraScale Bitstream Settings (Cont’d)
. Default Possible _——

Setting Value Values Description
BITSTREAM.CONFIG. Enable Enable, When set to Disable the IPROG command is removed
NEXT_CONFIG_REBOOT Disable from the .bit file. This allows the Golden image to

load upon power up rather than jumping to the
multiboot image in a multiboot setup.
BITSTREAM.CONFIG. Disable Disable, Enables the device to shut down when the System
OVERTEMPSHUTDOWN Enable Monitor detects a temperature beyond the
acceptable operational maximum. An external
circuitry set up for the System Monitor is required to
use this option.
BITSTREAM.CONFIG. No No, Yes Maintains the configuration logic access to the
PERSIST multi-function configuration pins after
configuration. Primarily used to maintain the
SelectMAP port after configuration for readback
access, but can be used with any configuration mode.
Persist is not needed for JTAG configuration since the
JTAG port is dedicated and always available. Persist
and ICAP cannot be used at the same time.
Refer to the user guide for a description. Persist is
needed for Readback and Partial Reconfiguration
using the SelectMAP configuration pins, and should
be used when either SelectMAP or Serial modes are
used.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up to the PROGRAM_B pin. The
PROGPINa Pullnone Pullnone setting disables the pullup. The pullup
affects the pin after configuration.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to the
PUDC_B? Pulldown, PUDC_B pin. Select Pullnone to disable both the
Pullnone pull-up resistor and the pull-down resistor on the
PUDC_B pin.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to the
RDWR_B_FCS_B? Pulldown, RDWR_B_FCS_B pin. Select Pullnone to disable both
Pullnone the pull-up resistor and the pull-down resistor on the
RDWR_B_FCS_B pin.
BITSTREAM.CONFIG. 00 00, 01, 10, 11 | Specifies the internal value of the RS[1:0] settings in
REVISIONSELECT the Warm Boot Start Address (WBSTAR) register for
the next warm boot.
BITSTREAM.CONFIG. Disable Disable, Specifies whether the RS[1:0] 3-state is enabled by
REVISIONSELECT_ Enable setting the option in the Warm Boot Start Address
TRISTATE (WBSTAR).
« RS[1:0] pins 3-state enable
+ 0: Enable RS 3-state
« 1: Disable RS 3-state
BITSTREAM.CONFIG. Enable Enable, Enables or disables the SelectMAP mode Abort
SELECTMAPABORT Disable sequence. If disabled, an Abort sequence on the

device pins is ignored.
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Table A-3: UltraScale Bitstream Settings (Cont’d)
. Default Possible _——

Setting Value Values Description
BITSTREAM.CONFIG. No No, Yes Enables SPI 32-bit address style, which is required for
SPI_32BIT_ADDR SPI devices with storage of 256 Mb and larger.
BITSTREAM.CONFIG. NONE NONE, 1, 2,4, | Sets the SPI bus to Dual (x2) or Quad (x4) mode for
SPI_BUSWIDTH 8 Master SPI configuration from third party SPI flash

devices.
BITSTREAM.CONFIG. No No, Yes Sets the FPGA to use a falling edge clock for SPI data
SPI_FALL_EDGE capture. This improves timing margins and may allow
faster clock rates for configuration.
BITSTREAM.CONFIG. Pullup Pullup, Adds a pull-up, a pull-down, or neither to the TCK
TCKPINa Pulldown, pin, the JTAG test clock. The Pullnone setting shows
Pullnone that there is no connection to either the pull-up or
the pull-down.
BITSTREAM.CONFIG. Pullup Pullup, Adds a pull-up, a pull-down, or neither to the TDI pin,
TDIPIN2 Pulldown, the serial data input to all JTAG instructions and JTAG
Pullnone registers. The Pullnone setting shows that there is no
connection to either the pull-up or the pull-down.
BITSTREAM.CONFIG. Pullup Pullup, Adds a pull-up, a pull-down, or neither to the TDO
TDOPIN@ Pulldown, pin, the serial data output for all JTAG instruction and
Pullnone data registers. The Pullnone setting shows that there
is no connection to either the pull-up or the
pull-down.
BITSTREAM.CONFIG. None <8-digit hex | Enables the Watchdog Timer in Configuration mode
TIMER_CFG string> and sets the value. This option cannot be used at the
same time as TIMER_USR.
BITSTREAM.CONFIG. 0x0000000 | <8-digit hex | Enables the Watchdog Timer in Configuration mode
TIMER_USR 0 string> and sets the value. This option cannot be used at the
same time as TIMER_CFG.
BITSTREAM.CONFIG. Pullup Pullup, Adds a pull-up, pull-down, or neither to the TMS pin,
TMSPIN?® Pulldown, the mode input signal to the TAP controller. The TAP
Pullnone controller provides the control logic for JTAG. The
Pullnone setting shows that there is no connection to
either the pull-up or the pull-down.
BITSTREAM.CONFIG. Pulldown | Pulldown, Adds a pull-up, a pull-down, or neither to unused
UNUSEDPIN Pullup, SelectIO pins (IOBs). It has no effect on dedicated
Pullnone configuration pins. The list of dedicated
configuration pins varies depending upon the
architecture. The Pullnone setting shows that there is
no connection to either the pull-up or the pull-down.
BITSTREAM.CONFIG. OxFFFFFFF | <8-digit hex | Used to identify implementation revisions. You can
USERID F string> enter up to an 8-digit hexadecimal string in the User

ID register.
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Table A-3: UltraScale Bitstream Settings (Cont’d)
. Default Possible A
Setting Value Values Description
BITSTREAM.CONFIG. None <8-digit hex | Writes an 8-digit hexadecimal string, or a timestamp
USR_ACCESS string>, into the AXSS configuration register. The format of
TIMESTAMP | the timestamp value is ddddd MMMM yyyyyy hhhhh
mmmmmm ssssss : day, month, year (year 2000 =
00000), hour, minute, seconds. The contents of this
register may be directly accessed by the FPGA fabric
via the USR_ACCESS primitive.
BITSTREAM.ENCRYPTION. No No Yes Encrypts the bitstream.
ENCRYPT
BITSTREAM.ENCRYPTION. bbram bbram, efuse | Determines the location of the AES encryption key to
ENCRYPTKEYSELECT be used, either from the battery-backed RAM
(BBRAM) or the eFUSE register.
Note: This property is only available when the Encrypt
option is set to True.
BITSTREAM.ENCRYPTION. None Path to Specifies the install location of the Family Key. No
FAMILY_KEY_FILEPATH familyKey.cfg | specific directory is required.
Note: Xilinx does not provide the family key as part of the
Xilinx Tool Suite. Customers must send a request for the
family key to secure.solutions@xilinx.com. The family key is
then distributed to qualified customers through the
Product Licensing site on www.xilinx.com.
BITSTREAM.ENCRYPTION. None <hex string> | KeyO sets the AES encryption key for bitstream
KEYO encryption. To use this option, you must first set
Encrypt to Yes.
BITSTREAM.ENCRYPTION. None <string> Specifies the name of the input encryption file (with
KEYFILE a .nky file extension). To use this option, you must
first set Encrypt to Yes.
BITSTREAM.ENCRYPTION. 32 4 up to The number of 128-bit encryption blocks over which
KEYLIFE 2147483647 | a single key should be used for AES-GCM
authenticated bitstreams.
Setting this to 0 will disable these options
BITSTREAM.ENCRYPTION. 8 8 up to Specifies how many configuration frames should be
RSAKEYLIFEFRAMES 2147483647 | used for any given AES-256 key when RSA Public Key
Authentication is specified. A value of 8
configuration frames is equivalent to using the key
for 246 encryption blocks.
Setting this to 0 will disable these options.
BITSTREAM.ENCRYPTION. Disable Enable, Creates a bitstream whereby the key used to encrypt
OBFUSCATEKEY Disable the bitstream is obfuscated before it is written to

eFUSE or battery-backed RAM (BBR). This allows the
user to provide the device programmer with an
obfuscated key rather than the original customer key.
The device programmer can then write the
obfuscated key to the eFUSE or BBR and mark it as
obfuscated using the obfuscated-key flag in the
selected storage location.
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Table A-3:

UltraScale Bitstream Settings (Cont’d)

Appendix A: Device Configuration Bitstream Settings

Setting

Default
Value

Possible
Values

Description

BITSTREAM.ENCRYPTION.

STARTIVO

The initialization vector used to specify the initial
GCM count value in the first AES-GCM message.
32-bit hex value.

BITSTREAM.ENCRYPTION.

STARTIVOBFUSCATE

Starting obfuscate initial vector (Obfuscate IV0)
value.

BITSTREAM.GENERAL.
COMPRESS

False

True, False

Uses the multiple frame write feature in the bitstream
to reduce the size of the bitstream, not just the
Bitstream (.bit) file. Using Compress does not
guarantee that the size of the bitstream shrinks.

BITSTREAM.GENERAL.
CRC

Enable

Enable,
Disable

Controls the generation of a Cyclic Redundancy
Check (CRC) value in the bitstream. When enabled, a
unique CRC value is calculated based on bitstream
contents. If the calculated CRC value does not match
the CRC value in the bitstream, the device will fail to
configure. When CRC is disabled a constant value is
inserted in the bitstream in place of the CRC, and the
device does not calculate a CRC.

The CRC default value is Enable, except when

BITSTREAM.ENCRYPTION.ENCRYPT is Yes, the CRC is
disabled.

BITSTREAM.GENERAL.
DEBUGBITSTREAM

No

No, Yes

Lets you create a debug bitstream. A debug bitstream
is significantly larger than a standard bitstream.
DebugBitstream can be used only for master and
slave serial configurations. DebugBitstream is not
valid for Boundary Scan or Slave Parallel/SelectMAP.
In addition to a standard bitstream, a debug
bitstream offers the following features:

« Writes 32 Os to the LOUT register after the
synchronization word.

« Loads each frame individually.

« Performs a Cyclic Redundancy Check (CRC) after
each frame.

« Writes the frame address to the LOUT register after
each frame.

BITSTREAM.GENERAL.
DISABLE_JTAG

No

No, Yes

Disables communication to the Boundary Scan
(BSCAN) block via JTAG after configuration.

BITSTREAM.GENERAL.
PERFRAMECRC

No

No, Yes

Inserts CRC values at regular intervals within
bitstreams. These values validate the integrity of the
incoming bitstream and can flag an error (shown on
the INIT_B pin and the PRERROR port of the ICAP)
prior to loading the configuration data into the
device. While most appropriate for partial bitstreams,
when set to Yes, this property inserts the CRC values
into all bitstreams, including full device bitstreams.

BITSTREAM.GENERAL.
JTAG_SYSMON

Enable

Enable,
Disable,
StatusOnly

Enables or disables the JTAG connection to SYSMON.
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Table A-3: UltraScale Bitstream Settings (Cont’d)
. Default Possible -

Setting Value Values Description
BITSTREAM.GENERAL. Disable Disable, Enables the device to power down SYSMON to save
SYSMONPOWERDOWN Enable power. Only recommended for permanently

powering down SYSMON.
BITSTREAM.READBACK. No No, Yes Prevents the assertions of GHIGH and GSR during
ACTIVERECONFIG configuration. This is required for the active partial
reconfiguration enhancement features.
BITSTREAM.READBACK. Auto Auto, Top, Selects between the top and bottom ICAP ports.
ICAP_SELECT Bottom
BITSTREAM.READBACK. False True, False Lets you perform the Readback function by creating
READBACK the necessary readback files.
BITSTREAM.READBACK. None None, Levell, | Specifies whether to disable Readback and
SECURITY Level2 Reconfiguration.
Note: Specifying Security Levell disables Readback.
Specifying Security Level2 disables Readback and
Reconfiguration.
BITSTREAM.STARTUP. 4 4,1,2,3,5,6, | Selects the Startup phase that activates the FPGA
DONE_CYCLE Keep Done signal. Done is delayed when DonePipe=Yes.
BITSTREAM.STARTUP. 5 51,2, 3,4,6, | Selects the Startup phase that releases the internal
GTS_CYCLE Done, Keep 3-state control to the I/O buffers.
BITSTREAM.STARTUP. 6 6,1,2 3,4,5, | Selects the Startup phase that asserts the internal
GWE_CYCLE Done, Keep write enable to flip-flops, LUT RAMs, and shift
registers. GWE_cycle also enables the BRAMS. Before
the Startup phase, both block RAMs writing and
reading are disabled.
BITSTREAM.STARTUP. NoWait NoWait, 0, 1, | Selects the Startup phase to wait until
LCK_CYCLE 2,3,4,5,6 DLLs/DCMs/PLLs lock. If you select NoWait, the
Startup sequence does not wait for DLLs/DCMs/PLLs
to lock.
BITSTREAM.STARTUP. Auto Auto, Specifies a stall in the Startup cycle until digitally
MATCH_CYCLE NoWait, 0, 1, | controlled impedance (DCI) match signals are
2,3,4,5 6 asserted. DCI matching does not begin on the

Match_cycle. The Startup sequence waits in this cycle
until DCI has matched. Given that there are a number
of variables in determining how long it takes DCI to
match, the number of CCLK cycles required to
complete the Startup sequence may vary in any given
system. Ideally, the configuration solution should
continue driving CCLK until DONE goes high.

Note: When the Auto setting is specified,
write_bitstream searches the design for any DCII/O
standards. If DCI standards exist, write_bitstream uses
BITSTREAM.STARTUP.MATCH_CYCLE=2. Otherwise,
write_bitstream uses

BITSTREAM.STARTUP.MATCH_CYCLE=NoWait.

a. For the dedicated configuration pins Xilinx recommends that you use the default bitstream setting.
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Virtex and Kintex UltraScale+ Bitstream Settings

The device configuration settings for Virtex and Kintex® UltraScale+™ devices available for
use with the set_property <Setting> <Value> [current_design] Vivado tool Tcl
command are shown in Table A-4.

Table A-4: Virtex and Kintex UltraScale+ Bitstream Settings
. Default Possible ..
Setting Values Values Description
BITSTREAM. No No, Yes Indicates whether or not to use RSA authentication.
AUTHENTICATION. If No then AES_GCM is used.
AUTHENTICATE
BITSTREAM. Specifies the OpenSSL .pem file that contains the
AUTHENTICATION. key pairs that should be used to sign the RSA-2048
RSAPRIVATEKEYFILE authenticated bitstream.
BITSTREAM.CONFIG. 1 1,2 3,4 Helps synchronize BPI configuration with the timing
BPI_1ST_READ_CYCLE of page mode operations in flash devices. It allows
you to set the cycle number for a valid read of the
first page. The BPI_page_size must be set to 4 or 8
for this option to be available.
BITSTREAM.CONFIG. 1 1, 4,8 For BPI configuration, this sub-option lets you
BPI_PAGE_SIZE specify the page size which corresponds to the
number of reads required per page of flash memory.
BITSTREAM.CONFIG. Disable Disable, Sets the BPI synchronous configuration mode for
BPI_SYNC_MODE Typel, Type2 | different types of BPI flash devices.

- Disable (the default) disables the synchronous
configuration mode.

« Typel enables the synchronous configuration
mode and settings to support the Micron G18(F)
family.

« Type2 enables the synchronous configuration
mode and settings to support the Micron
(Numonyx) P30 and P33 families.

BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up to the Cclk pin. The
CCLKPIN Pullnone Pullnone setting disables the pullup.
BITSTREAM.CONFIG. No No, Yes Prohibit usage of the configuration pins as user I/O
PERSIST and persist after configuration.
BITSTREAM.CONFIG. 2.7 2.7,5.3, 8.0, Bitstream generation uses an internal oscillator to
CONFIGRATE 10.6, 21.3, generate the configuration clock, Cclk, when

31.9, 364, configuring is in a master mode. Use this

51.0, 56.7, sub-option to select the rate for Cclk.

63.8,72.9,

85.0, 102.0,

127.5,170.0
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Appendix A: Device Configuration Bitstream Settings

Table A-4: Virtex and Kintex UltraScale+ Bitstream Settings (Cont’d)
. Default Possible _—

Setting Values Values Description
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to
D00_MOSI Pulldown, the DOO_MOSI pin. Select Pullnone to disable both

Pullnone the pull-up resistor and the pull-down resistor on
the DOO_MOSI pin.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to
D01_DIN Pulldown, the DO1_DIN pin. Select Pullnone to disable both
Pullnone the pull-up resistor and the pull-down resistor on
the DO1_DIN pin.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to
D02 Pulldown, the D02 pin. Select Pullnone to disable both the
Pullnone pull-up resistor and the pull-down resistor on the
D02 pin.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to
D03 Pulldown, the D03 pin. Select Pullnone to disable both the
Pullnone pull-up resistor and the pull-down resistor on the
D03 pin.
BITSTREAM.CONFIG. AsRequire | AsRequired, Controls how often the Digitally Controlled
DCIUPDATEMODE d Quiet, Safe Impedance circuit attempts to update the
impedance match for DCI IOSTANDARDs.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up to the DONE pin. The
DONEPIN Pullnone Pullnone setting disables the pullup. Use DonePin
only if you intend to connect an external pull-up
resistor to this pin. The internal pull-up resistor is
automatically connected if you do not use DonePin.
BITSTREAM.CONFIG. Disable Disable, Allows an external clock to be used as the
EXTMASTERCCLK_EN Div-1, Div-2, configuration clock for all master modes. The
Div-3. Div-4, external clock must be connected to the
Div-6, Div-8, | dual-purpose EMCCLK pin.
Div-12,
Div-16,
Div-24,
Div-48
BITSTREAM.ENCRYPTION. None Path to Specifies the install location of the Family Key. No
FAMILY_KEY_FILEPATH familyKey.cfg | specific directory is required.
Note: Xilinx does not provide the family key as part of the
Xilinx Tool Suite. Customers must send a request for the
family key to secure.solutions@xilinx.com. The family key
is then distributed to qualified customers through the
Product Licensing site on www.xilinx.com.
BITSTREAM.CONFIG. Pullup Pullup, Specifies whether you want to add a Pullup resistor
INITPIN Pullnone to the INIT pin, or leave the INIT pin floating.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to
MOPIN Pulldown, the MO pin. Select Pullnone to disable both the
Pullnone pull-up resistor and the pull-down resistor on the

MO pin.
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Appendix A: Device Configuration Bitstream Settings

Table A-4: Virtex and Kintex UltraScale+ Bitstream Settings (Cont’d)
. Default Possible A
Setting Values Values Description
BITSTREAM. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to
CONFIG.M1PIN Pulldown, the M1 pin. Select Pullnone to disable both the
Pullnone pull-up resistor and the pull-down resistor on the
M1 pin.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to
M2PIN Pulldown, the M2 pin. Select Pullnone to disable both the
Pullnone pull-up resistor and the pull-down resistor on the
M2 pin.
BITSTREAM.CONFIG. None <string> Sets the starting address for the next configuration
NEXT_CONFIG_ADDR in a MultiBoot set up, which is stored in the WBSTAR
register.
BITSTREAM.CONFIG. Enable Enable, When set to Disable the IPROG command is
NEXT_CONFIG_REBOOT Disable removed from the .bit file.
BITSTREAM.CONFIG. Enable Enable, Enables or disables the SelectMAP mode Abort
SELECTMAPABORT Disable sequence. If disabled, an Abort sequence on the
device pins is ignored.
BITSTREAM.CONFIG. Enable Enable, Enables or disables the loading of a default
CONFIGFALLBACK Disable bitstream when a configuration attempt fails.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up to the PROGRAM_B pin.
PROGPIN Pullnone The Pullnone setting disables the pullup. The pullup
affects the pin after configuration.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to
PUDC_B Pulldown, the PUDC_B pin. Select Pullnone to disable both the
Pullnone pull-up resistor and the pull-down resistor on the
PUDC_B pin.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to
RDWR_B_FCS B Pulldown, the RDWR_B_FCS_B pin. Select Pullnone to disable
Pullnone both the pull-up resistor and the pull-down resistor
on the RDWR_B_FCS_B pin.
BITSTREAM.CONFIG. 00 00, 01, 10, 11 | Specifies the internal value of the RS[1:0] settings in
REVISIONSELECT the Warm Boot Start Address (WBSTAR) register for
the next warm boot.
BITSTREAM.CONFIG. Disable Disable, Specifies whether the RS[1:0] 3-state is enabled by
REVISIONSELECT_ Enable setting the option in the Warm Boot Start
TRISTATE Address(WBSTAR).
« RS[1:0] pins 3-state enable
+ 0: Enable RS 3-state
« 1: Disable RS 3-state
BITSTREAM.CONFIG. Disable Disable, Enables the device to shut down when the System
OVERTEMPSHUTDOWN Enable Monitor detects a temperature beyond the
acceptable operational maximum. An external
circuitry set up for the System Monitor is required to
use this option.
BITSTREAM.CONFIG. No No, Yes Enables SPI 32-bit address style, which is required

SPI_32BIT_ADDR

for SPI devices with storage of 256 Mb and larger.
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Appendix A: Device Configuration Bitstream Settings

Table A-4: Virtex and Kintex UltraScale+ Bitstream Settings (Cont’d)
. Default Possible _—

Setting Values Values Description
BITSTREAM.CONFIG. NONE NONE, 1, 2, 4, | Sets the SPI bus to Dual (x2) or Quad (x4) mode for
SPI_BUSWIDTH 8 Master SPI configuration from third party SPI flash

devices.
BITSTREAM.CONFIG. No No, Yes Sets the FPGA to use a falling edge clock for SPI data
SPI_FALL_EDGE capture. This improves timing margins and may
allow faster clock rates for configuration.
BITSTREAM.CONFIG. Pullup Pullup, Adds a pull-up, a pull-down, or neither to the TCK
TCKPIN Pulldown, pin, the JTAG test clock. The Pullnone setting shows
Pullnone that there is no connection to either the pull-up or
the pull-down.
BITSTREAM.CONFIG. Pullup Pullup, Adds a pull-up, a pull-down, or neither to the TDI
TDIPIN Pulldown, pin, the serial data input to all JTAG instructions and
Pullnone JTAG registers. The Pullnone setting shows that
there is no connection to either the pull-up or the
pull-down.
BITSTREAM.CONFIG. Pullup Pullup, Adds a pull-up, a pull-down, or neither to the TDO
TDOPIN Pulldown, pin, the serial data output for all JTAG instruction
Pullnone and data registers. The Pullnone setting shows that
there is no connection to either the pull-up or the
pull-down.
BITSTREAM.CONFIG. Enables the Watchdog Timer in Configuration mode
TIMER_CFG and sets the value. This option cannot be used at the
same time as TIMER_USR.
BITSTREAM.CONFIG. Enables the Watchdog Timer in Configuration mode
TIMER_USR and sets the value. This option cannot be used at the
same time as TIMER_CFG.
BITSTREAM.CONFIG. Pullup Pullup, Adds a pull-up, pull-down, or neither to the TMS
TMSPIN Pulldown, pin, the mode input signal to the TAP controller. The
Pullnone TAP controller provides the control logic for JTAG.
The Pullnone setting shows that there is no
connection to either the pull-up or the pull-down.
BITSTREAM.CONFIG. Pulldown | Pullup, Adds a pull-up, a pull-down, or neither to unused
UNUSEDPIN Pulldown, SelectIO pins (IOBs). It has no effect on dedicated
Pullnone configuration pins. The list of dedicated
configuration pins varies depending upon the
architecture. The Pullnone setting shows that there
is no connection to either the pull-up or the
pull-down.
BITSTREAM.CONFIG. OXFFFFFFF | OXFFFFFFFF Used to identify implementation revisions. You can
USERID F enter up to an 8-digit hexadecimal string in the User

ID register.
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Appendix A: Device Configuration Bitstream Settings

Table A-4: Virtex and Kintex UltraScale+ Bitstream Settings (Cont’d)

. Default Possible .

Setting Values Values Description
BITSTREAM.CONFIG. None None, Writes an 8-digit hexadecimal string, or a
USR_ACCESS <8-digit hex | timestamp into the AXSS configuration register. The

string>, format of the timestamp value is ddddd MMMM
TIMESTAMP | yyyyyy hhhhh mmmmmm ssssss : day, month, year

(year 2000 = 00000), hour, minute, seconds. The
contents of this register may be directly accessed by
the FPGA fabric via the USR_ACCESS primitive.

BITSTREAM.CONFIG. Enable Enable, When Enabled, the INIT_B pin asserts to '0' when a

INITSIGNALSERROR Disable configuration error is detected.

BITSTREAM. No No, Yes Encrypts the bitstream.

ENCRYPTION.

ENCRYPT

BITSTREAM. bbram bbram, efuse | Determines the location of the AES encryption key

ENCRYPTION. to be used, either from the battery-backed RAM

ENCRYPTKEYSELECT (BBRAM) or the eFUSE register. This property is only
available when the Encrypt option is set to True.

BITSTREAM. Disable Disable, When the AES key is not read-secured, a read of the

ENCRYPTION. Enable key returns the CRC hash of the key instead of the

OBFUSCATEKEY actual key value.

BITSTREAM. KeyO sets the 64-bit AES encryption key for

ENCRYPTION. bitstream encryption. To get the pick setting, leave

KEYO this blank generator to select a random number for
the value. To use this option, you must first set
Encrypt to Yes.

BITSTREAM. Sets the 128-bit starting AES initial vector value. To

ENCRYPTION. use this option, you must first set Encrypt to Yes.

STARTIVO

BITSTREAM. Sets the 32-bit starting obfuscate initial vector

ENCRYPTION. value. To use this option, you must first set Encrypt

STARTIVOBFUSCATE to Yes.

BITSTREAM. Specifies the name of the input encryption file (with

ENCRYPTION. a .nky file extension). To use this option, you must

KEYFILE first set Encrypt to Yes.

BITSTREAM. 32 4 up to The number of 128-bit encryption blocks over which

ENCRYPTION. 2147483647 | a single key should be used for AES-GCM

KEYLIFE authenticated bitstreams.

BITSTREAM. 8 8 up to Specifies how many configuration frames should be

ENCRYPTION. 2147483647 used for any given AES-256 key when RSA Public

RSAKEYLIFEFRAMES Key Authentication is specified. A value of 8
configuration frames is equivalent to using the key
for 246 encryption blocks.

BITSTREAM. False True, False Uses the multiple frame write feature in the

GENERAL. bitstream to reduce the size of the bitstream, not

COMPRESS just the bit file. Using compress does not guarantee

that the size of the bitstream will shrink.
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(: XI LI NX® Appendix A: Device Configuration Bitstream Settings

Table A-4: Virtex and Kintex UltraScale+ Bitstream Settings (Cont’d)

Default Possible
Values Values

BITSTREAM.GENERAL.CRC Enable Enable, Controls the generation of a Cyclic Redundancy
Disable Check (CRC) value in the bitstream. When enabled,
a unique CRC value is calculated based on bitstream
contents. If the calculated CRC value does not match
the CRC value in the bitstream, the device will fail to
configure. When CRC is disabled a constant value is
inserted in the bitstream in place of the CRC, and
the device does not calculate a CRC.

The CRC default value is Enable, except when
BITSTREAM.ENCRYPTION.ENCRYPT is Yes, the CRC is
disabled.

BITSTREAM.GENERAL. No No, Yes Lets you create a debug bitstream. A debug
DEBUGBITSTREAM bitstream is significantly larger than a standard
bitstream. DebugBitstream can be used only for
master and slave serial configurations.
DebugBitstream is not valid for Boundary Scan or
Slave Parallel/SelectMAP. In addition to a standard
bitstream, a debug bitstream offers the following
features: Writes 32 Os to the LOUT register after the
synchronization word. Loads each frame
individually. Performs a Cyclic Redundancy Check
(CRC) after each frame. Writes the frame address to
the LOUT register after each frame.

BITSTREAM.GENERAL. No No, Yes Inserts CRC values at regular intervals within
PERFRAMECRC bitstreams. These values validate the integrity of the
incoming bitstream and can flag an error (shown on
the INIT_B pin and the PRERROR port of the ICAP)
prior to loading the configuration data into the
device. While most appropriate for partial
bitstreams, when set to Yes, this property inserts the
CRC values into all bitstreams, including full device
bitstreams.

BITSTREAM.GENERAL. Disable Disable, Enables the device to power down SYSMON to save
SYSMONPOWERDOWN Enable power. Only recommended for permanently
powering down SYSMON.

BITSTREAM.GENERAL. No No, Yes Disables communication to the Boundary Scan
DISABLE_JTAG (BSCAN) block via JTAG after configuration.

BITSTREAM.GENERAL. Enable Enable, Enables or disables the JTAG connection to
JTAG_SYSMON Disable, SYSMON.
StatusOnly

BITSTREAM.READBACK. Auto Auto, Top, Selects between the top and bottom ICAP ports.
ICAP_SELECT Bottom

BITSTREAM.READBACK. No No, Yes Prevents the assertions of GHIGH and GSR during
ACTIVERECONFIG configuration. This is required for the active partial
reconfiguration enhancement features.

Setting Description
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Appendix A: Device Configuration Bitstream Settings

Table A-4: Virtex and Kintex UltraScale+ Bitstream Settings (Cont’d)
. Default Possible .
Setting Values Values Description
BITSTREAM. None None, Levell, | Specifies whether to disable Readback and
READBACK. Level2 Reconfiguration.
SECURITY Note: Specifying Security Levell disables Readback.
BITSTREAM.STARTUP. 4 4,1, 2, 3,5 6 |Selects the Startup phase that activates the FPGA
DONE_CYCLE Done signal. Done is delayed when DonePipe=Yes.
BITSTREAM.STARTUP. 5 51,2, 3,4,6, | Selects the Startup phase that releases the internal
GTS_CYCLE Done, Keep 3-state control to the I/O buffers.
BITSTREAM.STARTUP. 6 6,1,2, 3,4,5, | Selects the Startup phase that asserts the internal
GWE_CYCLE Done, Keep write enable to flip-flops, LUT RAMs, and shift
registers. GWE_cycle also enables the BRAMS.
Before the Startup phase, both block RAMs writing
and reading are disabled.
BITSTREAM.STARTUP. NoWait NoWait, 0, 1, | Selects the Startup phase to wait until MMCM/PLLs
LCK_CYCLE 2,3,4,56 lock. If you select NoWait, the Startup sequence
does not wait for MMCM/PLLs to lock.
BITSTREAM.STARTUP. Auto Auto, NoWait, | Specifies a stall in the Startup cycle until digitally
MATCH_CYCLE 0,1,2 3,4,5, | controlled impedance (DCI) match signals are
6 asserted. DCI matching does not begin on the

Match_cycle. The Startup sequence waits in this
cycle until DCI has matched. Given that there are a
number of variables in determining how long it
takes DCI to match, the number of CCLK cycles
required to complete the Startup sequence may
vary in any given system. Ideally, the configuration
solution should continue driving CCLK until DONE
goes high.

Note: When the Auto setting is specified,
write_bitstream searches the design for any DCII/O
standards. If DCI standards exist, write_bitstream
uses BITSTREAM.STARTUP.MATCH_CYCLE=2. Otherwise,
write_bitstream uses
BITSTREAM.STARTUP.MATCH_CYCLE=NoWait.
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Appendix A: Device Configuration Bitstream Settings

& XILINX.

Zynq UltraScale+ MPSoC Bitstream Settings

The device configuration settings for Zynq® UltraScale+™ MPSoC devices available for use
with the set_property <Setting> <Value> [current_design] Vivado tool Tcl
command are shown in Table A-5.

Table A-5: Zynq UltraScale+ MPSoC Bitstream Settings

Default Possible

Setting Values Value

Description

BITSTREAM.CONFIG. AsRequired | AsRequired, | Controls how often the Digitally Controlled

DCIUPDATEMODE Quiet, Safe | Impedance circuit attempts to update the
impedance match for DCI IOSTANDARD:s.
BITSTREAM.CONFIG. Pullup Pullup, Adds an internal pull-up, pull-down, or neither to
PUDC_B Pulldown, the PUDC_B pin. Select Pullnone to disable both the
Pullnone pull-up resistor and the pull-down resistor on the
PUDC_B pin.
BITSTREAM.CONFIG. Disable Disable, Enables the device to shut down when the System
OVERTEMPSHUTDOWN Enable Monitor detects a temperature beyond the
acceptable operational maximum. An external
circuitry set up for the System Monitor is required to
use this option.
BITSTREAM.CONFIG. Pulldown Pullup, Adds a pull-up, a pull-down, or neither to unused
UNUSEDPIN Pulldown, SelectIO pins (IOBs). It has no effect on dedicated
Pullnone configuration pins. The list of dedicated

configuration pins varies depending upon the
architecture. The Pullnone setting shows that there
is no connection to either the pull-up or the

pull-down.
BITSTREAM.CONFIG. OxFFFFFFFF | OXFFFFFFFF | Used to identify implementation revisions. You can
USERID enter up to an 8-digit hexadecimal string in the User
ID register.
BITSTREAM.CONFIG. None None, Writes an 8-digit hexadecimal string, or a timestamp

USR_ACCESS <8-digithex | into the AXSS configuration register. The format of
string>, the timestamp value is ddddd MMMM yyyyyy hhhhh
TIMESTAMP | mmmmmm ssssss : day, month, year (year 2000 =
00000), hour, minute, seconds. The contents of this
register may be directly accessed by the FPGA fabric
via the USR_ACCESS primitive.
BITSTREAM.CONFIG. Enable Enable, When Enabled, the INIT_B pin asserts to '0' when a
INITSIGNALSERROR Disable configuration error is detected.
BITSTREAM.GENERAL. False True, False Uses the multiple frame write feature in the

COMPRESS

bitstream to reduce the size of the bitstream, not just
the bit file. Using compress does not guarantee that
the size of the bitstream will shrink.
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Table A-5: Zynq UltraScale+ MPSoC Bitstream Settings (Cont’d)
. Default Possible A
Setting Values Value Description
BITSTREAM.GENERAL. Enable Enable, Controls the generation of a Cyclic Redundancy
CRC Disable Check (CRC) value in the bitstream. When enabled, a
unique CRC value is calculated based on bitstream
contents. If the calculated CRC value does not match
the CRC value in the bitstream, the device will fail to
configure. When CRC is disabled a constant value is
inserted in the bitstream in place of the CRC, and the
device does not calculate a CRC.
BITSTREAM.GENERAL. No No, Yes Inserts CRC values at regular intervals within
PERFRAMECRC bitstreams. These values validate the integrity of the
incoming bitstream and can flag an error (shown on
the INIT_B pin and the PRERROR port of the ICAP)
prior to loading the configuration data into the
device. While most appropriate for partial
bitstreams, when set to Yes, this property inserts the
CRC values into all bitstreams, including full device
bitstreams.
BITSTREAM.GENERAL. Disable Disable, Enables the device to power down SYSMON to save
SYSMONPOWERDOWN Enable power. Only recommended for permanently
powering down SYSMON.
BITSTREAM.GENERAL. No No, Yes Disables communication to the Boundary Scan
DISABLE_JTAG (BSCAN) block via JTAG after configuration.
BITSTREAM.GENERAL. Enable Enable, Enables or disables the JTAG connection to SYSMON.
JTAG_SYSMON Disable,
StatusOnly
BITSTREAM.READBACK. Auto Auto, Top, Selects between the top and bottom ICAP ports.
ICAP_SELECT Bottom
BITSTREAM.READBACK. No No, Yes Prevents the assertions of GHIGH and GSR during
ACTIVERECONFIG configuration. This is required for the active partial
reconfiguration enhancement features.
BITSTREAM.READBACK. None None, Specifies whether to disable Readback and
SECURITY Levell, Reconfiguration.
Level2 Note: Specifying Security Levell disables
Readback.Specifying Security
BITSTREAM.STARTUP. 4 4,1, 2,3,5 | Selects the Startup phase that activates the FPGA
DONE_CYCLE 6, Keep Done signal. Done is delayed when DonePipe=Yes
BITSTREAM.STARTUP. 5 5,1, 2,3,4, |Selects the Startup phase that releases the internal
GTS_CYCLE 6, Done, 3-state control to the I/O buffers
Keep
BITSTREAM.STARTUP. 6 6,1, 2, 3,4, | Selects the Startup phase that asserts the internal
GWE_CYCLE 5, Done, write enable to flip-flops, LUT RAMs, and shift
Keep registers. GWE_cycle also enables the BRAMS. Before

the Startup phase, both block RAMs writing and
reading are disabled.
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Table A-5: Zynq UltraScale+ MPSoC Bitstream Settings (Cont’d)

. Default Possible .

Setting Values Value Description
BITSTREAM.STARTUP. NoWait NoWait, 0O, Selects the Startup phase to wait until MMCM/PLLs
LCK_CYCLE 1,2, 3,4,5 |lock. If you select NoWait, the Startup sequence

6 does not wait for MMCM/PLLs to lock.
BITSTREAM.STARTUP. Auto Auto, Specifies a stall in the Startup cycle until digitally
MATCH_CYCLE NoWait, 0, controlled impedance (DCI) match signals are

1,2, 3,4,5 | asserted. DCI matching does not begin on the

6 Match_cycle. The Startup sequence waits in this cycle

until DCI has matched. Given that there are a number
of variables in determining how long it takes DCI to
match, the number of CCLK cycles required to
complete the Startup sequence may vary in any
given system. Ideally, the configuration solution
should continue driving CCLK until DONE goes high.
Note: When the Auto setting is specified,
write_bitstream searches the design for any DCI1/O
standards. If DCI standards exist, write_bitstream uses
BITSTREAM.STARTUP.MATCH_CYCLE=2. Otherwise,
write_bitstream uses

BITSTREAM.STARTUP.MATCH_CYCLE=NoWait.
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Appendix B

Trigger State Machine Language
Description

The trigger state machine language is used to describe complex trigger conditions that map
to the advanced trigger logic of the ILA debug core. The trigger state machine has the
following features:

* Up to 16 states.

« One-, two-, and three-way conditional branching used for complex state transitions.
« Four built-in 16-bit counters used to count events, implement timers, etc.

« Four built-in flags used for monitoring trigger state machine execution status.

« Trigger action.

States

Each state machine program can have up to 16 states declared. Each state is composed of
a state declaration and a body:

state <state_name>:
<state_body>

Goto Action

The goto action is used to transition between states. Here is an example of using the goto
action to transition from one state to another before triggering:

state my_state_0:
goto my_state_1;

state my_state_1:
trigger;
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Conditional Branching

The trigger state machine language supports one-, two-, and three-way conditional
branching per state.

« One-way branching involves using goto actions without any if/elseif/else/endif
constructs:

state my_state_0:
goto my_state_1;

« Two-way conditional branching uses goto actions with if/else/endif constructs:

state my_state_0:
if (<conditionl>) then
goto my_state_1;
else
goto my_ state_0;
endif

« Three-way conditional branching uses goto actions with if/else/elseif/endif
constructs:

state my_state_0:

if (<conditionl>) then
goto my_state_1;

elseif (<condition2>) then
goto my_ state_2;

else
goto my_state_0;

endif

For more information on how to construct conditional statements represented above with
<conditionl> and <condition2>, refer to the section called Conditional Statements.

Counters

The four built-in 16-bit counters have fixed names and are called $counter0, Scounterl,
Scounter?2, Scounter3. The counters can be reset, incremented, and used in conditional
statements.

« To reset a counter, use the reset_counter action:

state my_state_0:
reset_counter S$counter(;
goto my_state_1;
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« To increment a counter, use the increment counter action:

state my_ state_0:
increment_counter S$Scounter3;
goto my_state_1;

For more information on how to use counters in conditional statements, refer to Conditional
Statements.

Flags

Flags can be used to monitor progress of the trigger state machine program as it executes.
The four built-in flags have fixed names and are called $£1ag0, $flagl, $flag2, and
$flag3. The flags can be set and cleared.

« To set a flag, use the set_flag action:

state my_state_0:
set_flag $flag0;
goto my_state_1;

« Toclear a flag, use the clear_flag action:

state my_state_0:
clear_flag $flag2;
goto my_state_1;

Conditional Statements

Debug Probe Conditions

Debug probe conditions can be used in two-way and three-way branching conditional
statements. Each debug probe condition consumes one trigger comparator on the PROBE
port of the ILA to which the debug probe is attached.

ﬁ IMPORTANT: Each PROBE port can have from 1 to 16 trigger comparators as configured at compile
time. This means that you can only use a particular debug probe in a debug probe condition up from 1
to 16 times in the entire trigger state machine program, depending on the number of comparators
configured on the PROBE port.
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The debug probe conditions consist of a comparison operator and a value. The valid debug
probe condition comparison operators are:

« == (equals)
« 1= (not equals)
« > (greater than)

+ < (less than)

« >= (greater than or equal to)

+ <= (less than or equal to)
Valid values are of the form:

<bit_width>'<radix><value>

Where:

+ <bit width> is the width of the probe (in bits)

« <radix> is one of
- Db (binary)

- h (hexadecimal)

o u (unsigned decimal)

« <value> is one of
o 0 (Logical zero)
o 1 (Logical one)

. X (dont care)

o R (0-to-1 transition) - Valid only for 1 bit probes

o F (1-to-0 transition) - Valid only for 1 bit probes

o B (both transitions) - Valid only for 1 bit probes

- N (No transitions) - Valid only for 1 bit probes

Examples of valid debug probe condition values are:

« 1-bit binary value of 0
1'b0
« 12-bit hex value of 7A

12'h07A
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« 9-bit integer value of 123

9'ul23

Examples of debug probe condition statements are:

« Asingle-bit debug probe called abc equals 0
if (abc == 1'b0) then
« A 23-bit debug probe xyz equals 456
if (xyz >= 23'u456) then
* A 23-bit debug probe k1m does not equal hex A5

if (klm != 23'h0000A5) then
Examples of multiple debug probe condition statements are:

+ Two debug probe comparisons combined with an "OR" function:
if ((xyz >= 23'u456) || (abc == 1'b0)) then
« Two debug probe comparisons combined with an "AND" function:
if ((xyz >= 23'u456) && (abc == 1'b0)) then
» Three debug probe comparisons combined with an "OR" function:
if ((xyz >= 23'u456) || (abc == 1'b0) || (klm != 23'h0000A5)) then
« Three debug probe comparisons combined with an "AND" function:

if ((xyz >= 23'u4db6) && (abc == 1'b0) && (klm != 23'h0000A5)) then

Counter Conditions

Counter conditions can be used in two-way and three-way branching conditional
statements. Each counter condition consumes one counter comparator.

f IMPORTANT: Each counter has only one counter comparator. This means that you can only use a
particular counter in a counter condition once in the entire trigger state machine program.

The probe port conditions consist of a comparison operator and a value. The valid probe
condition comparison operators are:

« == (equals)

« = (not equals)

f IMPORTANT: Each counter is always 16 bits wide.
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Examples of valid counter condition values are:

« 16-bit binary value of 0

16'b0000_0000_0000_0000
16'b0000000000000000

« 16-bit hex value of 7A
16'h007A
« 16-bit integer value of 123

16'ul23

Examples of counter condition statements:

« Counter $counter0 equals binary 0
($counter0 == 16'10000000000000000)
« Counter $counter2 does not equal decimal 23

(Scounter2 != 16'u23)

Combined Debug Probe and Counter Conditions

Debug probe conditions and counter conditions can be combined together to form a single
condition using the following rules:

« All debug probe comparisons must be combined together using the same "| |" (OR) or
"&&" (AND) operators.

» The combined debug probe condition can be combined with the counter condition
using either the "| |" (OR) or "&&" (AND) operators, regardless of the operator used to
combine the debug probe comparisons together.

Examples of multiple debug probe and counter condition statements are:

+ Two debug probe comparisons combined with an "OR" function, then combined with
counter conditional using "AND" function:
if (((xyz >= 23'u4db6) || (abc == 1'b0)) && (Scounter0 == 16'u0023)) then

« Two debug probe comparisons combined with an "AND" function, then combined with
counter conditional using "OR" function:

if (((xyz >= 23'u456) && (abc == 1'b0)) || ($counter0 == 16'u0023)) then

« Three debug probe comparisons combined with an "OR" function, then combined with
counter conditional using "AND" function:

if (((xyz >= 23'u456) || (abc == 1'b0) || (klm != 23'h0000A5)) && (Scounter0 ==
16'u0023)) then
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« Three debug probe comparisons combined with an "AND" function, then combined
with counter conditional using "OR" function:

if (((xyz >= 23'udb6) && (abc == 1'b0) && (klm != 23'h0000A5)) || (Scounter0 ==
16'u0023)) then

Trigger State Machine Language Grammar
NOTES:

« The language is case insensitive

« Comment character is hash "#' character. Anything including and after a # character is
ignored.

e 'THING' = THING is a terminal
e {<thing>} = 0 or more thing

e [<thing>] =0or1l thing

<program> ::= <state_list>

<state_list> ::= <state_list> <state> | <state>

<state> ::= 'STATE' <state_label> ':' <if condition> | <action_block>
<action_block> ::= <action_list> 'GOTO' <state_label> ';'

| <action_list> 'TRIGGER' ';
| 'GOTO' <state_label> ';'

| 'TRIGGER' ;'
<action_list> ::= <action_statement> | <action_list> <action_statement>
<action_statement> ::= 'SET FLAG' <flag_name> ';'

| 'CLEAR_FLAG' <flag_name> ';'
| 'INCREMENT COUNTER' <counter_name> ';'
| 'RESET_COUNTER' <counter_name> ';'

<if_condition> ::= 'IF' ' (' <condition> ')' 'THEN' <actionblock>
['"ELSEIF' ' (' <condition> ')' 'THEN' <actionblock>]
'ELSE' <actionblock>
'ENDIF'

<condition> ::= <probe_match_list>

| <counter_match>
| <probe_counter_match>

<probe_counter_match> ::= ' (' <probe_counter_match> ')
| <probe_match_list> <boolean_logic_op> <counter_match>
| <counter_match> <boolean_logic_op> <probe_match_list>

<probe_match_list> ::= '(' <probe_match> ')
| <probe_match>
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<probe_match> ::= <probe_match_list> <boolean_logic_op> <probe_match_list>
| <probe_name> <compare_op> <constant>
| <constant> <compare_op> <probe_name>

<counter_match> ::= ' (' <counter_match> ')'
| <counter_name> <compare_op> <constant>
| <constant> <compare_op> <counter_name>

<constant> ::= <integer_constant>
| <hex_constant>
| <binary_constant>

<compare_op> ::= '==' | '1=' | ‘>t | >zt Py Peot
<boolean logic_op> ::= '&&' | '||"

--- The following are in regular expression format to simplify expressions:
--- [A-Z0-9] means match any single character in AB...Z,0..9

-—-- [AB]+ means match [AB] one or more times like A, AB, ABAB, AAA, etc
-—-- [AB]* means match [AB] zero or more times

<probe_name> = [A-Z_\N[\1<>/]1[A-Z_0-9\[\]<>/1+
<state_label> c:= [A-Z_][A-Z_0-9]+

<flag_name> ::= \SFLAG[0-3]

<counter_name> ::= \SCOUNTER[0-3]
<hex_constant> ::= <integer>*'h<hex_ digit>+
<binary_constant> ::= <integer>*'b<binary_digit>+
<integer_constant> ::= <integer>*'u<integer_digit>+
<integer> ::= <digit>+

<hex_digit> ::= [0-9ABCDEFBN_ ]
<binary_digit> ::= [01XRFBN_]

<digit> ::= [0-9]
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Appendix C

Low Level SVF JTAG Commands

Low level JTAG commands allow you to scan multiple FPGA JTAG chains. The SVF commands
generated for chain operations use these low-level commands to access the FPGAs in the
chain.

This appendix is an overview of these commands. A detailed explanation can be found in
the Serial Vector Format Specification document that can be found at:
http://www.jtagtest.com/pdf/svf specification.pdf.

Header Data Register (HDR), Header Instruction
Register (HIR)

Syntax:
HDR length [TDI (tdi)] [TDO (tdo)] [MASK (mask)] [SMASK (smask)];
HIR length [TDI (tdi)] [TDO (tdo)] [MASK (mask)] [SMASK (smask)];
Purpose

Specifies a default header pattern that is shifted in before every scan operation. The header
pattern specifies how to pad the scan statements with a set of leading bits that
accommodate the devices located on the scan path beyond the component of interest.

General Information

The Header Data Register (HDR) specifies a default header pattern that is pre-pended to the
beginning of all subsequent SDR commands. The Header Instruction Register (HIR)
specifies a default header pattern that is pre-pended to the beginning of all subsequent SIR
commands. The header commands have a set of counterpart trailer commands (TIR, TDR)
that are described in a following section. A header can be removed by setting its length to
0.
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TDR, TIR (Trailer Data Register, Trailer Instruction
Register)

Syntax
TDR length [TDI (tdi)] [TDO (tdo)][MASK (mask)] [SMASK (smask)];
TIR length [TDI (tdi)] [TDO (tdo)][MASK (mask)] [SMASK (smask)];
Purpose

Specifies a default trailer pattern that is shifted in after all subsequent scan operations. The
trailer pattern specifies how to pad the scan statements with a set of trailing bits that
accommodate the devices located on the scan path after the component of interest.

General Information

The Trailer Data Register (TDR) specifies a trailer pattern that will be appended to the end
of all subsequent SDR commands. Trailer Instruction Register (TIR) specifies a default trailer
pattern that is appended to the end of all subsequent SIR commands. A trailer can be
removed by setting its length to 0.

Example

In this example a SVF file is developed for an ASIC. The ASIC is then placed in a board as u3,
shown below:

™I —» | ul » u2 —» u3 » ud » us | —»TDO

Figure C-1: TDR Example

The set of SVF statements originally developed for the ASIC can be reused with minimal
modification if the appropriate header and trailer statements are defined to accommodate
the devices in front of and behind u3. In this example, a header pattern would be defined
for devices u4 and u5, and a trailer pattern would be defined for u2 and ul. The optional
parameters can be specified in any order. Each optional parameter can only be specified
once. Hex strings specified for TDI, TDO, MASK, or SMASK cannot be a value larger than the
maximum implied by the length parameter. Leading zeros are assumed for a hex string if
not explicitly specified.
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scan_ir_hw

Perform shift IR on hw_jtag.

Syntax

scan_ir_hw_jtag [-tdi <arg>] [-tdo <arg>] [-mask <arg>] [-smask <arg>] [-quiet]
[-verbose] <length>

General Information

The scan_ir_hw_jtag command specifies a scan pattern to be scanned into the JTAG
interface target instruction register. The command targets a hw_jtag object which is
created when the hw_target is opened in JTAG mode through the use of the
open_hw_target -jtag_mode command. When targeting the hw_jtag object prior to
shifting the scan pattern specified in the scan_ir_hw_jtag command, the last defined header
property (HIR) is pre-pended to the beginning of the specified data pattern. The last
defined trailer property (TIR) is appended to the end of the data pattern.

The number of bits represented by the hex strings specified for -tdi, -tdo, -mask, or
-smask cannot be greater than the maximum specified by <length>.

The scan_ir_hw_jtag command returns a hex array containing captured TDO data from
the hw_jtag, or returns an error if it fails.

Example

The following example scans the JTAG instruction register for a 24 bit value:

scan_ir_hw_jtag 24

The following example sends a 24 bit value 0x00_0010 (LSB first) to TDI, then captures the
TDO output, applies a mask with OxF3_FFFF, and compares the returned TDO value against
the specified value -tdo 0x81_8181.

scan_ir_hw_jtag 24 -tdi 000010 -tdo 818181 -mask F3FFFF -smask 0

scan_ir_hw

Perform shift DR on 'hw_jtag'.
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Syntax

scan_dr_hw_jtag [-tdi <arg>] [-tdo <arg>] [-mask <arg>] [-smask <arg>] [-quiet]
[-verbose] <length>

General Information

The scan_dr_hw_jtag command specifies a scan pattern to be scanned into the JTAG
interface target data register. The command targets a hw_jtag object which is created
when the hw_target is opened in JTAG mode through the use of the open_hw_target
-jtag_mode command. When targeting the hw_Jjtag object prior to shifting the scan
pattern specified in the scan_dr_hw_jtag command, the last defined header property
(HDR) is pre-pended to the beginning of the specified data pattern. The last defined trailer
property (TDR) is appended to the end of the data pattern.

The scan_dr_hw_jtag command returns a hex array containing captured TDO data from
the hw_7jtag, or returns an error if it fails.

Example
The following example scans the JTAG data register for a 24 bit value:
scan_dr_hw_jtag 24

The following example sends a 24 bit value 0x00_0010 (LSB first) to TDI, then captures the
data output, TDO, applies a mask with OxF3_FFFF, and compares the returned TDO value
against the specified value -tdo 0x81_8181.

scan_dr_hw_jtag 24 -tdi 000010 -tdo 818181 -mask F3FFFF -smask 0

Multi Chain SVF Operation

The following examples show how to handle operations on a SVF chain.

Two devices, xckull and xcku9, are connected in a chain. A configuration memory is
attached to the second device in the chain (xcku9). To access this configuration memory,
SVF generates commands using the HIR, HDR, TIR, and TDR commands. The commands
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generated for flashing this configuration memory take into account the chain length, and
incorporate this information in the low level JTAG operations.

is25wp032d-spi-x1_x2_x4

) 4
o1 [ $ b {100
xckullp_ 0 xcku9p_1

Figure C-2: Multi Chain SVF Operation Example

The generated .svf file contains the following operations:

HIR O ;

TIR 6 TDI (3f) SMASK (3f) ;

HDR 0 ;

TDR 1 TDI (00) SMASK (01) ;

// config/idcode

SIR 6 TDI (09) ;

SDR 32 TDI (00000000) TDO (0484a093) MASK (Offfffff) ;
// config/jprog

STATE RESET;

STATE IDLE;

SIR 6 TDI (0b) ;

SIR 6 TDI (14) ;

// Modify the below delay for config init operation (0.100000 sec typical, 0.100000
sec maximum)

RUNTEST 0.100000 SEC;

// config/jprog/poll

RUNTEST 10000 TCK;

SIR 6 TDI (14) TDO (11) MASK (31) ;

// config/slr

SIR 6 TDI (05) ;

Multi Chain SVF Operation with Configuration Memory
Attached to First Device

In this example, to access the ku9 device, a SMASK value of 0000 0011 1111 (0x3f) is used
with the TIR and TDR instructions. To access the second device in the chain, the mask value
is pushed in followed by SIR and SDR instructions. SIR and SDR instructions combine HIR,
HDR, TIR, and TDR information.
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If the configuration memory attached to the first device (xckull) needs to be programmed,
the SVF generated commands are different:

is25wp016d-spi-x1_x2_x4

> 4
70! [ D §~ s [ T00
xckullp_0 xcku9p_1

Figure C-3: Multi Chain SVF Operation Example with Configuration Memory Attached to First
Device

HIR 6 TDI (3f) SMASK (3f)

TIR 0 ;

HDR 1 TDI (00) SMASK (01)

TDR 0 ;

// config/idcode

SIR 6 TDI (09)

SDR 32 TDI (00000000) TDO (04a4e093) MASK (Offfffff)
// config/jprog

STATE RESET;

STATE IDLE;

SIR 6 TDI (0b) ;

SIR 6 TDI (14)

// Modify the below delay for config init operation (0.100000 sec typical, 0.100000
sec maximum)

RUNTEST 0.100000 SEC;

// config/jprog/poll

RUNTEST 10000 TCK;

SIR 6 TDI (14) TDO (11) MASK (31)

// config/slr

SIR 6 TDI (05)

Multi Chain SVF Operation with Configuration Memory
Attached to Second Device in Chain

In this example, to access the kull device, a SMASK value of 0011 1111 (0Ox3f) is used with
the HIR and HDR instructions. To access the first device in the chain, the mask value is
pushed first followed by a SIR and SDR instructions. SIR and SDR instructions combine HIR,
HDR, TIR, and TDR information.
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Now let's consider four devices, xckull, xcku9, xckull and xcku9, are connected in a chain.
A configuration memory is attached to the second device in the chain (xcku9) and we want
to access it, both the HIR and TIR instructions are used in this case:

is25wp016d-spi-x1_x2_x4

T I— i‘ iA E i‘ - i‘ = l—>TDO
xckullp_0 xcku9p_1 xckullp_2 xcku9p_3

Figure C-4: Multi-Chain-SVF- Operation- Example-Second Device in Chain

HIR 12 TDI (0fff) SMASK (Offf) ;

TIR 6 TDI (3f) SMASK (3f) ;

HDR 2 TDI (00) SMASK (03)

TDR 1 TDI (00) SMASK (01)

// config/idcode

SIR 6 TDI (09) ;

SDR 32 TDI (00000000) TDO (0484a093) MASK (Offfffff) ;
// config/jprog

STATE RESET;

STATE IDLE;

SIR 6 TDI (0b) ;

SIR 6 TDI (14) ;

// Modify the below delay for config init operation (0.100000 sec typical, 0.100000
sec maximum)

RUNTEST 0.100000 SEC;

// config/jprog/poll

RUNTEST 10000 TCK;

SIR 6 TDI (14) TDO (11) MASK (31) ;

// config/slr

SIR 6 TDI (05) ;

’

’
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(: X| |_| NX@ Appendix C: Low Level SVF JTAG Commands

Multi Chain SVF Operation with Configuration Memory
Attached to Third Device in Chain

If a configuration memory is attached to the third device in the chain (xcku9).

is25wp016d-spi-x1_x2_x4
2d

xckullp_0 xcku9p_1 xckullp_2 xcku9p_3

Figure C-5: Multi-Chain-SVF- Operation- Example-Third Device in Chain

HIR 6 TDI (3f) SMASK (3f) ;
TIR 12 TDI (0fff) SMASK (0fff) ;
HDR 1 TDI (00) SMASK (01) ;

TDR 2 TDI (00) SMASK (03)
// config/idcode

SIR 6 TDI (09) ;

SDR 32 TDI (00000000) TDO (04a4e093) MASK (Offfffff) ;

// config/jprog

STATE RESET;

STATE IDLE;

SIR 6 TDI (0b) ;

SIR 6 TDI (14) ;

// Modify the below delay for config_init operation (0.100000 sec typical, 0.100000
sec maximum)

RUNTEST 0.100000 SEC;

// config/jprog/poll

RUNTEST 10000 TCK;

SIR 6 TDI (14) TDO (11) MASK (31) ;

// config/slr

SIR 6 TDI (05) ;

7
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& XILINX

Appendix D

Configuration Memory Support

W

This section covers the various non-volatile device memories that are supported by
Vivado® software. Use this section as a guide to select the appropriate configuration
memory device for your application by Xilinx® family, interface, manufacturer, density, and
data width.

Artix-7 Configuration Memory Devices

The Flash devices supported for configuration of Artix®-7 devices that can be erased, blank
checked, programmed, and verified by Vivado® software are shown in the following table.

The tables in this Appendix are running lists per Xilinx® family of non-volatile memories
which Vivado software is capable of erasing, blank checking, programming, and verifying.
Xilinx strives to retain components on this list even after they are no longer appropriate for
new designs, to support long-term maintenance of end products which may contain them.

IMPORTANT: Given the evolving nature of the commodity non-volatile memory market, Xilinx
recommends contacting your non-volatile memory supplier to confirm device availability and life cycle.
References to specific devices in the tables are not an assurance of their current or future availability.

Table D-1: Supported Flash Memory Devices for Artix-7 Memory Devices

Interface | Manufacturer Mar;:ﬁ:ﬁ;urer Device Alias Dl\e,elr;?:tsy DataBitV\gidth

BPI Micron gl8 28f128g18f 128 x16

BPI Micron gl8 mt28gu256aaxle 256 x16
[28f256g18f-bpi-x16]

BPI Micron g18 mt28gu512aaxle 512 x16
[28f512g18f-bpi-x16]

BPI Micron gl8 mt28gu0lgaaxle 1,024 x16
[28f00ag18f-bpi-x16]

BPI Micron m29ew 28f064m29ewb 64 x16, x8

BPI Micron m29ew 28f064m29ewh 64 x16, x8

BPI Micron m29ew 28f064m29ewl 64 x16, x8

BPI Micron m29ew 28f064m29ewt 64 x16, x8

BPI Micron m29ew 28f128m29%ew 128 x16, x8
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Table D-1: Supported Flash Memory Devices for Artix-7 Memory Devices (Cont’d)

Interface | Manufacturer Mar;:ia:::;;urer Device Alias DISIE?:? Data:si\i\;idth
BPI Micron m29ew 28f256m29ew 256 x16, x8
BPI Micron m29ew 28f512m29ew 512 x16, x8
BPI Micron m29ew 28f00am29ew 1,024 x16, x8
BPI Micron m29ew 28f00bm29ew 2,048 x16, x8
BPI Micron m29w m29w640gh 64 x16, x8
BPI Micron m29w m29w640gl 64 x16, x8
BPI Micron m29w m29w128gh 128 x16, x8
BPI Micron m29w m29w128gl 128 x16, x8
BPI Micron m29w m29w256gh 256 x16, x8
BPI Micron m29w m29w2564l 256 x16, x8
BPI Micron mt28ew mt28ewl28a 128 x16, x8
BPI Micron mt28ew mt28ew256a 256 x16, x8
BPI Micron mt28ew mt28ew512a 512 x16, x8
BPI Micron mt28ew mt28ew01lga 1,024 x16, x8
BPI Micron mt28fw mt28fw02gb 2,048 x16
BPI Micron p30 28f640p30b 64 x16
BPI Micron p30 28f640p30t 64 x16
BPI Micron p30 28f128p30b 128 x16
BPI Micron p30 28f128p30t 128 x16
BPI Micron p30 28f256p30b 256 x16
BPI Micron p30 28f256p30t 256 x16
BPI Micron p30 28f512p30b 512 x16
BPI Micron p30 28f512p30e 512 x16
BPI Micron p30 28f512p30t 512 x16
BPI Micron p30 28f00ap30b 1,024 x16
BPI Micron p30 28f00ap30e 1,024 x16
BPI Micron p30 28f00ap30t 1,024 x16
BPI Micron p30 28f00bp30e 2,048 x16
BPI Micron p33 28f640p33b 64 x16
BPI Micron p33 28f640p33t 64 x16
BPI Micron p33 28f128p33b 128 x16
BPI Micron p33 28f128p33t 128 x16
BPI Micron p33 28f256p33b 256 x16
BPI Micron p33 28f256p33t 256 x16
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Table D-1: Supported Flash Memory Devices for Artix-7 Memory Devices (Cont’d)
Interface | Manufacturer Mar;:ia:::;;urer Device Alias DISIE?:? Data:si\i\;idth
BPI Micron p33 28f512p33b 512 x16
BPI Micron p33 28f512p33e 512 x16
BPI Micron p33 28f512p33t 512 x16
BPI Micron p33 28f00ap33b 1,024 x16
BPI Micron p33 28f00ap33e 1,024 x16
BPI Micron p33 28f00ap33t 1,024 x16
BPI Spansion s29glxxxp s29gl128p 128 x16, x8
BPI Spansion s29glxxxp s29gl256p 256 x16, x8
BPI Spansion s29glxxxp s29gl512p 512 x16, x8
BPI Spansion s29glxxxp s29gl01gp 1,024 x16, x8
BPI Spansion s29glxxxp s70gl02gp 2,048 x16
BPI Spansion s29glxxxs s29gl128s 128 x16
BPI Spansion s29glxxxs s29gl256s 256 x16
BPI Spansion s29glxxxs s29gl512s 512 x16
BPI Spansion s29glxxxs s29gl01gs 1,024 x16
BPI Spansion s29glxxxs s70gl02gs 2,048 x16
BPI Spansion s29glxxxt s29gl512t 512 x16, x8
BPI Spansion s29glxxxt s29gl01gt 1,024 x16, x8
BPI Spansion s29glxxxt s70gl02gt 2,048 x16, x8
SPI ISSI is25lp is251p080d 8 x1, x2, x4
SPI ISSI is25lp is25Ip016d 16 x1, x2, x4
SPI ISSI is25Ip is25lp032d 32 x1, X2, x4
SPI ISSI is25Ip is25lp064a 64 x1, x2, x4
SPI ISSI is25Ip is25lp128f 128 x1, X2, x4
SPI ISSI is25Ip is25lp256d 256 x1, x2, x4
SPI ISSI is25wp is25wp080d 8 x1, X2, x4
SPI ISSI is25wp is25wp016d 16 x1, x2, x4
SPI ISSI is25wp is25wp032d 32 x1, x2, x4
SPI ISSI is25wp is25wp064a 64 x1, x2, x4
SPI ISSI is25wp is25wp128f 128 x1, x2, x4
SPI ISSI is25wp is25wp256d 256 x1, x2, x4
SPI Micron mt25ql mt25ql128 128 x1, x2, x4

[n25q128-3.3v-spi-x1_x2_x4]

SPI Micron mt25¢]| mt25ql256 256 x1, x2, x4

[N25q256-3.3v-spi-x1_x2_x4]
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Table D-1: Supported Flash Memory Devices for Artix-7 Memory Devices (Cont’d)

Interface | Manufacturer Mar;:ﬁ::;;urer Device Alias DISIE?:? Data:si\i\;idth
SPI Micron mt25¢| mt25ql512 512 x1, x2, x4
SPI Micron mt25¢]| mt25ql01g 1,024 x1, x2, x4
SPI Micron mt25q]| mt25ql02g 2,048 x1, x2, x4
SPI Micron mt25qu mt25qul28 128 x1, x2, x4
[N250128-1.8v-spi-x1_x2_x4]
SPI Micron mt25qu mt25qu256 256 x1, x2, x4
[n25g256-1.8v-spi-x1_x2_x4]
SPI Micron mt25qu mt25qu512 512 x1, x2, x4
SPI Micron mt25qu mt25qu0lg 1,024 x1, x2, x4
SPI Micron mt25qu mt25qu02g 2,048 x1, x2, x4
SPI Micron n25q n25qg32-1.8v 32 x1, x2, x4
SPI Micron n25q n25q32-3.3v 32 x1, x2, x4
SPI Micron n25q n25q64-1.8v 64 x1, x2, x4
SPI Micron n25q n25q64-3.3v 64 x1, x2, x4
SPI Spansion s25fl1 s25fl116k 16 x1, x2, x4
SPI Spansion s25fl1 s25f1132k 32 x1, x2, x4
SPI Spansion s25fl1 s25fl164k 64 x1, x2, x4
SPI Spansion s25fIxxx| s25fl064| 64 x1, x2, x4
SPI Spansion s25fIxxx| s25f1128l 128 x1, x2, x4
SPI Spansion s25fIxxx| s25fl256l 256 x1, x2, x4
SPI Spansion s25flxxxp s25fl032p 32 x1, x2, x4
SPI Spansion s25flxxxp s25fl064p 64 x1, x2, x4
SPI Spansion s25flxxxs $25f1128sxxxxxx0 128 x1, x2, x4
[s25f1127s-spi-x1_x2_x4]
SPI Spansion s25flxxxs s25f1128sxxxxxx1 128 x1, x2, x4
SPI Spansion s25flxxxs s25f1256sxxxxxx0 256 x1, x2, x4
SPI Spansion s25flxxxs s25f1256sxxxxxx1 256 x1, x2, x4
SPI Spansion s25flxxxs s25fI512s 512 x1, x2, x4
SPI Macronix mx25I| mx25v8035f 8 x1, x2, x4
SPI Macronix mx25I| mx25v1635f 16 x1, x2, x4
SPI Macronix mx25I mx2513233f 32 x1, x2, x4
SPI Macronix mx25I mx2516433f 64 x1, x2, x4
SPI Macronix mx25I mx25112845¢g 128 x1, x2, x4
[Mmx25112835f-spi-x1_x2_x4]
SPI Macronix mx25I mx25125645¢g 256 x1, x2, x4
[Mmx25125635f-spi-x1_x2_x4]
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Table D-1: Supported Flash Memory Devices for Artix-7 Memory Devices (Cont’d)

Interface | Manufacturer Marll::i::icltyurer Device Alias D&Eﬂ? Datagi\i\;idth

SPI Macronix mx25I| mx25151245¢g 512 x1, x2, x4
[Mmx66151235f-spi-x1_x2_x4]

SPI Macronix mx25u mx25u8033e 8 x1, x2, x4

SPI Macronix mx25u mx25ul635f 16 x1, x2, x4

SPI Macronix mx25u mx25u3235f 32 x1, x2, x4

SPI Macronix mx25u mx25u6435f 64 x1, x2, x4

SPI Macronix mx25u mx25ul12835f 128 x1, x2, x4

SPI Macronix mx25u mx25u25645g 256 x1, x2, x4
[Mmx25u25635f-spi-x1_x2_x4]

SPI Macronix mx25u mx25u51245g 512 x1, x2, x4
[Mmx66u51235f-spi-x1_x2_x4]

SPI Macronix mx66| mx6611g45¢g 1,024 x1, x2, x4

SPI Macronix mx66| mx6612g45¢g 2,048 x1, x2, x4

SPI Macronix mx66u mx66ulg45g 1,024 x1, x2, x4

SPI Macronix mx66u mx66u2g45g 2,048 x1, x2, x4

Kintex-7 Configuration Memory Devices

The Flash devices supported for configuration of Kintex®-7 devices that can be erased,
blank checked, programmed, and verified by Vivado® software are shown in the following
table.

The tables in this Appendix are running lists per Xilinx® family of non-volatile memories
which Vivado software is capable of erasing, blank checking, programming, and verifying.
Xilinx strives to retain components on this list even after they are no longer appropriate for
new designs, to support long-term maintenance of end products which may contain them.
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f IMPORTANT: Given the evolving nature of the commodity non-volatile memory market, Xilinx
recommends contacting your non-volatile memory supplier to confirm device availability and life cycle.
References to specific devices in the tables are not an assurance of their current or future availability

Table D-2: Supported Flash Memory Devices for Kintex-7 Device Configuration

Interface | Manufacturer Mar;:i:;:ltyurer Device Alias Dh?lr;?:tsy DataBi\ﬁidth
BPI Micron g18 28f128g18f 128 x16
BPI Micron gl8 mt28gu256aaxle 256 x16
[28f256918f-bpi-x16]
BPI Micron gl8 mt28gu512aaxle 512 x16
[28f512918f-bpi-x16]
BPI Micron gl8 mt28gullgaaxle 1,024 x16
[28f00agl8f-bpi-x16]
BPI Micron m29ew 28f064m29ewb 64 x16, x8
BPI Micron m29ew 28f064m29ewh 64 x16, x8
BPI Micron m29ew 28f064m29ewl 64 x16, x8
BPI Micron m29ew 28f064m29ewt 64 x16, x8
BPI Micron m29ew 28f128m29%ew 128 x16, x8
BPI Micron m29ew 28f256m29%ew 256 x16, x8
BPI Micron m29ew 28f512m29%ew 512 x16, x8
BPI Micron m29ew 28f00am29ew 1,024 x16, x8
BPI Micron m29ew 28f00bm29ew 2,048 x16, x8
BPI Micron m29w m29w640gh 64 x16, x8
BPI Micron m29w m29w640g| 64 x16, x8
BPI Micron m29w m29w128gh 128 x16, x8
BPI Micron m29w m29w128g| 128 x16, x8
BPI Micron m29w m29w256gh 256 x16, x8
BPI Micron m29w m29w2564g| 256 x16, x8
BPI Micron mt28ew mt28ew128a 128 x16, x8
BPI Micron mt28ew mt28ew256a 256 x16, x8
BPI Micron mt28ew mt28ew512a 512 x16, x8
BPI Micron mt28ew mt28ew01lga 1,024 x16, x8
BPI Micron mt28fw mt28fw02gb 2,048 x16
BPI Micron p30 28f640p30b 64 x16
BPI Micron p30 28f640p30t 64 x16
BPI Micron p30 28f128p30b 128 x16
BPI Micron p30 28f128p30t 128 x16
BPI Micron p30 28f256p30b 256 x16
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Table D-2: Supported Flash Memory Devices for Kintex-7 Device Configuration (Cont’d)
Interface | Manufacturer Mar;::f:;:ltyurer Device Alias Dl\(lelrl‘)?:zy Data:si\i\éidth
BPI Micron p30 28f256p30t 256 x16
BPI Micron p30 28f512p30b 512 x16
BPI Micron p30 28f512p30e 512 x16
BPI Micron p30 28f512p30t 512 x16
BPI Micron p30 28f00ap30b 1,024 x16
BPI Micron p30 28f00ap30e 1,024 x16
BPI Micron p30 28f00ap30t 1,024 x16
BPI Micron p30 28f00bp30e 2,048 x16
BPI Micron p33 28f640p33b 64 x16
BPI Micron p33 28f640p33t 64 x16
BPI Micron p33 28f128p33b 128 x16
BPI Micron p33 28f128p33t 128 x16
BPI Micron p33 28f256p33b 256 x16
BPI Micron p33 28f256p33t 256 x16
BPI Micron p33 28f512p33b 512 x16
BPI Micron p33 28f512p33e 512 x16
BPI Micron p33 28f512p33t 512 x16
BPI Micron p33 28f00ap33b 1,024 x16
BPI Micron p33 28f00ap33e 1,024 x16
BPI Micron p33 28f00ap33t 1,024 x16
BPI Spansion s29glxxxp s29gl128p 128 x16, x8
BPI Spansion s29glxxxp s29gl256p 256 x16, x8
BPI Spansion s29glxxxp s29gl512p 512 x16, x8
BPI Spansion s29glxxxp s29gl01lgp 1,024 x16, x8
BPI Spansion s29glxxxp s70gl02gp 2,048 x16
BPI Spansion s29glxxxs s29gl128s 128 x16
BPI Spansion s29glxxxs s29gl256s 256 x16
BPI Spansion s29glxxxs s29g1512s 512 x16
BPI Spansion s29glxxxs s29gl01gs 1,024 x16
BPI Spansion s29glxxxs s70gl02gs 2,048 x16
BPI Spansion s29glxxxt s29gl512t 512 x16, x8
BPI Spansion s29glxxxt s29gl01gt 1,024 x16, x8
BPI Spansion s29glxxxt s70gl02gt 2,048 x16, x8
SPI ISSI is25Ip is251p080d 8 X1, x2, x4
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Table D-2: Supported Flash Memory Devices for Kintex-7 Device Configuration (Cont’d)

Interface | Manufacturer Mar;:tan;a:;:ltyurer Device Alias Dl\(lelrl‘)?:zy Data:si\i\éidth
SPI ISSI is25Ip is25lp0l6d 16 x1, x2, x4
SPI ISSI is25Ip is25lp032d 32 x1, x2, x4
SPI ISSI is25Ip is25lp064a 64 x1, x2, x4
SPI ISSI is25Ip is25lp128f 128 x1, x2, x4
SPI ISSI is25Ip is25lp256d 256 x1, x2, x4
SPI ISSI is25wp is25wp080d 8 x1, x2, x4
SPI ISSI is25wp is25wp016d 16 x1, x2, x4
SPI ISSI is25wp is25wp032d 32 x1, x2, x4
SPI ISSI is25wp is25wp064a 64 x1, x2, x4
SPI ISSI is25wp is25wp128f 128 x1, x2, x4
SPI ISSI is25wp is25wp256d 256 x1, x2, x4
SPI Micron mt25¢| mt25ql128 128 x1, x2, x4
[n250128-3.3v-spi-x1_x2_x4]
SPI Micron mt25¢| mt25ql256 256 x1, x2, x4
[n250256-3.3v-spi-x1_x2_x4]
SPI Micron mt25q| mt25ql512 512 x1, x2, x4
SPI Micron mt25q| mt25ql01g 1,024 x1, x2, x4
SPI Micron mt25q| mt25ql02g 2,048 x1, x2, x4
SPI Micron mt25qu mt25qul28 128 x1, x2, x4
[n250128-1.8v-spi-x1_x2_x4]
SPI Micron mt25qu mt25qu256 256 x1, x2, x4
[N2509256-1.8v-spi-x1_x2_x4]
SPI Micron mt25qu mt25qu512 512 x1, x2, x4
SPI Micron mt25qu mt25qu0llg 1,024 x1, x2, x4
SPI Micron mt25qu mt25qu02g 2,048 x1, x2, x4
SPI Micron n25q n25q32-1.8v 32 x1, x2, x4
SPI Micron n25q n25q32-3.3v 32 x1, x2, x4
SPI Micron n25q n25q64-1.8v 64 x1, x2, x4
SPI Micron n25q n25qg64-3.3v 64 x1, x2, x4
SPI Spansion s25fl1 s25fl116k 16 x1, x2, x4
SPI Spansion s25fl1 s25f1132k 32 x1, x2, x4
SPI Spansion s25fl1 s25fl164k 64 x1, x2, x4
SPI Spansion s25fIxxx| s25f1064| 64 x1, x2, x4
SPI Spansion s25flxxx| s25f1128l 128 x1, x2, x4
SPI Spansion s25flxxx| s25fl1256l 256 x1, x2, x4
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Table D-2: Supported Flash Memory Devices for Kintex-7 Device Configuration (Cont’d)

Interface | Manufacturer Mar;:tan;a:;:ltyurer Device Alias Dl\(lelrl‘)?:zy Data:si\i\éidth
SPI Spansion s25flxxxp s25fl032p 32 x1, x2, x4
SPI Spansion s25flxxxp s25fl064p 64 x1, x2, x4
SPI Spansion s25flxxxs s25f1128sxxxxxx0 128 x1, x2, x4
[s25f1127s-spi-x1_x2_x4]
SPI Spansion s25flxxxs s25f1128sxxxxxx1 128 x1, x2, x4
SPI Spansion s25flxxxs s25f12565xxxxxx0 256 x1, x2, x4
SPI Spansion s25flxxxs s25f1256sxxxxxx1 256 x1, x2, x4
SPI Spansion s25flxxxs s25fI512s 512 x1, x2, x4
SPI Macronix mx25I mx25v8035f 8 x1, x2, x4
SPI Macronix mx25I mx25v1635f 16 x1, x2, x4
SPI Macronix mx25I mx2513233f 32 x1, x2, x4
SPI Macronix mx25I mx2516433f 64 x1, x2, x4
SPI Macronix mx25I mx25112845¢g 128 x1, x2, x4
[Mmx25112835f-spi-x1_x2_x4]
SPI Macronix mx25I mx25125645¢g 256 x1, x2, x4
[Mmx25125635f-spi-x1_x2_x4]
SPI Macronix mx25I mx25151245¢g 512 x1, x2, x4
[Mmx66151235f-spi-x1_x2_x4]
SPI Macronix mx25u mx25u8033e 8 x1, x2, x4
SPI Macronix mx25u mx25ul635f 16 x1, x2, x4
SPI Macronix mx25u mx25u3235f 32 x1, x2, x4
SPI Macronix mx25u mx25u6435f 64 x1, x2, x4
SPI Macronix mx25u mx25ul2835f 128 x1, x2, x4
SPI Macronix mx25u mx25u25645g 256 x1, x2, x4
[Mmx25u25635f-spi-x1_x2_x4]
SPI Macronix mx25u mx25u51245¢g 512 x1, x2, x4
[Mmx66u51235f-spi-x1_x2_x4]
SPI Macronix mx66I| mx6611g45g 1,024 x1, x2, x4
SPI Macronix mx66| mx6612g45g 2,048 x1, x2, x4
SPI Macronix mx66u mx66ulg45g 1,024 x1, x2, x4
SPI Macronix mx66u mx66u2g45g 2,048 x1, x2, x4
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Spartan-7 Configuration Memory Devices

The Flash devices supported for configuration of Spartan®-7 devices that can be erased,
blank checked, programmed, and verified by Vivado® software are shown in the following
table.

The tables in this Appendix are running lists per Xilinx® family of non-volatile memories
which Vivado software is capable of erasing, blank checking, programming, and verifying.
Xilinx strives to retain components on this list even after they are no longer appropriate for
new designs, to support long-term maintenance of end products which may contain them.

IMPORTANT: Given the evolving nature of the commodity non-volatile memory market, Xilinx
recommends contacting your non-volatile memory supplier to confirm device availability and life cycle.
References to specific devices in the tables are not an assurance of their current or future availability.

Note: Serial peripheral interface (SPI) flash is the supported configuration memory storage for
Spartan-7 devices. Byte-wide Peripheral Interface (BPI) flash is not supported for Spartan-7 devices

Table D-3: Supported Flash Memory Devices for Spartan-7 Device Configuration

Interface | Manufacturer Mar:::ﬁicltyurer Device Alias D&Eﬂ? DataBi\gidth
SPI ISSI is25lp is251p080d 8 x1, x2, x4
SPI ISSI is25lp is251p080d 8 x1, x2, x4
SPI ISSI is25lp is25lp016d 16 x1, x2, x4
SPI ISSI is25lp is25lp032d 32 x1, x2, x4
SPI ISSI is25lp is25lp064a 64 x1, x2, x4
SPI ISSI is25lp is25lp128f 128 x1, x2, x4
SPI ISSI is25lp is25lp256d 256 x1, x2, x4
SPI ISSI is25wp is25wp080d 8 x1, x2, x4
SPI ISSI is25wp is25wp016d 16 x1, x2, x4
SPI ISSI is25wp is25wp032d 32 x1, x2, x4
SPI ISSI is25wp is25wp064a 64 x1, x2, x4
SPI ISSI is25wp is25wp128f 128 x1, x2, x4
SPI ISSI is25wp is25wp256d 256 x1, x2, x4
SPI Micron mt25q]l mt25ql128 128 x1, x2, x4
[n250128-3.3v-spi-x1_x2_x4]
SPI Micron mt25¢| mt25ql256 256 x1, x2, x4
[n250256-3.3v-spi-x1_x2_x4]
SPI Micron mt25¢| mt25ql512 512 x1, x2, x4
SPI Micron mt25¢| mt25ql01lg 1,024 x1, x2, x4
SPI Micron mt25¢| mt25ql02g 2,048 x1, x2, x4
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Table D-3: Supported Flash Memory Devices for Spartan-7 Device Configuration (Cont’d)

Interface | Manufacturer Marl\::z::ltyurer Device Alias DISIE?:? Dat%midth
SPI Micron mt25qu mt25qul28 128 x1, x2, x4
[n250128-1.8v-spi-x1_x2_x4]
SPI Micron mt25qu mt25qu256 256 x1, x2, x4
[n259256-1.8v-spi-x1_x2_x4]
SPI Micron mt25qu mt25qu512 512 x1, x2, x4
SPI Micron mt25qu mt25qu0lg 1,024 x1, x2, x4
SPI Micron mt25qu mt25qu02g 2,048 x1, x2, x4
SPI Micron n25q n25qg32-1.8v 32 x1, x2, x4
SPI Micron n25q n25q932-3.3v 32 x1, x2, x4
SPI Micron n25q n25q64-1.8v 64 x1, x2, x4
SPI Micron n25q n25q64-3.3v 64 x1, x2, x4
SPI Spansion s25fl1 s25fl116k 16 x1, x2, x4
SPI Spansion s25fl1 s25f1132k 32 x1, x2, x4
SPI Spansion s25fl1 s25fl164k 64 x1, x2, x4
SPI Spansion s25fIxxx| s25fl064| 64 x1, x2, x4
SPI Spansion s25flxxxl| s25f1128l 128 x1, x2, x4
SPI Spansion s25flxxxl| s25fl1256l 256 x1, x2, x4
SPI Spansion s25flxxxp s25fl032p 32 x1, x2, x4
SPI Spansion s25flxxxp s25fl064p 64 x1, x2, x4
SPI Spansion s25flxxxs $25f1128sxxxxxx0 128 x1, x2, x4
[s25fl127s-spi-x1_x2_x4]
SPI Spansion s25flxxxs s25f1128sxxxxxx1 128 x1, x2, x4
SPI Spansion s25flxxxs s25f12565xxxxxx0 256 x1, x2, x4
SPI Spansion s25flxxxs s25f1256sxxxxxx1 256 x1, x2, x4
SPI Spansion s25flxxxs s25f1512s 512 x1, x2, x4
SPI Macronix mx25I mx25v8035f 8 x1, x2, x4
SPI Macronix mx25I mx25v1635f 16 x1, x2, x4
SPI Macronix mx25I mx2513233f 32 x1, x2, x4
SPI Macronix mx25I mx2516433f 64 x1, x2, x4
SPI Macronix mx25I mx25112845¢g 128 x1, x2, x4
[Mmx25112835f-spi-x1_x2_x4]
SPI Macronix mx25I mx25125645¢g 256 x1, x2, x4
[Mmx25125635f-spi-x1_x2_x4]
SPI Macronix mx25I mx25151245¢g 512 x1, x2, x4
[Mx66151235f-spi-x1_x2_x4]
SPI Macronix mx25u mx25u8033e 8 x1, x2, x4
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Table D-3: Supported Flash Memory Devices for Spartan-7 Device Configuration (Cont’d)

Interface | Manufacturer Marl\::z::ltyurer Device Alias D&Eﬂ? Dat%midth
SPI Macronix mx25u mx25ul635f 16 x1, x2, x4
SPI Macronix mx25u mx25u3235f 32 x1, x2, x4
SPI Macronix mx25u mx25u6435f 64 x1, x2, x4
SPI Macronix mx25u mx25ul2835f 128 x1, x2, x4
SPI Macronix mx25u mx25u25645¢g 256 x1, x2, x4
[Mx25u25635f-spi-x1_x2_x4]
SPI Macronix mx25u mx25u51245g 512 x1, x2, x4
[Mx66u51235f-spi-x1_x2_x4]
SPI Macronix mx66l| mx6611g45g 1,024 x1, x2, x4
SPI Macronix mx66l| mx6612g45g 2,048 x1, x2, x4
SPI Macronix mx66u mx66ulg45g 1,024 x1, x2, x4
SPI Macronix mx66u mx66u2g45g 2,048 x1, x2, x4
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)

Virtex-7 Configuration Memory Devices

The Flash devices supported for configuration of Virtex®-7 devices that can be erased,
blank checked, programmed, and verified by Vivado® software are shown in the following
table.

The tables in this Appendix are running lists per Xilinx® family of non-volatile memories
which Vivado software is capable of erasing, blank checking, programming, and verifying.
Xilinx strives to retain components on this list even after they are no longer appropriate for
new designs, to support long-term maintenance of end products which may contain them.

IMPORTANT: Given the evolving nature of the commodity non-volatile memory market, Xilinx
recommends contacting your non-volatile memory supplier to confirm device availability and life cycle.
References to specific devices in the tables are not an assurance of their current or future availability.

Table D-4: Supported Flash Memory Devices for Virtex-7 Device Configuration

Interface | Manufacturer Marli:;:zicltyurer Device Alias Dlslr';ﬂgy Dat%i\ﬁidth
BPI Micron gl8 28f128g18f 128 x16
BPI Micron gl8 mt28gu256aaxle 256 x16
[28f256918f-bpi-x16]
BPI Micron gl8 mt28gu512aaxle 512 x16
[28f512g18f-bpi-x16]
BPI Micron g18 mt28gullgaaxle 1,024 x16
[28f00ag18f-bpi-x16]
BPI Micron m29ew 28f064m29ewb 64 x16, x8
BPI Micron m29ew 28f064m29ewh 64 x16, x8
BPI Micron m29ew 28f064m29ewl 64 x16, x8
BPI Micron m29ew 28f064m29ewt 64 x16, x8
BPI Micron m29ew 28f128m29ew 128 x16, x8
BPI Micron m29ew 28f256m29%ew 256 x16, x8
BPI Micron m29ew 28f512m29ew 512 x16, x8
BPI Micron m29ew 28f00am29ew 1,024 x16, x8
BPI Micron m29ew 28f00bm29ew 2,048 x16, x8
BPI Micron m29w m29w128gh 128 x16, x8
BPI Micron m29w m29w128gl 128 x16, x8
BPI Micron m29w m29w256gh 256 x16, x8
BPI Micron m29w m29w2564l 256 x16, x8
BPI Micron mt28ew mt28ew128a 128 x16, x8
BPI Micron mt28ew mt28ew256a 256 x16, x8
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Table D-4: Supported Flash Memory Devices for Virtex-7 Device Configuration (Cont’d)
Interface | Manufacturer Marl\:gi;:icltyurer Device Alias DISIE?:? Data:si\i\éidth
BPI Micron mt28ew mt28ew512a 512 x16, x8
BPI Micron mt28ew mt28ew01lga 1,024 x16, x8
BPI Micron mt28fw mt28fw02gb 2,048 x16
BPI Micron p30 28f640p30b 64 x16
BPI Micron p30 28f640p30t 64 x16
BPI Micron p30 28f128p30b 128 x16
BPI Micron p30 28f128p30t 128 x16
BPI Micron p30 28f256p30b 256 x16
BPI Micron p30 28f256p30t 256 x16
BPI Micron p30 28f512p30b 512 x16
BPI Micron p30 28f512p30e 512 x16
BPI Micron p30 28f512p30t 512 x16
BPI Micron p30 28f00ap30b 1,024 x16
BPI Micron p30 28f00ap30e 1,024 x16
BPI Micron p30 28f00ap30t 1,024 x16
BPI Micron p30 28f00bp30e 2,048 x16
BPI Spansion s29glxxxp s29gl128p 128 x16, x8
BPI Spansion s29glxxxp s29g1256p 256 x16, x8
BPI Spansion s29glxxxp s29gl512p 512 x16, x8
BPI Spansion s29glxxxp s29gl01gp 1,024 x16, x8
BPI Spansion s29glxxxs s29gl128s 128 x16
BPI Spansion s29glxxxs s29gl256s 256 x16
BPI Spansion s29glxxxs s29gl512s 512 x16
BPI Spansion s29glxxxs s29gl01gs 1,024 x16
BPI Spansion s29glxxxs s70gl02gs 2,048 x16
BPI Spansion s29glxxxt s29gl512t 512 x16, x8
BPI Spansion s29glxxxt s29gl01gt 1,024 x16, x8
BPI Spansion s29glxxxt s70gl02gt 2,048 x16, x8
SPI ISSI is25Ip is251p080d 8 x1, x2, x4
SPI ISSI is25Ip is25lp016d 16 x1, x2, x4
SPI ISSI is25Ip is251p032d 32 x1, x2, x4
SPI ISSI is25Ip is25lp064a 64 x1, x2, x4
SPI ISSI is25Ip is25lp128f 128 x1, x2, x4
SPI ISSI is25Ip is25lp256d 256 x1, x2, x4
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Table D-4: Supported Flash Memory Devices for Virtex-7 Device Configuration (Cont’d)

Interface | Manufacturer Marl\:gi;:icltyurer Device Alias DISIE?:? Data:si\i\éidth
SPI ISSI is25wp is25wp080d 8 x1, x2, x4
SPI ISSI is25wp is25wp016d 16 x1, x2, x4
SPI ISSI is25wp is25wp032d 32 x1, x2, x4
SPI ISSI is25wp is25wp064a 64 x1, x2, x4
SPI ISSI is25wp is25wp128f 128 x1, x2, x4
SPI ISSI is25wp is25wp256d 256 x1, x2, x4
SPI Micron mt25qu mt25qul28 128 x1, x2, x4
[n25g128-1.8v-spi-x1_x2_x4]
SPI Micron mt25qu mt25qu256 256 x1, x2, x4
[n25q256-1.8v-spi-x1_x2_x4]
SPI Micron mt25qu mt25qu512 512 x1, x2, x4
SPI Micron mt25qu mt25qu0lg 1,024 x1, x2, x4
SPI Micron mt25qu mt25qu02g 2,048 x1, x2, x4
SPI Micron n25q n25q32-1.8v 32 x1, x2, x4
SPI Micron n25q n25q64-1.8v 64 x1, x2, x4
SPI Spansion s25flxxxs s25f1128sxxxxxx0 128 x1, x2, x4
[s25fI127s-spi-x1_x2_x4]
SPI Spansion s25flxxxs s25f1128sxxxxxx1 128 x1, x2, x4
SPI Spansion s25flxxxs s25f12565xxxxxx0 256 x1, x2, x4
SPI Spansion s25flxxxs s25f1256sxxxxxx1 256 x1, x2, x4
SPI Spansion s25flxxxs s25fI512s 512 x1, x2, x4
SPI Macronix mx25u mx25u8033e 8 x1, x2, x4
SPI Macronix mx25u mx25ul635f 16 x1, x2, x4
SPI Macronix mx25u mx25u3235f 32 x1, x2, x4
SPI Macronix mx25u mx25u6435f 64 x1, x2, x4
SPI Macronix mx25u mx25ul2835f 128 x1, x2, x4
SPI Macronix mx25u mx25u25645g 256 x1, x2, x4
[Mmx25u25635f-spi-x1_x2_x4]
SPI Macronix mx25u mx25u51245g 512 x1, x2, x4
[Mmx66u51235f-spi-x1_x2_x4]
SPI Macronix mx66u mx66ulg45g 1,024 x1, x2, x4
SPI Macronix mx66u mx66u2g459g 2,048 x1, x2, x4
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Kintex UltraScale Configuration Memory Devices

The Flash devices supported for configuration of Kintex® UltraScale™ devices that can be
erased, blank checked, programmed, and verified by Vivado® software are shown in the
following table.

The tables in this Appendix are running lists per Xilinx® family of non-volatile memories
which Vivado software is capable of erasing, blank checking, programming, and verifying.
Xilinx strives to retain components on this list even after they are no longer appropriate for
new designs, to support long-term maintenance of end products which may contain them.

IMPORTANT: Given the evolving nature of the commodity non-volatile memory market, Xilinx
recommends contacting your non-volatile memory supplier to confirm device availability and life cycle.
References to specific devices in the tables are not an assurance of their current or future availability.

Table D-5: Supported Flash Memory Devices for Kintex UltraScale Device Configuration

Interface |Manufacturer Mar;:t;:icltyurer Device Alias Density Mbits Wi(li)tahtal‘Bits
BPI Micron gl8 28f128g18f 128 x16
BPI Micron gl8 mt28gu256aaxle 256 x16
[28f256918f-bpi-x16]
BPI Micron gl8 mt28gu512aaxle 512 x16
[28f512g18f-bpi-x16]
BPI Micron gl8 mt28gullgaaxle 1,024 x16
[28f00ag18f-bpi-x16]
BPI Micron m29ew 28f064m29ewb 64 x16, x8
BPI Micron m29ew 28f064m29ewh 64 x16, x8
BPI Micron m29ew 28f064m29ewl 64 x16, x8
BPI Micron m29ew 28f064m29ewt 64 x16, x8
BPI Micron m29ew 28f128m29ew 128 x16, x8
BPI Micron m29ew 28f256m29ew 256 x16, x8
BPI Micron m29ew 28f512m29ew 512 x16, x8
BPI Micron m29ew 28f00am29ew 1,024 x16, x8
BPI Micron m29ew 28f00bm29ew 2,048 x16, x8
BPI Micron m29w m29w640gh 64 x16, x8
BPI Micron m29w m29w640gl 64 x16, x8
BPI Micron m29w m29w128gh 128 x16, x8
BPI Micron m29w m29w128gl 128 x16, x8
BPI Micron m29w m29w256gh 256 x16, x8
BPI Micron m29w m29w2564l 256 x16, x8
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Table D-5: Supported Flash Memory Devices for Kintex UltraScale Device Configuration (Cont’d)
Interface |Manufacturer Marll::i;‘a'\.icltyurer Device Alias Density Mbits Wi(?tal'ntal‘?.its
BPI Micron mt28ew mt28ewl128a 128 x16, x8
BPI Micron mt28ew mt28ew256a 256 x16, x8
BPI Micron mt28ew mt28ew512a 512 x16, x8
BPI Micron mt28ew mt28ew01lga 1,024 x16, x8
BPI Micron mt28fw mt28fw02gb 2,048 x16
BPI Micron p30 28f640p30b 64 x16
BPI Micron p30 28f640p30t 64 x16
BPI Micron p30 28f128p30b 128 x16
BPI Micron p30 28f128p30t 128 x16
BPI Micron p30 28f256p30b 256 x16
BPI Micron p30 28f256p30t 256 x16
BPI Micron p30 28f512p30b 512 x16
BPI Micron p30 28f512p30e 512 x16
BPI Micron p30 28f512p30t 512 x16
BPI Micron p30 28f00ap30b 1,024 x16
BPI Micron p30 28f00ap30e 1,024 x16
BPI Micron p30 28f00ap30t 1,024 x16
BPI Micron p30 28f00bp30e 2,048 x16
BPI Micron p33 28f640p33b 64 x16
BPI Micron p33 28f640p33t 64 x16
BPI Micron p33 28f128p33b 128 x16
BPI Micron p33 28f128p33t 128 x16
BPI Micron p33 28f256p33b 256 x16
BPI Micron p33 28f256p33t 256 x16
BPI Micron p33 28f512p33b 512 x16
BPI Micron p33 28f512p33e 512 x16
BPI Micron p33 28f512p33t 512 x16
BPI Micron p33 28f00ap33b 1,024 x16
BPI Micron p33 28f00ap33e 1,024 x16
BPI Micron p33 28f00ap33t 1,024 x16
BPI Spansion s29glxxxp s29gl128p 128 x16, x8
BPI Spansion s29glxxxp s29gl256p 256 x16, x8
BPI Spansion s29glxxxp s29gl512p 512 x16, x8
BPI Spansion s29glxxxp s29gl01gp 1,024 x16, x8
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Table D-5: Supported Flash Memory Devices for Kintex UltraScale Device Configuration (Cont’d)

Manufacturer . . - . Data
Interface |Manufacturer Family Device Alias Density Mbits Width Bits
BPI Spansion s29glxxxp s70gl02gp 2,048 x16
BPI Spansion s29glxxxs s29gl128s 128 x16
BPI Spansion s29glxxxs s29gl256s 256 x16
BPI Spansion s29glxxxs s29¢gl512s 512 x16
BPI Spansion s29glxxxs s29gl01gs 1,024 x16
BPI Spansion s29glxxxs s70gl02gs 2,048 x16
BPI Spansion s29glxxxt s29gl512t 512 x16, x8
BPI Spansion s29glxxxt s29gl01gt 1,024 x16, x8
BPI Spansion s29glxxxt s70gl02gt 2,048 x16, x8
SPI ISSI is25lp is251p080d 8 x1, x2, x4,
x8
SPI ISSI is25lp is25lp01l6d 16 x1, x2, x4,
x8
SPI ISSI is25lp is25lp032d 32 x1, x2, x4,
x8
SPI ISSI is25lp is25lp064a 64 x1, x2, x4,
x8
SPI ISSI is25lp is251p128f 128 x1, x2, x4,
x8
SPI ISSI is25lp is25lp256d 256 x1, x2, x4,
x8
SPI ISSI is25wp is25wp080d 8 x1, x2, x4,
x8
SPI ISSI is25wp is25wp016d 16 x1, x2, x4,
x8
SPI ISSI is25wp is25wp032d 32 x1, x2, x4,
x8
SPI ISSI is25wp is25wp064a 64 x1, x2, x4,
x8
SPI ISSI is25wp is25wp128f 128 x1, x2, x4,
x8
SPI ISSI is25wp is25wp256d 256 x1, x2, x4,
x8
SPI Micron mt25q]| mt25ql128 128 x1, x2, x4,
[n25q128-3.3v-spi-x1_x2_x4, x8
n25q128-3.3v-spi-x1_x2_x4_x8]
SPI Micron mt25q| mt25ql256 256 x1, x2, x4,
[N259256-3.3v-spi-x1_x2_x4, x8
n25q256-3.3v-spi-x1_x2_x4_x8]
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Table D-5: Supported Flash Memory Devices for Kintex UltraScale Device Configuration (Cont’d)
Manufacturer . . . . Data

Interface |Manufacturer Family Device Alias Density Mbits Width Bits

SPI Micron mt25q! mt25ql512 512 x1, x2, x4,

x8

SPI Micron mt25q! mt25ql01g 1,024 x1, x2, x4,

x8

SPI Micron mt25q! mt25ql02g 2,048 x1, x2, x4,

x8

SPI Micron mt25qu mt25qul28 128 x1, x2, x4,
[N25q128-1.8v-spi-x1_x2_x4, x8
n25q128-1.8v-spi-x1_x2_x4_x8]

SPI Micron mt25qu mt25qu256 256 x1, x2, x4,
[N25g256-1.8v-spi-x1_x2_x4, x8
n25q256-1.8v-spi-x1_x2_x4_x8]

SPI Micron mt25qu mt25qu512 512 x1, x2, x4,

x8

SPI Micron mt25qu mt25qu0lg 1,024 x1, x2, x4,

x8

SPI Micron mt25qu mt25qu02g 2,048 x1, x2, x4,

x8

SPI Micron n25q n25qg32-1.8v 32 x1, x2, x4

SPI Micron n25q n25qg32-3.3v 32 x1, x2, x4

SPI Micron n25q n25q64-1.8v 64 x1, x2, x4

SPI Micron n25q n25q64-3.3v 64 x1, x2, x4

SPI Spansion s25fl1 s25fl116k 16 x1, x2, x4

SPI Spansion s25fl1 s25f1132k 32 x1, x2, x4

SPI Spansion s25fl1 s25fl164k 64 x1, x2, x4

SPI Spansion s25flxxxl s25fl064| 64 x1, x2, x4

SPI Spansion s25flxxxl s25f1128l 128 x1, x2, x4,

x8

SPI Spansion s25flxxxp s25fl032p 32 x1, x2, x4

SPI Spansion s25flxxxp s25fl064p 64 x1, x2, x4

SPI Spansion s25flxxxs s25f1128sxxxxxx0 128 x1, x2, x4,
[s25f1127s-spi-x1_x2_x4, x8
s25fl127s-spi-x1_x2_x4_x8]

SPI Spansion s25flxxxs s25f1128sxxxxxx1 128 x1, x2, x4,

x8

SPI Spansion s25flxxxs s25f12565xxxxxx0 256 x1, x2, x4,

x8

SPI Spansion s25flxxxs s25f1256sxxxxxx1 256 x1, x2, x4,

x8
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Table D-5: Supported Flash Memory Devices for Kintex UltraScale Device Configuration (Cont’d)

Manufacturer . . . . Data

Interface |Manufacturer Family Device Alias Density Mbits Width Bits

SPI Spansion s25flxxxs s25fI512s 512 x1, x2, x4,

x8

SPI Macronix mx25I mx25v8035f 8 x1, x2, x4,

x8

SPI Macronix mx25I mx25v1635f 16 x1, x2, x4,

x8

SPI Macronix mx25I mx2513233f 32 x1, x2, x4,

x8

SPI Macronix mx25I mx2516433f 64 x1, x2, x4,

x8

SPI Macronix mx25I mx25112845¢g 128 x1, x2, x4,
[mx25112835f-spi-x1_x2_x4, x8
mx25112835f-spi-x1_x2_x4_x8]

SPI Macronix mx25I mx25125645¢g 256 x1, x2, x4,
[Mmx25125635f-spi-x1_x2_x4, x8
mx25u25635f-spi-x1_x2_x4_x8]

SPI Macronix mx25I mx25151245¢g 512 x1, x2, x4,
[Mmx66151235f-spi-x1_x2_x4, x8
mx66151235f-spi-x1_x2_x4_x8]

SPI Macronix mx25u mx25u8033e 8 x1, x2, x4,

x8

SPI Macronix mx25u mx25ul635f 16 x1, x2, X4,

x8

SPI Macronix mx25u mx25u3235f 32 x1, x2, x4,

x8

SPI Macronix mx25u mx25u6435f 64 x1, x2, x4,

x8

SPI Macronix mx25u mx25ul2835f 128 x1, x2, x4,

x8

SPI Macronix mx25u mx25u25645g 256 x1, x2, x4,
[Mmx25u25635f-spi-x1_x2_x4, x8
mx25u25635f-spi-x1_x2_x4_x8]

SPI Macronix mx25u mx25u51245¢g 512 x1, x2, x4,
[Mmx66u51235f-spi-x1_x2_x4, x8
mx66u51235f-spi-x1_x2_x4_x8]

SPI Macronix mx66l| mx6611g45g 1,024 x1, x2, x4,

x8

SPI Macronix mx66l| mx6612g45g 2,048 x1, x2, x4,

x8
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Table D-5: Supported Flash Memory Devices for Kintex UltraScale Device Configuration (Cont’d)
Manufacturer . . . . Data
Interface |Manufacturer Family Device Alias Density Mbits Width Bits
SPI Macronix mx66u mx66ulg45g 1,024 x1, x2, x4,
x8
SPI Macronix mx66u mx66u2g45g 2,048 x1, x2, x4,
x8
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Kintex UltraScale+ Configuration Memory Devices

The Flash devices supported for configuration of Kintex® UltraScale+™ devices that can be
erased, blank checked, programmed, and verified by Vivado® software are shown in the
following table.

The tables in this Appendix are running lists per Xilinx® family of non-volatile memories
which Vivado software is capable of erasing, blank checking, programming, and verifying.
Xilinx strives to retain components on this list even after they are no longer appropriate for
new designs, to support long-term maintenance of end products which may contain them.

f IMPORTANT: Given the evolving nature of the commodity non-volatile memory market, Xilinx
recommends contacting your non-volatile memory supplier to confirm device availability and life cycle.
References to specific devices in the tables are not an assurance of their current or future availability

Table D-6: Supported Flash Memory Devices for Kintex UltraScale+ Device Configuration

Interface | Manufacturer Marli:;:zicltyurer Device Alias Dl\slr;:tsy Dat%it‘l\gdth
BPI Micron gl8 28f128g18f 128 x16
BPI Micron gl8 mt28gu256aaxle 256 x16
[28f256918f-bpi-x16]
BPI Micron gl8 mt28gu512aaxle 512 x16
[28f512g18f-bpi-x16]
BPI Micron g18 mt28gullgaaxle 1,024 x16
[28f00ag18f-bpi-x16]
BPI Micron m29ew 28f064m29ewb 64 x16, x8
BPI Micron m29ew 28f064m29ewh 64 x16, x8
BPI Micron m29ew 28f064m29ew| 64 x16, x8
BPI Micron m29ew 28f064m29ewt 64 x16, x8
BPI Micron m29ew 28f128m29ew 128 x16, x8
BPI Micron m29ew 28f256m29ew 256 x16, x8
BPI Micron m29ew 28f512m29ew 512 x16, x8
BPI Micron m29ew 28f00am29ew 1,024 x16, x8
BPI Micron m29ew 28f00bm29ew 2,048 x16, x8
BPI Micron m29w m29w128gh 128 x16, x8
BPI Micron m29w m29w128gl 128 x16, x8
BPI Micron m29w m29w256gh 256 x16, x8
BPI Micron m29w m29w2564l 256 x16, x8
BPI Micron mt28ew mt28ew128a 128 x16, x8
BPI Micron mt28ew mt28ew256a 256 x16, x8
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Table D-6: Supported Flash Memory Devices for Kintex UltraScale+ Device Configuration (Cont’d)

Interface | Manufacturer Marl\:gi;:icltyurer Device Alias DISIrI‘a?:tsy DataBi\i\;idth
BPI Micron mt28ew mt28ew512a 512 x16, x8

BPI Micron mt28ew mt28ew01lga 1,024 x16, x8

BPI Micron mt28fw mt28fw02gb 2,048 x16

BPI Micron p30 28f640p30b 64 x16

BPI Micron p30 28f640p30t 64 x16

BPI Micron p30 28f128p30b 128 x16

BPI Micron p30 28f128p30t 128 x16

BPI Micron p30 28f256p30b 256 x16

BPI Micron p30 28f256p30t 256 x16

BPI Micron p30 28f512p30b 512 x16

BPI Micron p30 28f512p30e 512 x16

BPI Micron p30 28f512p30t 512 x16

BPI Micron p30 28f00ap30b 1,024 x16

BPI Micron p30 28f00ap30e 1,024 x16

BPI Micron p30 28f00ap30t 1,024 x16

BPI Micron p30 28f00bp30e 2,048 x16

BPI Spansion s29glxxxp s29gl128p 128 x16, x8

BPI Spansion s29glxxxp s29g1256p 256 x16, x8

BPI Spansion s29glxxxp s29gl512p 512 x16, x8

BPI Spansion s29glxxxp s29gl01gp 1,024 x16, x8

BPI Spansion s29glxxxs s29gl128s 128 x16

BPI Spansion s29glxxxs s29gl256s 256 x16

BPI Spansion s29glxxxs s29gl512s 512 x16

BPI Spansion s29glxxxs s29gl01gs 1,024 x16

BPI Spansion s29glxxxs s70gl02gs 2,048 x16

BPI Spansion s29glxxxt s29gl512t 512 x16, x8

BPI Spansion s29glxxxt s29gl01gt 1,024 x16, x8

BPI Spansion s29glxxxt s70gl02gt 2,048 x16, x8

SPI ISSI is25wp is25wp080d 8 x1, x2, x4, x8
SPI ISSI is25wp is25wp016d 16 x1, x2, x4, x8
SPI ISSI is25wp is25wp032d 32 x1, x2, x4, x8
SPI ISSI is25wp is25wp064a 64 x1, x2, x4, x8
SPI ISSI is25wp is25wp128f 128 x1, x2, x4, x8
SPI ISSI is25wp is25wp256d 256 x1, x2, x4, x8
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Table D-6: Supported Flash Memory Devices for Kintex UltraScale+ Device Configuration (Cont’d)

Manufacturer . . Density Data Width
Interface | Manufacturer Family Device Alias Mbits Bits
SPI Micron mt25qu mt25qul28 128 x1, x2, x4, x8

[N25q128-1.8v-spi-x1_x2_x4,
n25q128-1.8v-spi-x1_x2_x4_x8]

SPI Micron mt25qu mt25qu256 256 x1, x2, x4, x8
[N250256-1.8v-spi-x1_x2_x4,
n25q256-1.8v-spi-x1_x2_x4_x8]

SPI Micron mt25qu mt25qu512 512 x1, x2, x4, x8
SPI Micron mt25qu mt25qu0llg 1,024 x1, x2, x4, x8
SPI Micron mt25qu mt25qu02g 2,048 x1, x2, x4, x8
SPI Micron n25q n25qg32-1.8v 32 x1, x2, x4
SPI Micron n25q n25q64-1.8v 64 x1, x2, x4
SPI Spansion s25fl1 s25fl116k 16 x1, x2, x4
SPI Spansion s25fl1 s25fl132k 32 x1, x2, x4
SPI Spansion s25fl1 s25fl164k 64 x1, x2, x4
SPI Spansion s25fIxxx| s25fl064l 64 x1, x2, x4
SPI Spansion s25fIxxx| s25f1128l 128 x1, x2, x4, x8
SPI Spansion s25flxxxp s25f1032p 32 x1, x2, x4
SPI Spansion s25flxxxp s25fl064p 64 x1, x2, x4
SPI Spansion s25flxxxs s25f1128sxxxxxx0 128 x1, x2, x4, x8

[s25f1127s-spi-x1_x2_x4,
s25fl127s-spi-x1_x2_x4_x8]

SPI Spansion s25flxxxs s25f1128sxxxxxx1 128 x1, x2, x4, x8
SPI Spansion s25flxxxs s25f1256sxxxxxx0 256 x1, x2, x4, x8
SPI Spansion s25flxxxs s25f1256sxxxxxx1 256 x1, x2, x4, x8
SPI Spansion s25flxxxs s25fI512s 512 x1, x2, x4, x8
SPI Macronix mx25u mx25u8033e 8 x1, x2, x4, x8
SPI Macronix mx25u mx25ul635f 16 x1, x2, x4, x8
SPI Macronix mx25u mx25u3235f 32 x1, x2, x4, x8
SPI Macronix mx25u mx25u6435f 64 x1, x2, x4, x8
SPI Macronix mx25u mx25ul2835f 128 x1, x2, x4, x8
SPI Macronix mx25u mx25u25645g 256 x1, x2, x4, x8

[Mmx25u25635f-spi-x1_x2_x4,
mx25u25635f-spi-x1_x2_x4_x8]

SPI Macronix mx25u mx25u51245g 512 x1, x2, x4, x8
[Mmx66u51235f-spi-x1_x2_x4,
mx66u51235f-spi-x1_x2_x4_x8]
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Table D-6: Supported Flash Memory Devices for Kintex UltraScale+ Device Configuration (Cont’d)
Manufacturer . . Density Data Width

Interface | Manufacturer Family Device Alias Mbits Bits
SPI Macronix mx66u mx66ulg45g 1,024 x1, x2, x4, x8
SPI Macronix mx66u mx66u2g45g 2,048 x1, x2, x4, x8
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Virtex UltraScale Configuration Memory Devices

The Flash devices supported for configuration of Virtex UltraScale devices that can be
erased, blank checked, programmed, and verified by Vivado® software are shown in the
following table.

The tables in this Appendix are running lists per Xilinx® family of non-volatile memories
which Vivado software is capable of erasing, blank checking, programming, and verifying.
Xilinx strives to retain components on this list even after they are no longer appropriate for
new designs, to support long-term maintenance of end products which may contain them.

f IMPORTANT: Given the evolving nature of the commodity non-volatile memory market, Xilinx
recommends contacting your non-volatile memory supplier to confirm device availability and life cycle.
References to specific devices in the tables are not an assurance of their current or future availability.

Table D-7: Supported Flash Memory Devices for Virtex UltraScale Device Configuration

Interface | Manufacturer Mar;::tra;iclglurer Device Alias D&";Si,ictsy Dat%midth
BPI Micron gl8 28f128g18f 128 x16
BPI Micron gl8 mt28gu256aaxle 256 x16
[28f256918f-bpi-x16]
BPI Micron gl8 mt28gu512aaxle 512 x16
[28f512g18f-bpi-x16]
BPI Micron g18 mt28gullgaaxle 1,024 x16
[28f00ag18f-bpi-x16]
BPI Micron m29ew 28f064m29ewb 64 x16, x8
BPI Micron m29ew 28f064m29ewh 64 x16, x8
BPI Micron m29ew 28f064m29ew! 64 x16, x8
BPI Micron m29ew 28f064m29ewt 64 x16, x8
BPI Micron m29ew 28f128m29ew 128 x16, x8
BPI Micron m29ew 28f256m29ew 256 x16, x8
BPI Micron m29ew 28f512m29ew 512 x16, x8
BPI Micron m29ew 28f00am29ew 1,024 x16, x8
BPI Micron m29ew 28f00bm29ew 2,048 x16, x8
BPI Micron m29w m29w128gh 128 x16, x8
BPI Micron m29w m29w128gl 128 x16, x8
BPI Micron m29w m29w256gh 256 x16, x8
BPI Micron m29w m29w2564l 256 x16, x8
BPI Micron mt28ew mt28ew128a 128 x16, x8
BPI Micron mt28ew mt28ew256a 256 x16, x8
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Table D-7: Supported Flash Memory Devices for Virtex UltraScale Device Configuration (Cont’d)

Interface | Manufacturer Mar;:tan;a:;:ltyurer Device Alias DISIE?{? DataB“V\;idth
BPI Micron mt28ew mt28ew512a 512 x16, x8

BPI Micron mt28ew mt28ew01lga 1,024 x16, x8

BPI Micron mt28fw mt28fw02gb 2,048 x16

BPI Micron p30 28f640p30b 64 x16

BPI Micron p30 28f640p30t 64 x16

BPI Micron p30 28f128p30b 128 x16

BPI Micron p30 28f128p30t 128 x16

BPI Micron p30 28f256p30b 256 x16

BPI Micron p30 28f256p30t 256 x16

BPI Micron p30 28f512p30b 512 x16

BPI Micron p30 28f512p30e 512 x16

BPI Micron p30 28f512p30t 512 x16

BPI Micron p30 28f00ap30b 1,024 x16

BPI Micron p30 28f00ap30e 1,024 x16

BPI Micron p30 28f00ap30t 1,024 x16

BPI Micron p30 28f00bp30e 2,048 x16

BPI Spansion s29glxxxp s29gl128p 128 x16, x8

BPI Spansion s29glxxxp s29g1256p 256 x16, x8

BPI Spansion s29glxxxp s29gl512p 512 x16, x8

BPI Spansion s29glxxxp s29gl01lgp 1,024 x16, x8

BPI Spansion s29glxxxs s29gl128s 128 x16

BPI Spansion s29glxxxs s29gl256s 256 x16

BPI Spansion s29glxxxs s29gl512s 512 x16

BPI Spansion s29glxxxs s29gl01gs 1,024 x16

BPI Spansion s29glxxxs s70gl02gs 2,048 x16

BPI Spansion s29glxxxt s29gl512t 512 x16, x8

BPI Spansion s29glxxxt s29gl01gt 1,024 x16, x8

BPI Spansion s29glxxxt s70gl02gt 2,048 x16, x8

SPI ISSI is25lp is251p080d 8 x1, x2, x4, x8
SPI ISSI is25lp is25lp016d 16 x1, x2, x4, x8
SPI ISSI is25lp is251p032d 32 x1, x2, x4, x8
SPI ISSI is25lp is25lp064a 64 x1, x2, x4, x8
SPI ISSI is25lp is25lp128f 128 x1, x2, x4, x8
SPI ISSI is25lp is25lp256d 256 x1, x2, x4, x8
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Table D-7: Supported Flash Memory Devices for Virtex UltraScale Device Configuration (Cont’d)

Interface | Manufacturer Mar;:tan;a:;:ltyurer Device Alias D&gﬂ? Dat%midth
SPI ISSI is25wp is25wp080d 8 x1, x2, x4, x8
SPI ISSI is25wp is25wp016d 16 x1, x2, x4, x8
SPI ISSI is25wp is25wp032d 32 x1, x2, x4, x8
SPI ISSI is25wp is25wp064a 64 x1, x2, x4, x8
SPI ISSI is25wp is25wp128f 128 x1, x2, x4, x8
SPI ISSI is25wp is25wp256d 256 x1, x2, x4, x8
SPI Micron mt25q]l mt25ql128 128 x1, x2, x4
[n25q128-3.3v-spi-x1_x2_x4]
SPI Micron mt25¢| mt25ql256 256 x1, x2, x4
[N250256-3.3v-spi-x1_x2_x4]
SPI Micron mt25¢]| mt25ql512 512 x1, x2, x4
SPI Micron mt25¢| mt25ql01g 1,024 x1, x2, x4
SPI Micron mt25¢| mt25ql02g 2,048 x1, x2, x4
SPI Micron mt25qu mt25qul28 128 x1, x2, x4, x8

[N25q128-1.8v-spi-x1_x2_x4,
n25q128-1.8v-spi-x1_x2_x4_x8]

SPI Micron mt25qu mt25qu256 256 x1, x2, x4, x8
[N259256-1.8v-spi-x1_x2_x4,
n25q256-1.8v-spi-x1_x2_x4_x8]

SPI Micron mt25qu mt25qu512 512 x1, x2, x4, x8
SPI Micron mt25qu mt25qu0llg 1,024 x1, x2, x4, x8
SPI Micron mt25qu mt25qu02g 2,048 x1, x2, x4, x8
SPI Micron n25q n25qg32-1.8v 32 x1, x2, x4
SPI Micron n25q n25qg32-3.3v 32 x1, x2, x4
SPI Micron n25q n25q64-1.8v 64 x1, x2, x4
SPI Micron n25q n25q64-3.3v 64 x1, x2, x4
SPI Spansion s25fl1 s25fl116k 16 x1, x2, x4
SPI Spansion s25fl1 s25fl132k 32 x1, x2, x4
SPI Spansion s25fl1 s25fl164k 64 x1, x2, x4
SPI Spansion s25fIxxx| s25fl064l 64 x1, x2, x4
SPI Spansion s25fIxxx| s25f1128l 128 x1, x2, x4, x8
SPI Spansion s25flxxxp s25fl032p 32 x1, x2, x4
SPI Spansion s25flxxxp s25fl064p 64 x1, x2, x4
SPI Spansion s25flxxxs $25f1128sxxxxxx0 128 x1, x2, x4, x8

[s25f1127s-spi-x1_x2_x4,
s25f1127s-spi-x1_x2_x4_x8]

SPI Spansion s25flxxxs s25f1128sxxxxxx1 128 x1, x2, x4, x8
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Table D-7: Supported Flash Memory Devices for Virtex UltraScale Device Configuration (Cont’d)

Interface | Manufacturer Mar;:tan;a:;:ltyurer Device Alias DISIE?{? DataB“V\;idth
SPI Spansion s25flxxxs s25f12565xxxxxx0 256 x1, x2, x4, x8
SPI Spansion s25flxxxs s25f1256sxxxxxx1 256 x1, x2, x4, x8
SPI Spansion s25flxxxs s25f1512s 512 x1, x2, x4, x8
SPI Macronix mx25lI mx25v8035f 8 x1, x2, x4
SPI Macronix mx25lI mx25v1635f 16 x1, x2, x4
SPI Macronix mx25lI mx2513233f 32 x1, x2, x4
SPI Macronix mx25lI mx2516433f 64 x1, x2, x4
SPI Macronix mx25I mx25112845¢g 128 x1, x2, x4
[Mmx25112835f-spi-x1_x2_x4]
SPI Macronix mx25lI mx25125645g 256 x1, x2, x4
[Mmx25125635f-spi-x1_x2_x4]
SPI Macronix mx25I mx25151245¢g 512 x1, x2, x4
[Mmx66151235f-spi-x1_x2_x4]
SPI Macronix mx25u mx25u8033e 8 x1, x2, x4, x8
SPI Macronix mx25u mx25ul635f 16 x1, x2, x4, x8
SPI Macronix mx25u mx25u3235f 32 x1, x2, x4, x8
SPI Macronix mx25u mx25u6435f 64 x1, x2, x4, x8
SPI Macronix mx25u mx25ul2835f 128 x1, x2, x4, x8
SPI Macronix mx25u mx25u25645g 256 x1, x2, x4, x8
[Mmx25u25635f-spi-x1_x2_x4,
mx25u25635f-spi-x1_x2_x4_x8]
SPI Macronix mx25u mx25u51245g 512 x1, x2, x4, x8
[Mmx66u51235f-spi-x1_x2_x4,
mx66u51235f-spi-x1_x2_x4_x8]
SPI Macronix mx66| mx6611g45g 1,024 x1, x2, x4
SPI Macronix mx66| mx6612g45g 2,048 x1, x2, x4
SPI Macronix mx66u mx66ulg45g 1,024 x1, x2, x4, x8
SPI Macronix mx66u mx66u2g45g 2,048 x1, x2, x4, x8

Vivado Programming and Debugging Send Feedback 369
UG908 (v2019.1) May 22, 2019 www.Xxilinx.com l—\/—l


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=369

(: X”_INX® Appendix D: Configuration Memory Support

)

Virtex UltraScale+ Configuration Memory Devices

The Flash devices supported for configuration of Virtex UltraScale+ devices that can be
erased, blank checked, programmed, and verified by Vivado® software are shown in the
following table.

The tables in this Appendix are running lists per Xilinx® family of non-volatile memories
which Vivado software is capable of erasing, blank checking, programming, and verifying.
Xilinx strives to retain components on this list even after they are no longer appropriate for
new designs, to support long-term maintenance of end products which may contain them.

IMPORTANT: Given the evolving nature of the commodity non-volatile memory market, Xilinx
recommends contacting your non-volatile memory supplier to confirm device availability and
life cycle. References to specific devices in the tables are not an assurance of their current or
future availability.

Table D-8: Supported Flash Memory Devices for Virtex UltraScale+ Device Configuration

Interface | Manufacturer Marli:::zicltyurer Device Alias Dl\tilrt‘)?izy DataBitV\gidth
BPI Micron gl8 28f128g18f 128 x16
BPI Micron gl8 mt28gu256aaxle 256 x16
[28f256918f-bpi-x16]
BPI Micron gl8 mt28gu512aaxle 512 x16
[28f512918f-bpi-x16]
BPI Micron g18 mt28gullgaaxle 1,024 x16
[28f00agl8f-bpi-x16]
BPI Micron m29ew 28f064m29%ewb 64 x16, x8
BPI Micron m29ew 28f064m29ewh 64 x16, x8
BPI Micron m29ew 28f064m29ewl 64 x16, x8
BPI Micron m29ew 28f064m29ewt 64 x16, x8
BPI Micron m29ew 28f128m29ew 128 x16, x8
BPI Micron m29ew 28f256m29ew 256 x16, x8
BPI Micron m29ew 28f512m29ew 512 x16, x8
BPI Micron m29ew 28f00am29ew 1,024 x16, x8
BPI Micron m29ew 28f00bm29ew 2,048 x16, x8
BPI Micron m29w m29w128gh 128 x16, x8
BPI Micron m29w m29w128gl 128 x16, x8
BPI Micron m29w m29w256gh 256 x16, x8
BPI Micron m29w m29w2564l 256 x16, x8
BPI Micron mt28ew mt28ew128a 128 x16, x8
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Table D-8: Supported Flash Memory Devices for Virtex UltraScale+ Device Configuration (Cont’d)
Interface | Manufacturer Marl\::il":::ltyurer Device Alias D&gﬂtsy Datagi\i\;idth
BPI Micron mt28ew mt28ew256a 256 x16, x8
BPI Micron mt28ew mt28ew512a 512 x16, x8
BPI Micron mt28ew mt28ew01lga 1,024 x16, x8
BPI Micron mt28fw mt28fw02gb 2,048 x16
BPI Micron p30 28f640p30b 64 x16
BPI Micron p30 28f640p30t 64 x16
BPI Micron p30 28f128p30b 128 x16
BPI Micron p30 28f128p30t 128 x16
BPI Micron p30 28f256p30b 256 x16
BPI Micron p30 28f256p30t 256 x16
BPI Micron p30 28f512p30b 512 x16
BPI Micron p30 28f512p30e 512 x16
BPI Micron p30 28f512p30t 512 x16
BPI Micron p30 28f00ap30b 1,024 x16
BPI Micron p30 28f00ap30e 1,024 x16
BPI Micron p30 28f00ap30t 1,024 x16
BPI Micron p30 28f00bp30e 2,048 x16
BPI Spansion s29glxxxp s29gl128p 128 x16, x8
BPI Spansion s29glxxxp s29gl256p 256 x16, x8
BPI Spansion s29glxxxp s29gl512p 512 x16, x8
BPI Spansion s29glxxxp s29gl01gp 1,024 x16, x8
BPI Spansion s29glxxxs s29gl128s 128 x16
BPI Spansion s29glxxxs s29gl256s 256 x16
BPI Spansion s29glxxxs s29gl512s 512 x16
BPI Spansion s29glxxxs s29gl01gs 1,024 x16
BPI Spansion s29glxxxs s70gl02gs 2,048 x16
BPI Spansion s29glxxxt s29gl512t 512 x16, x8
BPI Spansion s29glxxxt s29gl01gt 1,024 x16, x8
BPI Spansion s29glxxxt s70gl02gt 2,048 x16, x8
SPI ISSI is25wp is25wp080d 8 x1, x2, x4, x8
SPI ISSI is25wp is25wp016d 16 x1, x2, x4, x8
SPI ISSI is25wp is25wp032d 32 x1, x2, x4, x8
SPI ISSI is25wp is25wp064a 64 x1, x2, x4, x8
SPI ISSI is25wp is25wp128f 128 x1, x2, x4, x8
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Table D-8: Supported Flash Memory Devices for Virtex UltraScale+ Device Configuration (Cont’d)

Manufacturer . . Density Data Width
Interface | Manufacturer Family Device Alias Mbits Bits
SPI ISSI is25wp is25wp256d 256 x1, x2, x4, x8
SPI Micron mt25qu mt25qul28 128 x1, x2, x4, x8

[n25q128-1.8v-spi-x1_x2_x4,
n25q128-1.8v-spi-x1_x2_x4_x8]

SPI Micron mt25qu mt25qu256 256 x1, x2, x4, x8
[n259256-1.8v-spi-x1_x2_x4,
n25q256-1.8v-spi-x1_x2_x4_x8]

SPI Micron mt25qu mt25qu512 512 x1, x2, x4, x8
SPI Micron mt25qu mt25qu0llg 1,024 x1, x2, x4, x8
SPI Micron mt25qu mt25qu02g 2,048 x1, x2, x4, x8
SPI Micron n25q n25q932-1.8v 32 x1, x2, x4
SPI Micron n25q n25q64-1.8v 64 x1, x2, x4
SPI Spansion s25fl1 s25fl116k 16 x1, x2, x4
SPI Spansion s25fl1 s25fl132k 32 x1, x2, x4
SPI Spansion s25fl1 s25fl164k 64 x1, x2, x4
SPI Spansion s25fIxxx| s25fl064| 64 x1, x2, x4
SPI Spansion s25fIxxx| s25f1128l 128 x1, x2, x4, x8
SPI Spansion s25flxxxp s25f1032p 32 x1, x2, x4
SPI Spansion s25flxxxp s25fl064p 64 x1, x2, x4
SPI Spansion s25flxxxs s25f1128sxxxxxx0 128 x1, X2, x4, x8

[s25fl127s-spi-x1_x2_x4,
s25fl127s-spi-x1_x2_x4_x8]

SPI Spansion s25flxxxs $25f1128sxxxxxx1 128 x1, x2, x4, x8
SPI Spansion s25flxxxs $25f1256sxxxxxx0 256 x1, x2, x4, x8
SPI Spansion s25flxxxs $25fl256sxxxxxx1 256 x1, x2, x4, x8
SPI Spansion s25flxxxs s25f1512s 512 x1, x2, x4, x8
SPI Macronix mx25u mx25u8033e 8 x1, x2, x4, x8
SPI Macronix mx25u mx25ul635f 16 x1, x2, x4, x8
SPI Macronix mx25u mx25u3235f 32 x1, x2, x4, x8
SPI Macronix mx25u mx25u6435f 64 x1, x2, x4, x8
SPI Macronix mx25u mx25ul2835f 128 x1, x2, x4, x8
SPI Macronix mx25u mx25u256459g 256 x1, x2, x4, x8

[Mx25u25635f-spi-x1_x2_x4,
mx25u25635f-spi-x1_x2_x4_x8]

SPI Macronix mx25u mx25u51245g 512 x1, x2, x4, x8
[Mx66u51235f-spi-x1_x2_x4,
mx66u51235f-spi-x1_x2_x4_x8]
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Table D-8: Supported Flash Memory Devices for Virtex UltraScale+ Device Configuration (Cont’d)
Manufacturer . . Density Data Width
Interface | Manufacturer Family Device Alias Mbits Bits
SPI Macronix mx66u mx66ulg45g 1,024 x1, x2, x4, x8
SPI Macronix mx66u mx66u2g45g 2,048 x1, x2, x4, x8
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Zynqg-7000 Configuration Memory Devices

The Flash devices supported for configuration of Zynq®-7000 devices that can be erased,
blank checked, programmed, and verified by Vivado® software are shown in following
table.

The tables in this Appendix are running lists per Xilinx® family of non-volatile memories
which Vivado software is capable of erasing, blank checking, programming, and verifying.
Xilinx strives to retain components on this list even after they are no longer appropriate for
new designs, to support long-term maintenance of end products which may contain them.

IMPORTANT: Given the evolving nature of the commodity non-volatile memory market, Xilinx
recommends contacting your non-volatile memory supplier to confirm device availability and life cycle.
References to specific devices in the tables are not an assurance of their current or future availability.

Note: The U-Boot tags used to build the Configuration Memory Device Programmer are as follows:

Interface UBoot Tags
gspi xilinx-v2015.2.01
nor xilinx-14.3-build1
nand xilinx-v2015.2.01

Table D-9: Supported Flash Memory Devices for Zynq-7000 Device Configuration

Interface | Manufacturer Mar;:g:;tyurer Device Alias D&gﬂ;y Data Width Bits
NAND Micron mt29f mt29f2g08ab 2,048 | x8
NAND Micron mt29f mt29f2gl6ab 2,048 x16
NAND Spansion s34ml s34ml01gl 1,024 | x16, x8
NAND Spansion s34ml s34ml02g1 2,048 | x16, x8
NOR nor 0 NA
NOR Micron m29ew 28f032m29ewt 32 x8
NOR Micron m29ew 28f064m29ewt 64 x8
NOR Micron m29ew 28f128m29ewh 128 x8
NOR Micron m29ew 28f256m29ewh 256 x8
NOR Micron m29ew 28f512m29ewh 512 x8
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Table D-9: Supported Flash Memory Devices for Zynq-7000 Device Configuration (Cont’d)

Manufacturer Density
Family Mbits

QSPI ISSI is25Ip is25Ip080d 8 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25lp is25lp016d 16 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25lp is251p032d 32 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25Ip is25Ip064a 64 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25lp is25lp128f 128 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25Ip is25Ip256d 256 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

Interface | Manufacturer Device Alias Data Width Bits
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Table D-9: Supported Flash Memory Devices for Zynq-7000 Device Configuration (Cont’d)

Manufacturer Density
Family Mbits

QSPI ISSI is25Ip is25Ip512m 512 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25wp is25wp080d 8 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25wp is25wp016d 16 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25wp is25wp032d 32 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25wp is25wp064a 64 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25wp is25wp128f 128 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

Interface | Manufacturer Device Alias Data Width Bits
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Table D-9: Supported Flash Memory Devices for Zynq-7000 Device Configuration (Cont’d)

Interface | Manufacturer Mar;::l;a:icltyurer Device Alias Dl\(;lrk‘)?;:;y Data Width Bits

QSPI ISSI is25wp is25wp256d 256 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25wp is25wp512m 512 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Winbond w25q w25q128fv 128 x1-dual_stacked,

[w25q128jv-qspi-x1-dual_stacked, x1-single,
w25q128jv-qgspi-x1-single, x2-dual_stacked,
w25q128jv-qspi-x2-dual_stacked, x2-single,
w25q128jv-qspi-x2-single, x4-dual_stacked,
w25q128jv-qspi-x4-dual_stacked, x4-single,
w25q128jv-qspi-x4-single, x8-dual_parallel
w25q128jv-qspi-x8-dual_parallel]

QSPI Winbond w25q w25q128fw 128 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Micron mt25q| mt25ql128 128 x1-dual_stacked,

[n25g128-3.3v-qgspi-x1-dual_stacked, x1-single,
n25q128-3.3v-gspi-x1-single, x2-dual_stacked,
n25q128-3.3v-qgspi-x2-dual_stacked, x2-single,
n25q128-3.3v-qgspi-x2-single, x4-dual_stacked,
n25q128-3.3v-qspi-x4-dual_stacked, x4-single,
n25q128-3.3v-qgspi-x4-single, x8-dual_parallel
n25q128-3.3v-qspi-x8-dual_parallel]

QSPI Micron mt25¢| mt25ql256 256 x1-dual_stacked,

[n25g256-3.3v-qspi-x1-dual_stacked,
n25g256-3.3v-qgspi-x1-single,
n25q256-3.3v-qgspi-x2-dual_stacked,
n25g256-3.3v-qspi-x2-single,
n25q256-3.3v-qgspi-x4-dual_stacked,
n25g256-3.3v-qgspi-x4-single,
n25q256-3.3v-qgspi-x8-dual_parallel]

x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel
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Table D-9: Supported Flash Memory Devices for Zynq-7000 Device Configuration (Cont’d)

Interface | Manufacturer Mar;::l;a:icltyurer Device Alias Dl\(;lrk‘)?;:;y Data Width Bits

QSPI Micron mt25¢| mt25ql512 512 x1-dual_stacked,
[n259512-3.3v-qgspi-x1-dual_stacked, x1-single,
n25g512-3.3v-qgspi-x1-single, x2-dual_stacked,
n25q512-3.3v-qgspi-x2-dual_stacked, x2-single,
n25q512-3.3v-qgspi-x2-single, x4-dual_stacked,
n25q512-3.3v-qgspi-x4-dual_stacked, x4-single,
n25q512-3.3v-gspi-x4-single, x8-dual_parallel
n25q512-3.3v-qgspi-x8-dual_parallel]

QSPI Micron mt25¢]| mt25ql01lg 1,024 | x1-dual_stacked,
[n25q00a-3.3v-qgspi-x1-dual_stacked, x1-single,
n25q00a-3.3v-gspi-x1-single, x2-dual_stacked,
n25q00a-3.3v-gspi-x2-dual_stacked, x2-single,
n25q00a-3.3v-gspi-x2-single, x4-dual_stacked,
n25q00a-3.3v-gspi-x4-dual_stacked, x4-single,
n25g00a-3.3v-gspi-x4-single, x8-dual_parallel
n25q00a-3.3v-qgspi-x8-dual_parallel]

QSPI Micron mt25q| mt25ql02g 2,048 | x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Micron mt25qu mt25qul28 128 x1-dual_stacked,
[n25q128-1.8v-qspi-x1-dual_stacked, x1-single,
n25g128-1.8v-qspi-x1-single, x2-dual_stacked,
n25q128-1.8v-qspi-x2-dual_stacked, x2-single,
n25q128-1.8v-qspi-x2-single, x4-dual_stacked,
n25q128-1.8v-qgspi-x4-dual_stacked, x4-single,
n25q128-1.8v-qspi-x4-single, x8-dual_parallel
n25q128-1.8v-qspi-x8-dual_parallel]

QSPI Micron mt25qu mt25qu256 256 x1-dual_stacked,
[n25g256-1.8v-qgspi-x1-dual_stacked, x1-single,
n25g256-1.8v-qspi-x1-single, x2-dual_stacked,
n25q256-1.8v-qspi-x2-dual_stacked, x2-single,
n25g256-1.8v-qspi-x2-single, x4-dual_stacked,
n25q256-1.8v-qspi-x4-dual_stacked, x4-single,
n25g256-1.8v-qspi-x4-single, x8-dual_parallel
n25q256-1.8v-qspi-x8-dual_parallel]

QSPI Micron mt25qu mt25qu512 512 x1-dual_stacked,

[n25g512-1.8v-qgspi-x1-dual_stacked,
n25g512-1.8v-qspi-x1-single,
n25q512-1.8v-gspi-x2-dual_stacked,
n25g512-1.8v-qgspi-x2-single,
n25q512-1.8v-qgspi-x4-dual_stacked,
n25g512-1.8v-qspi-x4-single,
n25g512-1.8v-qspi-x8-dual_parallel]

x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

Vivado Programming and Debugging
UG908 (v2019.1) May 22, 2019

www.Xxilinx.com

l Send Feedback I 378



https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=378

& XILINX.

Table D-9:

Appendix D: Configuration Memory Support

Supported Flash Memory Devices for Zyng-7000 Device Configuration (Cont’d)

Interface

Manufacturer

Manufacturer
Family

Device Alias

Density
Mbits

Data Width Bits

QSPI

Micron

mt25qu

mt25qu0lg
[n259q00a-1.8v-qgspi-x1-dual_stacked,
n25g00a-1.8v-gspi-x1-single,
n25q00a-1.8v-qgspi-x2-dual_stacked,
n25q00a-1.8v-qgspi-x2-single,
n25q00a-1.8v-qspi-x4-dual_stacked,
n25q00a-1.8v-gspi-x4-single,
n25q00a-1.8v-qgspi-x8-dual_parallel]

1,024

x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI

Micron

mt25qu

mt25qu02g

2,048

x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI

Micron

n25q

n25q64-1.8v

64

x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI

Micron

n25q

n25q64-3.3v

64

x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI

Spansion

s25fIxxx|

s25fl064|

64

x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI

Spansion

s25flxxxp

s25fl129p

128

x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel
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Table D-9: Supported Flash Memory Devices for Zynq-7000 Device Configuration (Cont’d)

Manufacturer Density
Family Mbits

QSPI Spansion s25flxxxs s25f1128s-1.8v 128 x1-dual_stacked,
[s25f1127s-1.8v-qspi-x4-dual_stacked, x1-single,
s25f1127s-1.8v-qgspi-x4-single, x2-dual_stacked,
s25f1127s-1.8v-qspi-x8-dual_parallel] x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Spansion s25flxxxs s25f1128s-3.3v 128 x1-dual_stacked,
[s25f11275s-3.3v-qspi-x4-dual_stacked, x1-single,
s25fl127s-3.3v-qgspi-x4-single, x2-dual_stacked,
s25fl127s-3.3v-qgspi-x8-dual_parallel] x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Spansion s25flxxxs s25fl256s-1.8v 256 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Spansion s25flxxxs s25f1256s-3.3v 256 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Spansion s25flxxxs s25f1512s-1.8v 512 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Spansion s25flxxxs s25f1512s-3.3v 512 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Spansion s70flxxxp s70fl01gs_00 1,024 | x4-dual_stacked

Interface | Manufacturer Device Alias Data Width Bits

Vivado Programming and Debugging Send Feedback 380
UG908 (v2019.1) May 22, 2019 www.Xxilinx.com [—\/—]


https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=380

& XILINX.

Appendix D: Configuration Memory Support

Table D-9: Supported Flash Memory Devices for Zynq-7000 Device Configuration (Cont’d)

Interface | Manufacturer Mar;::l;a:icltyurer Device Alias Dl\(;lrk‘)?;:;y Data Width Bits

QSPI Macronix mx25lI mx25112835f 128 x1-dual_stacked,
[mx25112833f-qspi-x1-dual_stacked, x1-single,
mx25112833f-qgspi-x1-single, x2-dual_stacked,
mx25112833f-qspi-x2-dual_stacked, x2-single,
mx25112833f-qspi-x2-single, x4-dual_stacked,
mx25112833f-qspi-x4-dual_stacked, x4-single,
mx25112833f-qgspi-x4-single, x8-dual_parallel
mx25112833f-qgspi-x8-dual_parallel]

QSPI Macronix mx25lI mx25112845¢g 128 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Macronix mx25I mx25125635f 256 x1-dual_stacked,

[mx25125645g-qspi-x1-dual_stacked, x1-single,
mx25125645g-qgspi-x1-single, x2-dual_stacked,
mx25125645g-qspi-x2-dual_stacked, x2-single,
mx25125645g-qspi-x2-single, x4-dual_stacked,
mx25125645g-qspi-x4-dual_stacked, x4-single,
mx25125645g-qgspi-x4-single, x8-dual_parallel
mx25125645g-qgspi-x8-dual_parallel]

QSPI Macronix mx25lI mx25151245¢g 512 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Macronix mx25u mx25ul12835f 128 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Macronix mx25u mx25u25635f 256 x1-dual_stacked,

[mx25u25645g-qspi-x1-dual_stacked,
mx25u25645g-qgspi-x1-single,
mx25u25645g-qspi-x2-dual_stacked,
mx25u25645g-qgspi-x2-single,
mx25u25645g-qgspi-x4-dual_stacked,
mx25u25645g-qspi-x4-single,
mx25u25645g-qgspi-x8-dual_parallel]

x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel
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Table D-9: Supported Flash Memory Devices for Zynq-7000 Device Configuration (Cont’d)

Manufacturer Density
Family Mbits

QSPI Macronix mx25u mx25u51245¢g 512 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Macronix mx66l| mx66151235f 512 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Macronix mx66| mx6611g45g 1,024 | x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Macronix mx66l| mx6612g45g 2,048 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Macronix mx66u mx66u2g45g 2,048 | x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

Interface | Manufacturer Device Alias Data Width Bits
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W

Zynq UltraScale+ MPSoC Configuration Memory
Devices

The Flash devices supported for configuration of Zynq UltraScale+™ MPSoC devices that
can be erased, blank checked, programmed, and verified by Vivado® software are shown in
the following table.

The tables in this Appendix are running lists per Xilinx® family of non-volatile memories
which Vivado software is capable of erasing, blank checking, programming, and verifying.
Xilinx strives to retain components on this list even after they are no longer appropriate for
new designs, to support long-term maintenance of end products which may contain them.

IMPORTANT: Given the evolving nature of the commodity non-volatile memory market, Xilinx
recommends contacting your non-volatile memory supplier to confirm device availability and life cycle.
References to specific devices in the tables are not an assurance of their current or future availability

Table D-10: Supported Flash Memory Devices for Zynq UltraScale+ MPSoC Device Configuration

Interface | Manufacturer Mar;:t::::ltyurer Device Alias Dh?lg?itsy Data Width Bits
EMMC jedec4.51-4gb 32,768
EMMC jedec4.51-8gb 65,536
EMMC jedec4.51-16gb 131,07

2
EMMC jedec4.51-32gb 262,14

4
EMMC jedec4.51 524,28

8
EMMC jedec4.51-64gb 524,28

8
EMMC Micron mtfc mtfc8gakajcn-4m 65,536
NAND Micron mt29f mt29f2g08ab 2,048 x8
NAND Micron mt29f mt29f8g08ab 8,192 x8
NAND Micron mt29f mt29f16g08ab 16,384 | x8
NAND Micron mt29f mt29f32g08ae 32,768 | x8
NAND Micron mt29f mt29f64g08ae 65,536 | x8
NAND Spansion s34ml s34ml01gl 1,024 x8
NAND Spansion s34ml s34ml02g1l 2,048 x8
Vivado
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Table D-10: Supported Flash Memory Devices for Zynq UltraScale+ MPSoC Device Configuration

Manufacturer Density
Family Mbits

QSPI ISSI is25Ip is25/p080d 8 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

Interface | Manufacturer Device Alias Data Width Bits

QSPI ISSI is25lp is251p016d 16 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25lp is251p032d 32 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25Ip is25|p128f 128 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25lp is251p256d 256 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25Ip is25Ip512m 512 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel
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Table D-10: Supported Flash Memory Devices for Zynq UltraScale+ MPSoC Device Configuration

Manufacturer Density
Family Mbits

QSPI ISSI is25wp is25wp080d 8 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

Interface | Manufacturer Device Alias Data Width Bits

QSPI ISSI is25wp is25wp016d 16 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25wp is25wp032d 32 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25wp is25wp064a 64 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25wp is25wp128f 128 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25wp is25wp256d 256 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel
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Table D-10: Supported Flash Memory Devices for Zynq UltraScale+ MPSoC Device Configuration
Interface | Manufacturer Mar;::i":\.ﬁtyurer Device Alias Dl\(/elrl‘)?;y Data Width Bits
QSPI ISSI is25wp is25wp512m 512 x1-dual_stacked,

x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Micron mt25q| mt25ql128 128 x1-dual_stacked,
[n25g128-3.3v-gspi-x1-dual_stacked, x1-single,
n25q128-3.3v-qgspi-x1-single, x2-dual_stacked,
n25q128-3.3v-qspi-x2-dual_stacked, x2-single,
n25q128-3.3v-qspi-x2-single, x4-dual_stacked,
n25q128-3.3v-qspi-x4-dual_stacked, x4-single,
n25q128-3.3v-qspi-x4-single, x8-dual_parallel
n25q128-3.3v-qgspi-x8-dual_parallel]

QSPI Micron mt25q| mt25ql256 256 x1-dual_stacked,
[n25g256-3.3v-gspi-x1-dual_stacked, x1-single,
n259256-3.3v-qgspi-x1-single, x2-dual_stacked,
n25q256-3.3v-qspi-x2-dual_stacked, x2-single,
n25q256-3.3v-qgspi-x2-single, x4-dual_stacked,
n25q256-3.3v-qspi-x4-dual_stacked, x4-single,
n25g256-3.3v-qspi-x4-single, x8-dual_parallel
n259256-3.3v-qspi-x8-dual_parallel]

QSPI Micron mt25¢| mt25ql512 512 x1-dual_stacked,
[n25g512-3.3v-gspi-x1-dual_stacked, x1-single,
n259512-3.3v-qgspi-x1-single, x2-dual_stacked,
n25q512-3.3v-qspi-x2-dual_stacked, x2-single,
n259512-3.3v-qspi-x2-single, x4-dual_stacked,
n25q512-3.3v-qgspi-x4-dual_stacked, x4-single,
n259512-3.3v-qgspi-x4-single, x8-dual_parallel
n25q512-3.3v-qgspi-x8-dual_parallel]

QSPI Micron mt25q]! mt25ql01lg 1,024 x1-dual_stacked,
[n25g00a-3.3v-qgspi-x1-dual_stacked, x1-single,
n25qg00a-3.3v-gspi-x1-single, x2-dual_stacked,
n25q00a-3.3v-gspi-x2-dual_stacked, x2-single,
n25q00a-3.3v-gspi-x2-single, x4-dual_stacked,
n25q00a-3.3v-qgspi-x4-dual_stacked, x4-single,
n25q00a-3.3v-gspi-x4-single, x8-dual_parallel
n25q00a-3.3v-qgspi-x8-dual_parallel]

QSPI Micron mt25q| mt25ql02g 2,048 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel
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Table D-10: Supported Flash Memory Devices for Zynq UltraScale+ MPSoC Device Configuration
Interface | Manufacturer Mar;::i":\.ﬁtyurer Device Alias Dl\(/elrl‘)?;y Data Width Bits
QSPI Micron mt25qu mt25qul28 128 x1-dual_stacked,

[n25q128-1.8v-gspi-x1-dual_stacked, x1-single,
n25q128-1.8v-qgspi-x1-single, x2-dual_stacked,
n25q128-1.8v-qspi-x2-dual_stacked, x2-single,
n25q128-1.8v-qspi-x2-single, x4-dual_stacked,
n25q128-1.8v-qspi-x4-dual_stacked, x4-single,
n25q128-1.8v-qspi-x4-single, x8-dual_parallel
n25q128-1.8v-qspi-x8-dual_parallel]

QSPI Micron mt25qu mt25qu256 256 x1-dual_stacked,
[n25g256-1.8v-gspi-x1-dual_stacked, x1-single,
n25g256-1.8v-qspi-x1-single, x2-dual_stacked,
n259256-1.8v-qspi-x2-dual_stacked, x2-single,
n259256-1.8v-qspi-x2-single, x4-dual_stacked,
n259256-1.8v-qspi-x4-dual_stacked, x4-single,
n259256-1.8v-qspi-x4-single, x8-dual_parallel
n25q256-1.8v-qgspi-x8-dual_parallel]

QSPI Micron mt25qu mt25qu512 512 x1-dual_stacked,
[n25g512-1.8v-gspi-x1-dual_stacked, x1-single,
n25q512-1.8v-qgspi-x1-single, x2-dual_stacked,
n25q512-1.8v-qspi-x2-dual_stacked, x2-single,
n25q512-1.8v-qgspi-x2-single, x4-dual_stacked,
n25q512-1.8v-qgspi-x4-dual_stacked, x4-single,
n25q512-1.8v-qspi-x4-single, x8-dual_parallel
n25q512-1.8v-qspi-x8-dual_parallel]

QSPI Micron mt25qu mt25qu0lg 1,024 x1-dual_stacked,
[n25q00a-1.8v-qspi-x1-dual_stacked, x1-single,
n25q00a-1.8v-qgspi-x1-single, x2-dual_stacked,
n25q00a-1.8v-gspi-x2-dual_stacked, x2-single,
n25q00a-1.8v-qspi-x2-single, x4-dual_stacked,
n25q00a-1.8v-qgspi-x4-dual_stacked, x4-single,
n25q00a-1.8v-gspi-x4-single, x8-dual_parallel
n25q00a-1.8v-gspi-x8-dual_parallel]

QSPI Micron mt25qu mt25qu02g 2,048 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Micron n25q n25q64-1.8v 64 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel
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Table D-10: Supported Flash Memory Devices for Zynq UltraScale+ MPSoC Device Configuration

Manufacturer Density
Family Mbits

QSPI Micron n25q n25q64-3.3v 64 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

Interface | Manufacturer Device Alias Data Width Bits

QSPI Spansion s25flxxxp s25f1129p 128 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Spansion s25flxxxs s25f1128s-1.8v 128 x1-dual_stacked,
[s25f1127s-1.8v-qspi-x4-dual_stacked, x1-single,
s25fl127s-1.8v-qgspi-x4-single, x2-dual_stacked,
s25fl127s-1.8v-qgspi-x8-dual_parallel] x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Spansion s25flxxxs s25f1128s-3.3v 128 x1-dual_stacked,
[s25fl127s-3.3v-gspi-x4-dual_stacked, x1-single,
s25fl127s-3.3v-qgspi-x4-single, x2-dual_stacked,
s25fl127s-3.3v-gspi-x8-dual_parallel] x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Spansion s25flxxxs s25fl256s-1.8v 256 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Spansion s25flxxxs s25fl256s-3.3v 256 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel
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Table D-10: Supported Flash Memory Devices for Zynq UltraScale+ MPSoC Device Configuration
Interface | Manufacturer Mar;::i":\.ﬁtyurer Device Alias Dl\(/elrl‘)?;y Data Width Bits
QSPI Spansion s25flxxxs s25fl512s-1.8v 512 x1-dual_stacked,

x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Spansion s25flxxxs s25fl1512s-3.3v 512 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Spansion s70flxxxp s70fl01gs_00 1,024 x4-dual_stacked

QSPI Macronix mx25I mx25112835f 128 x1-dual_stacked,
[mx25112833f-gspi-x1-dual_stacked, x1-single,
mx25112833f-qspi-x1-single, x2-dual_stacked,
mx25112833f-qspi-x2-dual_stacked, x2-single,
mx25112833f-qspi-x2-single, x4-dual_stacked,
mx25112833f-qspi-x4-dual_stacked, x4-single,
mx25112833f-qspi-x4-single, x8-dual_parallel
mx25112833f-qspi-x8-dual_parallel]

QSPI Macronix mx25I mx25125635f 256 x1-dual_stacked,
[mx25125645g-qspi-x1-dual_stacked, x1-single,
mx25125645g-qspi-x1-single, x2-dual_stacked,
mx25125645g-qspi-x2-dual_stacked, x2-single,
mx25125645g-qspi-x2-single, x4-dual_stacked,
mx25125645g-qspi-x4-dual_stacked, x4-single,
mx25125645g-qspi-x4-single, x8-dual_parallel
mx25125645g-qspi-x8-dual_parallel]

QSPI Macronix mx25I mx25151245¢g 512 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Macronix mx25u mx25u25635f 256 x1-dual_stacked,
[mx25u25645g-qspi-x1-dual_stacked, x1-single,
mx25u25645g-qspi-x1-single, x2-dual_stacked,
mx25u25645g-qspi-x2-dual_stacked, x2-single,
mx25u25645g-qgspi-x2-single, x4-dual_stacked,
mx25u25645g-qgspi-x4-dual_stacked, x4-single,
mx25u25645g-qgspi-x4-single, x8-dual_parallel
mx25u25645g-qspi-x8-dual_parallel]
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Table D-10: Supported Flash Memory Devices for Zynq UltraScale+ MPSoC Device Configuration

Manufacturer Density
Family Mbits

QSPI Macronix mx25u mx25u51245¢g 512 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

Interface | Manufacturer Device Alias Data Width Bits

QSPI Macronix mx66| mx6611g45g 1,024 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Macronix mx66| mx6612g45¢g 2,048 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Macronix mx66u mx66u51235f 512 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Macronix mx66u mx66ulg45g 1,024 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Macronix mx66u mx66u2g45g 2,048 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel
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2: X”_INX® Appendix D: Configuration Memory Support

Zynq UltraScale+ RFSoC Configuration Memory
Devices

The Flash devices supported for configuration of Zynq UltraScale+™ RFSoC devices that can
be erased, blank checked, programmed, and verified by Vivado® software are shown in the
following table.

The tables in this Appendix are running lists per Xilinx® family of non-volatile memories
which Vivado software is capable of erasing, blank checking, programming, and verifying.
Xilinx strives to retain components on this list even after they are no longer appropriate for
new designs, to support long-term maintenance of end products which may contain them.

IMPORTANT: Given the evolving nature of the commodity non-volatile memory market, Xilinx

ﬁ recommends contacting your non-volatile memory supplier to confirm device availability and life cycle.
References to specific devices in the tables are not an assurance of their current or future
availability.new table goes here

Table D-11: Supported Flash Memory Devices for Zynq UltraScale+ RFSoC Device Config

Manufacturer . . Density . .

Interface | Manufacturer Family Device Alias Mbits Data Width Bits

EMMC jedec4.51-4gb 32,768

EMMC jedec4.51-8gb 65,536

EMMC jedec4.51-16gb 131,072

EMMC jedec4.51-32gb 262,144

EMMC jedec4.51 524,288

EMMC jedec4.51-64gb 524,288

EMMC Micron mtfc mtfc8gakajcn-4m 65,536

NAND Micron mt29f mt29f2g08ab 2,048 x8

NAND Micron mt29f mt29f8g08ab 8,192 x8

NAND Micron mt29f mt29f16g08ab 16,384 | x8

NAND Micron mt29f mt29f32g08ae 32,768 | x8

NAND Micron mt29f mt29f64g08ae 65,536 | x8

NAND Spansion s34ml s34ml01gl 1,024 x8

NAND Spansion s34ml s34ml02g1 2,048 x8

QSPI ISSI is25Ip is25/p080d 8 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel
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Table D-11: Supported Flash Memory Devices for Zynq UltraScale+ RFSoC Device Config (Cont’d)

Manufacturer Density
Family Mbits

QSPI ISSI is25Ip is25Ip016d 16 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

Interface | Manufacturer Device Alias Data Width Bits

QSPI ISSI is25lp is251p032d 32 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25lp is251p128f 128 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25Ip is25Ip256d 256 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25lp is251p512m 512 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25wp is25wp080d 8 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel
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Table D-11: Supported Flash Memory Devices for Zynq UltraScale+ RFSoC Device Config (Cont’d)

Manufacturer Density
Family Mbits

QSPI ISSI is25wp is25wp016d 16 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

Interface | Manufacturer Device Alias Data Width Bits

QSPI ISSI is25wp is25wp032d 32 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25wp is25wp064a 64 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25wp is25wp128f 128 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25wp is25wp256d 256 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI ISSI is25wp is25wp512m 512 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel
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Table D-11: Supported Flash Memory Devices for Zynq UltraScale+ RFSoC Device Config (Cont’d)
Interface | Manufacturer Marll::i::icltyurer Device Alias DISIE?L? Data Width Bits
QSPI Micron mt25¢| mt25ql128 128 x1-dual_stacked,

[n25q128-3.3v-gspi-x1-dual_stacked, x1-single,
n25q128-3.3v-qgspi-x1-single, x2-dual_stacked,
n25q128-3.3v-qgspi-x2-dual_stacked, x2-single,
n25q128-3.3v-qspi-x2-single, x4-dual_stacked,
n25q128-3.3v-qspi-x4-dual_stacked, x4-single,
n25q128-3.3v-qspi-x4-single, x8-dual_parallel
n25q128-3.3v-qspi-x8-dual_parallel]

QSPI Micron mt25¢| mt25ql256 256 x1-dual_stacked,
[n25g256-3.3v-gspi-x1-dual_stacked, x1-single,
n25g256-3.3v-qgspi-x1-single, x2-dual_stacked,
n25256-3.3v-qspi-x2-dual_stacked, x2-single,
n259256-3.3v-qspi-x2-single, x4-dual_stacked,
n259256-3.3v-qspi-x4-dual_stacked, x4-single,
n259256-3.3v-qspi-x4-single, x8-dual_parallel
n25q256-3.3v-gspi-x8-dual_parallel]

QSPI Micron mt25¢| mt25ql512 512 x1-dual_stacked,
[n25g512-3.3v-gspi-x1-dual_stacked, x1-single,
n25q512-3.3v-gspi-x1-single, x2-dual_stacked,
n25q512-3.3v-qspi-x2-dual_stacked, x2-single,
n25q512-3.3v-gspi-x2-single, x4-dual_stacked,
n25q512-3.3v-qgspi-x4-dual_stacked, x4-single,
n25q512-3.3v-qgspi-x4-single, x8-dual_parallel
n25q512-3.3v-qspi-x8-dual_parallel]

QSPI Micron mt25¢]| mt25ql01lg 1,024 x1-dual_stacked,
[n25q00a-3.3v-qgspi-x1-dual_stacked, x1-single,
n25q00a-3.3v-gspi-x1-single, x2-dual_stacked,
n25q00a-3.3v-gspi-x2-dual_stacked, x2-single,
n25q00a-3.3v-gspi-x2-single, x4-dual_stacked,
n25q00a-3.3v-gspi-x4-dual_stacked, x4-single,
n25q00a-3.3v-gspi-x4-single, x8-dual_parallel
n25q00a-3.3v-gspi-x8-dual_parallel]

QSPI Micron mt25q| mt25ql02g 2,048 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Micron mt25qu mt25qul28 128 x1-dual_stacked,

[n259128-1.8v-gspi-x1-dual_stacked,
n25q128-1.8v-qgspi-x1-single,
n25q128-1.8v-qspi-x2-dual_stacked,
n25q128-1.8v-qgspi-x2-single,
n25q128-1.8v-qspi-x4-dual_stacked,
n25q128-1.8v-qgspi-x4-single,
n25q128-1.8v-qspi-x8-dual_parallel]

x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel
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Table D-11: Supported Flash Memory Devices for Zynq UltraScale+ RFSoC Device Config (Cont’d)
Interface | Manufacturer Marll::i::icltyurer Device Alias DISIE?L? Data Width Bits
QSPI Micron mt25qu mt25qu256 256 x1-dual_stacked,

[n25g256-1.8v-gspi-x1-dual_stacked, x1-single,
n259256-1.8v-qspi-x1-single, x2-dual_stacked,
n25g256-1.8v-qspi-x2-dual_stacked, x2-single,
n259256-1.8v-qspi-x2-single, x4-dual_stacked,
n259256-1.8v-qspi-x4-dual_stacked, x4-single,
n259256-1.8v-qspi-x4-single, x8-dual_parallel
n259256-1.8v-qspi-x8-dual_parallel]

QSPI Micron mt25qu mt25qu512 512 x1-dual_stacked,
[n25g512-1.8v-gspi-x1-dual_stacked, x1-single,
n25q512-1.8v-qgspi-x1-single, x2-dual_stacked,
n25q512-1.8v-qspi-x2-dual_stacked, x2-single,
n25q512-1.8v-qgspi-x2-single, x4-dual_stacked,
n25q512-1.8v-qspi-x4-dual_stacked, x4-single,
n259512-1.8v-qspi-x4-single, x8-dual_parallel
n25q512-1.8v-qgspi-x8-dual_parallel]

QSPI Micron mt25qu mt25qu0lg 1,024 x1-dual_stacked,
[n25g00a-1.8v-qgspi-x1-dual_stacked, x1-single,
n25q00a-1.8v-gspi-x1-single, x2-dual_stacked,
n25q00a-1.8v-gspi-x2-dual_stacked, x2-single,
n25q00a-1.8v-gspi-x2-single, x4-dual_stacked,
n25q00a-1.8v-qspi-x4-dual_stacked, x4-single,
n25q00a-1.8v-qgspi-x4-single, x8-dual_parallel
n25q00a-1.8v-qspi-x8-dual_parallel]

QSPI Micron mt25qu mt25qu02g 2,048 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Micron n25q n25q64-1.8v 64 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Micron n25q n25q64-3.3v 64 x1-dual_stacked,

x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel
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Table D-11:

Appendix D: Configuration Memory Support

Supported Flash Memory Devices for Zynq UltraScale+ RFSoC Device Config (Cont’d)

Interface

Manufacturer

Manufacturer
Family

Device Alias

Density
Mbits

Data Width Bits

QSPI

Spansion

s25flxxxp

s25fl129p

128

x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI

Spansion

s25flxxxs

s25f1128s-1.8v
[s25fl127s-1.8v-gspi-x4-dual_stacke
d, s25fl127s-1.8v-gspi-x4-single,
s25fl127s-1.8v-qgspi-x8-dual_parallel]

128

x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI

Spansion

s25flxxxs

s25f1128s-3.3v
[s25fl127s-3.3v-qgspi-x4-dual_stacke
d, s25fl127s-3.3v-qgspi-x4-single,
s25f1127s-3.3v-qspi-x8-dual_parallel]

128

x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI

Spansion

s25flxxxs

s25fl256s-1.8v

256

x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI

Spansion

s25flxxxs

s25fl256s-3.3v

256

x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI

Spansion

s25flxxxs

s25fI1512s-1.8v

512

x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel
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Table D-11: Supported Flash Memory Devices for Zynq UltraScale+ RFSoC Device Config (Cont’d)
Interface | Manufacturer Marll::i::icltyurer Device Alias DISIII;?;? Data Width Bits
QSPI Spansion s25flxxxs s25fl512s-3.3v 512 x1-dual_stacked,

x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Spansion s70flxxxp s70fl01gs_00 1,024 x4-dual_stacked

QSPI Macronix mx25lI mx25112835f 128 x1-dual_stacked,
[mx25112833f-qspi-x1-dual_stacked, x1-single,
mx25112833f-qgspi-x1-single, x2-dual_stacked,
mx25112833f-qspi-x2-dual_stacked, x2-single,
mx25112833f-qspi-x2-single, x4-dual_stacked,
mx25112833f-qspi-x4-dual_stacked, x4-single,
mx25112833f-qspi-x4-single, x8-dual_parallel
mx25112833f-gspi-x8-dual_parallel]

QSPI Macronix mx25lI mx25125635f 256 x1-dual_stacked,
[mx25125645g-qspi-x1-dual_stacked, x1-single,
mx25125645g-qspi-x1-single, x2-dual_stacked,
mx25125645g-qgspi-x2-dual_stacked, x2-single,
mx25125645g-qspi-x2-single, x4-dual_stacked,
mx25125645g-qspi-x4-dual_stacked, x4-single,
mx25125645g-qspi-x4-single, x8-dual_parallel
mx25125645g-qspi-x8-dual_parallel]

QSPI Macronix mx25lI mx25151245¢g 512 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Macronix mx25u mx25u25635f 256 x1-dual_stacked,
[mx25u25645g-qspi-x1-dual_stacked x1-single,

, mx25u25645g-qspi-x1-single, x2-dual_stacked,
mx25u25645g-qspi-x2-dual_stacked, x2-single,
mx25u25645g-qspi-x2-single, x4-dual_stacked,
mx25u25645g-qspi-x4-dual_stacked, x4-single,
mx25u25645g-qspi-x4-single, x8-dual_parallel
mx25u25645g-qspi-x8-dual_parallel]

QSPI Macronix mx25u mx25u51245¢g 512 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel
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Table D-11: Supported Flash Memory Devices for Zynq UltraScale+ RFSoC Device Config (Cont’d)

Manufacturer Density
Family Mbits

QSPI Macronix mx66l| mx6611g45¢g 1,024 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

Interface | Manufacturer Device Alias Data Width Bits

QSPI Macronix mx66| mx6612g45¢g 2,048 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Macronix mx66u mx66u51235f 512 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Macronix mx66u mx66ulg45g 1,024 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel

QSPI Macronix mx66u mx66u2g45g 2,048 x1-dual_stacked,
x1-single,
x2-dual_stacked,
x2-single,
x4-dual_stacked,
x4-single,
x8-dual_parallel
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Appendix E

Command Line Options for hw_server

The following is a list of hw_server command line options.

f IMPORTANT: When remotely connecting to a hw_server running on a PC, ensure that the firewall
policy is properly configured. Make sure that hw_server. exe has permission to listen for new socket
connections on port 3121.

Standard hw_server Options

Table E-1: Standard hw_server Options
Option Purpose Example
-d Run hw_server in daemon mode hw_server -d
(output is sent to system logger).
--help Basic command line help.
-I Exit if there are no target hw_server -I 20
connections established for the
specified time. Time here is
specified in seconds.
-L Enable logging of JTAG commands | hw_server -L-
from clients to the hw_server. The above option will log output to stdout
hw_server -Lmy_file.log
The above option will log output to filemy_file.log
-s Sets up an agent listening port and | hw_server -stcp::3122
protocol. The above option is used to connect when using the local host
with port 3122 at hw_server start up.
-q Do not display version information
on start up.
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Appendix E: Command Line Options for hw_server

Table E-1: Standard hw_server Options
Option Purpose Example
-p Assign a range of ports to be used | hw_server -p<port>

by Xilinx® GDB server, or disable

the feature. <port> is the base port number for Xilinx® GDB server.
Default is 3000
The server opens one port per target architecture:
3000: ARM;
3001: ARM64;
3002: MicroBlaze;
3003: MicroBlaze64
hw_server -p0 disables the port

--init This option is used to specify an hw_server --init my_ init.txt

initialization script file to hw_server

The file my_init.txt contains options that will be applied
to the hw_server at startup

Environment variable
HW_SERVER_INIT_FILE

Use to specify default --init file

export HW_SERVER_INIT_FILE=~/my_init.txt

hw_server

In this case, the hw_server is initialized with the settings
coming from the file pointed to by the environment variable
HW_SERVER_INIT_FILE.

Vivado Programming and Debugging
UG908 (v2019.1) May 22, 2019

. l Send Feedback I 400
www.Xxilinx.com



https://www.xilinx.com
https://www.xilinx.com/about/feedback/document-feedback.html?docType=User_Guides&docId=UG908&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Programming%20and%20Debugging&releaseVersion=2019.1&docPage=400

(: XI LI NX® Appendix E: Command Line Options for hw_server

Advanced Options

Table E-2: Advanced Option

Option Purpose

detect-ir-length Disable detecting the IR detect length during scan chain discovery.

This option is used to start up the hw_server with additional devices added to its
device table. By default the hw_server starts with a preset list of devices that are
compiled in from the XICOM SQL jtag master table. These settings can be overridden
or extended using the this set device-info-file option. The file that is
specified is a .csv file that ignores lines that start with a "#".

This is how you specify a . csv file at hw_server start-up:
hw_server -e "set device-info-file my_file.csv"

The .cvs file is formatted as shown below
(hw_server_device_info_file.csv):
HHBHHBH BB HBHHBH BB HBHHBHHBHBHHBHHBHBBHHBHHBHHBHBFHBHH B H B HBFHH
# File: hw_server_device_info_file.csv
# Description:
# This is a sample jtag ID table. This file can be used to define

additional devices to be detected by the hw_server application.

In this file empty lines, lines with spaces, and lines that begin
with the '#' character will be ignored.

The format of this file is as follows:

#

#

#

#

#

#

#

# ROW 1: fields

# The standard JTAG id fields are "idcode,mask,irlen,name"
# ROW 2: field types

# For each field specified in ROW 1, the type is used to
# interpret the field data read per device. The types

# accepted are "i" for integer and "s" for string. If

# you use the standard fields on ROW 1 then you should
# use "i,i,i,s" in ROW 2 to set the fields idcode,mask

# irlength to integer and name as string

#
#
#
#
#
#
#

To use this table you start hw_server with the following
command line arguments:

hw_server -e "set device-info-file <file>"

Where <file> is replaced with this filename.
HHHHBH AR HBHHBH AR HBHHBHHBH AR HBHHBHHFHBHHBH AR HBHHBH AR B H B RS
idcode,mask,irlen,name
ii,i,s
167784595,268435455,10,chipscope_soft_tap

device-info-file Sets a default device file .csv to be used
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Appendix E: Command Line Options for hw_server

Table E-2: Advanced Option

Option

Purpose

max-jtag-devices

Increases the max number of devices that can be detected in a scan chain. Default is
32.

This option is used to start up the hw_server with the ability to detect more than
the default number of devices in a scan chain. The default value for this setting is 32.
A user can increase this value for longer jtag chains. Note that increasing this
number slows down the device discovery process, which in turn can slow down cable
access. Therefore, it is only for systems with large device counts should a user
increase this value.

This is how to specify the option at hw_server start-up:

hw_server -e "set max-jtag-devices 64"

xdb-user-bscan

Sets which bscan will be used to scan for xsdb cores.
This option is used to start the hw_server scanning a for xsdb master cores on
alternate bscans. By default, hw_server will scan user 1 and 3 bscans. With this
option you can launch hw_server and have it look for bscans on different bscan user
slots.
This is how to specify the option at hw_server start-up:

hw_server -e "set xsdb-user-bscan 1,2,3,4"
The arguments to this parameter specify the list of parameters. The list will be a
comma separated list ranging from 1-4. The minimum number specified is 1 element
in the list and the maximum is 4.

mdm-detect-bscan-ma

sk

Sets which bscan will be used to scan for mdm cores.
This option is used to start the hw_server scanning a for MicroBlaze™ master cores
on alternate bscans. By default hw_server will scan user 2 bscan. With this option the
user can launch hw_server and have it look for MicroBlaze on different bscan user
slots.
This is how to specify the option at hw_server start-up:

hw_server -e "set mdm-detect-bscan-mask 2"

The bitmask is for any FPGA discovered by hw_server. Here are some examples of
common bitmask settings:

Mask Value BSCAN Scanned

0 none

1 Userl

3 Userl, User2

7 Userl, User2, User3

f Userl, User2, User3, User4
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Appendix E: Command Line Options for hw_server

Table E-2: Advanced Option

Option

Purpose

always-open-jtag

Forces hw_server to open up all targets at start up.
When hw_server starts by default no cables are initialized. When the first connection
is initiated the cables will be discovered and opened. This discovery period takes a
couple of seconds to several minutes depending on the system. Once fully initialized
the cables are read and devices discovered.
In some cases, it is necessary to have the cables discovered and ready to be used.
For instance when setting up a linux system as a board server, it may be desirable to
have the cables always initialized and ready to serve connections. For these cases
you can use the always-open-3jtag option to force the cables to open.
By default this is the setting at start up (no argument needs to be passed in):
hw_server -e "set always-open-jtag 0"
To force opening the cable, pass in this argument as shown below:
hw_server -e "set always-open-jtag 1"

auto-open-servers

Opens a cable server with specific parameters., used for XVC cable opening.

This option is a debug option used to automatically open an XVC cable connection,
and to control which types of USB cables hw_server should detect. The argument to
the auto-open-servers parameter is a comma separated list of fields. Each field is a
colon separated list of sub-fields where the first sub-field is the type and the
remaining sub-fields are type specific. For the xilinx-xvc type the sub-fields are
host and port. The default value for auto-open-servers is "*" which indicates
that hw_server should detect all types of cables that it can. Cables types that
require parameters, like XVC, are not covered by "*".

This is how to specify the option at hw_server start-up:

hw_server -e "set auto-open-servers
xilinx-xvc:localhost:10200"

To open up two servers you would use:

hw_server -e "set auto-open-servers
xilinx-xvc:localhost:10200,xilinx-xvc:localhost:10210"

To open up two XVC servers in addition to the all USB based cables you would use:

hw_server -e "set auto-open-servers
*:xilinx-xvc:localhost:10200,xilinx-xvc:localhost:10210"

auto-open-ports

Controls automatic open of ports (cables or scan chains).

This option is used to control the automatic open of JTAG scan chains. The argument
tothe auto-open-ports parameterisaboolean value, 1 indicating that all known
JTAG scan chains should automatically be opened and 0 indicating that clients will
open select JTAG scan chains. The default value is 1. Setting this to 0 is useful for
example, when multiple JTAG scan chains are connected to a single host and
different instances of hw_server are used to access each scan chain.

This is how to specify the option at hw_server start-up:
hw_server -e "set auto-open-ports 0"
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Table E-2: Advanced Option

Option Purpose

xvc-timeout Changes the XVC timeout value to help debug XVC servers.

This option is a debug option used to increase the timeout period needed for an XVC
transaction to terminate. The argument to the xvc-timeout parameter is a time
in seconds. A value of 0 will disable timeout and thus wait indefinitely.

This is how you specify the option at hw_server start-up:

hw_server -e "set xvc-timeout 100"

XVC-servers Start XVC servers for cables.
This option is used make hw_server start XVC servers for specified JTAG cables. The
argument to the xvc-servers parameter is a comma (,) separated list of XVC
server descriptions. Each XVC server description is a colon () separated list
containing the cable identification, XVC server host name or number and port
number. The cable identification is the manufacturer name and a unique identifier
separated by slash (/) characters. The cable identification may be a subset of the full
cable identification and the host name may be empty. If it is empty, it indicates that
the server should listen for incoming connections on all network interfaces.
See processor-debug-claimfor how to avoid interference when both XVC client
and XVC server are debuggers of the same device types and XVC locking mode is
used.
This is how to specify the option at hw_server start-up:

hw_server -e "set xvc-servers 210203356596A:1localhost:3000"
Note that you will still have to connect to this hw_server instance first to initialize
the cable interface. If you do not connect to the cable you will see a message like
the following:

TCF 19:11:02.417: XVC open port failed: Cannot find

JTAG cable matching 21020320314DA

To have the XVC cable automatically opened and locked to XVC add the
always-open-jtag option as shown below:

hw_server -e 'set xvc-servers 210203A0314DA:xcoatslab-9:3122' -e

'set always-open-jtag 1'

xvc-packet-len Change max package length of XVC servers.
This option controls the XVC package length returned by XVC servers started using
the xvc-servers option. Current default package length is 16000, however this
may change in newer versions.
This is how to specify the option at hw_server start-up:
hw_server -e "set xvc-servers 210203356596A:1ocalhost:3000"
-e "set xvc-packet-len 1000"

xvc-version Change XVC protocol version of XVC servers.
This is a debug option that can be used together with xvc-servers to control which
XVC protocol version is exposed to XVC clients. The current default protocol version
is 1.1, however this may change if new versions of the XVC protocol are defined.
This is how to specify the option at hw_server start-up:
hw_server -e "set xvc-servers 210203356596A:1ocalhost:3000"
-e "set xvc-version 1.0"
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Table E-2: Advanced Option

Option Purpose

xvc-capabilities Change XVC capabilities of XVC servers.

This is a debug option that can be used together with xvc-servers to control which
capabilities are exposed to XVC clients. Current default capabilities are 1ocking,
status, and state-aware, however additional capabilities may be added in future
versions. This option has no effect if xvc-version is set to 1.0.

This is how to specify the option at hw_server start-up:
hw_server -e "set xvc-servers 210203356596A:1ocalhost:3000"

-e "set xvc-capabilities status, state-aware"

processor-debug-cla | Automatically claim select device types to prevent debugger from using them.

im This option is used to prevent hw_server debugger from using selected device types
for debugging. The argument gives to this option is a bit mask. By default, hw_server
uses all known device types for debugging. Bit number meaning

Bit Device Type
0 Arm DAP
1 MPSoC

2 FPGA

This option is useful for example when starting XVC server using xvc-servers with an
XVC client that is a debugger of one or more of the above devices, or when
hw_server connects to an XVC server that is a debugger of one or more of the above
devices. In both cases this is only relevant when using the locking capability since
that allows time sharing between the debuggers.

This is how to specify the option at hw_server start-up:
hw_server -e "set processor-debug-claim 2"

jtag-poll-delay Delay in uS. Default 50000.

This option is a polling option used to reduce the JTAG polling frequency. The JTAG
polling frequency is the smallest period taken between JTAG poll operations. The
default and smallest value is 50,000 uS. The argument to the jtag-poll-delay
parameter is a number in uS.

n_n

help Displays hw_server "e" options
This option is used to display all the available "e" options for hw_server.
This is how to specify the option at hw_server start-up:

hw_server -e help

show-all Shows all options passed set in hw_serv.
This option is used to display all the "e" option settings for hw_server.
This is how you specify the option at hw_server start-up:

hw_server -e show-all

jtag-default-freque | Sets default frequency for all cables.

ncy This option sets the default JTAG TCK frequency. The jtag-default-frequency
parameter is a number in Hz.

This is how to specify the option at hw_server start-up:
hw_server -e "set jtag-default-frequency 5000000"
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Table E-2: Advanced Option

Option Purpose

jtag-port-filter Set JTAG port filter.
This option is used to control JTAG port filtering. When it is set, hw_server ignores
JTAG ports that do not match the filter. The argument to this parameter is a comma
separated list of complete or partial port identifiers. A port identifier is a string of
the form <manufacturer>/<productid>/<serial><port>. The filter matches
when any of the port filter's strings can be found anywhere in the port identifier
string.
This parameter is useful when running multiple instances of hw_server on the same
host to specify which cable should be handled by which hw_server.
This is how to specify the option at hw_server start-up:

hw_server -e "set jtag-port-filter

Xilinx/DLC10/0000128£515601"

Another example filtering any Xilinx DLC9 or DLC10 cable while having the
hw_server start on port 3122:

hw_server -stcp::3122 -e "set jtag-port-filter DLCY9,DLC10"

bscan-switch-user-m | Enables bscan switch.
ask This option is used to control the bscan switch detection.
This is how to specify the option at hw_server start-up:
hw_server -e "set bscan-switch-user-mask <user-bit-mask>"

jtag-port-devices Sets JTAG port device list.
This option is used to specify a static list of devices for a JTAG scan chain. When this
is specified hw_server does not read the IDCODE registers to detect devices on the
scan chain. This is useful when a scan chain contains devices that do not conform to
the IEEE 1149.1 specification. The value given to this parameter is a comma
separated list of IDCODE values in the same order as the devices on the scan chain.
This is how to specify the option at hw_server start-up:

hw_server -e "set jtag-port-devices 0xe970203f,0x03632093"

max-ir-length Enables devices in JTAG chain whose ir length is greater than 64 bits.

This option is used to start up the hw_server with the ability to enable ir lengths
greater than 64 bits. The default value for this setting is 64. A user can increase this
value for devices in the JTAG chains whose ir length is wide (for example, 93). Note
that increasing this number will slow down the device discovery process which in
turn can slow down cable access. Therefore, only for systems with long ir lengths
device counts should a user increase this value.

This is how to specify the option at hw_server start-up:
hw_server -e "set max-ir-length 93"
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Appendix F

Additional Resources and Legal Notices

Xilinx Resources

For support resources such as Answers, Documentation, Downloads, and Forums, see Xilinx
Support.

Solution Centers

See the Xilinx Solution Centers for support on devices, software tools, and intellectual
property at all stages of the design cycle. Topics include design assistance, advisories, and
troubleshooting tips.

Documentation Navigator and Design Hubs

Xilinx Documentation Navigator provides access to Xilinx documents, videos, and support
resources, which you can filter and search to find information. To open the Xilinx
Documentation Navigator (DocNav):

« From the Vivado IDE, select Help > Documentation and Tutorials.
+  On Windows, select Start > All Programs > Xilinx Design Tools > DocNav.

« At the Linux command prompt, enter docnav.

Xilinx Design Hubs provide links to documentation organized by design tasks and other
topics, which you can use to learn key concepts and address frequently asked questions. To
access the Design Hubs:

« In the Xilinx Documentation Navigator, click the Design Hubs View tab.
* On the Xilinx website, see the Design Hubs page.

Note: For more information on Documentation Navigator, see the Documentation Navigator page
on the Xilinx website.
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Xilinx IP Documentation

25. Virtual Input/Output LogiCORE IP Product Guide, (PG159)

26. Integrated Bit Error Ratio Tester for 7 Series GTX Transceivers LogiCORE IP Product Guide,
(PG132)

27. Integrated Bit Error Ratio Tester for 7 Series GTP Transceivers LogiCORE IP Product Guide
(PG133)

28. Integrated Bit Error Ratio Tester for 7 Series GTH Transceivers LogiCORE IP Product Guide,
(PG152)

29. Integrated Logic Analyzer LogiCORE IP Product Guide, (PG172)

30. JTAG to AXI Master LogiCORE IP Product Guide, (PG174)

31. LogiCORE IP System Integrated Logic Analyzer Product Guide, (PG261)

32. UltraScale+ Devices Integrated Block for PCl Express LogiCORE IP Product Guide, (PG213)
33. LogiCORE IP Devices Debug Bridge Product Guide, (PG245)

34. In-System IBERT LogiCORE IP Product Guide, (PG246)

35. UltraScale Architecture-Based FPGAs Memory IP LogiCORE IP Product Guide, (PG150)

36. AXI High Bandwidth Memory Controller LogiCORE IP Product Guide, (PG276)

37. IBERT for UltraScale GTM Transceivers LogiCORE IP Product Guide, (PG342)

Training Courses

Xilinx provides a variety of training courses and QuickTake videos to help you learn more
about the concepts presented in this document. Use these links to explore related training:

Designing FPGAs Using the Vivado Design Suite 1

Designing FPGAs Using the Vivado Design Suite 2

Designing FPGAs Using the Vivado Design Suite 4

1
2
3. Designing FPGAs Using the Vivado Design Suite 3
4
5

. Vivado Design Suite QuickTake Video: Targeting Zyng Devices Using Vivado IP
Integrator

6. Vivado Design Suite QuickTake Video: Partial Reconfiguration in Vivado Design Suite

7. Vivado Design Suite QuickTake Video: Using Vivado Design Suite with Revision Control

8. Vivado Design Suite QuickTake Video Tutorials
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https://www.xilinx.com/cgi-bin/docs/ipdoc?c=ibert_ultrascale_gtm;v=v1_0;d=pg342-ibert-ultrascale-gtm.pdf
https://www.xilinx.com/support/documentation/ip_documentation/hbm/v1_0/pg276-axi-hbm.pdf
https://www.xilinx.com/cgi-bin/docs/ipdoc?c=vio;v=latest;d=pg159-vio.pdf
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https://www.xilinx.com/cgi-bin/docs/ipdoc?c=system_ila;v=latest;d=pg261-system-ila.pdf
https://www.xilinx.com/cgi-bin/docs/ipdoc?c=pcie4_uscale_plus;v=latest;d=pg213-pcie4-ultrascale-plus.pdf
https://www.xilinx.com/cgi-bin/docs/ipdoc?c=debug_bridge;v=latest;d=pg245-debug-bridge.pdf
https://www.xilinx.com/cgi-bin/docs/ipdoc?c=in_system_ibert;v=latest;d=pg246-in-system-ibert.pdf
https://www.xilinx.com/cgi-bin/docs/ipdoc?c=ultrascale_memory_ip;v=latest;d=pg150-ultrascale-memory-ip.pdf
https://www.xilinx.com/training/courses/designing-fpgas-vivado-design-suite-1.html
https://www.xilinx.com/cgi-bin/docs/ndoc?t=video;d=hardware/targeting-zynq-using-vivado-ip-integrator.html
https://www.xilinx.com/cgi-bin/docs/ndoc?t=video;d=hardware/partial-reconfiguration-in-vivado.html
https://www.xilinx.com/cgi-bin/docs/ndoc?t=training;d=fpga/debugging-techniques-using-vivado-logic-analyzer.htm
https://www.xilinx.com/cgi-bin/docs/ndoc?t=vivado+videos
https://www.xilinx.com/training/courses/designing-fpgas-vivado-design-suite-2.html
https://www.xilinx.com/training/courses/designing-fpgas-vivado-design-suite-3.html
https://www.xilinx.com/training/courses/designing-fpgas-vivado-design-suite-4.html
https://www.xilinx.com/cgi-bin/docs/ipdoc?c=ibert_ultrascale_gtm;v=v1_0;d=pg342-ibert-ultrascale-gtm.pdf
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Please Read: Important Legal Notices

The information disclosed to you hereunder (the "Materials”) is provided solely for the selection and use of Xilinx products. To the
maximum extent permitted by applicable law: (1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS
ALL WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether
in contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related
to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special,
incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a
result of any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised
of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of
updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials
without prior written consent. Certain products are subject to the terms and conditions of Xilinx's limited warranty, please refer to
Xilinx's Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos; IP cores may be subject to warranty and
support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or for use
in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in such critical
applications, please refer to Xilinx's Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos.

AUTOMOTIVE APPLICATIONS DISCLAIMER

AUTOMOTIVE PRODUCTS (IDENTIFIED AS “XA" IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF
AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE (“SAFETY APPLICATION") UNLESS THERE IS A
SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD (“SAFETY
DESIGN"). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS, THOROUGHLY
TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A SAFETY DESIGN IS FULLY
AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING LIMITATIONS ON PRODUCT
LIABILITY.

© Copyright 2012-2019 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Vivado, Zynq, and other designated
brands included herein are trademarks of Xilinx in the United States and other countries. PCI, PCle, and PCI Express are trademarks
of PCI-SIG and used under license.All other trademarks are the property of their respective owners.
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